
 

 

 

Deltek MPM™ 3.4 

Projects Manual 
 

 

 

 

 

 

June 24, 2011 

 



While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and 
is subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published June 2011. 

© 2011 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license 
agreement. Unauthorized reproduction or distribution of the program or any portion thereof 
could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners. 

 

 

 

 

 

 

 

 

 

 

 

 



MPM Projects   iii 

Contents 
About this Manual .................................................................................. xiii 

If You Need Assistance ......................................................................... xiv 

1  Overview of Project Management ............................................ 1 

1.1  Introduction .................................................................................. 2 

1.2  General Steps for Creating and Managing a Project .................... 4 

1.3  Creating a Global Set ................................................................... 6 

1.4  Creating Logins and Assigning Access Privileges ........................ 8 

1.5  Defining the New Project ........................................................... 10 

1.6 Defining the Organizational Breakdown Structure ....................... 12 

1.7  Defining the Contract Line Item Number (CLIN) Tables ............. 14 

1.8  Defining the Work Breakdown Structure (WBS) ........................ 16 

1.9  Creating the Project Baseline ..................................................... 18 

1.10  Estimating Completion Costs ................................................... 20 

1.11  Entering Milestones and Selecting EVMs ................................. 22 

1.12  Entering Actuals ....................................................................... 24 

1.13  Revising Estimates .................................................................. 26 

1.14  Replanning the Project ............................................................. 28 

1.15  Maintaining Program Logs ....................................................... 30 

1.16  Analyzing Data Graphically ...................................................... 32 

1.17  Generating Standard Reports .................................................. 34 

1.18  Importing and Exporting Data .................................................. 36 

2  Creating and Maintaining Project Settings ........................... 39 

2.1  Introduction to Creating a Project ............................................... 40 

2.2  Accessing the Project Maintenance Window .............................. 42 

2.2.1  Opening Multiple Projects ....................................................... 44 

2.3  Orientation to the Project Maintenance Window ........................ 45 

2.4  Creating a Project ...................................................................... 46 

2.4.1  Entering the Basic Project Information .............................. 48 

2.4.2  Entering Pricing Options.................................................... 52 

2.4.3  Selecting the EQPM Calculation Method ........................... 54 

2.4.4  Selecting a Fee Calculation Method .................................. 56 



iv   MPM Projects 

2.4.5  Entering Company and Manager Information .................... 58 

2.4.6  Entering Contract Information ........................................... 60 

2.4.7 Entering Cross References ................................................ 62 

2.5 Copying and Pasting Project Information .................................... 63 

2.6 Changing the Path for a Project .................................................. 65 

2.7 Deleting Project Data .................................................................. 66 

2.8 Deleting Selected Categories of Project Data ............................. 68 

2.9 Setting Rollup Processing ........................................................... 70 

2.10 Suspending Access to a Project ............................................... 72 

2.11 Recovering Project Data ........................................................... 73 

3  Creating the Organizational Breakdown Structure (OBS) ... 75 

3.1 Introduction to OBS .................................................................... 76 

3.2 Accessing the OBS Window ....................................................... 78 

3.3 Orientation to the OBS Window .................................................. 80 

3.4 Creating the OBS ....................................................................... 82 

3.5 OBS Field Descriptions ............................................................... 84 

3.6 Maintaining the OBS ................................................................... 86 

3.7 Recommended Reports .............................................................. 88 

4  Creating the CLIN Table .......................................................... 89 

4.1 Introduction to CLIN Table .......................................................... 90 

4.2 Accessing the Contract Line Items window ................................. 92 

4.3 Orientation to the Contract Line Items Window ........................... 94 

4.4 Creating the CLIN Table ............................................................. 96 

4.5 CLIN Table Field Descriptions .................................................... 98 

4.6 Maintaining the CLIN Table ...................................................... 100 

4.7 CLIN Table Recommended Reports ......................................... 102 

5  Creating the Work Breakdown Structure (WBS) ................. 103 

5.1 Introduction to WBS .................................................................. 104 

5.1.1 Linking the WBS to the OBS ............................................ 106 

5.1.2 Structuring the WBS ........................................................ 108 

5.2 Accessing the WBS Window .................................................... 110 

5.3 Orientation to the WBS Window ............................................... 112 

5.3.1 Navigating the WBS Window ........................................... 114 



MPM Projects   v 

5.3.2 WBS Thresholds .............................................................. 116 

5.4  Creating Work Breakdown Structures ...................................... 122 

5.5  WBS Field Descriptions ........................................................... 124 

5.5.1  WBS Fields for Display Only ........................................... 131 

5.5.2  Task Descriptions ............................................................ 132 

5.6  Maintaining WBS Data ............................................................. 134 

5.6.1  Copying/Pasting WBS Legs ............................................ 136 

5.7 Changing WBS Data ................................................................. 138 

5.7.1  Using the Copy WBS Utility ............................................. 140 

5.7.2  Moving WBS Legs........................................................... 142 

5.7.3  Renaming WBS Legs ...................................................... 144 

5.7.4  Sorting WBS Legs ........................................................... 146 

5.8  Changing the WBS Display ...................................................... 148 

5.9  Recommended WBS Reports .................................................. 150 

6  Integrated Planning - An Overview ...................................... 151 

6.1  Introduction to Integrated Planning .......................................... 152 

6.2  Accessing the Views ................................................................ 154 

6.3  Selecting WBS Elements to Download .................................... 156 

6.4  Navigating the Views ............................................................... 158 

6.5  Viewing Totals ......................................................................... 160 

7  Estimating the Project Baseline........................................... 163 

7.1  Introduction to Estimating the Project Baseline ........................ 164 

7.2  Orientation to the Baseline View .............................................. 166 

7.3  Adding Resource Estimates ..................................................... 168 

7.3.1  Saving Estimates ............................................................ 171 

7.3.2  Using the Overtime Field ................................................. 173 

7.3.3  Entering Estimate Values ................................................ 175 

7.3.4  Entering Information Using Autofill .................................. 177 

7.3.5  Entering Estimate Values Using Autospread ................... 179 

7.4  Creating Apportioned Estimates .............................................. 181 

7.4.1  Special Guidelines for Apportioned Estimates ................. 183 

7.5  Baseline Field Descriptions ...................................................... 185 

7.6  Maintaining Estimate Data ....................................................... 188 

7.6.1  Copying and Pasting Estimates ....................................... 190 



vi   MPM Projects 

7.6.2  Copying and Pasting Cells .............................................. 192 

7.6.3  Deleting Estimates and Cells .......................................... 194 

7.7  Adding, Editing, and Viewing Task Descriptions ...................... 196 

7.8  Changing the Baseline Display ................................................ 198 

7.9  Basis of Estimates ................................................................... 200 

7.10  Summary Basis of Estimate ................................................... 202 

7.11  Baseline Calculations and Formulas ...................................... 204 

7.12  Previewing and Printing Baseline Estimates .......................... 206 

7.13  Recommended Baseline Reports .......................................... 208 

8  Revising the Forecast (ETC) ................................................. 209 

8.1  Introduction to Forecasting ...................................................... 210 

8.2  Orientation to the ETC View .................................................... 212 

8.3  Creating an ETC as You Create the Baseline .......................... 214 

8.4  Recommended ETC Reports ................................................... 216 

9  Tracking the Project Milestones .......................................... 217 

9.1  Introduction to Tracking Project Milestones ............................. 218 

9.2  Orientation to the Milestones View ........................................... 220 

9.3  Creating Milestones ................................................................. 222 

9.3.1  Choosing an Earned Value Method................................. 224 

9.3.2  Earned Value Method Descriptions ................................. 226 

9.3.3  Selecting a BCWP Base ................................................. 229 

9.3.4  Inserting a Milestone ....................................................... 230 

9.4  Entering Weights ..................................................................... 232 

9.4.1  Entering Weights Manually ............................................. 234 

9.4.2  Entering Weights Automatically ...................................... 236 

9.5  Statusing Milestones ................................................................ 238 

9.5.1  Specifying the As Of Month ............................................. 240 

9.5.2  Revising the Forecast Date ............................................. 242 

9.5.3  Statusing the Milestone ................................................... 244 

9.6  Modifying Milestone Information for Work in Progress ............. 248 

9.6.1  Changing an Earned Value Method ................................ 249 

9.6.2  Changing the BCWP Base .............................................. 250 

9.6.3  Changing a Milestone Weight ......................................... 251 

9.6.4  Modifying an Element’s Prior Status ............................... 252 



MPM Projects   vii 

9.6.5  Changing an Element’s Budget at Completion (BAC) ..... 254 

9.7  Impact of Budget Changes on BCWP Values .......................... 256 

9.8  Entering Information Using Autofill ........................................... 258 

9.9  Milestone Field Descriptions .................................................... 259 

9.10  Maintaining Milestones ........................................................... 263 

9.10.1  Copying and Pasting Milestones ................................... 265 

9.10.2  Copying and Pasting Cells ............................................ 267 

9.10.3  Deleting Milestones ....................................................... 269 

9.10.4  Deleting Cells ................................................................ 271 

9.11  Changing the Milestone Display ............................................. 273 

9.12  Previewing and Printing Milestones ........................................ 275 

9.13  Recommended Milestone Reports ......................................... 277 

10  Entering the Project Actuals .............................................. 279 

10.1  Introduction to Actuals ........................................................... 280 

10.2  Accessing Actuals .................................................................. 282 

10.3  Orientation to the Actuals Window ......................................... 284 

10.4  Creating Actuals..................................................................... 286 

10.5  Actuals Field Descriptions ...................................................... 288 

10.5.1  Resource Actuals Field Descriptions ............................. 289 

10.5.2  EOC Actuals Field Descriptions .................................... 291 

10.6  Maintaining Actuals ................................................................ 293 

10.7  Changing the Actuals Display ................................................ 295 

10.8  Recommended Actuals Reports and Graphs ......................... 297 

11  Utilities ................................................................................. 299 

11.1  Introduction to Utilities ............................................................ 300 

11.2  Repricing Data ....................................................................... 302 

11.2.1  Repricing Procedure...................................................... 304 

11.3  Adjusting Baseline and ETC Estimates .................................. 306 

11.3.1  Estimate Adjust Procedure ............................................ 308 

11.3.2  Entering Adjustment Units ............................................. 310 

11.4  Renaming Resource Codes and Departments ....................... 312 

11.4.1  Renaming Procedure .................................................... 314 

11.4.2  Impact on Summary BOE .............................................. 316 

11.5  Shifting the Dates for a Project .............................................. 318 



viii   MPM Projects 

11.6  Calculating BCWP ................................................................. 320 

11.7  Posting Weekly Data ............................................................. 322 

11.8  Audit Trail .............................................................................. 326 

11.8.1  Setting the Security Audit Trail Options ......................... 327 

11.8.2  Setting the Audit Trail Options in Project Maintenance.. 330 

11.8.3  Deleting Audit Trail Data in Project Maintenance .......... 332 

12  Replanning Projects ............................................................ 335 

12.1  Introduction to Replanning ..................................................... 336 

12.2  Replanning Rules and Assumptions ...................................... 338 

12.3  How Replanning Affects Other MPM Functions ..................... 340 

12.4  General Replan Procedure .................................................... 342 

12.5  Selecting a Replan Option ..................................................... 344 

12.5.1 Set Baseline Equal to Actuals ........................................ 347 

12.5.2 Set Earned Value Equal to Actuals ................................ 349 

12.5.3 Set Baseline and Earned Value Equal to Actuals ........... 351 

12.5.4 Set Baseline Equal to Earned Value .............................. 353 

12.5.5 Set Estimate to Complete Equal to Baseline .................. 355 

12.6 Selecting a WBS Leg .............................................................. 356 

13  Maintaining the Program Log ............................................. 359 

13.1  Introduction to the Program Log ............................................ 360 

13.2  Accessing the Program Log Window ..................................... 363 

13.3  Orientation to the Program Log Window ................................ 365 

13.4  Creating the Program Log ..................................................... 367 

13.5  Program Log Field Descriptions ............................................. 369 

13.6  Maintaining the Program Log ................................................. 371 

13.7  Program Log Recommended Reports ................................... 373 

14  Analyzing the Project Graphically (GDD)........................... 375 

14.1  Introduction to Graphic Drill Down ......................................... 376 

14.2  Accessing the GDD Window .................................................. 378 

14.3  Orientation to the GDD Window ............................................. 380 

14.4  Selecting the Graph ............................................................... 382 

14.5  Conditioning the Timeframe ................................................... 384 

14.6  Drilling Methods ..................................................................... 386 



MPM Projects   ix 

14.6.1  Specifying the Drill Down Method .................................. 388 

14.6.2  Drilling Down Bar or Line Graphs .................................. 390 

14.6.3  Drilling Down Stacked Bar Graphs ................................ 392 

14.6.4  Drilling Down Stacked Area Graphs .............................. 394 

14.6.5  Drilling Down Area Graphs or Grids .............................. 396 

14.7  Selecting the Data to Include ................................................. 398 

14.8  Changing the GDD Display .................................................... 400 

14.9  Outputting the Graph ............................................................. 402 

14.10  Creating Common Graphs ................................................... 404 

14.10.1  Creating an SPA Line Graph ....................................... 406 

14.10.2  Creating an EOC/Resource Usage Graph ................... 408 

14.10.3  Examining Work Done ................................................ 410 

15  Reports................................................................................. 413 

15.1  Introduction to Reports ........................................................... 414 

15.2  Accessing the Report Conditioning Windows ......................... 416 

15.3  Orientation to the Report Conditioning Windows .................... 418 

15.3.1  Conditioning the Report ................................................. 420 

15.3.2  Outputting the Report .................................................... 422 

15.4  Creating Government-Required Reports ................................ 424 

15.4.1  Entering Government Report Data ................................ 428 

15.4.2  Cost of Money Override ................................................ 432 

15.5  Viewing and Editing Reports .................................................. 434 

15.5.1  Orientation to the Report Viewer Window ...................... 436 

15.5.2  Editing Report Data ....................................................... 438 

15.5.3  Formatting Cell Content Output ..................................... 440 

15.5.4  Report Viewer Sheets ................................................... 442 

15.5.5  Setting the Report Viewer Output .................................. 444 

15.6  Batch Report Processing ....................................................... 446 

15.6.1 Using Formulated Dates ................................................. 449 

16  Importing Data ..................................................................... 451 

16.1  Introduction to Data Imports ................................................... 453 

16.1.1  General Import Steps .................................................... 454 

16.2  Accessing the Import Conditioning Windows ......................... 455 

16.3  Orientation to the Import Conditioning Windows .................... 457 



x   MPM Projects 

16.3.1 Import Data Conditioning ............................................... 460 

16.4 Creating Import Files .............................................................. 462 

16.5  Batch Import Processing ........................................................ 465 

16.5.1 Using Formulated Dates ................................................ 467 

16.5.2 Batch Import Conversion Utility ...................................... 469 

16.6 Importing Actuals .................................................................... 478 

16.6.1 Actuals Import File ......................................................... 480 

16.7  Importing BCWP .................................................................... 482 

16.7.1 BCWP Import File .......................................................... 484 

16.8  Importing Distributed Projects ................................................ 486 

16.9  Importing Estimates ............................................................... 488 

16.9.1  Importing Complete Estimates ...................................... 490 

16.9.2  Importing Partial Estimates ........................................... 491 

16.9.3 Estimates Import File ..................................................... 495 

16.10  Importing Global Files .......................................................... 498 

16.10.1  Importing Fiscal Calendars ......................................... 499 

16.10.2  Importing Holiday Calendars ....................................... 500 

16.10.3  Importing Elements of Cost ......................................... 501 

16.10.4  Importing Burden Codes ............................................. 502 

16.10.5  Importing Burden Rates .............................................. 503 

16.10.6  Importing Burden Templates ....................................... 504 

16.10.7  Importing Resource Codes ......................................... 506 

16.10.8  Importing Resource Rates .......................................... 507 

16.11  Importing Milestones ............................................................ 508 

16.11.1  Setting the Import Milestones Options......................... 510 

16.11  Importing Milestones ............................................................ 513 

16.11.2  Milestone Import File Format ....................................... 513 

16.12  Importing OBS ..................................................................... 515 

16.13  Importing Task Descriptions and Basis of Estimates ........... 517 

16.13.1  Task Description Import File Format ........................... 519 

16.13.2  Resource BOE Import File Format .............................. 521 

16.13.3  Summary BOE Import File Format .............................. 523 

16.14  Importing WBS Descriptive Data ......................................... 525 

16.14.1 Import WBS Descriptive File Format ............................ 527 

16.15  Importing WBS Schedule Data ............................................ 529 



MPM Projects   xi 

16.15.1  Shifting Milestones ...................................................... 531 

16.15.2  Import WBS Schedule File Format .............................. 533 

16.16  Automating Data Imports ..................................................... 535 

17  Exporting Data ..................................................................... 541 

17.1 Introduction to Data Exports .................................................... 542 

17.2 Accessing the Export Conditioning Windows .......................... 544 

17.3 Orientation to the Export Conditioning Windows ..................... 546 

17.4 Global Export Conditioning Options ........................................ 548 

17.5  Project Export Conditioning Options ...................................... 549 

17.6  Creating Export Files ............................................................. 553 

17.7  Using Format Files ................................................................. 555 

17.7.1  Creating Format Files .................................................... 557 

17.8  Batch Export Processing ........................................................ 559 

17.9  Using Formulated Dates ........................................................ 562 

17.10  Conditioning Options for Specific Exports ............................ 564 

17.10.1  Actuals by WBS Exports ............................................. 565 

17.10.2  Audit Trail Exports ....................................................... 567 

17.10.3  BCWP Status Exports ................................................. 569 

17.10.4  Burden Templates Exports .......................................... 571 

17.10.5  Distributed Projects Exports ........................................ 573 

17.10.6  EOC Rollups Exports .................................................. 575 

17.10.7  EOC Tables Exports .................................................... 577 

17.10.8  Estimates by WBS Exports ......................................... 579 

17.10.9  Fiscal Calendars Exports ............................................. 581 

17.10.10  Holiday Calendars Exports ........................................ 582 

17.10.11  Milestones Exports .................................................... 583 

17.10.12  Resources & Burdens Exports .................................. 585 

17.10.13  Task Descriptions and Basis of Estimates Exports .... 587 

17.10.14  WBS Data Exports .................................................... 589 

17.10.15 Weekly Data Exports .................................................. 591 

18  MSP Link .............................................................................. 599 

18.1 Introduction to the MSP Link ................................................... 600 

18.2 Accessing the MSP Link ......................................................... 602 

18.3 Orientation to the MSP Link .................................................... 604 



xii   MPM Projects 

18.3.1 Interface Conditioning Options ....................................... 606 

18.4  MSP Link Mappings ............................................................... 617 

18.4.1 Creating a New Mappings Definition .............................. 618 

18.4.2 Opening a Saved Mappings Definition ........................... 620 

18.4.3 Editing a Saved Mappings Definition .............................. 621 

18.4.4 Mappings Field Descriptions .......................................... 623 

18.5  The MSP Link Processes ....................................................... 639 

18.5.1 Generate File and Validate, Generate File ..................... 640 

18.5.2 Import ............................................................................ 645 

18.6  Batch Processing ................................................................... 647 

18.6.1  Saving an MSP Link Interface ....................................... 649 

18.6.2  Editing an MSP Link Interface ....................................... 651 

18.6.3  Deleting an MSP Link Interface ..................................... 652 

19  Using Distributed Projects ................................................. 653 

19.1 Introduction to Distributed Projects ......................................... 654 

19.2  Consolidating Distributed Projects ......................................... 656 

19.3  Running the Analyze Distributed Import File Report .............. 658 

19.4  Recommended Distributed Projects Reports ......................... 660 

19.5  Distributed Project Conversion Utility (DPCU) ........................ 661 



MPM Projects   xiii 

About this Manual 

The MPM Projects manual describes how to create and maintain the components of the 

project data. The components include: 

 Creating Projects and Settings 

 Organizational Breakdown Structures (OBS) 

 Contract Line Items (CLIN) 

 Work Breakdown Structures (WBS) 

 Integrated Planning (Baselines, ETCs, Milestones) 

 Actuals 

 Project Updating Utilities 

 Program Logs 

 Graphic Drill Down (GDD) 

 Reports 

 Imports 

 Exports 

 Distributed Projects 

Chapter Skeleton 

In writing each of the chapters in the Globals and Projects manuals, we used the 

following chapter skeleton as a guideline. 

 Introduction to the chapter 

 Accessing the application window 

 Orientation to the application window 

 Creating the objects managed by the application (for example, calendars) 

 Field descriptions for those applications that have a large number of fields 

 Maintaining the objects (for example, editing, moving, copying and pasting) 

 Changing the display (for example, filtering, expanding and collapsing items, 

displaying and hiding fields) 

 Recommended reports 

 

This general skeleton should help you locate similar information in the chapters.  
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If You Need Assistance 

If you need assistance installing, implementing, or using MPM, Deltek makes a wealth of 

information and expertise readily available to you. 

Customer Services 
For over 20 years, Deltek has maintained close relationships with client firms, helping 

with their problems, listening to their needs, and getting to know their individual 

business environments. A full range of customer services has grown out of this close 

contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

Find out more about these and other services from the Customer Care Connect 
site. 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web portal for Deltek customers 

who purchase an Ongoing Support Plan (OSP).  

The following are some of the many options that the Customer Care Connect site 

provides: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Display or download product information, such as release notes, user guides, 

technical information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Ask questions, exchange ideas, and share knowledge with other Deltek 

customers through the Deltek Connect Customer Forums 
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 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

For more information regarding Deltek Customer Care Connect, refer to the 
online help available from the web site. 

Access Customer Care Connect 
To access the Customer Care Connect site, complete the following steps:  

1. Go to https://deltek.custhelp.com.  

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

If you forget your username or password, you can click the Account Assistance 
button on the login screen for help. 

Additional Documentation  
The following table lists the additional Deltek documentation available for this 

release. Except where noted, all the user guides listed in this table are available 

for download from the Deltek Customer Care Connect site. 

Document Name Description 

MPM Installation Guide This guide describes the system requirements as well as how 

to install MPM, Data Warehouse and OLAP. 

MPM Globals Guide This guide describes how to set up and manage your Global 

Sets in MPM, which are used in all your MPM projects. 

MPM Standard Reports 

Guide 

This guide describes, and provides examples of, standard 

reports available in MPM. 

 

https://deltek.custhelp.com/
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Document Name Description 

Online Help You can access complete online Help in any of the 

following ways: 

 Click Menu Manager Help » Deltek MPM Help 

Topics 

 Press F1 from within the MPM product 

 Click the Help button on one of the MPM dialog 

boxes 
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2   Chapter 1: Overview of Project Management 

1.1  Introduction 
MPM (Micro-Frame Program Manager) is a comprehensive WBS-based system for 
integrating proposals, cost estimating, and program management. MPM meets all 
government proposal/reporting requirements and enables you to respond to the most 
complex Request for Proposal quickly and effectively. It is easy to use and intuitive, and 
provides project solutions and information in a “real time” environment. The key features 
of MPM are described below. 

Proposals and Cost Estimating 
You can use MPM to: 

 Price proposals and estimate costs 
 Prepare pre-RFPs 
 Run "what if" analysis 
 Run proposal and comparison reports 
 Prepare best and final offers 

Baseline Planning/Estimates to Complete  
 Apply indirect costs using burden templates  
 Define multiple rate tables  
 Rollover from proposal to baseline(negotiated estimates become baseline)  
 Maintain integrated but separate baseline and estimate to complete  
 Run multiple estimate at complete calculations 

Performance Measurement  
 Supports major earned value methods 
 Can define 99 milestones per WBS element 
 Integrated program log includes management reserve and undistributed budget  
 Enter actuals by resource and/or element of cost  
 Enter actuals manually or by batch import, including option to apply indirect 

costs  
 Online control account plan for simplified reporting and statusing  

C/SCSC Reporting  
 A complete set of standard reports  
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 User-defined report formats with numerous sort, conditioning, summary, and 
time window options  

 Variance analysis  
 Required government report formats including Cost Performance Report 

Formats, Cost/Schedule Status Report, and Contractor Cost Data Reports  
 Direct report interface with Excel  
 Batch reporting options 

Subcontract Management  
 Develop baselines across PCs at distributed sites  
 Automatic update of performance and actuals  
 Track subcontractor cost variance and schedule variance  
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1.2  General Steps for Creating and Managing a Project 
Below we have listed the general steps you are most likely to perform in using MPM to 
track a project. The chapters in this manual are organized in the same order. 

 Create a Global Set 
 Create Logins for Users and Assign Access Privileges 
 Create the New Project 
 Create the Organizational Breakdown Structure (OBS) 
 Create the Contract Line Item Numbers (CLIN) Table 
 Create the Work Breakdown Structure (WBS) 
 Estimate the Project Baseline 
 Enter Milestones and Select EVMs 
 Enter Actuals 
 Revise Estimates 
 Replan the Project 
 Maintain Program Logs 
 Analyze the project graphically 
 Generate Standard Reports 
 Import and Export data 

MPM is a complex product with many functions. How you use the product will depend 
on your specific environment. Some functions have prerequisites, for example you must 
create a WBS before you can estimate the project baseline. But you can use the functions 
in any order. 

Main Menu 
The majority of the functions listed above can be accessed from the Globals and Projects 
tabs in the MPM Menu Manager window. The tabs are shown in Figure A. 
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Figure A. Most of the functions in MPM are accessed from the Globals 
and Projects tabs in the Menu Manager window. 
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1.3  Creating a Global Set 
When you create a project in MPM, you must specify a broad range of information for 
the project including: 

 A fiscal calendar 
 A holiday calendar 
 Burden templates 
 Resource and burden codes 
 Resource and burden rate tables 
 Elements of Cost table 

 
In MPM, you create a “global set” that contains this information. A global set is defined 
by a global ID, description, and path. After defining a global set, you assign it to a project 
using the Project Maintenance window. The relationship is shown in Figure A.  

Figure A. Global set IDs are assigned to projects. 

Multiple Global Sets, Multiple Projects 
You can define an unlimited number of global sets, and you can assign a global set to an 
unlimited number of projects. You can share global sets as long as the projects use the 
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same calendar. If projects will be using different calendars, each project will require its 
own global set. 

For More Information 
Global sets and how to create them are described in the MPM Globals manual. 
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1.4  Creating Logins and Assigning Access Privileges 
MPM’s security features let you control user access to: 

 Different applications in the product  
 Editing features for each project 
 WBS elements for each project 

You can customize access for each user. The Equivalent User feature lets you assign the 
same access privileges to many users with a single selection from a drop-down list box. 
The Security window is shown in Figure A. 

 
Figure A. You add users and assign projects to users from the Security. 

Application Access 
You can control access to the following applications in MPM: 

 Globals. A user with Globals privileges has access to all applications on the 
Globals tab in Menu Manager. A user without this access will not be able to 
select the Globals tab. 

 Report Edit. A user with Report Edit privileges can modify the conditions 
defined for a report. Without this access, a user can run the standard reports, but 
not modify them. 

 Spread Curve. A user with Spread Curve privileges can create custom spread 
curves. A user without this access can apply spread curves to baseline estimates 
and ETCs, but cannot create custom spread curves. 
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Project Feature Access 
When you assign users access to a project, you can determine what types of edits they 
can perform by restricting their access to the different project edit features. The features 
are generally available from the menu items in the various project windows. You can 
tailor the features for each user for each project. 

Authorization Levels 
When you add a user to the MPM system, you can assign them to one of three 
authorization levels: 

 System Administrator. A user with system administrator authorization has 
access to all applications, projects, and edit features. 

 Project Administrator. A user with project administrator authorization has 
access to assigned applications, to assigned projects, and all edit features for 
assigned projects. Project administrators can also add and delete users to and 
from projects they administer. 

 User. Users with “User” authorization have only those privileges assigned to 
them by a system administrator or project administrator. 

Only system administrators and project administrators have access to the Security 
application. 

For More Information 
Creating users and assigning projects to users is covered in Chapter 8: Controlling 
Security Access to MPM in the MPM Globals manual. 
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1.5  Defining the New Project 
When you are ready to create a new project in MPM, you enter information using the 
Project Maintenance window shown in Figure A. In the window, each row represents a 
project. 

Figure A. You create a project using the Project Maintenance window. 

Required Information  
The required information includes: 

 Project ID 
 Path 
 Global Set ID 
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Full Functionality 
For full functionality of MPM, you must also complete the following fields: 

 Contract Start 
 Contract Complete 
 Baseline Rate Table 
 ETC Rate Table 
 Actuals Rate Table 
 Calendar 
 Fee Calculation 

For More Information 
Creating projects is described in Chapter 2: Creating and Maintaining Project Settings in 
the MPM Projects manual. 
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1.6 Defining the Organizational Breakdown Structure  
An Organizational Breakdown Structure, or OBS, is a pyramid- or tree-like structure 
which describes the relationships and work responsibilities of the people in your 
organization. The highest level of the OBS is the top level of management. The 
organizational structure is progressively detailed downward to the lowest level. To create 
an OBS, you use the OBS window shown in Figure A. 

 
Figure A. To create an OBS, you use the Organizational Breakdown Structure 
window. 

Types of OBS Trees 
Within the OBS, two separate organizational hierarchies (or trees) are available to 
provide detail and summary project data through the company organizational structure: 

 A Performing Organization tree reflects the hierarchy of reporting within a 
company or "line" organization.  

 A Responsible Organization tree is for projects that employ some degree of 
matrix management. The Responsible OBS can be a functional category such as 
engineering, production, management, or manufacturing. 
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Some projects use both trees while others use neither, managing the project within the 
WBS framework only. You may create one or both types of OBS tree for each project.  

How the OBS Works 
When you create an OBS element, you specify a parent department ID.  Child 
departments become parent departments and their parents become grandparents when 
you assign them subordinate departments. In Figure B, Engineering is a parent of 
Department 600 and a grandparent of Departments 601 and 602. 

 
Figure B. A Sample OBS 

When creating the WBS, you assign the WBS tasks to the OBS departments to create the 
Responsibility Assignment Matrix (RAM), typically matching work package WBS tasks 
with the Performing OBS departments, and control account WBS tasks with the 
Responsible OBS departments.  

For More Information 
Creating an OBS is described in Chapter 3: Creating the OBS. 
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1.7  Defining the Contract Line Item Number (CLIN) 
Tables 

The Contract Line Item Number (CLIN) Table contains a list of all the Contract Line 
Items in the project’s contract. CLINs summarize WBS tasks. The CLIN Table also 
contains descriptions, quantity, and reference codes for each CLIN to be reported. To 
define CLINs, you use the Contract Line Items window shown in Figure A. 

The Role of CLINs in Government Reporting 
The CLIN Table is used for providing data needed in government reports, much like 
headers (see Chapter 15: Reports for details).  

Reports Summarizing CLINs 
The MPM government reports which utilize the CLIN Table are: 

 SF 1411 Report (includes quantity and reference codes) 
 DD 1921 Report (includes element codes as defined in RFPs) 
 CLIN/SOW/WBS Report (must be linked to the WBS) 
 CLIN Table Report 

For More Information 
Defining CLINs is described in Chapter 4: Creating the Contract Line Item Numbers. 
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Figure A. To define contract line item numbers, you use the Contract Line 
Items window. 
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1.8  Defining the Work Breakdown Structure (WBS) 
A Work Breakdown Structure or WBS is an organized framework in which you can 
progressively subdivide a project’s work content into elements that can be easily 
identified and tracked. Using the WBS methodology: 

 Makes planning, scheduling, estimating, and reporting easy 
 Provides the framework for cost collection and responsibility assignment 
 Provides detail and summary reporting of cost, schedule, and performance 

MPM’s design is based on the government’s concept of supplying data by WBS, OBS, 
and EOC. Government contractors managing major procurements generally follow the 
guidelines detailed in MS-881 (DOD) and MA-0295 (DOE). 

 
Figure A. A Sample WBS 

 

To define a WBS, you use the Work Breakdown Structue window shown in Figure B. 
You define each WBS element, assigning it a unique WBS ID and a level. 

To provide time-phased cost data, you can link your OBS (which provides your 
organizational breakdown structure of human resources) to your WBS (which describes 
the tasks to be performed in the project). Linking the WBS to the OBS assigns the 
responsibility of the tasks to departments within your organization.  

For More Information 
Defining the WBS is described in Chapter 5:Creating the WBS. 
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Figure A. To create a WBS, you use the Work Breakdown Structure window. 
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1.9  Creating the Project Baseline 
After creating the globals and defining the WBS and OBS, you are ready to define the 
project baseline. The baseline defines the initial project plan. The Baseline estimate uses 
the WBS as its foundation. To create a baseline estimate, you use the Baseline tab in the 
Integrated Planning window shown in Figure A. 

To generate estimates, you assign resources to each WBS element in the left pane of the 
window. After entering the resource information, you enter estimate values in the right 
pane. You can select from the following estimates types: 

 Standard Hours (Industrial Engineering Standard Hour) 
 Hours  
 Units  
 EQP (Equivalent Persons) 
 Prime (Resource Rate x Hours) 
 Total Burdened (Prime + Overhead) 
 Total Cost (Total Burdened + G&A) 
 Total Dollars (Total Cost + COM) 
 Total Price (Total Dollars + Fee) 

Whichever estimate type you choose to enter, MPM calculates the other values 
automatically. This is one of MPM’s most powerful features. You can view any of the 
values at any time by selecting from the Estimate Type drop-down list box in the 
Toolbar. 

For More Information 
Creating the Baseline is described in Chapter 7:Estimating the Project Baseline. 

 



MPM Projects   19 

 
Figure A. To create a Baseline estimate, you use the Baseline tab in the Integrated 
Planning window. 
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1.10  Estimating Completion Costs 
After you have completed the baseline estimate, you can create a revised version of the 
baseline using the Estimate to Complete (ETC) view in the Integrated Planning window. 
The ETC view is identical in look and feel to the Baseline view. Changes you make to the 
ETC do not change the baseline estimate, making it possible to compare current estimates 
to the original baseline estimates. 

The original monthly baseline estimate data is automatically maintained by MPM to 
provide performance measurement of the baseline plan. Baseline and ETC dates are 
displayed in various Gantt and Time Analysis reports. 

When you have created the ETC, MPM can use it to: 

 Generate Estimate to Complete reports 
 Generate Latest Revised Estimate (LRE) reports 
 Graph LRE data in Graphic Drill Down (GDD) 
 Calculate Estimate at Completion (EAC) reports 

Baseline and ETC Relationship 
There are two ways to create the ETC: 

 You can save the resources estimates to the ETC as you create the Baseline. 
 You can copy the Baseline estimates to the ETC using the Project Replan 

function  

For More Information 
Estimating completion costs is described in Chapter 8: Revising the Forecast (ETC). 
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Figure A. To create an ETC, you use the ETC tab in the Integrated Planning 
window. 
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1.11  Entering Milestones and Selecting EVMs 
The Integrated Planning Milestones window provides activity work-in-progress 
assessment capability. Milestones for each WBS element are represented graphically in a 
Gantt chart. You can “status” the milestones and review the resulting changes in the 
updated fields. 

Each milestone is assigned a unique identifier, making it possible to export and import 
data keyed to specific milestones. 

Note that, as with the Baseline and the ETC, the Milestones view is based on the WBS. 

When you define milestones for a WBS element, you select an Earned Value Method 
(EVM) that you want MPM to use to calculate the Budgeted Cost of Work Performed 
(BCWP). You can select a different EVM for each WBS element, but the EVM you 
choose for a WBS element applies to all milestones assigned to that element. 

As a project progresses and milestones are met, you can status the project in MPM to 
generate a percent that represents the work that has been completed. You will usually 
status a project at the end of a fiscal period. The method you use to status the project 
depends on the earned value method you selected for each WBS element. 

For More Information 
Entering milestones is described in Chapter 9: Tracking the Project Milestones. 
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Figure A. To create milestones, you use the Milestones tab in the Integrated 
Planning window. 
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1.12  Entering Actuals 
You can enter or import the actual costs incurred by the project into MPM for analysis 
and comparison with the budget. Actuals are not collected by MPM. Your accounting 
system provides the actuals, which you can either input manually or import directly. 
MPM sorts and summarizes actual costs by WBS/OBS and then provides comparative 
reports and graphs. Actuals may be collected by Element of Cost or by Resource at any 
level of the WBS.  

 
Figure A. You enter actuals using the Actuals window. 

You can enter actuals data for resources and Elements of Cost (EOCs) by selecting the 
appropriate tab in the Actuals window. 
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Once you have entered your actuals, you can run several reports and graphs to compare 
your actuals to your budget and try to predict the costs and schedule required to finish the 
project. The graph in Figure A shows the SPA Line Graph, which compares BCWS, 
BCWP, ACWP (actuals), Schedule Variance, and Cost Variance. 

 
Figure B. You can run several reports and graphs to compare 
your actuals to your budget. 

For More Information 
Entering actuals is described in Chapter 10:Entering the Project Actuals. 
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1.13  Revising Estimates 
Even the most carefully planned project will require changes throughout its life span. 
MPM provides several utilities that facilitate making changes to estimates across an 
entire project, or selected WBS elements and legs. 

You access the utilities from the Tools menu in the Project Maintenance window. 

 
Figure A. Access the Estimate utilities from the Tools menu. 

Reprice 
You can revise Baseline, ETC, and actuals estimates in one process using the Reprice 
utility. This saves a great deal of time over modifying each estimate separately. Repricing 
is usually performed when there are major modifications to burden templates or rate 
tables. You can also use the Reprice utility to run “what if” scenarios against copies of 
your project. You can easily shift resources and change direct or indirect rates to produce 
different pricing scenarios. 

Estimate Adjust 
You can revise Baseline and ETC estimates in one process using the Estimate Adjust 
utility. The Estimate Adjust utility uses a fixed percentage to adjust the estimates. 
Estimate Repricing uses the underlying rate tables. Estimate Adjust is most useful in cost 
proposal/bid development to produce “what if” scenarios.  
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Estimate Rename 
You can rename resource codes or resource departments in the Baseline and ETC 
estimates for a project using the MPM Estimate Rename utility. The function renames 
and reprices at the same time.  

Date Shift 
If you want to change the start date for a project, or part of a project, you can use the 
MPM Project Date Shift utility. The function changes dates and reprices. 

Calculate BCWP 
Whenever you need to calculate Budgeted Cost of Work Performed (BCWP), you use the 
Calculate BCWP utility in Project Maintenance. For example, whenever you modify 
milestone information in Integrated Planning, you will want to calculate a new BCWP. 

 
Figure B. You can calculate BCWP. 

For More Information 
Using the utilities is described in Chapter 11: Utilities. 
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1.14  Replanning the Project 
During the life of a contract, changes may take place that make the available contract 
budgets for the remaining work insufficient. When this happens, it is no longer practical 
to measure performance against the available budgets. Under these circumstances, you 
should formally reprogram or replan the project. You access the Project Replan utility 
from the Tools menu in the Project Maintenance window. 

 
Figure A. Project Replan dialog box 

Formal reprogramming by a contractor may include replanning future work, replanning 
in-process work, or adjusting cost and/or schedule variances. Reprogramming allows the 
contractor to adjust the amount of budget for the remaining work to a more practical 
amount that provides realistic budget objectives, work control, and performance 
measurement. 

The MPM replanning function conforms to government requirements, and can be tailored 
to meet the needs of the contracting parties. All changes to baseline budgets are fully 
documented and traceable. 
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Applications 
Using the MPM replanning function, you can: 

 Replan an entire project, or specific WBS elements and legs 
 Replan smaller projects that do not require earned value 
 Nullify a cost variance 
 Nullify cost and schedule variances 
 Nullify a schedule variance 
 Establish ETC after entering baseline estimates 
 Set ETC equal to baseline after replanning the baseline 

For More Information 
Replanning projects is described in Chapter 12: Replanning Projects. 
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1.15  Maintaining Program Logs 
Program Logs provide a synergistic link between budget data and the internal control 
procedures and practices that implement budget changes. The logs are used to record total 
budget and all customer-directed changes that affect the baseline. Changes are identified 
as negotiated changes or authorized unpriced updates. Program Logs contain the status of 
the Management Reserve (MR) and Undistributed Budget (UB). To create program logs, 
you use the Program Log window. 

 
Figure A. To create program logs, you use the Program Log window. 
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The Role of Program Logs in Government Reporting 
If your project requires submittal of the government reports C/SSR, CPR, or NASA, you 
can create and maintain program logs to satisfy control and auditability requirements for 
government contracting. 

MPM uses the values you enter in the Program Logs to perform calculations, which in 
combination with header values you also enter, result in computed fields displayed on the 
C/SSR, CPR and NASA report headers 

Program Log +
CPR Header

values you enter
Calculated values
on CPR Reports=

Program Log +
C/SSR Header

values you enter
Calculated values
on C/SSR Report=

 
Figure A. Calculations Used in Government Reporting. 

For More Information 
Program logs are described in Chapter 13: Maintaining the Program Log. 
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1.16  Analyzing Data Graphically 
Graphic Drill Down™ (GDD) is a management tool that provides the ability to 
graphically display and explore data created in MPM. GDD provides a wide range of 2-D 
and 3-D charts, graphs, and grids. You can graph schedule, cost, actuals, variances, and 
condition the data in many powerful ways, to represent and analyze the data in your 
project. 

By displaying your project’s data as a graph, you can drill down (display additional detail 
information) into the data by clicking on a portion of a graph. For example, you can view 
a Horizontal Bar Graph that displays Timeframe cumulative BCWS in Total Dollars, then 
click on a bar representing a specific month to view a breakdown of cumulative BCWS 
data through that fiscal month. You can continue to drill down into a time period and into 
a WBS leg. 

You can drill down by WBS, Element of Cost, or Resource. You can also choose to 
display any or all of the following types of data: 

 Budgeted Cost of Work Scheduled (BCWS) 
 Budgeted Cost of Work Performed (BCWP) 
 Actual Cost of Work Performed (ACWP) 
 Estimate to Complete (ETC) 
 Latest Revised Estimate (LRE) 
 Schedule Variance 
 Cost Variance 
 Other Variance 

For More Information 
Graphic Drill Down is described in Chapter 14: Analyzing the Project Graphically 
(GDD). 
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Figure A. You can drill down to see increasing levels of detail. 
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1.17  Generating Standard Reports 
MPM provides a variety of tabular and graphic standard reports, specifically designed to 
meet government reporting requirements and your in-house reporting and analysis needs. 
You can condition each report to select its content and format for a specific purpose. To 
run the reports, you use the Reports tab in the Menu Manager window. For more 
information on reports, see Chapter 15: Reports. 

 
Figure A. You run reports from the Reports tab in the Menu 
Manager window. 

The table below lists the types of reports offered in MPM: 
Type Reports 
Baseline Reports Resource Detail and Summary Reports 
 Manpower Detail and Summary Reports 
 Responsibility Assignment Matrix Reports 
 Work Authorization Document Reports 
 Project Comparison Reports 
 Apportioned Estimates Relationships – Baseline Reports 
Proposal Reports SF 1411 Reports  
 DD 1861 Reports 
 DD 1921 Reports 
 CLIN Table Reports 
 Resource Department Summary Reports 
 Resource and Summary Basis of Estimate Reports 
 CLIN/SOW/WBS Reports 
 Proposal Summary Reports by WBS or CLIN Reports 
 Labor/Price Summary by WBS or CLIN Reports 
 Burden/Fee Detail/Summary – Baseline/ETC Reports 
Cost and Forecast Reports Resource Detail/Summary – Actuals, ETC, Budget/LRE 
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Type Reports 
Cost and Forecast Reports (cont.) Element of Cost Reports, including: 

WBS Recap by EOC Reports 
Budget/Actuals Recap by EOC Reports 
Element of Cost/Class Detail Reports 
S/P/A Tabular and Recap by EOC Reports 
Actuals by EOC or Charge Number Reports 

 Project Comparison Reports 
 Work Status Document – EV or Budget/LRE Reports 
Planning and Analysis Reports Detail Variance Analysis Reports 
 EVM Planning & Analysis Reports 
 Program Log, Management Reserve Log, Undistributed 

Budget Log Reports 
 Apportioned Estimates Relationships – ETC Reports 
 Price/Usage Variance Analysis Reports 
 Control Account Plan Report 
 Compare Detail versus EOC Rollup Reports 

Compare Detail versus Summary Rollup Reports 
 EAC Comparison Reports 
 Weekly Performance Report 
 Weekly EOC Detail Report 
 Weekly EOC Rollup Report 
DOD/DOE Reports CPR Format  1 Reports (in three formats) 
 CPR Format  2 Reports (in three formats) 
 CPR Format  3 Reports (in three formats) 
 CPR Format  4 Reports (in three formats) 
 C/SSR Reports (in two formats) 
NASA Reports NASA533 M Reports 
 NASA533 P Reports 
 NASA 533 Q Reports 
Administrative Reports OBS Indented Reports 
 OBS Burden Templates Reports 
 WBS Hierarchy Reports 
 WBS Indented Reports 
 Task Description Reports 
Globals Reports Element of Cost Table 
 Resources and Burdens 
 Responsibility Assignment Reports 
 Accounting Calendar Reports 
 Spread Curves Reports 
Worksheets/Documents Milestone Status Turnaround Document 
 Variance Analysis Turnaround Document 
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1.18  Importing and Exporting Data 

Importing Data 
Use the Data Imports to bring data into the various MPM modules. Many customers 
import some of their cost or scheduling data from other software systems, such as 
accounting or personnel systems. There are also customers who export their MPM data, 
make some change to it, and then import it back into MPM. 

MPM allows import of the following types of data: 

 Actuals  BCWP 
 Calendars  Distributed Projects 
 EOC Tables  Burdens and Resources 
 Burden Templates  Estimates 
 Milestones  Task descriptions 
 Basis of Estimate  Descriptive WBS data 
 WBS Schedule data  OBS data 

 

 
Figure A. To import data, you use the Imports tab in the Menu 
Manager window. 

Exporting Data 
You can use the Data Exports to save data out of the various MPM modules. Many 
customers export some of their cost data for use in other software systems, such as 
accounting or personnel systems. There are also customers who export their MPM data, 
make some change to it, and then import it back into MPM. 
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MPM performs exports of the following kinds of global data: 

 Fiscal Calendar  Holiday Calendar 
 Burden Templates  Element of Cost Table 
 Resource Library  

 
MPM performs exports of the following kinds of project data: 

 Actuals by WBS  BCWP Status 
 Distributed Project  EOC Rollup by WBS 
 Estimates by WBS  Milestones 
 Resource BOE  Task Descriptions 
 WBS  

 

 
Figure B. To export data, you use the Exports tab in the Menu 
Manager window. 

For More Information 
Importing data is described in Chapter 16: Importing Data. Exporting data is described 
in Chapter 17: Exporting Data. 
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2.1  Introduction to Creating a Project 
To create a project in MPM, you enter information using the Project Maintenance 
window shown in Figure A.  

 
Figure A. You create a project using the Project Maintenance window. 

The required information includes:  

 Project ID 
 Path for project files 
 Global ID 

For full functionality of MPM, you must also complete the following fields: 

 Contract Start date 
 Contract Complete date 
 Baseline Rate Table 
 ETC Rate Table 
 Actuals Rate Table 
 Fiscal and Holiday Calendar 
 Fee Calculation (by WBS or Resource) 
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Before You Begin 
Before you can create a project, you must have defined a global set for the project in the 
Global Maintenance application. If you have not defined a specific global set for the 
project, you can use the Default global set, but this is not recommended. For information 
on defining global sets, see Chapter 1: Creating and Managing Global Sets in the MPM 
Globals manual. 

Headers 
The MPM government-required reports contain data which is not tracked by MPM. You 
can enter values for the Header, Variance, and COM data in the Program Log and/or on 
the Header dialog.  These values are saved with the project. You can then use the values 
repeatedly on multiple reports. The values appear as the default when requesting reports 
that use them. For more information on the operation of the Program Log and headers, 
see topic 13.1 Introduction to the Program Log and topic 15.4.1 Entering Government 
Report Data. 
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2.2  Accessing the Project Maintenance Window 
You access the Project Maintenance view from the MPM Menu Manager. When you 
open the Project Maintenance window, the projects displayed are those to which you 
have been given access.  Rows containing projects are displayed in gray with only the 
Project ID, Program Name, Project Description, Path and Global ID columns populated.  
By loading only a partial record for each project, performance is increased.  

 
Figure A. Project records as displayed upon opening Project Maintenance. 

The remaining project data is loaded by double-clicking the Folder Open icon next to the 
row number of the project you want to work with.  The entire project record is then 
loaded and displayed for the project you selected.  

You can also open several projects at one time using the Multiple Projects Open function.  
(See topic 2.2.1 Opening Multiple Projects, for detailed information.) 

Most functions on the Edit menu and the Tools menu cannot be used until the 
entire project record is loaded.  

 
Figure B. Project records as displayed after clicking the Folder Open icon. 
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Procedure  
To access the Project Maintenance window: 

1. From the Menu Manager window, click the Projects tab and do one of the 
following: 

 Select the Project Maintenance icon. 
 From the File menu, select Projects | Project Maintenance. 

 MPM displays the Project Maintenance window shown in Figure A listing the 
Project ID, Program Name, Path and Global ID information for each project.   

2. Double-click the Folder Open icon for the project you want to work with to 
display the entire project record for the project. 
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 Accessing the Project Maintenance Window 
2.2.1  Opening Multiple Projects 

The Multiple Projects Open function allows you to open several projects in one 
operation. 

Procedure 
To access the Multiple Project Open function: 

1. From the Menu Manager window, click the Projects tab. 

2. Click the Project Maintenance icon to display the Project Maintenance window. 

3. From the File menu, select Multiple Project Open.  MPM displays the Multiple 
Project Open dialog shown in Figure A. 

 

Figure A. Multiple Project Open 

4. Highlight all the projects you want to open.  To select contiguous projects, press 
Shift+Enter.  To select noncontiguous projects, press Ctrl+Enter. 

5. Click OK when you have selected all the projects you want to open. 
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2.3  Orientation to the Project Maintenance Window 
The Project Maintenance window is the grid you use to enter project information. You 
can scroll the window left and right, and up and down. Projects are listed alphabetically 
by Project ID. 

 
Figure A. Project Maintenance window 

Navigating 
You can scroll the display horizontally and vertically, and resize the window. When you 
scroll the window, MPM displays locator boxes showing the column name when you 
scroll horizontally, and the row number and Project ID when you scroll vertically. 

Special Symbols 
If MPM has trouble accessing a project file, it displays an icon in front of the row 
number. The different icons are described below. 

Icon Description 

 Indicates the .HED file cannot be found. Double clicking the icon 
brings up the Locate Project Files dialog box. 

 Indicates the .HED file is locked. Double-clicking the icon tries 
again to get the file. 

Previewing and Printing 
You can preview the grid online and print it by clicking the corresponding buttons 

 in the Toolbar, or by selecting the corresponding commands under the File menu. 
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2.4  Creating a Project 
To create a project in MPM, you enter information using the Project Maintenance 
window shown in Figure A. 

 
Figure A. The required fields are Project ID, Path, and Global ID. 

The required information includes: 

 Project ID 
 Path for project files 
 Global ID 

For full functionality of MPM, you must also complete the following fields: 

 Contract Start date 
 Contract Complete date 
 Baseline Rate Table 
 Fiscal and Holiday Calendar 
 Fee Calculation 

All other fields are optional and do not impact the functionality of the product. 
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Each of the fields is described in the sub-topics that follow. The fields are described in 
the order they are displayed in the window. To facilitate documenting the fields, the 
fields have been grouped into the following topics: 

Topic Fields Described 

2.4.1 Entering the Basic Project Information Project ID 
Program Name 
Project Description 
Contract Start 
Contract Complete 
Path 
Global ID 

2.4.2 Entering Pricing Options Baseline Rate Table 
ETC Rate Table 
Actuals Rate Table 
Rate Table Override 
Burden Template Override 

2.4.3 Calendar Fields  Calendar 

2.4.4 Fee Calculation Fields Fee Calculation 

2.4.5 Company and Manager Information Fields Company Name 
Program Manager 
Program Manager Phone Number 
Proposal Manager 
Proposal Manager Phone Number 

2.4.6 Contract Information Fields Proposal No. 
Contract No. 
Internal ID 
Program Type 
Contract Type 

2.4.7 Cross References Fields Xref-1 through Xref-10 
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2.4  Creating a Project 
2.4.1  Entering the Basic Project Information 

When you setup a project, you should enter the following fields: 

 Project ID (required) 
 Program Name (optional) 
 Project Description (optional) 
 Contract Start and Complete dates (required) 
 Path for project files (required) 
 Global ID (required) 

Figure A. There are only a handful of required fields. 

Path Conventions 
You can use Universal Naming Conventions (UNC) for the path of global or project files.  
You can also use UNC when saving exports or reports to a file or for the location of an 
import file. 

The following information is excerpted from the Microsoft Developers Network: 

You can access a file on a shared network resource by entering the file's location 
in UNC format, or by browsing Network Neighborhood. To specify a file using UNC 
format, use the following syntax:  

\\computername\sharename\path\filename  

For example, to access a file named Report.xls in the Current\Month folder on a 
share named Documents on a computer named Sales, you would use the following 
syntax:  

\\sales\documents\current\month\report.xls  

The file system uses the backslash (\) character to separate directory names and the file 
name when forming a path.  
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 Use a period (.) to separate the base file name from the extension in a 
directory name or file name.  

 Do not use device names, such as aux, con, lpt1, and prn, as file names or 
directory names.  

 Do not assume case sensitivity. Consider names such as OSCAR, Oscar, and 
oscar to be the same.  

Do not use the following characters in directory names or file names because 
they are reserved:  

Symbol 
Name 

Symbol Symbol 
Name 

Symbol 

Less Than < Backslash \ 

Greater 
Than 

> Forward 
Slash 

/ 

Colon : Quotation 
Mark 

“ 

Pipe |   

 
Backward slashes (\) are used as element dividers in paths (dividing the file name from 
the path to it, or directories from one another in a path). You cannot use them in file or 
directory names. They may be required as part of volume names (for example, C:\). 

For additional information about UNC Path Support, please refer to msdn.Microsoft.com. 

Procedure 
To enter the fields: 

1. Enter a unique project ID.  

 The project ID can be up to 20 characters long. You can use letters and numbers, 
as well as the other standard characters. 

2. (Optional) Enter a Program Name for the project.  

 The description can be up to 40 characters long. 

http://msdn.microsoft.com/
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3. (Optional) Enter a description for the project, then select OK. The description 
will only be saved when the project information is saved. I.e., When you remove 
focus from that project row, a Project Maintenance dialog asks if you would like 
to save the changes. The information is only saved once you select Yes.  

This field contains a notepad button . When the notepad button is clicked, the 
project description dialog is displayed (see Figure B). This dialog has a field size 
of 450 characters, with the first 30 characters (or first characters prior to a 
carriage return) displayed in the Project Description cell.  

If the notepad button is double-clicked when the project is in grey mode, the 
Project description dialog will be Read Only regardless of security rights. 

If the notepad button is double-clicked when the project is in edit mode, the 
Project Description dialog will be Read/Write if the user has Edit Project 
Information rights.  

A user with no edit rights will still be able to click on the notepad button and 
view the description, but will not be able to make any changes to it.  

 
Figure B. Project Description dialog. 

4. Enter the contract start and complete dates.  

 MPM accepts most date formats up to eight characters long, then converts them 
to the DD-MMM-YY format shown in Figure A. 

5. Enter the path where the project files will be located, or select it by clicking on 
the button at the end of the Path field.  

 If you clicked on the button, MPM displays the Choose Directory dialog box 
shown in Figure C. 
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Figure C. You can select a project path. 

6. Select the directory and choose OK. 

7. After entering the path, select the Global ID you want assigned to the project.  

 For information on defining global IDs, see Chapter 1: Creating and 
Maintaining Global Sets in the MPM Globals manual. 

8. Select the default resource tables to be used for each of the following: 

 Baseline Rate Table 
 ETC (Estimate to Complete) Rate Table 
 Actuals Rate Table 

 For information on defining resource tables, see the MPM Globals manual. 

9. Save the project information by doing one of the following: 

 Click the Save button  in the Toolbar. 
 From the File menu, choose Save. 
 Press Ctrl+S. 
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2.4  Creating a Project 
2.4.2  Entering Pricing Options 

MPM bases its baseline, ETC (estimate to complete), and actuals calculations on rate 
tables defined in the Globals application. When you define a project, you designate which 
rate tables to use for each calculation. In Figure A, all projects are using Baseline Rate 
Table 1. For information on defining resource tables, see the MPM Globals manual. 

 
Figure A. Select the rate tables you want used for calculating baseline, ETC, 
and actuals. 

You can also specify if the rate table selections and burden templates can be overridden 
in the Baseline and ETC windows in the Integrated Planning application. The Baseline 
fields in Integrated Planning are shown in Figure B. 

 
Figure B. The Override options control whether you can select different rate 
tables and burden templates in the Integrated Planning window. 
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Selecting Rate Tables 
To select the rate tables: 

1. Open the Baseline Rate Table drop-down list box and select a rate table. 

2. Do the same for the ETC and Actuals rate tables. 

Setting Rate Table Overrides 
By default, the rate tables you select cannot be overridden in the Integrated Planning 
application. You should begin a project with the override options set to off (no 
checkmark). If a situation arises that requires you to override the rates, you can change 
the setting.  

To change the setting, double-click in the Rate Table Override field. MPM places a check 
mark in the field indicating that the rate tables can be overriden. 

Setting the Burden Template Override 
When you define a resource in the Globals – Resources and Burdens application, you can 
assign the resource a burden template. When you add the resource to the WBS structure 
in a baseline estimate or ETC, you can assign a different burden template if the Burden 
Template Override field in the Project Maintenance window is checked. 

To change the setting, double-click in the Rate Table Override field. MPM places a check 
mark in the field indicating that the rate tables can be overridden. 
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2.4  Creating a Project 
2.4.3  Selecting the EQPM Calculation Method 

The Calendar field lets you select how MPM will calculate equivalent person months. 
The options are Resource Work and EQPM Hours. 

 
Figure A. The Calendar field lets you select how 
MPM will calculate equivalent person months. 

Resource Work 
If you select Resource Work, MPM calculates equivalent person months using the hours 
per day and days per week defined for each resource in the Resources and Burdens 
Global window shown in Figure B. 

 
Figure B. The Resource Work option uses the Hours/Day and 
Days/Week fields to calculate equivalent persons. 
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EQPM Hours 
If you select the EQPM Hours option, MPM calculates equivalent person months using 
the figures entered in the Equivalent Person Month Hours grid of the Calendar 
application shown in Figure C. 

 
Figure C. The EQPM Hours option uses the Equivalent Person Month Hours grid 
to calculate equivalent persons. 
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2.4  Creating a Project 
2.4.4  Selecting a Fee Calculation Method 

The Fee Calculation field lets you select how MPM will calculate fees: by WBS or by 
Resource. 

 
Figure A. The Fee Calculation field lets you select 
how MPM will calculate fees. 

WBS Option 
If you select the WBS option, MPM calculates fees for baseline estimates and ETC 
using the Fee % assigned to the WBS element in the Work Breakdown Structure 
window shown in Figure B. When fee is calculated by WBS: 

 Fee is always calculated against total cost in Integrated Planning.   

 Repricing actuals will not generate fee if the WBS option is selected;  
reprice calculates fee only if the Resource option for fee calculation is  
selected. 

 
Figure B. The WBS option uses the Fee % field to calculate fees. 
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Resource Option 
If you select the Resource option, MPM will calculate fees for baseline estimates and 
ETC using the burden template assigned to the resource in the Resources and Burdens 
application. 

 
Figure C. The Resource option uses the burden template assigned to 
the resource to calculate fees. 
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2.4  Creating a Project 
2.4.5  Entering Company and Manager Information 

All company and manager information fields are optional. They do not impact any of the 
calculations performed by MPM. To enter information in any of these fields, select the 
field and type in the information. The fields are shown in Figure A. 

 
Figure A. The company and manager fields are optional. 

Company Name 
You can enter up to 40 characters, including spaces. 

By default, this field is hidden. To display the field, select Column Hide from the Format 
menu. MPM displays the Column Hide dialog box. To select the field, hold down the Ctrl 
key and click on the column name. 

Program Manager 
You can enter up to 20 characters, including spaces. 

Program Manager Phone Number 
You can enter up to 12 characters, including spaces. 

By default, this field is hidden. To display the field, select Column Hide from the Format 
menu, hold down the Ctrl key, and click on the column name. 
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Proposal Manager 
You can enter up to 20 characters, including spaces. 

Proposal Manager Phone Number 
You can enter up to 12 characters, including spaces. 

By default, this field is hidden. To display the field, select Column Hide from the Format 
menu. MPM displays the Column Hide dialog box. To select the field, hold down the Ctrl 
key and click on the column name. 
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2.4  Creating a Project 
2.4.6  Entering Contract Information 

All contract information fields are optional. They do not impact any of the calculations 
performed by MPM. The fields are shown in Figure A. 

 
Figure A. The contract information fields are optional. 

Proposal No. 
Enter the customer’s proposal identifier number if applicable. The number may be up to 
20 characters. 

If you enter a number, the number will be printed in the upper right corner of the header 
on all tabular Baseline reports. 

Contract No. 
Enter the customer’s contract number if applicable. The number may be up to 20 
characters. 

If you enter a number, the number will be printed in the upper right corner of the header 
on all tabular Baseline reports. 

Internal ID 
Enter the number assigned to the project by your accounting department. The number 
may be up to 20 characters. 

By default, this field is hidden. To display the field, select Column Hide from the Format 
menu. MPM displays the Column Hide dialog box. To select the field, hold down the Ctrl 
key and click on the column name. 
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Program Type 
You can use the Program Type field to identify the different types of programs conducted 
by your company. You identify the programs by entering abbreviations that can be up to 
five characters.  

Contract Type 
You can use the Contract Type field to identify the different types of contracts used by 
your company. You identify the contracts by entering abbreviations that can be up to five 
characters long. For example, “PROD” could be used for Production. 
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2.4  Creating a Project 
2.4.7 Entering Cross References 

You can use the cross reference fields to enter information specific to your operation. 
There are 10 cross reference fields: Xref-1 through Xref-10. The values you enter for the 
Xref fields in the Project Maintenance window become column headings for fields in the 
WBS window, and can be used in reports. 

 
Figure A. The values you enter in the Xref fields become column 
headings in the WBS window. 

SOW 
If you want SOW data included on the CLIN/SOW/WBS Baseline Report, one of the 
Xref fields must be labeled “SOW.” 

Distributed Project Function 
If you plan to use the Distributed Project function, you must change the Xref-1 field label 
to “DISTRIBUTED” in all upper case letters. 
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2.5 Copying and Pasting Project Information 
If you have the appropriate access privileges to a project, you can copy and paste 
individual fields or all fields for a project. 

You can copy individual fields for one or more projects at a time. Read-only fields and 
hidden columns included in a selection, although not visible, are copied along with the 
editable fields. 

When you paste information, MPM checks the format of the data to ensure it conforms to 
the field requirements. 

If you copy and paste a project, you must specify a new Project ID, and optionally 
change the path. You can copy only one project at a time. 

Copying and Pasting Fields 
To copy and paste one or more fields: 

1. Select one or more adjacent fields. 

 You cannot select fields that are not adjacent. However, by using the Column 
Hide feature, you can remove intervening fields. 

2. Place the contents of the fields onto the clipboard by doing one of the following: 

 Click the Copy button  in the Toolbar. 
 From the Edit menu, choose Copy Cell(s). 

3. Place the cursor at the location where you want to insert the information and do 
one of the following: 

 Click the Paste button  in the Toolbar. 
 From the Edit menu, choose Paste Cell(s). 

 MPM pastes the information into the cells. If the information is not valid for a 
field, MPM displays an appropriate message. 

Copying and Pasting Projects 
To copy and paste projects: 

1. Select a project. 

 You can only select one project at a time. 

2. Place the contents of the project onto the clipboard by doing one of the 
following: 
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 Click the Copy button  in the Toolbar. 
 From the Edit menu, choose Copy Project. 

3. Select the empty row where you want to paste the project information. 

4. From the Edit menu, choose Paste Project. 

 MPM displays the Copy Project dialog box shown in Figure A. 

 
Figure A. Specify a project ID and path. 

5. Enter a unique Project ID. The Project ID can be up to 20 characters long. You 
can use letters and numbers, as well as the other standard characters. 

6. Enter a path for the project, or select a path by clicking the Browse button. 

7. To accept the settings, click OK. 

 MPM inserts a new project row and fills in the project data. 
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2.6 Changing the Path for a Project 
You can move the files for a project to a new directory by entering a new path in the Path 
field. When you enter a new path, MPM runs a number of checks to make sure the move 
can be executed. The checks performed are summarized below. 

If: Then MPM displays the following message: 

Path has been changed on an 
existing project 

Move project files from xxx to yyy? 

All project files are not 
available for moving 

The operation cannot be performed because there are 
users currently accessing Project xyz. 

Path does not exist The specified directory path x:\yyyy\zzz does not exist. 
Do you wish to create it? 

Adequate disk space does not 
exist 

Insufficient disk space at x:\yyyy\zzz. 
Space required:  NN,NNN 
Space Available:  N,NNN 

Only a drive letter is entered 
for the path 

Root directory files are not supported 

Drive specified is not 
available or invalid 

Invalid disk drive 

Directory Invalid directory name 

Users are accessing the project The operation cannot be performed because there are 
users currently accessing Project XYZ 

 

To move project files, you must have the appropriate rights. 

Procedure 
To move the files for a project to a new directory: 

1. Enter the directory name in the Path field. 

2. Save the change. 

 If MPM successfully completes all the checks, it performs the move. 
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2.7 Deleting Project Data 
You can delete data in cells on the Project Maintenance grid, delete all project data or 
delete selected categories of data using the Delete Project Data command under the Edit 
menu. To delete project data, you must have the appropriate access privileges. If someone 
is currently working with a project, you cannot delete the project data. 

Deleting data from cells and deleting all project data are described in this topic. Deleting 
selected categories of data is described in the next topic. 

Warning! Deletion of project data is final. Exercise extreme caution when 
deleting project data. Always back up your project data before deleting the data. 
Always delete project files through MPM, never through any file management 
tool. Project files contain pointers. If you delete them through a file management 
tool, you will corrupt the database. 

Deleting Data in Cells 
To delete project data in one or more cells: 

1. Select one or more cells in one or several projects. 

 The cells must be adjacent to one another. 

2. Initiate the delete by doing one of the following: 

 Open the Edit menu and select Delete Cell(s). 
 Press the Delete key. 
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 MPM deletes the selected data from the cells and takes one of several actions 
based on the data you deleted. 

If you deleted one of 
these fields: 

 
Then MPM: 

Project ID 
Path 

Fills the field with <Required>. 

Global ID 
Baseline Rate Table  
ETC Rate Table 
Actuals Rate Table 
Calendar 
Fee Calculation 

Fills the field with the default value. 

 

Deleting Projects 
You can delete the data for an entire project. You can delete only one project at a time. 

Warning! Once you delete a project, you cannot restore it from MPM. 

To delete a project: 

1. Select a project. 

2. Initiate the delete by doing one of the following: 

 Open the Edit menu and select Delete Cell(s). 
 Press the Delete key. 

 MPM asks you to confirm the delete. 

3. To confirm the delete, click Yes. 

 If MPM cannot find the files, it will still delete the project data from the grid. 

 If the project is locked, you will not be able to delete the project. 
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2.8 Deleting Selected Categories of Project Data 
If you want to delete selected categories of project data, you use the Delete Project Data 
command under the Edit menu. 

 
Figure A. Select the types of data you 
want to delete. 

Warning! Deletion of project data is final. Exercise extreme caution when 
deleting project data. Always back up your project data before deleting the data. 
Always delete project files through MPM, never through any file management 
tool. Project files contain pointers. If you delete them through a file management 
tool, you will corrupt the database. 

Procedure 
To delete selected categories of project data: 

1. From the Edit menu, choose Delete Project Data. 

 MPM displays the Delete Project Data dialog box shown in Figure A. 
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2. Select the data you want to delete.  

3. To accept the categories and execute the delete, click OK. 

Limiting Deleted Data 
You can specify limits for deleting BCWS, ETC, and ACWP data. The limits are 
described below. 

Data Limits 
BCWS You can select a specific WBS leg. If you do not select a leg, BCWS will be 

deleted for the entire project. 
You also can limit the delete to replan estimates only. 
 

ETC You can select a specific WBS leg. If you do not select a leg, ETC will be 
deleted for the entire project. 
 

ACWP If selected, both actuals by resource and actuals by element of cost will be 
deleted. 
You can select a specific WBS leg. If you do not select a leg, ACWP will be 
deleted for the entire project. 
You can limit the delete using the From and Through months. The dates 
entered must fall within the projects’ fiscal calendar. If you do not enter 
months, ACWP will be deleted for the entire duration of the project. 
 

Monthly 
Status % 

If selected, this option deletes both BCWP Monthly Status records and BCWP 
from rollup file.  When Monthly Status (%) is selected, the Performance 
(BCWP) option is automatically included and the check box is dimmed. 

Performance 
(BCWP) 

If selected, BCWP only is deleted from the rollup file. 
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2.9 Setting Rollup Processing 
If you are working on large projects, the time it takes MPM to calculate rollup values can 
slow down data entry. MPM gives you the option of turning off rollup processing. After 
you have entered the data, you can turn rollup processing back on and MPM will 
calculate and update all rollup figures. 

 
Figure A. Rollup Processing dialog box 

EOC and Summary Options 
There are two types of rollup processing: EOC and Summary. The EOC rollup controls 
all onscreen summaries. The Summary option controls summaries for Proposal Summary 
Reports only. 

If you turn the EOC rollup option off, it has the following effects: 

 The WBS element summaries and WBS column totals will not be updated. 
 The following utilities will be unavailable: Date Shift, Estimate Reprice, 

Estimate Adjust, Estimate Rename, Calculate BCWP, and WBS Leg Utilites.  
 The Summary option is disabled. 
 The Rollup Processing dialog box shown in Figure A displays a message next to 

the option indicating when it was set to off. 



MPM Projects   71 

If you turn the Summary option off, it has the following effects: 

 Summary records are not available in the following reports: Proposal Summary 
Report by WBS, Proposal Summary Report by CLIN, Labor/Price Summary by 
WBS, Labor/Price Summary by CLIN, and Resource Department Summary. 

 The Rollup Processing dialog box shown in Figure A displays a message next to 
the option indicating when it was set to off. 

Rebuild Options 
You can choose to rebuild estimates, actuals, or both. If you turn on the EOC or 
Summary option after they have been off, MPM automatically calculates and rebuilds the 
values for these options when you choose OK. 

Procedure 
To set the Rollup Processing options: 

1. Select a project. 

2. From the Tools menu, choose Rollup Processing. 

 MPM displays the Rollup Processing dialog box shown in Figure A. 

3. Select the appropriate options and click OK. 
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2.10 Suspending Access to a Project 
If you are going to use one of the utilities, or perform other maintenance on a project, it is 
best to prevent users from working with the project by using the Suspend function. The 
Suspend function prevents users from accessing a project. If a user is currently editing a 
project when you initiate the Suspend, they will be able to continue working until they 
close the project. 

You control the Suspend function using the Suspend Users field in the Project 
Maintenance grid. 

 
Figure A. You can suspend access to a project. 

Procedure 
To suspend access to a project: 

1. Double-click the Suspend Users field. 

 MPM places a check mark in the field, enters your user ID in the Suspended By 
field, and enters the current system date in the Suspended Date field. 

2. To clear the suspend, double-click the Suspend Users field. 

 MPM removes the check mark from the field, clears your user ID from the 
Suspended By field, and clears the date from the Suspended Date field. 
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2.11 Recovering Project Data 
It is possible for one or more of the data files that make up a project to become corrupted. 
When this happens, you need to run the recover utility. The recover utility attempts to 
reset the database indexes and correct any internal file errors.  

 
Figure A. You can recover project 
files that have been corrupted. 

The files that can be recovered are shown in Figure A 

Before You Begin 
Before you begin the recovery process, be sure all users are logged out of MPM. This 
will prevent a user from accessing the files while you are running the recovery. 
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Procedure 
To recover project files: 

1. Select the project that has the corrupted files. 

2. From the Tools menu, select Recover Files. 

 MPM displays the Recover Files dialog box shown in Figure A. 

3. Select the files you want to recover. 

 You can use the Shift+Click and Ctrl+Click combinations to select two or more 
files. 

4. To start the recovery process, click OK. 

 MPM asks you to confirm the recovery operation. 

5. To continue with the recovery, click Yes. 

MPM executes the recovery, displaying an hour glass during the process.  

If there are files that could not be recovered, MPM displays the following message: 

Data records from the following files cannot be recovered: ‘xxxx’, 
‘yyyyy’. Files may have to be recovered from backup. 

If any project files are unrecoverable, then the entire project must be restored from a 
full backup. 

 



MPM Projects   75 

3  
Creating the Organizational Breakdown 
Structure (OBS) 

3.1 Introduction to OBS ...................................................................... 76 
3.2 Accessing the OBS Window ......................................................... 78 
3.3 Orientation to the OBS Window.................................................... 80 
3.4 Creating the OBS ......................................................................... 82 
3.5 OBS Field Descriptions ................................................................ 84 
3.6 Maintaining the OBS .................................................................... 86 
3.7 Recommended Reports................................................................ 88 

 



76   Chapter 3: Creating the Organizational Breakdown Structure (OBS) 

3.1 Introduction to OBS 
An Organizational Breakdown Structure, or OBS, is a pyramid- or tree-like structure 
which describes the relationships and work responsibilities of the people in your 
organization. The highest level of the OBS is the top level of management. The 
organizational structure is progressively detailed downward to the lowest level. 

Types of OBS Trees 
Within the OBS, two separate organizational hierarchies (or trees) are available to 
provide detail and summary project data through the company organizational structure: 

 A Performing Organization tree reflects the hierarchy of reporting within a 
company or "line" organization.  

 A Responsible Organization tree is for projects that employ some degree of 
matrix management. The Responsible OBS can be a functional category such as 
engineering, production, management, or manufacturing. 

Some projects use both trees while others use neither, managing the project within the 
WBS framework only. You may create one or both types of OBS tree for each project.  

If you are using both performing and responsible OBS trees, MPM treats them as 
separate organizational structures. 
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How the OBS Works 
When you create an OBS element, you specify a parent department ID. Child 
departments become parent departments and their parents become grandparents when 
you assign them subordinate departments. In Figure A below, Engineering is a parent of 
Department 600 and a grandparent of Departments 601 and 602. 

 
Figure A. A Sample OBS 

When creating the WBS, you assign the WBS tasks to the OBS departments to create the 
Responsibility Assignment Matrix (RAM), typically matching work package WBS tasks 
with the Performing OBS departments, and control account WBS tasks with the 
Responsible OBS departments. See Chapter 5: Creating the WBS for details.  

The Role of Burden Templates 
Burden Templates are used when estimating to add indirect costs. You can assign a 
Burden Template to a Department in the OBS, which is then used in Integrated Planning 
when creating the Baseline and ETC estimates.  

If you assign the Burden Template to the resource (in the Resources and Burdens 
window under the Globals tab), that Burden Template is used during Integrated 
Planning. However, if you don’t assign the Burden Template to the resource directly, the 
Burden Template assigned to the Resource Department in the OBS is used. 

See MPM Globals for more information about entering burden templates and resources. 
See Chapters 6, 7, 8 and 9 of this manual for details about creating, revising and tracking 
the project estimates. 
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3.2 Accessing the OBS Window 
You open the OBS window from the MPM Menu Manager. When you open the OBS 
window, you select the project you want to view and the starting view: performing or 
responsible. 

Procedure 
To open the OBS window: 

1. From the Menu Manager window shown in Figure A, do one of the following: 

 Select the Projects tab and choose Organizational Breakdown Structure  
 Choose Projects|Organizational Breakdown Structure from the File 

menu  

 
Figure A. Select the OBS icon. 

 MPM displays the Organizational Breakdown Structure Open dialog box shown 
in Figure B. 

 
Figure B. Select a project and a 
starting view. 

2. Choose a project from the Project list box. 

3. Select the starting view: Performing or Responsible. 
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 Note that you can switch between the two views at any time. 

4. To accept the selections and display the OBS window, click OK. 

 
Figure C. The Organizational Breakdown Structure window 
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3.3 Orientation to the OBS Window 
You use the OBS Window to enter, edit, and view the OBS elements. A toolbar gives 
you quick access to common tasks, and two tabs (Performing and Responsible) allow 
you to switch between Performing and Responsible OBS Tree views. The OBS Grid 
displays the information about each OBS element. Each element is represented by a 
single row. 

Horizontal Scroll Bar

Vertical Scroll Bar

Select theee
Performing viewe Select the

Responsible view

 
Figure A. The Organizational Breakdown Structure window 

Hierarchical/Alphabetical Listing 
MPM automatically sorts the departments first by level and then alphabetically by 
Department ID each time you open the OBS window. In Figure B below, notice that the 
Level 2 departments CM, DM, and ENG are sorted alphabetically, and DM’s Level 3 
children AC and IS are inserted under their parents alphabetically.   

 
Figure B. Departments are sorted by parent and  
then alphabetically. 

Departments are indented to depict their levels. In Figure B, the Level 2 Departments are 
indented one tab. Level 3 Departments are indented two tabs, and so on. 
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You cannot have one description for a department in the Performing Tree and a different 
description for that same department in the Responsible Tree. They must be the same. 

Navigating the Grid 
 To advance to the next or previous field, press the Tab and Shift+Tab or the left- 

and right-arrow keys. To move between rows, use the Up and Down-arrow keys.  
 Use the horizontal and vertical scroll bars to bring additional columns and rows 

into view. When clicking and dragging the vertical scroll 
bar, a pop-up label displays the current OBS department 
and row number.  
When clicking and dragging the horizontal scroll bar, a 
pop-up label displays the current OBS field (column).  

Expanding and Collapsing the OBS Levels 
Initially, all OBS levels are shown. To see the children of a collapsed level, click the 
parent, and then click the  button or choose Show Children on the Tools menu. To 
collapse the children of a parent level, click the parent, and then click the  button or 
choose Hide Children on the Tools menu. To see only Level 1 (Top Dept), click the  
button, or choose Hide All Departments on the Tools menu. To expand all collapsed 
levels, click the  button or choose Show All Departments on the Tools menu. 

Displaying and Hiding OBS Fields 
MPM displays the OBS fields as columns in the OBS Grid. You can display or hide any 
or all of the columns, using Column Hide on the Format menu. To select a column, click 
in the column’s heading. To select or deselect multiple columns, use the SHIFT and Ctrl 
while clicking the mouse. 

Previewing and Printing OBS Elements 
You can preview and print the OBS data using the options on the File menu. For 
complete details on using these options, see Using MPM of the Getting Started manual. 
Note that Print and Preview only show the columns and OBS elements which you have 
displayed on the OBS Grid; either Performing or Responsible departments (whichever 
tab you had selected), the columns displayed, and the OBS legs as you have expanded or 
collapsed them.  
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3.4 Creating the OBS 
You use the OBS Grid to create and edit the OBS elements. Each parent can have up to 
200 children. MPM supplies powerful spreadsheet-like controls to make it easy. Most 
operations can be performed in several different ways, using either the keyboard, the 
mouse, or both.  

MPM treats the performing and responsible OBS trees as two separate organizational 
structures. If you want to include a department in both the OBS trees, you must enter the 
department in both trees. However, once you enter a Department in one OBS Tree 
(Performing or Responsible), you need only enter the Department name in the other Tree 
and MPM will automatically fill in the Description, Manager, and Burden Template 
fields you had previously entered. 

 
Figure A. To create a new department, select a parent  
department and press the Insert key.  

Procedure 
To add a new OBS element: 

1. Select the parent element. In Figure A, the QA department is selected. 

2. Press the Insert key or choose Insert Department from the Edit menu.  

 MPM inserts a new row after the other children associated with the parent, and 
auto-fills the name of the parent in the Parent field. In Figure A, the new line has 
been added after QA. The <Required> Department field awaits entry. 

Note: For information on importing OBS data from outside of MPM, see 
Chapter 16: Importing Data in the Projects manual. 
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If the Department you enter already exists in the other OBS Tree (Performing or 
Responsible), MPM automatically displays the other fields entered in the other OBS 
Tree. The OBS fields may be changed in either Tree of the OBS Grid, and the changes 
can be seen immediately in the other Tree. For example, if you entered the QA 
Department under the Performing tab, and then created a new QA Department under the 
Responsible tab, everything you entered under the Performing tab is displayed under the 
Responsible tab, and all edits made under the Responsible tab can be seen immediately 
under the Performing tab. 

Required Entries 
You must fill in the following fields when creating new OBS elements: Department and 
Parent. See topic 3.5 OBS Field Descriptions for detailed information. 

Saving OBS Information 
To save the OBS data, do one of the following: 

 Click the Save button . 
 Choose Save from the File menu or press Ctrl+S. 
 Close the OBS window, by clicking the Close box  or choosing Close 

from the File menu. 
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3.5 OBS Field Descriptions 
These are the fields on the OBS Grid. Several fields are required entries, and display 
<Required> in the cell until you fill them. You can change the columns that are 
displayed using Column Hide on the Tools menu. 

Level 
This read-only field shows the hierarchical level of the OBS element and the relationship 
of the element to its parent. MPM automatically creates the top level of the OBS tree (just 
as it does in the WBS Tree). The top level, or Top Department, is Level 1, and always 
includes the total organization. Every new OBS element is created as a child of the Top 
Department or as a child of another department. 

Department 
This required field contains a Department identifier (ID) of up to 10 characters. MPM 
supports a maximum of 200 children for each parent department. The department name 
for new OBS elements must be unique within the project. The names are case sensitive, 
so MPM would recognize Design and DESIGN as different departments.  

If you enter a new department with a name that already exists, MPM displays an error 
message, and will not allow you to leave the Department field until you have entered a 
unique name. Spaces and other special characters are not allowed. 

If you enter an existing top level department name, MPM displays an error message. If a 
department that has children is modified, the parent fields of the children are 
automatically changed to reflect the new department. If the department exists in both 
trees, it is changed in both trees, and the Parent cells of the children in both trees are also 
changed. 

Parent Dept 
This required field identifies the Parent Department to this Department. All Departments 
in the project are shown on the drop-down list box. This field is auto-filled with the 
Department ID which was selected when you added the new OBS element, but you can 
override the default and choose another in the list. If a burden template has been assigned 
to the Parent Department, it is automatically displayed here in the child. You cannot 
identify a department as a child department in the Performing OBS and then enter that 
department in the Parent Department while working in the Responsible OBS (or vice 
versa) unless you have already also added the department to the Responsible OBS. Also, 
you cannot assign a Parent Department to one of its children or itself. 
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Description 
This optional field provides a 20-character description of the Department. The Top 
Department description is automatically filled as “Top Dept” but may be edited.  

Manager 
This optional field identifies the Manager of this Department. All WBS and OBS 
managers in the project are shown on the drop-down list box. You can select a manager’s 
name from the list, enter a new manager, or leave the manager field blank. 

Burden Template 
This optional field assigns a Burden Template to this Department. All Burden Templates 
in the global set assigned to the project are shown on the drop-down list box. When a 
burden template is assigned at the parent level, the burden template of the parent is 
initially assigned to the children, but may be changed in the child department.  

When you change an existing Burden Template for a parent department that is using the 
same template for any or all of its children, MPM prompts you to assign the same 
template to the children.  

Burden Templates may be specified for a department in the OBS Tree and/or for an 
individual resource on the Resources and Burdens window on the Globals tab.  The 
Burden Template designated at the resource level always takes precedence for estimating 
purposes. Therefore, in carrying out the estimating process, the Burden Template 
identified at the OBS level is used only if the resource code to be estimated has no 
Burden Template assigned. 
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3.6 Maintaining the OBS 

Editing OBS Departments 
Perform the following steps to change information for an existing OBS department:  

1. Click on the department in the OBS Grid. 

2. If necessary, use the Horizontal Scroll Bar to show the desired field to be 
changed. If a field you need is not displayed, use Column Hide on the Format 
menu to change the displayed fields. 

3. Change the data in one or more editable fields in the current row. Press the Tab 
or arrow keys to continue editing other fields or rows. 

4. If attempting to edit a required field (Department or Parent Department fields), 
you must first put the cell into Edit Mode by double-clicking the cell box. 

Deleting OBS Data 
To delete the data in an OBS cell: 

1. To select the data to be deleted, click in the cell(s). 

2. Press the Delete key or choose Delete from the Edit menu. 

 MPM erases the data in the selected cell(s). Note: you cannot delete the data from 
the Department or Parent Department fields since these are required fields. 

Deleting OBS Departments 
To delete an entire OBS Department: 

1. Highlight the entire department row by clicking the row number.  

2. Press the Delete key or choose Delete from the Edit menu. 

 MPM prompts for confirmation. 

 
Figure A. OBS Deletion Confirmation. 

To delete more than one OBS department at one time: 
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1. Highlight the desired departments using the Shift or Ctrl keys when clicking the 
row number, or by clicking the mouse button and dragging it downward.  

 
Figure B. Selecting three rows for deletion. 

2. Press the Delete key or choose Delete from the Edit menu. 

3. MPM prompts for confirmation. 

 
Figure C. You must confirm the delete. 

If the project data includes estimates that were assigned to the deleted OBS, you 
must edit those estimates in Integrated Planning and select another OBS 
department. 
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3.7 Recommended Reports 
Use these standard MPM reports to check your OBS structure and see its current status 
with other data. 

 OBS Indented Report — Shows the OBS Performing/Responsible department 
data in outline (indented) format. Use conditioning to show particular 
department(s).  

 Responsibility Assignment Matrix Report — Shows WBS data cross-
referenced with OBS Performing/Responsible department data in a tabular 
format. Use conditioning to restrict WBS legs, elements or levels.  

 OBS Burden Template Report — Shows the Burden Templates assigned to 
the OBS in tabular format. Use conditioning to show particular department(s).  

 Resource Detail - Baseline Report — Shows the lowest level of time-phased 
budget detail and constitutes the project baseline at the resource level, with 
subtotals for each resource and WBS. Use conditioning to restrict data by OBS 
department or resource. 

 Resource Summary - Baseline Report — Shows time-phased budget summary 
and constitutes the project baseline at the resource level, sorted by resource. Use 
conditioning to restrict data by OBS department or resource. 

 Manpower Detail Report — Shows manpower loading sorted by labor 
categories, with subtotals for each labor categories. Use conditioning to select 
Performing or Responsible OBS. 

 Manpower Summary Report — Shows manpower loading sorted by labor 
categories, with subtotals for each labor categories. Use conditioning to select 
Performing or Responsible OBS. 

 Element of Cost EOC/Class  - Baseline Report — Shows baseline data sorted 
by EOC/COC. Use conditioning to select Performing or Responsible OBS. 
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4.1 Introduction to CLIN Table 

The Contract Line Item Number (CLIN) table contains a list of all the Contract Line 
Items in the project’s contract. CLINs summarize WBS tasks. The CLIN table also 
contains descriptions, quantity, and reference codes for each CLIN to be reported. 

The Role of CLINs in Government Reporting 
The CLIN table is used for providing data needed in government reports, much like 
headers (see Chapter 15: Reports for details).  

The SF1411 (Contract Pricing Proposal Cover Sheet) report is used by DoD contractors 
for providing all required information for your proposal, sorted by CLIN (Contract Line 
Item).  

The DD1921 (Cost Data Summary) report is used by DoD contractors for reporting cost 
data summaries for providing all required information for your proposal, sorted by CLIN 
(Contract Line Item) in OMB format.  

To include the CLIN table in either or both of these reports, see topic 4.5  CLIN Table 
Field Descriptions. 

Reports Summarizing CLINs 
The MPM government reports which utilize the CLIN table are: 

 SF 1411 Report (includes quantity and reference codes) 
 DD 1921 Report (includes element codes as defined in RFPs) 
 CLIN/SOW/WBS Report (must be linked to the WBS) 
 CLIN Table Report 
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Linking the WBS to the CLIN 
To link a CLIN element with a WBS element, access the WBS window and enter the 
CLIN code on the applicable WBS element. The WBS element must contain a CLIN 
element or it will not be included in the CLIN/SOW/WBS Report. See the table below. 

Contract Line Item WBS ID Description 
0050 - PROPULSION 11-200 

11-210 
11-211 
11-212 

Research 
Software & Communications 
Systems Engineering 
Development T&E 

0055 - EQUIPMENT 20-300 
20-310 

Equipment 
Spare Parts 
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4.2 Accessing the Contract Line Items window 

You open the Contract Line Items window from the MPM Menu Manager in the Projects 
tab. When you open the Contract Line Items window, you select the project to view. 

Procedure 
To open the Contract Line Items window: 

1. From the Menu Manager window shown in Figure A, do one of the following: 

 Select the Projects tab and choose the Contract Line Items icon  
 Choose Projects|Contract Line Items from the File menu.  

MPM displays the CLIN Table Open dialog box shown in Figure A. 

 
Figure A. Select the Contract Line Items icon. 

2. Choose a project from the Project list box. 

3. To accept the selections and display the Contract Line Items window shown in 
Figure B, click OK. 

MPM displays the Contract Line Items window. 
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Figure B. The Contract Line Items window 
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4.3 Orientation to the Contract Line Items Window 

You use the Contract Line Items window to edit and view the CLIN elements. A toolbar 
gives you quick access to common tasks. The CLIN table grid displays the information 
about each CLIN table element. Each element is represented by a single row. 

 
Figure A. The Contract Line Items window 

CLIN Element Listing 
MPM automatically sorts all CLIN table elements by CLIN number each time you open 
the Contract Line Items window.  

Navigating the CLIN Table Grid 
To navigate through the fields in the CLIN table grid: 

 To advance to the next or previous field, press the Tab and Shift+Tab or the Left 
and Right arrow keys.  

 To move between rows, use the Up and Down arrow keys.  
 Use the horizontal and vertical scroll bars to bring additional columns and 

rows into view. When clicking and dragging the vertical scroll bar, a pop-
up label displays the current CLIN table department and row number.  

 To move to any cell, click in the cell with the mouse. 
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Displaying and Hiding CLIN Table Fields 
MPM displays the CLIN table fields as columns in the CLIN table grid. You can display 
or hide any or all of the columns, using Column Hide on the Format menu. To select a 
column, click in the column’s heading. To select or deselect multiple columns, use the 
Shift and Ctrl keys while clicking the mouse button as you normally would within 
Windows. 

Previewing and Printing CLIN Table Elements 
You can preview and print the CLIN table data using the options on the File menu. For 
complete details on using these options, see Using MPM in the Getting Started manual. 
Note that Print and Preview only show the columns and CLIN table elements which you 
have displayed on the CLIN table grid.  
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4.4 Creating the CLIN Table 

You use the CLIN table grid to create and edit the CLIN table elements. MPM supplies 
powerful spreadsheet-like controls to make it easy. Most operations can be performed in 
several different ways, using the keyboard, the mouse, or both.  

 
Figure A. To create a new CLIN, press the Insert key.  

Adding CLIN Elements 
To add a new CLIN table element, press the Insert key or choose Insert CLIN from the 
Edit menu.  

MPM inserts a new row just before the current row. In Figure A, the new line has been 
added before CLIN 0055. The <Required> CLIN table field awaits entry. 

Note spaces are not allowed in the CLIN column entries. 

Required Entries 
You must fill in the CLIN field when creating new CLIN table elements. See topic 4.5  
CLIN Table Field Descriptions for detailed information. 
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Saving CLIN Table Information 
To save the CLIN table data, do one of the following: 

 Click the Save button . 
 Choose Save from the File menu or press Ctrl+S. 

If the Prompt for Save option has been set, MPM prompts for verification.  
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4.5 CLIN Table Field Descriptions 

These are the fields on the CLIN table grid. The CLIN field is a required entry, and is 
displayed with <Required> in the cell until you fill it. You can change the columns that 
are displayed using Column Hide on the Tools menu. See the Getting Started manual for 
details. 

CLIN 
This required field contains the CLIN table identifier (ID) of up to eight characters which 
must be unique and cannot contain spaces. 

Description 
This optional field provides a 40-character description of the CLIN element.  

Quantity 
This optional field identifies the quantity of this CLIN element to be contracted. Valid 
values are -9999.99 to 99999.99. Values are rounded to two decimal places.  This value is 
displayed on the SF 1411 Proposal report. 

Reference Code 
This optional field is displayed on the SF 1411 proposal report if you have additional 
information about the Contract Line Item that you would like to reference elsewhere. 

Element Code 
This optional field is displayed on the DD 1921 proposal report to identify the type of 
cost data incurred for the Contract Line Item. 
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Include on SF 1411 
If you want to display this CLIN element on the SF 1411 proposal report, click this box 
or press the spacebar so that a check mark appears. If this box is left blank, this CLIN 
element will not be included in the SF 1411 report. 

Include on DD 1921 
If you want to display this CLIN element on the DD 1921 proposal report, click this box 
or press the spacebar so that a check mark appears. If this box is left blank, this CLIN 
element will not be included in the DD 1921 report. 
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4.6 Maintaining the CLIN Table 

Editing CLIN Elements 
To change information for an existing CLIN element, perform the following steps:  

1. Click on the department in the CLIN table grid. 

2. If necessary, use the horizontal scroll bar to show the desired field to be changed.  

If a field you need is not displayed, use Column Hide on the Format menu to 
change the displayed fields. 

3. Change the data in one or more editable fields in the current row.  

Press the Tab or arrow keys to continue editing other fields or rows. 

4. To save your changes, click the Save button  or press Ctrl+S.  

Deleting One CLIN Element 
To delete one CLIN element: 

1. Highlight the entire CLIN Table row by clicking the row number.  

In Figure A below, row 2, CLIN 0050 – Airframe is selected. 

 
Figure A. Select the entire CLIN table row to be deleted. 

2. Press the Delete key or choose Delete CLIN(s) from the Edit menu. 
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MPM displays the dialog box shown in Figure B. 

 
Figure B. Contract Line Items Deletion dialog box. 

If you click Yes, the CLIN is removed from the CLIN table and from the WBS 
element(s) that reference it. 

If the Prompt for Save option has been set, MPM prompts for confirmation. 

Deleting Two or More CLIN Elements 
To delete more than one CLIN element at the same time: 

1. Highlight the desired CLIN element(s) using the Shift key when clicking the row 
number, or click the mouse button and drag it up or down. 

2. Press the Delete key or choose Delete CLIN(s) from the Edit menu. 

If the Prompt for Save option has been set, MPM prompts for confirmation. 
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4.7 CLIN Table Recommended Reports 

Use these standard MPM reports to check your CLIN table and check its current status 
with other data. 

 SF 1411 Report (includes quantity and reference codes) 
 DD 1921 Report (includes element codes as defined in RFPs) 
 CLIN/SOW/WBS Report 
 CLIN Table Report 
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5.1 Introduction to WBS 

A Work Breakdown Structure or WBS is an organized framework in which you can 

progressively subdivide a project’s work content into elements that can be easily 

identified and tracked. Using the WBS methodology: 

 Makes planning, scheduling, estimating, and reporting easy 

 Provides the framework for cost collection and responsibility assignment 

 Provides detail and summary reporting of cost, schedule, and performance 

MPM’s design is based on the government’s concept of supplying data by WBS, OBS, 

and EOC. Government contractors managing major procurements generally follow the 

guidelines detailed in MS-881 (DOD) and MA-0295 (DOE). 

 

Figure A. A Sample WBS 

WBS Elements and the WBS Tree 

A WBS element is a product, set of data, or service produced by the project. The 

collection of all WBS elements in a project, organized into levels, is called the WBS 

Tree. In Figure A, the WBS elements in Level 2 are: Engineering, Avionics, and Program 

Mgmt. 

A WBS element that has one or more sub-elements is known as a parent element or a 

parent.  Each sub-element under the parent element is known as a child element or child. 

A WBS Tree with at least three levels may also contain grandparents and grandchildren. 

In Figure A, the Level 2 element, Engineering, is a parent element with three children 

(Concept Formulation, Build Prototype, and Inspection & Test). These three elements 

are grandchildren of the Project Level 1. 

WBS Roll-Ups Provide Cumulative Costs 

In Figure A, the WBS elements in Level 3 all roll up to Level 2, the Control Account 

elements, meaning that all cost, schedule, and performance data in these children will 

roll up creating totals at the parent level. 
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For example, all of the costs, schedule, resources, and performance data associated with 

the Level 3 WBS element Concept Formulation, together with those of Build Prototype 

and Inspection & Test, will be rolled up into Engineering. This allows the project leaders 

of the X-20 Project to know how much it cost to do the engineering segment of the X-20 

project, how long it took, and how well the participants stayed within the baseline 

schedule and budget of the project. Using the rolled up data, you can then generate 

management reports showing both detailed and summary information.  

For example, in Figure B below, the Estimated time, Estimated cost, Time spent so far, 

Cost so far, and Percent complete for the three child elements at Level 3 roll up into the 

parent at Level 2. MPM individually adds the estimates and actuals of the children, and 

their totals are saved at the parent level.  

The Total Estimated Time (not elapsed time) to complete the tasks for all three child 

elements, 21 months, becomes the estimated time to complete the task at level 3, Concept 

Formulation.  The Total Estimated Cost of $240,000 becomes the estimated cost at Level 

3. The project has started and three months have elapsed. Preliminary Study is about 

35% complete after three months of work and has cost $40,000 so far. Engineering 

Design is about 15% complete after two months of work and has cost $20,000 so far. 

Detail Design hasn’t started yet.  

So the Concept Formulation portion of the project has spent 3 months (elapsed time) and 

$60,000 so far, and is about 25% complete. Estimating the time and cost that it will take 

to complete the tasks  (Estimate To Complete - ETC and Budgeted Cost of Work 

Scheduled - BCWS) and then adding that estimate to the actuals so far, we can get an 

idea of how closely the project is following what was estimated. 

 

Figure B. How a WBS Works 
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5.1 Introduction to WBS 

5.1.1 Linking the WBS to the OBS 

To provide time phased cost data, you can link your OBS (which provides your 

organizational breakdown structure of human resources) to your WBS (which describes 

the tasks to be performed in the project). Linking the WBS to the OBS assigns the 

responsibility of the tasks to departments within your organization.  

Responsibility Assignment Matrix (RAM) 

To link the WBS and OBS, assign each WBS control account (task) to an OBS element, 

which represents the department or organization responsible for completing the task. The 

resultant grid is called the Responsibility Assignment Matrix (or RAM), also known as a 

Control Account Matrix. The RAM sometimes becomes quite large, but it does provide a 

useful summary of the work contained in the WBS, and places responsibility for 

performance of all tasks. A RAM is most helpful when used early in a program, but can 

also be used during the proposal stage, and can be updated after the program is awarded. 

See Chapter 15: Reports about the Responsibilities Assignment Matrix report. 

Linking a Responsible OBS Tree to a WBS 

Figure A below illustrates a RAM which links the responsible organization tree and its 

interaction with a WBS: 

 
Figure A. Linking a Responsible OBS to the WBS 
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Linking a Performing OBS Tree to a WBS 

Figure B below illustrates a RAM which links the performing organization tree and its 

interaction with a WBS: 

 

Figure B. Linking a Performing OBS to the WBS 
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5.1 Introduction to WBS 

5.1.2 Structuring the WBS 

MPM provides several fields which describe your WBS elements. Many of these fields 

have important implications in how you will use your WBS. Consider these suggestions 

when structuring your WBS. 

WBS IDs 

The WBS element identifier (WBS ID) is a 40-character label used to identify each WBS 

element. This required identifier need not follow any particular sequence, and except for 

spaces or asterisks, any alphabetical or numerical sequence can be used. For example, 

222, BB, and C.B. are all valid WBS identifiers. We recommend that your WBS IDs be 

numbered in a sequence. By using a sequence that describes your data, WBS IDs are 

more easily identified which makes managing your project easier. See the samples 

below. Although MPM allows all special characters except spaces, we recommend that 

you only use dashes or periods.   

Note: Special characters that result in binary characters (for example, “em dash” 
(–)) are not to be used in MPM as they may cause problems in reports.  

 

Numbered Outline  Structured Scheme 

1.0 X20 PROJECT  X20 X20 PROJECT 

 1.1 Concept Formulation   1X Concept Formulation 

 1.2 Systems   11-110 Systems 

 1.3 Electrical Design   11-120 Electrical Design 

2.0 Engineering   2X Engineering 

 2.1 Vehicle   21-210 Vehicle 

 2.2 Avionics   21-220 Avionics 

 2.3 Prototype   21-230 Prototype 
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Alias 

Alias is an optional 20-character field you define to meet any unique internal 

organizational data requirements, such as CDRL elements, interdivisional assist effort, 

remote site effort, phase of contract elements, etc. You can use the Alias field to extract 

the WBS elements you need when running reports. The Alias field can also act as a 

wildcard. You can use the Alias field’s contents to match a specific group of data during 

reporting, exporting, or onscreen filtering. 

For example, suppose you are using the Alias field to store Contract Data Requirements 

List (CDRL) elements, and your WBS includes CDRLs A001 through A009 and B001 

through B009. To extract all CDRL elements that begin with the letter B for a report, you 

would type B in the Alias field when conditioning for a report. The output would then be 

limited to include only those CDRLs beginning with B (B001, B002, etc.).  

XREF Fields 

 XREF-1 through XREF-10 — These optional fields are provided as additional 

identifiers that can be used for reporting, exporting, or onscreen filtering. You 

enter the field name for these fields in the Project Maintenance window.  

For example, if you renamed the XREF-2 label to ―SOW‖ (in the Project 

Maintenance window) and you entered Statement of Work (SOW) numbers for 

all WBS elements, you can now create a report that lists all WBS elements that 

pertain to SOW 1.1. 
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5.2 Accessing the WBS Window 

You open the WBS window from the MPM Menu Manager. When you open the WBS 

window, you select the project you want to view and the data to download. 

 

Figure A. You can filter the data that is downloaded. 

Procedure 

To open the WBS window from the Menu Manager: 

1. Begin by doing one of the following: 

 Select the Projects tab and choose the Work Breakdown Structure icon 

 Choose Work Breakdown Structure from the File|Projects menu 

MPM displays the WBS Open dialog box shown in Figure A. 
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2. Choose a project from the Project list box. 

3. To select the data to be downloaded, do one or more of the following: 

 Filter by WBS Leg 

 Click the check mark box next to the desired WBS Leg(s), using the  and 

 boxes to expand or collapse the legs if necessary. 

 Filter by WBS Manager 

 Using the Shift and Ctrl keys, click the particular Manager(s) who are 

assigned to the WBS elements you want to download. 

 Filter by WBS Element Type 

 Select the type(s) of WBS elements you want to download. 

4. To accept the selections and display the WBS window, click OK.  

When the WBS window opens, the WBS elements you described here are downloaded. 

Selecting Project Start and Complete Dates 

If the project you selected does not yet have Start and Complete dates assigned in the 

Project Maintenance window, MPM displays the Project Start and Complete Dates 

dialog box so you can enter these dates.  

 

Figure B. Setting the Project Start  
and Complete Dates. 
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5.3 Orientation to the WBS Window 

You use the WBS Window to 

add, edit and view the WBS 

elements. A toolbar gives you 

quick access to common 

tasks. This window is split 

into two panes. The left pane 

shows the WBS Tree which 

displays the WBS 

hierarchically, and the right 

pane shows the WBS Sheet 

which displays the detail 

information for each WBS 

element. Each element is 

represented by a single row. 

See Figure A. 

The WBS Tree 

You can use the WBS Tree (the left pane in the WBS window) to view the WBS 

hierarchically and review the parent/child relationships of the WBS elements. You can 

also add new WBS elements, move, copy, or delete entire WBS legs, or select and 

deselect the WBS elements displayed on the WBS Sheet. 

The WBS Tree always contains all WBS elements to which you have access in the 

project, regardless of the data downloaded using the WBS Open dialog box. The WBS 

elements you selected for download are displayed in the WBS Tree with either a check 

mark  (indicating the leg has been downloaded) or filter  (indicating the leg has been 

downloaded but is currently filtered). Elements displayed with an empty box have not 

been downloaded, but you can download them immediately by checking the box.  

The WBS Sheet 

Use the WBS Sheet (the right pane in the WBS window to add, edit, and view selected 

WBS element information in a spreadsheet-like format. The WBS Sheet has a vertical 

scroll bar and horizontal scroll bar to help you position your cursor anywhere on the 

sheet while working with the WBS elements. The fields (columns) in the WBS Sheet 

contain the descriptive, accounting, status, and customization information about each 

WBS element.  

WBS Tree WBS Sheet

Separator

Bar

 
Figure A. The WBS Window  
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Hierarchical Listing 

MPM automatically sorts all WBS elements in a hierarchical order according to the way 

you have structured your WBS when adding new child elements and creating new 

parents. To change the structure, see topic 5.7.4 Sorting WBS Legs. The structure of the 

WBS Tree is used throughout the project. 

Previewing and Printing the WBS 

You can preview or print the WBS data using the options on the File menu. Note that 

Print and Preview only show the columns and WBS elements which you have displayed 

on the WBS Sheet. For complete details on using these options, see Using MPM in the 

Getting Started manual. 

To preview your WBS, do one of the following: 

 Click the Print Preview button  

 Choose Print Preview on the File menu 

 Press Alt+F and then V  

MPM displays the WBS Print dialog box. This dialog allows you to select whether to 

display task descriptions in your printout. 

 

Figure B. Indicate whether to include 
Task Descriptions. 

To print your WBS, do one of the following: 

 Click the Print button  

 Click the Print button in the Print Preview window 

 Choose Print on the File menu, or press Ctrl+P 

MPM displays the WBS Print dialog box, as described above, followed by the standard 

Windows dialog box. 
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5.3 Orientation to the WBS Window  

5.3.1 Navigating the WBS Window 

Navigating the WBS Tree 

To navigate the WBS Tree (the left window pane): 

 To advance to the next or previous WBS Leg, use the Up and Down Arrow keys.  

 To move to a specific WBS Leg, click on its description with the mouse. 

 To see additional fields and columns, use the horizontal and vertical scroll bars.  

 To show more or less of the WBS Leg descriptions, drag the separator bar. 

Navigating the WBS Sheet 

To navigate the WBS Sheet (the right window pane): 

 To advance to the next or previous field, use Tab and Shift+Tab, or the Left and 

Right Arrow keys.  

 To move between rows, use the Up and Down Arrow keys.  

 When clicking and dragging the vertical scroll bar, a pop-up label 

informs you of the current WBS element’s ID and row number. This 

makes scrolling through large databases very efficient.  

 When clicking and dragging the horizontal scroll bar, a pop-up label 

informs you of the current field (column). 

 To move to any cell, click in the cell with the mouse. 

 To select an entire WBS element (row), click on the row number. 

For more detailed information on navigating, see the Getting Started manual. 
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Navigating Between the WBS Panes 

You can navigate between the WBS Tree and WBS Sheet quickly using GoTo. 

To find the WBS detail data in the WBS Sheet when navigating the WBS Tree: 

1. Select a WBS leg in the WBS Tree by clicking on it. 

2. To find its detail data, choose GoTo WBS on the Edit menu, or press Ctrl+G. 

MPM displays the selected WBS in the WBS Sheet, displaying additional rows 

if necessary to display that WBS. 

To find the WBS leg in the WBS Tree when navigating the WBS Sheet: 

1. Select a WBS element by clicking its row number in the WBS Sheet. 

2. To find its leg, choose GoTo WBS on the Edit menu, or press Ctrl+G. 

MPM displays the selected WBS in the WBS Tree, expanding the parent if 

necessary to display that WBS. 

Searching the WBS 

To search for a word in the WBS Sheet (the right window pane only), click inside the 

Sheet. 

1. Choose Find WBS on the Edit menu, or press Ctrl+F. 

 MPM displays the Find Options dialog box shown in Figure A.  

 

Figure A. Specify the text to be found. 

2. Enter the text to find and click Find Next.  

 The WBS elements in the Sheet are searched.  

For more detailed information on searching, see the Getting Started manual. 
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5.3 Orientation to the WBS Window  

5.3.2 WBS Thresholds 

WBS thresholds allow users to establish thresholds for the various WBS elements.   

 Schedule variance thresholds can be established for the Current Period or the 

Cumulative Period and can be specified in value (hours or dollars) and/or 

percent.   

 Cost variance thresholds can be established for the Current Period, Cumulative 

Period or At Complete, and can be specified in value (hours or dollars) and/or 

percent.   

For schedule variance and cost variance, both favorable (positive) and unfavorable 

(negative) thresholds can be established. 

Add, edit, or delete thresholds from the Work Breakdown Structure View located on the 

Projects Tab of the Menu Manager. The thresholds column is automatically displayed on 

the WBS view and is not populated by default. 

Inheritance 

The concept of inheritance is applied to the MPM threshold functionality.  Thresholds 

established at a parent WBS Level are automatically inherited by the children WBS 

elements.   

For example, in the WBS shown below (Figure A), the threshold values established for 

Element 2.2 are automatically inherited by elements 2.2.1, 2.2.2, 2.2.2.3 and 2.2.2.4. 

 

Figure A. Example of Inheritance 
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Threshold Example 

The threshold dialog box below (see Figure B) represents the thresholds established for a 

Project Level as indicated in the window title bar.  The comparison logic is applied 

between each value and %. 

 

Figure B. Threshold dialog box 

 SV = BCWP – BCWS  

 The favorable current period schedule variance threshold is 25.00 and 

4%.  This means that current period SVs >[25.00 AND 4% of BCWS] 

will be flagged in the Detail Variance Analysis Report and the Variance 

Analysis Turnaround Document reports. 

 The unfavorable current period schedule variance threshold is -15.00 and 

– 3.00%.  This means that current period SVs < [-15.00 AND -3% of 

BCWS] will be flagged in the Detail Variance Analysis Report and the 

Variance Analysis Turnaround Document reports. 

 CV= BCWP-ACWP 

 The favorable current period cost variance threshold is $100.00 and 8%.  

This means that current period CVs > [$100 AND 8% of BCWP] will be 

flagged in the Detail Variance Analysis Report and the Variance 

Analysis Turnaround Document reports. 
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 The unfavorable current period cost variance threshold is -25.00 and -

9%.  This means that current period CVs<[-25.00 AND -9% of BCWP] 

will be flagged in the Detail Variance Analysis Report and the Variance 

Analysis Turnaround Document reports. 

Threshold Fields 

Use the Thresholds dialog box to establish both favorable and unfavorable thresholds for 

cumulative, current period, and at-complete variances. You can set values by the WBS 

element. Values are automatically copied down or inherited from the parent. 

 Comparison Logic — From the dropdown menu, select the logic to use between 

the Value and % (percent), as follows: 

 And – Select this so that the variance has to meet the Value and % (this 

is the default). 

 Or – Select this so that the threshold has to meet the Value or %. 

Note: The Comparison Logic, AND or OR, can only be established at the 

Project level of the WBS. The window title bar identifies the WBS element for 

which the thresholds are being established. 

 Units — You can set units by WBS element as needed. From the dropdown 

menu, select the units, as follows: 

 Dollars – Select to enter values as dollar amounts. 

 Hours – Select to enter values as hourly amounts. 

 Schedule Variance — The Schedule Variance (SV) is equal to the BCWP less 

the BCWS, as follows: 

SV = BCWP - BCWS 

Enter Favorable (positive threshold) and Unfavorable (negative threshold) values 

as needed in the following fields: 

 Current Period — Enter the Value and/or % (percentage) for favorable 

and unfavorable conditions for the current period. 

 Cumulative — Enter the Value and/or % (percentage) for favorable and 

unfavorable conditions for the cumulative amount through the current 

period. 
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 Cost Variance — The Cost Variance (CV) is equal to the BCWP less the 

ACWP, as follows: 

CV = BCWP - ACWP 

Enter Favorable (positive threshold) and Unfavorable (negative threshold) values 

as needed in the following fields: 

 Current Period — Enter the Value and/or % (percentage) for favorable 

and unfavorable conditions for the current period. 

 Cumulative — Enter the Value and/or % (percentage) for favorable and 

unfavorable conditions for the cumulative amount through the current 

period. 

 At Complete — Enter the Value and/or % (percentage) for favorable 

and unfavorable conditions for the At Complete value. 

Adding or Editing Threshold Values 

Thresholds are copied down to lower level breakdown elements or inherited at lower 

levels only if higher levels have values entered, as follows: 

 If the Thresholds are defined at the project level, the Threshold dialog is 

disabled for all lower level breakdown elements. 

 If the Thresholds are defined at WBS parent level, the Threshold dialog is 

disabled for all children elements. 

To add, edit, or view the threshold values, do the following: 

1. Click the ellipses  in the Threshold column of the Work Breakdown Structure 

(WBS) window. The Threshold dialog box displays for the WBS element. 

2. Select the Comparison Logic dropdown as ―And‖ or ―Or.‖  

Note: Comparison Logic can only be established at the highest level element 

(i.e., Project level) of the WBS.  

3. Set the Units dropdown to ―Dollars‖ or ―Hours.‖  

4. Enter up to 12 digits in the Value fields (in addition to the commas and decimals 

that are automatically added).  

5. Enter up to seven digits in the % (percent) fields (in addition to the commas and 

decimals that are automatically added). 
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 You can enter negative values or percentages only in the Unfavorable fields. 

 You can enter positive values or percentages only in the Favorable fields. 

 You can add percentage values of more than 100%. 

6. Click the left or right arrows to go to the next or previous WBS. 

7. Click OK to save all Threshold values and exit, or click one of the following: 

 Clear — erases any contents in the Threshold dialog and resets all values to 

zero (0). Note that a value of zero indicates no threshold for that particular 

item. It is not a zero-value threshold for dollars, hours or percent. 

 Cancel — closes the window without saving changes, and returns to the 

Work Breakdown Structure window. 

 Help — accesses online help for this topic. 

Deleting WBS Threshold Values 

WBS Thresholds can be deleted manually by zeroing out the values at the highest level, 

or can be deleted for the entire project by selecting the WBS Thresholds box in the 

Delete Project Data dialog box which is accessible from Project Maintenance. 

To delete WBS threshold values using the Delete Project Data dialog box, do the 

following: 

1. Within MPM, open the Project Maintenance applet from the Projects tab.   

2. Click Edit » Delete Project Data.  
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The Delete Project Data dialog box displays. 

 

 

Figure C. Select the WBS Thresholds check box 
 

3. Select the WBS Thresholds check box. 

4. Click OK.  All WBS threshold data is deleted.  
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5.4  Creating Work Breakdown Structures 

Use the WBS window to create and edit WBS elements. Most operations can be 

performed in several ways, using the keyboard, the mouse, or a combination of both, in 

the WBS Tree or the WBS Sheet.  

Inserting New WBS Elements Using the Tree 

To add a WBS element using the WBS Tree, perform the following steps: 

1. To add the new child, click on the prospective parent WBS leg in the WBS Tree.  

2. Select Insert WBS from the Edit menu, or press the Insert key.   

MPM displays the Insert WBS Element dialog box shown in Figure A. 

 

Figure A. Identify the new element’s ID 

3. The Parent field is auto-filled from the WBS element you had selected in the 

WBS Tree. If the wrong parent is displayed, click Cancel.  

4. The WBS ID field is auto-filled using the next numerical ID for the selected 

parent. You can override this and enter any ID desired. 

5. Enter the Description if desired. Click OK. 

A new row is inserted with the Level, Parent, and WBS ID fields filled. Edit the other 

fields as desired. 

Inserting New WBS Elements Using the Sheet 

You can also add a new element using the WBS Sheet: 

1. To add the new child, click on the prospective parent WBS in the WBS Sheet. 

2. Choose Insert WBS on the Edit menu or press the Insert key.  
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A new row is inserted in the WBS Sheet in Edit Mode (shown in blue), with the Level, 

Parent, and WBS ID fields auto-filled. Edit the fields as desired. 

You cannot add a WBS element beneath an element which has been labeled as 
a DISTRIBUTED field in XREF-1.  

Required Entries 

You must fill in the following fields when creating new WBS elements: WBS ID, Parent, 

Start, and Complete. See topic 5.5  WBS Field Descriptions for detailed information. 

Downloading Additional WBS Data 

The WBS legs containing downloaded data are displayed in the WBS Tree with either a 

check mark  (indicating the leg has been downloaded) or filter  (indicating the leg 

has been downloaded but is currently filtered).  

To download additional WBS legs, click in an empty check mark box. A check mark is 

inserted, the data is downloaded, and the additional records are displayed in the WBS 

Sheet. See topic 5.8  Changing the WBS Display for more information. 

To remove WBS legs from the display, click in the check marked box. The box is now 

empty, the data is released from memory, and those records are removed from the WBS 

Sheet. Any changes made to the data are saved prior to its release. 

Saving WBS Information 

To save the WBS data, do one of the following: 

 Click the Save button . 

 Choose Save from the File menu, or press Ctrl+S. 

 Move to another WBS row, using the Up or Down arrow keys. 

If Prompt for Save has been set, MPM prompts for verification.  

Importing WBS elements from outside of MPM 

Many organizations have created their WBS structure using spreadsheets or accounting 

systems. You can import the WBS Tree or WBS Schedule data from your spreadsheet or 

accounting system. For more information about importing WBS data, see Chapter 16: 

Importing Data. 
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5.5  WBS Field Descriptions 

These are the fields or columns displayed in the WBS Sheet. Fields which are required 

display <Required> in the cell. These fields must be filled. You can change the columns 

that are displayed using Column Hide. See Using MPM in the Getting Started manual for 

details.  

Field Description Page 
Level ..................................................................................................................................................... 124 
WBS ID ................................................................................................................................................ 125 
Parent ................................................................................................................................................... 125 
Description ........................................................................................................................................... 125 
Start/Complete ...................................................................................................................................... 125 
Manager................................................................................................................................................ 126 
Charge Number .................................................................................................................................... 126 
Perf Dept .............................................................................................................................................. 126 
Resp Dept ............................................................................................................................................. 126 
Threshold ............................................................................................................................................. 127 
Alias ..................................................................................................................................................... 127 
XREF-Fields ........................................................................................................................................ 127 
Element Type ....................................................................................................................................... 128 
Recur .................................................................................................................................................... 128 
CLIN .................................................................................................................................................... 128 
Fee % .................................................................................................................................................... 129 
Fee Limit .............................................................................................................................................. 129 
Revised Letter Date .............................................................................................................................. 130 
Schedule Reference Date ...................................................................................................................... 130 
 

Level 

The Level field shows the hierarchical level of the WBS element and the relationship of 

the element to its parent. The top element in the WBS has a Level value of 1. This field 

is assigned when you create the new WBS element and cannot be edited. 
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WBS ID 

The WBS element identifier (WBS ID) is a required 40-character label used to identify 

each WBS element.  This identifier need not follow any particular sequence, and except for 

spaces, any alphabetical, numerical or special characters can be used. This field can only 

be edited on existing WBS elements if you have been granted WBS Rename access to the 

project.  This field must be unique. See topic 5.1.2 Structuring the WBS for samples. 

Parent 

The Parent field positions the WBS element hierarchically within the WBS Tree. You 

can specify the WBS ID of the parent element when creating a new WBS element, but 

the field becomes read-only once the new WBS element information is saved. After 

creating a new WBS element, click on the  button in the Parent field to select a Parent 

element from the drop-down list box of existing WBS elements. MPM automatically 

creates the Project Level WBS element (Level 1). Level 1 represents the total project 

and its WBS ID cannot be changed. This field can only be edited if you have been 

granted Move WBS Leg access to the project. 

Description 

The Description field is an optional 100-character field used to provide a more detailed 

description of a WBS element. Level 1, the project level, defaults to the project name. 

Using commas in the WBS Description field (and other text fields) is not 
recommended, as commas are used as field separators when importing 
information. However, if the content of a string field does contain a comma, you 
can surround the field with quotation marks to avoid confusion. 

Start/Complete 

Enter the scheduled start and completion dates for the WBS.  See Appendix D for a list of 

valid date formats. These fields are filled automatically when the WBS is built by using 

the date of the parent as the default date.  The top level date (the total project start and 

complete date) defaults to the project start and complete dates entered in the Project 

Maintenance window. If only the month and year (MMYY) are entered in the Start field, 

MPM defaults to the fiscal start date for that period entered in the Fiscal Calendar.  
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Likewise, if MMYY is entered in the Complete field, MPM defaults to the fiscal 

complete date for that period from the Fiscal Calendar. If no project Start and Complete 

dates exist, MPM prompts you to enter them the first time the WBS is accessed for that 

project. Dates for a child WBS must be within the parent dates (inclusive). Once 

estimates have been entered for new WBS elements, the dates can only be changed by 

updating the underlying resource estimate dates using the Integrated Planning Baseline 

window. 

Manager 

The Manager field is an optional 20-character field used to specify the WBS manager’s 

name. The drop-down list box always reflects all manager entries that currently exist on 

any WBS in the project. You can also type in a new name, and the name is added to the 

list shown. The managers entered in the Manager field can be used to select which WBS 

elements to download when opening the WBS, Integrated Planning, or Actuals windows. 

Charge Number 

The Charge Number field is a 20-character internal accounting system identifier used to 

collect costs.  This is an optional field; however, a WBS ID must have a Charge Number 

for actuals to be collected in MPM.  An error will result if you attempt to enter or import 

Actuals for a WBS without a Charge Number. 

Perf Dept 

The Performing Department is an optional field which identifies the organization or 

department that is performing the WBS task. Select from the displayed drop-down list 

box of Department IDs from the Performing OBS Tree, or you can enter a new 

department, but you must also add them to the OBS Tree to use

 

them in reports. See 

Chapter 3: Creating the OBS for details. Although this is an optional field, we 

recommend you enter a Performing Department when creating new WBS elements if you 

are required to generate functional reports.   

Resp Dept 

Responsible Department is an optional field which identifies the organization or 

department that is responsible for the WBS task. Select from the displayed drop-down 

list box of Department IDs from the Responsible OBS Tree, or you can enter additional 

departments, but you must also then add them to the OBS Tree to use

 

them in reports. 

See Chapter 3: Creating the OBS for details.  
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In an Integrated Product Team (IPT) environment, the Responsible OBS Tree can be 

used as the IPT structure.  This enables you to link WBS elements to an IPT rather than 

to a department. Although this is an optional field, we recommend you enter a 

Responsible Department when creating new WBS elements if you are required to 

generate functional reports. 

Threshold 

You can assign cost and schedule variance thresholds, such as hours, dollars, or percent, 

to each WBS. Use this dialog box to establish both favorable and unfavorable thresholds 

for cumulative, current period, and at-complete variances. Click the ellipses  to access 

the Threshold dialog and assign cost and schedule variance thresholds to each 

breakdown structure element. See section 5.3.2, ―WBS Thresholds‖ for details. 

Alias 

Alias is an optional 20-character field you define to meet any unique internal 

organizational data requirements, such as CDRL elements, interdivisional assist effort, 

remote site effort, phase of contract elements, etc. Select from the displayed drop-down 

list box, which always reflects all Alias entries that currently exist on any WBS in the 

project. You can also enter a new Alias which is then added to the list. 

You can use the Alias field to extract the WBS elements you need when running reports. 

The Alias field also acts as a ―wild card‖ to match a specific group of data during 

reporting, exporting, or onscreen filtering. The Alias field and the Xref-1 field are the 

only unique selection fields that can be printed on the CPR Format 1 and C/SSR reports 

in place of the WBS ID field. See topic 5.1.2 Structuring the WBS for samples. 

XREF-Fields 

 These optional 20-character user-defined fields, Xref-1 through Xref-10, are provided as 

additional identifiers that can be used for reporting, exporting, or on-screen filtering. 

Select from the displayed drop-down list box for each field, which always reflects all the 

entries that currently exist on any WBS in the project. You can define the field name for 

these fields in the Project Maintenance window. You can use the Xref fields during 

reporting, exporting, or onscreen filtering as wild cards, to match a specific group of 

data. 

XREF-1 is used for identifying distributed WBSs. If Xref-1 is changed to 

DISTRIBUTED, it cannot be a parent WBS.  

The CLIN/SOW/WBS Baseline Report will not include SOW data unless one of the 

XREF fields is named "SOW" in the Project Maintenance window. For example, if you 
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renamed the XREF-2 label to ―SOW‖ (in the Project Maintenance window) and you 

entered Statement of Work (SOW) numbers for all WBS elements, you can now create a 

report that lists all WBS elements that pertain to SOW 1.1. 

Element Type 

The Element Type describes the element’s position and function in the WBS Tree. This 

field is used for creating reports, filtering exports, onscreen filtering, and filtering when 
using the WBS and Integrated Planning windows. It is recommended that you identify 

the type of all WBS elements in your Tree. WBS elements above the control account are 

typically blank. Available Element Types are: 

 Control Account: A Control Account WBS element is normally used as a 

management control point where actual costs are accumulated and compared to 

the budget. Control Accounts are usually at a high level of the WBS Tree. All 

Control Accounts must be identified before running the Control Account Plan 

report. 

 Work Package: A Work Package WBS element is normally a detail task 

representing a unit of work in a Control Account at the level where the work is 

performed, having scheduled start and completion dates and a budget. Work 

Packages are usually in a lower level of the WBS Tree. 

 Planning Package: A Planning Package WBS element is normally a detail task 

similar to a Work Package, but with no budget or time estimates, created during 

the planning phase of a project to collect time and resources within a Control 

Account. Planning Packages are usually in a lower level of the WBS Tree. 

 Other: A WBS element identified as type Other is normally a detail task similar 

to a Work Package, but used for any user-defined purpose. 

Recur 

Recur is an optional field that identifies a WBS element as an activity that is repeated 

(recurring) or an activity that is done only once (nonrecurring). MPM automatically 

marks all children of a WBS element as Recurring if the parent is a recurring element, or 

as Nonrecurring if the parent is a nonrecurring element. The Recur field of the child 

elements cannot be individually changed if the parent element’s Recur field is set.  

CLIN 

CLIN is an optional eight-character field which identifies the Contract Line Item Number 

for this WBS. Although CLIN is an optional field, we recommend you select a CLIN for 
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new WBS elements if the program utilizes CLINs and requires CLIN reporting. You 

create and maintain the CLIN table in the CLIN window. See Chapter 4: CLIN Table for 

details. The WBS window contains a drop-down list of items entered in the CLIN 

window. You cannot enter a CLIN that does not exist in the CLIN table. 

When a CLIN value is entered for a WBS element, that CLIN value is used for all 

children and grandchildren of that WBS element.  The CLIN field may only be edited on 

the parent WBS element where the CLIN was originally entered. If children of that 

parent must have different CLINs, the value must be removed from the parent and added 

at the child level where the CLIN values must be different.  

The CLIN/SOW/WBS Report is sorted by CLIN.  WBS elements without a CLIN value 

will not appear on the report. Any estimates entered above the level at which the CLIN is 

entered will not be included in the report. 

Fee % 

Fee % is an optional field where you enter the percentage of the fee allocable to each 

WBS element and its children. This field is available for entry only if you select Fee by 

WBS on the Project Maintenance window.  The Fee % (if any) is displayed on reports 

that show WBS fee amounts. The Fee % should be specified at the lowest level of a 

WBS leg where different Fee % values must be applied. You can enter whole numbers or 

decimals. A fee percentage input for a WBS element is applied to all children of that 

element and is displayed as a read-only field for child elements. The only way to edit the 

Fee % is to edit the Parent WBS element where the Fee % was originally entered.  

If you change the Fee % on the WBS element, the project must be repriced to reflect 

those changes. See Chapter 11: Using the Project Updating Utilities for information. 

Fee Limit 

Fee Limit is an optional field where you can enter the fee limit (up to 16 digits) for a 

WBS element. This field is only available for entry if you have selected Fee by WBS on 

the Project Maintenance window. The Fee Limit (if any) is displayed on reports that 

show WBS fee amounts. Once you enter a Fee Limit for a WBS element, the Fee Limit is 

set to blank on all child WBS elements (even if a value previously existed there) and 

cannot be edited on the child elements.  

Fee Limit is a reference field only. MPM continues to accumulate fee even after the limit 

is reached. 
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Revised Letter Date 

This field shows the date when this WBS was last revised. It can be edited only on 

control accounts. 

Schedule Reference Date 

This field shows the date when this WBS schedule was last updated.  It can be edited 

only on control accounts. 
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5.5  WBS Field Descriptions  

5.5.1  WBS Fields for Display Only 

The following fields cannot be edited in the WBS window. They are updated 

automatically in Integrated Planning and appear in this window only for reference. 

 EVM — This field shows the Earned Value Method (EVM) used to calculate 

BCWP.  

 BCWP Base — This field shows the unit type used to compute the earned value 

for the WBS element.  

 WBS % Complete — This field shows the cumulative percent complete of the 

WBS element.  

 Last Statused Date — This field shows the date that the WBS was last statused.  

 Base WBS ID — This field shows the WBS ID used as the base WBS for an 

apportioned effort task.  

 ETC Start — This field shows the earliest date the ETC is scheduled to start.  

 ETC Complete — This field shows the latest date the WBS is estimated to 

complete. 

 Early Start — This field shows the earliest date that the WBS should start.  

 Early Finish — This field shows the earliest date that the WBS should be 

completed.  

 Late Start — This field shows the latest date that the WBS can start.  

 Late Finish — This field shows the latest date that the WBS should be 

completed.  

 Float — This field shows the number of days between the earliest start and latest 

start dates.  
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5.5  WBS Field Descriptions  

5.5.2  Task Descriptions 

The Task Description is an optional entry that can be used to describe an individual 

WBS element. You can create a task description for each element in a WBS. When you 

create a task description, the  icon is displayed in front of the row number for the 

WBS element. In Figure A, WBS element 21-100 has a task description. 

 

Figure A. Enter a description of the WBS Task here. 

To view or edit the task description for a WBS element: 

1. Select the WBS element by clicking anywhere in the row for the WBS element. 

2. Do one of the following: 

 Click the  button in the Toolbar. 

 Choose Task Description from the Tools menu. 

 If the task description already exists, click the  icon in front of the row 

number. 

MPM displays the Task Description dialog box shown in Figure A. Note the 

WBS ID is displayed in the Task Description title bar.  
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Editing Text 

Enter the descriptive text and click OK to save, or Cancel to escape out of the Task 

Description window. There is a maximum of 100 lines of 78 characters per task 

description available in this window.  

Basic text editing capabilities are incorporated within MPM. Just type in your text as you 

would with any text editor.  

If you want to enter a tab to indent text, use the Ctrl+Tab key combination. If you press 

only the Tab key, the selection moves to the next button at the bottom of the text box. 

The Clear button clears the text so you can start over.  
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5.6  Maintaining WBS Data 

Editing WBS Elements 

Perform the following steps to change information for an existing WBS element: 

1. To show the field to be changed, use the Horizontal Scroll Bar. If the field you 

need is not displayed, use Column Hide on the Format menu to change the 

displayed fields.  

2. To select the WBS, click on the desired row in the WBS Sheet (or click on the 

leg in the WBS Tree and choose GoTo WBS on the Edit menu).  

3. To edit a cell, double-click the desired cell.  If your cursor is already placed in 

the cell you want to edit, press F2 to access Edit mode. 

4. Change the data in one or more editable fields in the current row. After 

modifying and leaving a cell, the row is shown in blue to indicate that it is in 

Edit mode 

5. To advance to the next field, use Tab, Shift+Tab, or the Left or Right Arrow keys. 

Filling Down Cells 

A quick way to propagate your data is to use Fill Down, which automatically fills the 

selected cells with the data in the first cell of the selected cells. The cell(s) to be filled 

must be in rows below the cell(s) to be copied. Copied dates must be within the Start and 

Complete dates of the parent. Perform the following steps to auto-fill WBS element 

cells: 

1. To select the data to be copied, select the cell that contains the desired data. 

2. To select the cells to be filled with this data, drag the mouse down the column, 

or click the desired rows while holding the Shift key. 

3. Select Fill Down on the Edit menu, or press Ctrl+D.  

4. Click Yes when asked to save the changes. 

The cells below the first cell will all now contain the same data as the first cell of the 

selected cells. 

Copying / Pasting Cell Data  

Copying element cells using the clipboard is another fast way to enter data into new 

WBS elements. Perform the following steps to copy WBS cell data: 
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1. To select the cells to be copied, click on the cell(s) in the WBS Sheet. To choose 

multiple elements, use Shift and Ctrl while clicking the mouse button. 

2. To copy the data to the clipboard, click the Copy button , choose Copy 

Cell(s) on the Edit menu, or press Ctrl+C.   

3. Highlight the cell(s) into which you would like to paste the copied cell(s).   

4. To paste, click the Paste button , choose Paste on the Edit menu, or press 

Ctrl+V.   

MPM pastes the new cell information over any existing information in the selected cells. 

Be sure that the target cell(s) contain the same type of information as the cell(s) you 

copied. If you copied more than one cell, you may have copied hidden fields. Copying 

hidden fields causes a problem if you attempt to paste the copied cells into cells that do 

not contain corresponding hidden fields. To solve this problem, copy and paste visible 

cells one at a time, or display hidden fields before copying and pasting. 

Deleting the Contents of One or More Cells 

To delete the data from one or more cells, choose the cell(s) from the WBS Sheet. Then 

select Delete Cell(s) on the Edit menu, or press the Delete key. If the deletion is across 

more than one row and any errors are encountered during the delete (for example: 

<Required> fields have been deleted), a message is displayed for each row that 

encounters an error.   

Deleting Entire WBS Legs 

When deleting WBS legs, all data (BCWS, BCWP, ACWP, BOEs, etc.) associated with 

that WBS element is also deleted.  

Once a WBS element is deleted, the only way to restore that element and its 
children is from a backup of the data. Be sure to back up your data first! 

To delete a WBS element and all of the WBS element’s children, perform these steps: 

1. To select the WBS leg to be deleted, click on the WBS in the WBS Tree, or click 

on the row number of the WBS leg in the WBS Sheet.  To choose multiple 

elements, use Shift and Ctrl while clicking the mouse button.   

2. To delete the selected legs, choose Delete WBS(s) on the Edit menu or press Del.   

3. MPM asks you to verify the deletion. Click Yes. 
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5.6  Maintaining WBS Data 

5.6.1  Copying/Pasting WBS Legs  

You can also Copy and Paste entire WBS legs, in two ways:  

 Using the clipboard, which copies just the data displayed in the WBS Sheet.  

 Using the Copy WBS Utility, which copies the WBS Sheet data and any 

associated data. See topic 5.7.1  Using the Copy WBS Utility for details. 

A copied WBS element becomes a child under the target WBS element. If the copied 

elements contain children or grandchildren, they retain their parent-child relationship 

when pasted. The WBS ID field is updated based on the replacement characters. 

If the start and complete dates of the WBS element that is being copied fall within the 

range of the new parent WBS element’s dates, MPM pastes in the dates with no change.  

If the start and complete dates of the WBS element that is being copied fall outside the 

range of the new parent WBS element’s dates, MPM changes the child WBS element’s 

dates to match those of the new WBS parent’s dates. 

If you have copied several (but not all) children of a parent and then pasted them under a 

different parent, only the selected children are copied. If the selected child also has 

children, all children are copied and the hierarchy is preserved. 

Note that you can also select WBS legs in the WBS Tree for copying, but only when 

using the Copy WBS Utility (see topic 5.7.1  Using the Copy WBS Utility). You cannot 

select WBS in the WBS Tree when copying and pasting to the clipboard. 

Copying/Pasting WBS Legs Using the Clipboard 

Copying WBS Legs to the clipboard is a fast way to populate the WBS when many 

elements contain similar information; however, remember that any associated data such 

as Task Descriptions and Estimate data is not copied using this method.  
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To copy and paste WBS elements using the clipboard: 

1. To select the WBS leg(s) to be copied, in the WBS Sheet click on the row number 

of the WBS leg to be copied. The entire row becomes highlighted. To choose 

multiple contiguous rows, click and drag on the row numbers, or hold the Shift 

key while clicking the first and last row numbers. 

2. To copy the WBS leg(s) to the clipboard, click the Copy button , choose 

Copy WBS(s) on the Edit menu, or press Ctrl+C.   

3. Click on the row number of the WBS parent under which you would like the 

copied element(s) to be pasted. If you have more than one WBS window open, 

you can copy and paste elements between WBS windows. 

4. Paste the WBS leg(s) from the clipboard. Click the Paste button , choose 

Paste on the Edit menu, or press Ctrl+V. WBS leg(s) are pasted as new WBS 

leg(s). Pasting does not override any existing WBS leg(s). 
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5.7 Changing WBS Data 

MPM provides several utilities for making large-scale changes to the WBS Tree. These 

utilities are available on the Utilities menu. Most utilities can also be invoked using the 

mouse. Be sure to back up your data before attempting to run any of the WBS utilities. 

This protects you from losing or disorganizing your data. 

Use the WBS utilities to: 

 Copy WBS legs into another parent 

 Move WBS legs to a different parent 

 Rename WBS legs 

 Reorder (sort) WBS legs 

Specifying Replacement Characters 

Each of these utilities requires you to specify replacement characters, which MPM uses 

for creating new unique WBS IDs. For each child element in the leg being copied, MPM 

replaces the same number of characters as was contained in their old parent ID. For 

example, assume the parent ID in the old leg contains two characters, and the new ID 

contains five characters. The first two characters of each child are replaced with the five-

character new ID. All remaining original characters in the ID are retained. WBS 21-100 

with replaced characters TEST becomes TEST-100. TEST-100 with replaced characters 

ZZ becomes ZZ-100. See Figure A. 

Old WBS ID Replacement Characters New WBS IDs 

2X 
21-100 
21-200 
21-300 

TEST TEST 
TEST-100 
TEST-200 
TEST-300 

12 
12A 
12B 
12C 

123 123 
123A 
123B 
123C 

TEST 
TEST-100 
TEST-200 
TEST-300 

ZZ ZZ 
ZZ-100 
ZZ-200 
ZZ-300 

Figure A. Results of Specifying Replacement Characters 

If the natural progression in the naming process would result in duplicate WBS 
IDs, MPM reports the error on the Processing Results report. 
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Processing Results Log and Report 

MPM keeps a log of the processing results when using the WBS utilities. Each time you 

launch the WBS window, a new WBS session is started and a log file is created. When 

you invoke one of the WBS utilities and an error results, all errors of processes you 

request are stored in the log file and are displayed in the Report Viewer. If no errors 

result, the log file is automatically deleted when you close the WBS window. 

If you have more than one WBS window open, you have more than one log file. 

Printing or Saving the Log 

If you run one of the WBS utilities and encounter an error, MPM displays the Report 

Viewer with the error. You can print or save the log file results using those options 

within the Report Viewer. When exiting the Report Viewer, if you have not saved its 

contents, MPM deletes the log file. 
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5.7 Changing WBS Data 

5.7.1  Using the Copy WBS Utility 

Use this utility to copy selected WBS elements and their associated data. There are three 

ways to access this utility:  

* Click the  button. 

* Choose the Copy WBS Leg on the Utilities menu. 

* Using the mouse on the WBS Tree. 

Be sure to back up your data before using this utility! 

Copying WBS legs using the button or menu 

Note that this button and menu option are only available if you have been granted WBS 

Leg Utility access. Once you click the button or choose the menu option, MPM displays 

the Copy WBS Leg Options dialog box. 

 

Figure A. Copy WBS Leg Utility 

Enter the WBS element to copy, the new parent’s ID, and the replacement characters for 

the ID (see topic 5.7 Changing WBS Data for information about specifying replacement 

characters). If you are unsure of the name of the IDs to copy, use the Browse button to 

select them from existing WBS elements.  

You can also choose to copy all data, or certain subsets. If any field is blank, OK is 

unavailable. If you have selected a WBS element or leg, the ID is shown as the default 

WBS to copy, which you can override if desired. 
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Copying WBS Legs using the mouse 

This utility is also available using drag-and-drop with the mouse on the WBS Tree. 

While pressing the Ctrl key, click on the WBS leg to copy, drag it to the new parent, and 

drop it onto the new parent (release the mouse button). MPM displays the Copy WBS 

Leg Utility dialog box, with both WBS IDs auto-filled. 

When using drag-and-drop with the mouse on the WBS Tree, make sure to keep 
the Ctrl key down. Without pressing Ctrl, you will be moving the WBS legs, not 
copying them!  

How MPM Copies WBS Legs 

The selected WBS element/leg is copied to a temporary area and a new leg is added to 

the WBS tree. The new leg is a duplicate of the old leg with the new IDs containing the 

replacement characters, and is placed as the last child in the hierarchy on the new parent.   

If All Data is selected, all existing BCWS, ACWP, BCWP, and ETC values are rolled up 

into the new parent’s hierarchy. This includes milestones, status information, Task 

Descriptions, and Basis Of Estimates. If one of the subsets were selected, only values for 

that subset are rolled up. 

All rollup date ranges are adjusted as necessary, whether estimates exist or not. 

If the new parent has a value for Recur/Nonrecur, Fee Limit or Fee% that is different 

than the new parent, values are automatically changed down the leg and the resulting 

changes are shown in the Processing Results report. 

If the new parent has a CLIN value, the leg being copied becomes associated with the 

new CLIN. If the WBS element being copied has a CLIN, the CLIN is cleared and the 

resulting changes are shown in the Processing Results report. 

For more information about this report, see topic 5.7 Changing WBS Data. 
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5.7 Changing WBS Data 

5.7.2  Moving WBS Legs  

You might need to move a WBS leg from one parent to another, perhaps as the result of a 

project reorganization. Use this utility to move selected WBS elements under a new 

parent.  

Be sure to back up your data before using this utility! 

To move WBS legs: 

 Click the  button. 

 Use the Move WBS Leg option on the Utilities menu. 

 Click the leg to be moved in the WBS Tree, drag it to the new location in the 

Tree, and drop it (releasing the mouse button). 

Moving WBS Elements Using the Button or Menu 

Note that this button and menu option are only available if you have been granted WBS 

Leg Utility access. Once you click the button or choose the menu option, MPM displays 

the Move WBS Leg Options dialog box. 

 

Figure A. Move WBS Leg Options 

Specify the WBS to be moved, and its new parent. If you are unsure of either entry, click 

Browse to find the desired WBS elements. Note that you must enter both fields; if either 

field is blank, OK is unavailable. If you have selected a WBS element or leg, the ID is 

shown as the default to move, which you can override if desired. 
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Moving WBS Elements Using the Mouse 

You can also move WBS elements using the drag-and-drop method with the mouse. In 

the WBS Tree, click on the desired WBS element/leg and while keeping the mouse 

button down, drag it to the desired new parent, and drop it (release the mouse button). 

MPM displays a confirmation message. 

How MPM Moves WBS Elements 

MPM moves the WBS element to be the last child in the hierarchy on the new parent. All 

existing BCWS, ACWP, BCWP, and ETC values are unrolled from the old parent’s 

hierarchy; all values are then rolled up into the new parent’s hierarchy.  All date ranges 

are adjusted (even if there are no existing estimates). 

If the new parent has a value for recur/nonrecur, Fee Limit or Fee% that is different from 

the parent being moved, the values are changed down the leg and resulting changes are 

shown in a processing report. 

If the new parent has a CLIN, the WBS leg being moved becomes associated with the 

new CLIN. If the element being moved has a CLIN, the CLIN is cleared and resulting 

changes are shown in a processing report. 
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5.7 Changing WBS Data 

5.7.3  Renaming WBS Legs 

You might need to rename a WBS leg, perhaps as the result of a reorganization. Use this 

utility to select all the WBS elements under the current parent and rename those elements 

as directed.  

Be sure to back up your data before using this utility! 

To rename WBS legs, do one of the following: 

 Click the  button. 

 Choose the Rename WBS Leg option on the Utilities menu 

 (This utility has no mouse equivalent.) 

Note that this button and menu option are only available if you have been granted WBS 

Leg Utility access. Once you click the button or select the menu option, MPM displays 

the Rename WBS Leg Options dialog box. 

 

Figure A. Rename WBS Leg Utility 

Enter the WBS element to rename and the replacement characters for the ID (since you 

must keep WBS IDs unique, you must give MPM a way to keep the new leg unique). If 

you are unsure of the desired ID, use the Browse button to find them. If any field is 

blank, OK is unavailable. If you have selected a WBS element or leg, the ID is shown as 

the default, which you can override if desired. 
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How MPM Renames WBS Legs 

See topic 5.7 Changing WBS Data for information about specifying replacement 

characters. The WBS ID of the parent element in the selected leg is renamed with the 

new WBS ID. For each child element in the leg, MPM replaces the same number of 

characters as was contained in the old parent ID. If the natural progression in the naming 

process would result in a duplicate WBS ID, MPM adds the old name at the end of the 

new name, and reports the solution in the Processing Results Log. 

All detail estimates, milestones, task descriptions, BOEs, actuals, and other associated 

data are relabeled for the leg being renamed. 
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5.7 Changing WBS Data 

5.7.4  Sorting WBS Legs 

You might need to sort a WBS leg after renaming or copying WBS data. Use this utility 

to select all the WBS elements under the current parent and reorder those elements as 

directed.  

Be sure to back up your data before using this utility! 

To sort your WBS data: 

1. Choose the Reorder WBS Leg option on the Utilities menu.  

Note that this menu option is only available if you have been granted WBS Leg 

Utility access. MPM displays the Reorder WBS Leg dialog box shown in 

Figure A. 

 

Figure A. Reorder WBS Leg Utility 

2. Click on the desired WBS leg to reorder. Click Browse to find the WBS if you 

are unsure. 

 To sort the entire project, select either the Project Level WBS ID in the 

WBS Tree or WBS Sheet. All WBS IDs in the project are reordered. 

 To sort just one WBS leg, select the desired WBS leg in the WBS Tree 

or WBS Sheet. 

3. Select the desired type of sort.  

If the ID is blank, OK is unavailable. If you have selected a WBS element or leg, 

the ID is shown as the default, which you can override if desired. 
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 Sort 1: By Character — This sort reorders the WBS elements by the 

characters in the WBS ID, regardless of the length of the ID. The 

elements are first sorted by the first character in the ID, then the second, 

etc. This sort works best with alphanumeric WBS IDs but not with 

numeric IDs, as you can see in the example below. 

 Sort 2: By Length — This sort reorders the WBS elements first by the 

length of the ID (shortest IDs first), then by character as in Sort 1. This 

sort works best with numeric IDs (see example below). 

4. To accept the settings, click OK. 

How MPM Sorts WBS Legs 

MPM reorders the selected WBS leg(s) using the sort method selected. For example, 

 

Sort Method 

 

Alpha IDs 

 

Numeric IDs 

Alpha- 

numeric IDs 

Alpha-num w/ 

special chars 

Sort 1: by character A 

AAC 

ABC 

CC 

Z 

1 

10 

2 

20 

5 

100 

10AA 

10B 

2 

21 

10-MATL 

160-PUR 

2-ENGR 

4-DESIGN 

7-MFG 

Sort 2: by length A 

Z 

CC 

AAC 

ABC 

1 

2 

5 

10 

20 

2 

21 

100 

10B 

10AA 

7-MFG  

2-ENGR  

10-MATL 

160-PUR 

4-DESIGN 
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5.8  Changing the WBS Display 

There are several ways to change the WBS window display. You can change the window 

to display only the information you are currently working with, by selecting the WBS 

legs to edit or view, displaying the columns to edit, or changing window characteristics 

such as pane size. See Getting Started for complete details. 

Filtering the WBS Legs 

You can filter the WBS legs 

to display only the data you 

need to see. To do this, you 

can expand or collapse the 

legs on the WBS Tree (the 

left window pane) or use 

Filter on the Tools menu to 

select a subset of WBS legs 

using any of the fields shown 

in Figure A. Selecting one of 

the menu options brings up a 

dialog box with a drop-down 

list box of available values to 

choose from. In Figure A, the 

user filtered to see only WBS 

starting in the date range 1-

Jan-96 to 1-Jul-96.  

Notice in the WBS Tree that 

some of the check mark boxes 

now show the  Filter symbol.  

This indicates that only some of the WBS elements in those legs are being displayed, and 

some have been filtered out. 

Expanding and Collapsing WBS legs 

The Expand/Collapse Box shows whether the WBS displays all of the sub-elements under 

a WBS element. To expand an entire WBS leg, highlight the parent and press Ctrl+E. To 

expand the entire WBS Tree, highlight the Project Level WBS and press Ctrl+E. 

A plus sign  indicates that the WBS is collapsed and there are lower level WBS 

children that are not currently displayed.   

Figure A. Filtering WBS legs by date range. 
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A minus sign  

indicates that the 

WBS is expanded 

and all children 

are displayed.  

The lack of an 

Expand/Collapse 

Box indicates the 

element has no 

children. 

Selecting and 

Deselecting 

WBS Legs 

To select or deselect which WBS elements to view, click the check mark box. MPM 

saves the status of which WBS elements are selected/deselected for the current project, 

so that the same selections are displayed the next time you open the project. 

 Selecting a collapsed WBS element downloads the WBS element and all of its 

children and grandchildren.  

 Selecting an expanded WBS element downloads just the selected WBS.  

 Deselecting a collapsed WBS element releases the WBS element and its children 

and grandchildren from memory. You must select this element to download its 

data again.  

Distributed WBS elements are not downloaded.  See Chapter 19: Distributed Projects 

for more information about distributed projects. 

Displaying and Hiding WBS Fields 

The WBS fields appear as columns in the WBS Sheet. You can display or hide any or all 

of the columns, using Column Hide on the Format menu. To select a column, click in the 

column’s heading. To select or deselect multiple columns, use the Shift and Ctrl keys. 

The Expand/Collapse Box The Select/Deselect Box

Loads the WBS Element

and all its children

Does not load the WBS

Element or its children

Load the WBS Element

and selected children

Figure B. Expanding and Collapsing WBS

Legs
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5.9  Recommended WBS Reports 

There are several standard MPM reports which you can use to check your WBS structure 

and see its coordination with other data. 

 WBS Indented Report — Shows the WBS in outline (indented) format. Use 

conditioning to show particular WBS leg(s).  

 WBS Hierarchy — Shows the WBS in tabular format. Use conditioning to show 

particular WBS leg(s).  

 Responsibility Assignment Report — Shows the OBS cross-referenced with 

the WBS in a tabular format. Use conditioning to restrict WBS legs, elements or 

levels.  

 Milestone Bar chart — Contains a combination milestone and Gantt chart with 

WBS elements shown as bars and milestones shown under the bars using the 

standard milestone symbols. 

 

 



MPM Projects   151 

6  
Integrated Planning -- An Overview 

6.1  Introduction to Integrated Planning ........................................... 152 
6.2  Accessing the Views ................................................................. 154 
6.3  Selecting WBS Elements to Download...................................... 156 
6.4  Navigating the Views ................................................................. 158 
6.5  Viewing Totals ........................................................................... 160 

 



152   Chapter 6: Integrated Planning -- An Overview 

6.1  Introduction to Integrated Planning 
To successfully complete a project, you must accurately track the projects schedule and 
budget. Accurate schedule and budget information lets you detect variances early and 
make informed adjustments as needed. 

MPM provides a suite of Integrated Planning views that you use to track projects. You 
can establish a baseline for a project, maintain up-to-date estimates on the costs to 
complete the project, and set milestones to directly measure performance. 

Three Views 
There are three Integrated Planning views (see Figure A): 

 Baseline (BCWS): You use the Baseline view to create and maintain the initial 
project plan.  

 Estimate to Complete (ETC): You use the ETC view to calculate the estimated 
costs to complete a project. MPM can automatically generate the initial ETC as 
you create the Baseline. You can then edit the ETC data as required to reflect 
changes in the project. 

 Milestones: You use the Milestones view to create, monitor, and measure 
performance for a WBS element. It presents the data in tables as well as in a 
Gantt chart. 

Chapter Organization 
This chapter describes the elements and actions common to the three views. The unique 
functions of each view are described in the following chapters: 

Chapter 7: Estimating the Project Baseline 
Chapter 8: Revising the Forecast (ETC) 
Chapter 9: Tracking the Project Milestones 
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Figure A. You use the Integrated Planning views to establish a baseline, 
estimate costs to complete, and track key milestones for projects. 
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6.2  Accessing the Views 
You access the three Integrated Planning views from the MPM Menu Manager. Before 
the view is displayed, you are given the opportunity to select a project, the WBS elements 
of the project that you want downloaded, and the type of view. You can also filter the 
WBS elements downloaded by Manager and Element Type. 

 
Figure A. To access the Integrated Planning views, double-click the Integrated 
Planning icon on the Projects tab in the Menu Manager. 

Downloading Elements 
When you select the options in the Integrated Planning Open dialog box, you are telling 
MPM which elements of the selected project to download. In large projects, this can be 
useful to reduce the amount of time it takes to open a view. Once you have opened a 
view, you are limited to working with the elements that were downloaded. If you want to 
work with other elements, you must reopen the view with the appropriate elements 
selected. 
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Procedure 
To open an Integrated Planning view: 

1. From the Menu Manager window, do one of the following: 

 Double-click the Integrated Planning icon. 
 From the File menu, select Projects|Integrated Planning. 

 MPM displays the Integrated Planning Open dialog box shown in Figure A. 

2. Select the project from the Project drop-down list box. 

3. Select the WBS elements you want downloaded. 

 For details on selecting WBS elements, see the next topic: 6.3 Selecting WBS 
Elements to Download. 

4. If appropriate, select one or more managers to be used as filters on the WBS 
elements downloaded. 

 If you want to download elements that do not have a designated manager, select 
the <Empty> option. To select more than one manager, use the Shift+Click and 
Ctrl+Click combinations. 

5. If appropriate, select the element types to be used as filters on the WBS elements 
downloaded. 

 The element types are assigned to projects at the time the WBS structure is 
created. You must select at least one element type. Usually elements above the 
control account level are not assigned an element type. To download only those 
high-level elements, select the <Empty> option only. 

6. Select a starting view. 

7. To accept the settings and begin the download, click OK. 
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6.3  Selecting WBS Elements to Download 
If you are working with a large project, downloading all WBS elements in the project 
may be time consuming. Using the WBS tree in the Integrated Planning Open dialog box, 
you can select the elements you want downloaded.  

 
Figure A. Use the WBS tree to select the elements you want 
downloaded. 

Selection Guidelines 
Below are guidelines for selecting elements. 

Click to expand and 
collapse an element 

Click to mark element 
for downloading 

 If none of the elements are selected, MPM downloads all elements. 
 If a collapsed element is selected, MPM downloads the element and all children 

of the element. 
 If an expanded element is selected, MPM will download the selected element, 

but you must also select each of the child elements you want downloaded. 
 Its possible to select children elements and not the parent elements, and MPM 

will download only the selected children elements. 
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Expand/Collapse Boxes 
The table below describes how to expand, collapse, select, and deselect elements in the 
WBS tree. 

To: Do this: 
Expand a WBS element to 
the next level 

Click the expand box  next to the element to display. 

Collapse a WBS element Click the collapse box  next to the element 
Select a WBS element Click the select box  next to the element to display a 

check mark. 
Deselect a WBS element Click the select box  next to the element to remove 

the check mark. 
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6.4  Navigating the Views 
The Integrated Planning window follows many of the standard Microsoft Windows 
conventions. You can: 

 Size the window by dragging the borders and corners. 
 Minimize and restore the window using the buttons in the upper right corner of 

the window. 
 Horizontally scroll the left and right panes individually using the horizontal 

scroll bars in each pane. 
 Vertically scroll the left and right panes at the same time using the vertical scroll 

bar at the right edge of the window. You cannot individually scroll the panes 
vertically. 

 Change the size of the panes by dragging the separator bar between the two 
panes. 

 Switch among the three Integrated Planning views by selecting the tabs. 
 Access the more frequently used commands from the Toolbar. 
 Hide the Toolbar and Status Bar using the commands under the View menu. 

WBS Elements 
All three views display the WBS elements. The elements are shaded gray. These serve as 
the foundation for the views. They cannot be edited in the Integrated Planning windows. 

In the Baseline and ETC views, resource estimates are listed under each WBS element. In 
the Milestones view, milestones are listed under each WBS element. 

Searching and Going to WBS Start  
If you are working with a large WBS, you may have hundreds of resource estimates 
defined. To help you find a specific entry, MPM provides a search feature for the 
Integrated Planning windows. You can search on any text string, and restrict the search 
by matching for a whole cell and/or case. To use the search feature, choose Find from the 
Edit menu. 

If your project spans several years, you can go to the first value for a WBS element using 
the Go to WBS Start feature. To use the feature, press Ctrl+G or select Go to WBS Start 
from the Edit menu. 

For more information on using these features, see the MPM Getting Started manual. 
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Figure A. The Integrated Baseline window conforms to the Microsoft 
Windows conventions. 
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6.5  Viewing Totals 
MPM displays totals for estimates in the WBS element rows, in the Total Values row at 
the bottom of window, and in a separate Totals window. You can view the totals for a 
WBS element or resource estimate in any of the views by displaying the Total window 
shown in Figure B. If you select a WBS element row, MPM shows the totals for that 
WBS element. 

 
Figure A. The WBS element rows show rolled up totals for all resource estimates 
under the element. 

Rollup Totals 
The totals displayed in the WBS element rows are generated by MPM’s rollup feature. 
Each time you enter a new estimate, MPM updates the totals as long as the rollup 
processing toggle is set to on.  

During the initial data entry phase on a large project, you may not want MPM to 
recalculate totals after every entry. You can turn the rollup feature off and on from 
Project Maintenance. For more information on the rollup feature, see Chapter 2: Creating 
and Maintaining Project Settings. 

Element row 
shows totals for 
all resources 
under element 

Totals row 
shows totals for 
periods 
(columns) 
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Burdened Totals for WBS Elements and Resource Estimates 
The Totals window shown in Figure B displays the burdened totals for a WBS element or 
a resource estimate. To display the window, do one of the following: 

 Click the Totals button  in the Toolbar. 

 Open the View menu and choose Total Window. 

 
Figure B. Total window 

The title bar of the window displays the name of the WBS element or the WBS element 
and resource estimate selected. In Figure B, the totals shown are for the Administrator 
resource under the 1.X.1 WBS element. Once opened, the Total window floats on top of 
the Integrated Planning windows so it is always visible. If you want to move the window 
to another location on the screen, click on the title bar of the window and drag it. 

Formulas 
MPM uses the following formulas to calculate the estimate totals displayed in the Total 
window: 

Total Burdened = Prime + Overhead 

Total Cost = Total Burdened + G&A 

Total Dollars = Total Cost + COM 

Total Price = Total Dollars + Fee 
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7.1  Introduction to Estimating the Project Baseline 
How you develop baseline estimates for a project will depend on the WBS you are using 
and whether you are developing the baseline in a proposal or contract environment. 

Estimating in a Proposal Environment 
In a proposal environment, there is no requirement that estimating be done at a particular 
level of the WBS. With MPM, you have the flexibility to estimate on any level with any 
element within your WBS structure. However, it is recommended that estimating for 
proposals be done at the level at which you would manage a project, usually the work 
package level. Doing this eliminates a great deal of duplication of effort when you move 
from proposal to contract once the award is made. You can use the proposal baseline as 
the management tool for the contract setup. 

Estimating in a Contract Environment 
In a contract environment, work content typically is estimated at the lowest level of the 
WBS. This lowest level of effort usually is assigned to a single performing organization 
responsible for an element of work. In government contracting, this element of work is 
referred to as the work package. 

Baseline and ETC Relationship 
MPM lets you create a Baseline estimate and an Estimate to Complete (ETC). The two 
estimates allow you to compare your original plan against the actual progress on a 
project. MPM gives you the option to create the initial ETC as you create the baseline 
estimate. For information on creating the ETC as you create the baseline estimate, see 
topic 7.3.1  Saving Estimates. 
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Accessing the Baseline View 
To access the Baseline View: 

1. Click the Projects tab in Menu Manager and do one of the following: 

 Double-click the Integrated Planning icon as shown in Figure A. 
 Open the File|Projects menu and choose Integrated Planning. 

2. Select the WBS elements you want downloaded. 

3. Select Baseline as the starting view. 

For details on opening the Baseline view, see Chapter 6: Integrated Planning – An 
Overview. 

 
Figure A. To open a Baseline view, select Integrated Planning from the 
Menu Manager. 

  



166   Chapter 7: Estimating the Project Baseline 

7.2  Orientation to the Baseline View 
The Baseline view is divided into two panes: 

 The Resource Sheet on the left 
 The Values Sheet on the right 

 
Figure A. Integrated Planning Baseline view 

Resource Sheet 
The Resource Sheet displays information about the WBS elements and their resources. 
You can scroll the window horizontally to bring columns into the viewing area, and 
vertically to bring WBS elements and resources into the viewing area. Initially, only the 
most important columns are displayed. You can display and hide columns by choosing 
the Column Hide command under the Format menu. For more information on displaying 
and hiding columns, see topic 7.8  Changing the Baseline Display. 

The WBS elements displayed in the view are taken from the WBS you defined for the 
project. You cannot edit the WBS elements in this view.  

Resource Sheet 
Estimate Type 

Values Sheet 
Window Separator Bar 

Total 
Values 
Row 
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Values Sheet 
The Values Sheet displays the timephased values for the WBS elements and their 
resources. You control the type of data displayed by selecting an estimate type from the 
Toolbar. The values displayed for a WBS element are the totals of the values displayed 
for the resources under the WBS element. You can scroll the window to bring columns 
into the viewing area. You can control the time span represented by each column (month, 
quarter, year) by choosing Periods from the View menu. 

Total Values Row 
The Total Values Row at the bottom of the Values sheet displays totals for each period 
for all currently displayed WBS elements and resources. However, if the estimate type is 
set to Units, totals are not shown. 

Multiple Windows 
You can open more than one Baseline view if you wish. To open another view, do one of 
the following: 

 Click the Open button  in the Toolbar. 

 From the File menu, choose Open. 

Before You Begin 
Before you can define a baseline estimate, the following tasks must have been completed: 

 A Work Breakdown Structure (WBS) must have been created for the project. 
(See Chapter 5: Creating the WBS.) 

 A burden template must have been created for burdening to occur. (See Chapter 
5: Defining Burden Templates in the MPM Globals manual.) 

 Resources and their rates must have been defined. (See Chapter 6: Defining 
Resources in the MPM Globals manual.) 
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7.3  Adding Resource Estimates 
You build a baseline estimate by adding resource estimates to the WBS elements in a 
project. To add a resource estimate, you select a WBS element and choose Insert 
Estimate from the Edit menu. Estimates can not exceed a 10 year time span. 

The combination of the WBS ID, Resource, Resource Department, and Overtime fields 
uniquely identify each estimate. If you wish, you can use the Overtime field to identify 
resources for different estimates by entering a one to four-letter code. You can then filter 
the display by the code. You can use this approach to enter different estimates for the 
same resource. 

When adding the estimate values, it is useful to keep the Totals window open as shown in 
Figure A. The Totals window shows the burdened totals for the currently selected 
element or resource. To display the window, select Total Window from the View menu. 

 
Figure A. The Totals window shows the totals for the 
currently selected element or resource. 

Procedure 
To add a new resource estimate: 

1. Select an estimate type from the Estimate Type list box in the Toolbar. 

2. Select a WBS element and do one of the following: 

Estimate Type list box 

 Select a resource code from the Resource drop-down list box in the WBS 
row. 

 Press the Insert key. 
 Select Insert Estimate from the Edit menu. 
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 MPM inserts a line below the existing estimates for the WBS element and 
highlights the text in blue to indicate the line is in edit mode. 

3. Select a resource from the drop-down list. 

 MPM automatically fills in the Resource Description and Resource Department 
fields. The Resource Department field is filled in with the performing department 
based on the department entered when the WBS was created. 

4. If you wish, you can select a different resource department from the drop-down 
list box. 

 For example, an Engineer Resource may normally be assigned to the performing 
organization but may be loaned to a different department for a specific work 
package. To show this assignment, you would select the department borrowing 
the resource. 

5. (Optional) Select an identifier from the XREF-EST field drop-down or enter a 
new one.  

The XREF-EST field is an optional 20-character user-defined field that can be 
used as a wild card for reporting, exporting, or onscreen filtering to match a 
specific group of data. You can define the XREF-EST field on the Baseline and 
ETC tabs in Integrated Planning or the Actuals screen. You cannot rename the 
XREF-EST field label.  

6. If appropriate, make an entry in the Overtime field. 

 The Overtime field can be used to calculate overtime for a resource, or as a 
reference field used to create more than one estimate for a resource. For more 
information on using this field, see topic 7.3.2  Using the Overtime Field. 

7. Enter the Start and Complete dates for the resource. 

 MPM accepts most common date formats, then converts them to the dd-mmm-yy 
format. 

8. Note the rate table and burden template assigned to the resource. These fields 
typically are read-only unless the Rate Table Override option and Burden 
Template Override option in the Project Maintenance window have been set to 
ON. For more information on these fields, see the descriptions in topic 
7.5 Baseline Field Descriptions. 

9. To save the estimate, do one of the following: 

 Click on another row in the window. 
 Click on the Save button  in the Toolbar. 
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 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save and asked if you want to save the 
changes to the ETC. For information on the Save options, see the next topic 7.3.1  
Saving Estimates. 
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7.3  Adding Resource Estimates 
7.3.1  Saving Estimates 

When you save data in the Integrated Planning views, how MPM responds depends on 
the Save options you set. The options control: 

 If you must confirm save commands. 
 If Baseline or Baseline and ETC data is saved. 

Confirming Saves 
There is an option you can set that requires you to confirm changes you make anywhere 
in MPM if you move the focus away from the item being edited without first saving it. 
You can move the focus by clicking on another row, tabbing to another row, selecting 
File|Close or File|Exit, switching to another application, as well as several other ways.  

You set the confirm option by choosing Options from the Tools menu in any of the 
application windows, selecting the General tab in the Options dialog box, and selecting 
Prompt Before Saving Modifications. For more information on this option, see the MPM 
Getting Started manual. 

Three Baseline Save Options 
When you are creating a baseline estimate, you can have MPM create the initial Estimate 
to Complete (ETC) at the same time. There are three Baseline save options available: 

Option Result 
Save Baseline only MPM saves the Baseline data only. 
Save Baseline and ETC MPM saves the Baseline data and saves the 

corresponding changes in the ETC data. 
Prompt for ETC save MPM saves the Baseline data and displays the dialog box 

below asking if you want to save the corresponding 
changes in the ETC data. 
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Procedure 
To set the Baseline save options: 

1. From the Tools menu, select Options. 

 MPM displays the Options dialog box shown in Figure A. 

 
Figure A. You can save Baseline 
changes to the ETC as well. 

2. Select the Integrated Planning tab. 

3. Select the appropriate option. 

4. To save your selection and close the dialog box, click OK. 
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7.3  Adding Resource Estimates 
7.3.2  Using the Overtime Field 

The Overtime field has several uses. It can be used to: 

 Calculate overtime rates for resources 
 Indicate different estimates for the same resource 
 Enter code information specific to your operation  

If you do not want to use the field for these purposes, you can leave the field blank. 

Calculating Overtime Rates 
If you want to calculate overtime rates for a resource, you can enter a numeric value in 
the Overtime field as shown in Figure A. MPM uses the value as a multiplier against the 
basic rate. For example, if overtime is billed out at one and one-half times the normal 
rate, you would enter the value as 1.5.   

 
Figure A. If you want MPM to calculate overtime, enter a numeric value. 

Note that to show overtime, you create two entries for the resource. In Figure A, two 
entries have been created for the Senior Engineer resource. One entry is used to calculate 
the basic rate; the other entry is used to calculate the overtime. Burdens for both the basic 
rate and overtime rate are calculated as straight time based on the burden template 
assigned to the resource. 
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Indicating Different Estimates 
If you want to indicate different estimates for the same resource in the same resource 
department, the Overtime field can be used to distinguish the entries. The entry can be up 
to 20 characters and must contain at least one alpha character.  When an entry in the 
Overtime field contains one or more alpha characters, it is interpreted as a reference code 
rather than a multiplier.   

In Figure B, two entries have been made for the Senior Engineer resource. You could 
now filter the display to show one entry or the other. 

 
Figure B. You can use the Overtime field to enter multiple estimates for the same 
resource. 

Another way to indicate different estimates is to use the XREF-EST field to filter 
information to match a specific group of data. 
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7.3  Adding Resource Estimates 
7.3.3  Entering Estimate Values 

After entering the resource information in the Resource Sheet, you can enter estimate 
values in the Values Sheet. You can select from the following estimates types: 

 Standard Hours (Industrial Engineering Standard Hour) 
 Hours  
 Units  
 EQP (Equivalent Persons) 
 Prime (Resource Rate x Hours) 
 Total Burdened (Prime + Overhead) 
 Total Cost (Total Burdened + G&A) 
 Total Dollars (Total Cost + COM) 
 Total Price (Total Dollars + Fee) 

Which ever estimate type you choose to enter, MPM calculates the other values 
automatically. This is one of MPM’s most powerful features. You can view any of the 
values at any time by selecting from the Estimate Type drop-down list box in the 
Toolbar. 

Estimate Total Window 
When you are entering estimates, it is helpful to have the Estimate Total window open as 
shown in Figure A. You can open the window by clicking the Show Total Window 
button  in the Toolbar. For more information on the Total window, see Chapter 6: 
Integrated Planning – An Overview. 

Entering a Value 
To enter a value in the Values sheet: 

1. Place the cursor in the cell where you want to enter the value. 

2. Select an Estimate Type from the drop-down list box in the Toolbar. 

3. Type in the value. 
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4. To save the entry: 

 Click on another row in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save and asked if you want to save the 
changes to the ETC. For information on the Save options, see topic 7.3.1  Saving 
Estimates. 

 
Figure A. You can select the estimate type displayed in the Values 
sheet.  

Other Ways 
There are two other ways you can enter estimates. They are covered in the following 
topics: 

7.3.4  Entering Information Using Autofill 
7.3.5  Entering Estimate Values Using Autospread 
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7.3  Adding Resource Estimates 
7.3.4  Entering Information Using Autofill 

Drawing on its similarity to a spreadsheet, MPM provides autofill features for replicating 
data across adjacent cells. In the Resource Sheet, you can autofill down a column. In the 
Values Sheet, you can autofill down a column and across a row. In both windows, you 
are restricted to autofilling within the resource estimates for a single WBS element. If 
you want to replicate resource estimates from one WBS element to another, you can use 
the Copy/Paste features. These are described in topic 7.6  Maintaining Estimate Data. 

 
Figure A. You can use the autofill feature to replicate data across adjacent 
cells. 

Procedure 
To autofill data in adjacent cells: 

1. Select the source cell(s) and the adjacent target cell(s). 

 In the Resource Sheet window, you can only autofill down a column. In the 
Values Sheet window, you can autofill down a column and across a row. 
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2. To fill right, do one of the following: 

 From the Edit menu, select Fill Right. 
 Press Ctrl+R. 

 To fill down, do one of the following: 

 From the Edit menu, select Fill Down. 
 Press Ctrl+D. 
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7.3  Adding Resource Estimates 
7.3.5  Entering Estimate Values Using Autospread 

Instead of manually entering estimate values for a resource estimate, you can use MPM’s 
Autospread feature to automatically spread values. Autospread distributes a total value 
across a specified period of time using predefined or custom curves. This topic describes 
how to apply Autospread curves. For information on the predefined curves and how to 
create custom curves, see Chapter 7: Defining Spread Curves in the MPM Globals 
manual. 

When you use Autospread to enter estimate values, MPM places the  symbol in the 
Estimate Type field. Double-clicking on the symbol will display the Autospread window. 

 
Figure A. The Autospread feature automatically distributes values across a 
specified time period. 

Respread Options 
When you apply the Autospread function to existing estimates, you can select one of 
three options.  

Symbol indicates values were 
generated using autospread 

 Replace All: replaces all existing values for the estimate with the value being 
respread. 

 Replace Part: only replaces values for the periods between the From and 
Through dates, and leaves any values outside that range alone. 
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 Compound: adds new amounts to any existing values for the periods defined by 
the From and Through dates. 

Procedure 
To enter values using the Autospread feature: 

1. Select a resource by clicking on the row number at the left of the Resource Sheet 
grid, or select a range of dates in the Values Sheet grid for the resource.  

 You will have the opportunity to change the range of dates in the Autospread 
dialog box. 

2. To display the Autospread dialog box, do one of the following: 

 Click the Autospread button  in the Toolbar. 

 From the Tools menu, choose Autospread. 
 Press Ctrl+A. 

 MPM displays the Autospread dialog box shown in Figure A. 

3. Enter the amount you want distributed. 

4. Enter the units you want to use. 

5. Select the curve to apply. 

6. Enter different From and Through dates if appropriate. 

 If you are entering a new estimate, MPM displays the WBS Start and Complete 
dates. If you selected a range of columns, the first and last column dates are 
displayed. 

7. Select a Respread option. 

8. To apply the Autospread settings, choose OK. 
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7.4  Creating Apportioned Estimates 
An apportioned estimate is an estimate based on a percentage of an existing baseline or 
ETC estimate. You can use the same base estimate for more than one apportioned 
estimate. You cannot base an apportioned estimate on another apportioned estimate.  

Characteristics of Apportioned Estimates 
An apportioned estimate has the following characteristics: 

 It has the same start and complete dates as the base estimate. 
 The values are calculated using the same estimate type and estimate curve as the 

base estimate. 
 Any changes made to the base estimate are automatically propagated in the 

apportioned estimate. 
Apportioned estimates are displayed towards the bottom of the list of resource estimates 
for each WBS element, just before any replan estimates. They are flagged with a percent 
symbol ( ) next to the resource code.  

 
Figure A. You can specify apportioned estimates. 
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Procedure 
To create an apportioned estimate: 

1. Select the base estimate from the baseline (or ETC) window and do one of the 
following: 

 Click the New Apportioned Estimate button  in the Toolbar. 

 From the Tools menu, choose Create Apportioned Estimate. 
 MPM displays the Apportioned Estimate dialog box shown in Figure A. 

Information about the base estimate is displayed in the top half of the dialog box. 
You use the bottom half of the dialog box to define the apportioned estimate. 

2. Enter a valid WBS ID for which the estimate that will be created.  

 You may also click the button at the end of the WBS ID field to select a WBS ID 
from a list. 

3. Select a resource from the drop-down list box. 

4. Select a department from the drop-down list box. 

5. Enter an overtime multiplier or reference code if appropriate. 

 For more information on using the Overtime field, see topic 7.3.2  Using the 
Overtime Field. 

6. Enter the percentage of the base estimate that is to be used to create the 
apportioned estimate values. 

7. To have MPM calculate the estimates, click the Calculate  button. 

8. To accept the new estimate and close the dialog box, click OK. 

 MPM displays the new apportioned estimate at the bottom of the WBS ID. 
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7.4  Creating Apportioned Estimates 
7.4.1  Special Guidelines for Apportioned Estimates 

MPM handles apportioned estimates differently than regular estimates. Below are a 
number of guidelines describing how MPM works with apportioned estimates. 

Importing Data 
 If an import estimate record has the same key (WBS, Resource Code, Resource 

Department, Overtime) as an existing apportioned estimate, MPM will reject the 
imported record. 

 You cannot import over an existing baseline or ETC apportioned estimate. If a 
base estimate is overwritten by an import, the apportioned estimate is 
recalculated per the new base estimate. 

 If you import WBS schedule dates, MPM will not shift resources on an 
apportioned estimate to the new time period if the base estimate is not also 
shifted. 

Exporting Data 
An apportioned estimate may be exported from MPM in the same manner as any other 
estimate. 

Estimating 
An apportioned estimate may be retrieved and viewed or deleted. You may also edit the 
apportioned percentage of an existing estimate.  

Estimating Utilities 
 Project Date Shift: If the base estimate is shifted, MPM adjusts the apportioned 

estimates to be consistent with the base estimate. Apportioned estimates are not 
directly shifted by this utility. 

 Estimate Reprice: MPM processes the base estimates first, then the apportioned 
estimates using the repriced estimates. 

 Estimate Adjust: MPM processes the base estimates first, then the apportioned 
estimates as needed. 

 Estimate Rename: Apportioned estimates can be renamed using this utility. 
This function also renames all associated Resource BOEs. 
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WBS Leg Utilities 
 Copy Leg: Apportioned estimates cannot be copied. 
 Delete Leg: When you delete a WBS ID, all apportioned estimates using base 

estimates within the deleted WBS are also deleted. 
 Rename Leg: The WBS can be renamed and all appropriate relationships will 

be maintained. 

WBS Rename 
 You can rename the WBS and MPM will maintain all appropriate relationships. 
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7.5  Baseline Field Descriptions 
The fields (columns) in the Resource Sheet provide information about the estimates. 
MPM displays <Required> in fields that are required. The WBS ID, Resource, 
Description, and Overtime fields uniquely define each estimate.  

Most of the WBS fields can be displayed in the Baseline view. However, they cannot be 
edited and initially they are hidden in the view. The WBS fields are listed below. For 
more information on the fields, see topic 5.5 WBS Field Descriptions. 

The fields can be displayed or hidden using the Column Hide command on the Format 
menu. The most frequently used fields are described below. 

WBS ID 
The WBS ID is a unique ID assigned to each element of the WBS when the WBS is 
created. To edit this field, you must be in the Work Breakdown Structure window. 

Resource 
This is a unique code assigned to each resource at the time the resource is defined in the 
Resources and Burdens window. You can select a resource code from the drop-down list 
box. This field is required. 

Description 
The Description is entered for the element at the time the resource code or WBS is 
defined. To edit this field, you must be in the Work Breakdown Structure window or the 
Resources and Burdens window. 

Resource Department 
You can select a Resource Department from the drop-down list box. The field defaults to 
the Performing Organization department assigned to the WBS element. You may change 
the department from the default. The Resource Department list contains the Performing 
Departments, but Responsible Departments may also be entered. 

XREF-EST 
Use this optional 20-character user-defined field as a wild card identifier for reporting, 
exporting, or onscreen filtering to match a specific group of data.  

You can define the XREF-EST field on the Baseline and ETC tabs in Integrated Planning 
or the Actuals screen. You cannot rename the XREF-EST field label.  
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Overtime 
You can use the Overtime field as an overtime multiplier, or as a cross-reference field. 
For more information on this field, see topic 7.3.2  Using the Overtime Field. 

Start and Complete 
The Start and Complete fields default to the WBS start and complete dates. You can enter 
different dates if you wish. The maximum time span is 10 years. 

You can work around the 10-year limit by entering a resource estimate in 10-year 
increments. For example, assume your contract runs for 15 years. You could create two 
estimates for Resource A. The first estimate would span 10 years; the second estimate 
would span the remaining five years. To use this approach, at least one of the key fields 
(Resource Code, Resource Department, or Overtime) must be different in the two 
estimates. 

Estimate Type 
This field displays the estimate type that was last used to create the resource estimate’s 
value. The field is read-only after the resource has been entered on the grid. If the values 
were generated by the Autospread function, MPM displays the symbol  in the field. 

Rate Table 
This field specifies the rate table used to calculate the estimates. This field is usually 
read-only. However, if the Rate Table Override option is set to Yes in the Project 
Maintenance window, you can select a rate table from the drop-down list box. 

Burden Template 
This field specifies the burden template used to calculate the burden applied to the 
estimates. This field is usually read-only. However, if the Burden Template Override 
option is set to Yes in the Project Maintenance window, you can select a burden template 
from the drop-down list box. 

You can define burden templates by department in the Organizational Breakdown 
Structure window, and by individual resource in the Resources and Burdens window. The 
burden template assigned to the resource takes precedence for estimating purposes. If 
there is no burden template defined for the resource, MPM will use the department 
burden template. 
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Efficiency 
The Efficiency field applies only to the Standard Hours estimate type. All companies do 
not have established efficiency factors. If your company has established efficiency factors 
for various activities, the percentage factor is entered in this field. 

For example, based on a given quantity and learning to date, it is anticipated that worker 
performance for a particular task is 90% or 90% productive. In this case, you would enter 
90 in this field. 

Scrap and Rework 
The Scrap and Rework field applies only to the Standard Hours estimate type. All 
companies do not have established scrap and rework factors. If your company has 
established efficiency factors for various activities, the percentage factor is entered in this 
field. 

For example, those tasks that must meet extremely close tolerances may have a high 
rejection and/or rework requirement. If 25% of all items must be rejected and/or 
reworked, the scrap and/or rework allowance provides for this estimate contingency. In 
this example, you would enter 25 in the field. 
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7.6  Maintaining Estimate Data 
Most of the fields in the Baseline display are read-only, with the information pulled from 
other areas of MPM. The editable fields are: 

 Resource  Start 
 Resource Department  Rate Table (if override option is set 
 Overtime  Burden Template (if override option is set) 
 Complete  

 

The editable fields are shown in Figure A. 

 
Figure A. There are several fields you can edit. 
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Editing an Estimate 
To edit a resource estimate: 

1. Select the field you want to edit. 

2. Make the change. 

 When you change a field value, MPM changes the color of the resource estimate 
field text to blue indicating the estimate has been changed but not saved. 

3. To save the change, do one of the following: 

 Click on another row in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save and asked if you want to save the 
changes to the ETC. For information on the Save options, see topic 7.3.1  Saving 
Estimates. 

If you do not want to save the changes, press Esc. 

When you modify an estimate, all of the values are re-priced based on the 
current Global rates. The displayed values will be maintained and MPM will 
calculate the others.  EQP is the exception. EQP will always recalculate based 
on hours, even if you are viewing EQP values. 

Sub-Topics 
Other editing functions are covered in the following sub-topics: 

7.6.1  Copying and Pasting Estimates 
7.6.2  Copying and Pasting Cells 
7.6.3  Deleting Estimates and Cells 
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7.6  Maintaining Estimate Data 
7.6.1  Copying and Pasting Estimates 

You can copy and paste resource estimates from one WBS element to another WBS 
element using the Copy and Paste commands under the Edit menu. If you have two 
different projects in two Integrated Planning windows open, you can copy and paste 
estimates between the windows. Copying estimates is a fast way to enter new estimates 
when estimates are similar. You can also copy individual cells. Copying cells is described 
in topic 7.6.2  Copying and Pasting Cells. 

 
Figure A. You can copy and paste estimates.  

Procedure 
To copy and paste an estimate: 

1. Select a single estimate by clicking on the row number in the left most column, 
or select multiple estimates by holding down the left mouse button and dragging 
across the row numbers. 

 If you select multiple estimates, they must be contained within the same WBS 
element. If you select multiple estimates across more than one WBS element, 
MPM will assume you want to copy the selected cells. For more information on 
copying cells, see topic 7.6.2  Copying and Pasting Cells. 
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2. Place the estimate(s) on the clipboard by doing one of the following: 

 Click the Copy  button. 

 From the Edit menu, select Copy Estimate(s). 
 Press Ctrl+C. 

3. Select the WBS element where you want to paste the estimate(s) and do one of 
the following: 

 Click the Paste  button. 

 From the Edit menu, select Paste Estimate(s). 
 Press Ctrl+V. 

 MPM may display a dialog box asking you to confirm the paste. Otherwise, the 
estimates are pasted immediately into the grid. 

4. To confirm the paste, choose Yes. 

 MPM may display a dialog box asking if you want to save the changes in the 
ETC as well. Otherwise, the estimates are pasted immediately into the grid. 

5. To save the changes to the ETC, choose Yes. 

Cutting and Pasting 
If you want to remove estimates from one WBS element and place them in another WBS 
element, you can use the Cut and Paste commands. The procedure is the same as copying 
and pasting, except you use the Cut command instead of the Copy command. 
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7.6  Maintaining Estimate Data 
7.6.2  Copying and Pasting Cells 

You can copy and paste resource estimate cells in the resource sheet and values sheet. If 
you have two Integrated Planning windows open, you can copy and paste cells between 
the windows. Copying estimates is a fast way to enter information into a resource 
estimate. You can also copy entire resource estimates. Copying estimates is described in 
topic 7.6.1  Copying and Pasting Estimates. 

 
Figure A. You can copy and paste one or more cells. 

Procedure 
To copy one or more cells: 

1. Select the cell(s) you want to copy. 

 To select more than one cell, hold down the left mouse button and drag across the 
cells. 
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2. Place the cell(s) on the clipboard by doing one of the following: 

 Click the Copy  button. 

 From the Edit menu, select Copy Cell(s). 
 Press Ctrl+C. 

3. Select the cell(s) where you want to paste the information (if you are pasting 
more than one cell, the paste range must be the same size as the range copied) 
and do one of the following: 

 Click the Paste  button. 

 From the Edit menu, select Paste Cell(s). 
 Press Ctrl+V. 

 MPM may display a dialog box asking you to confirm the paste. Otherwise, the 
estimates are pasted immediately into the grid. 

4. To confirm the paste, choose Yes. 

 MPM may display a dialog box asking if you want to save the changes in the 
ETC as well. Otherwise, the estimates are pasted immediately into the grid. 

5. To save the changes to the ETC, choose Yes. 

Cutting and Pasting 
If you want to remove cells from one WBS element and place them in another WBS 
element, you can use the Cut and Paste commands. The procedure is the same as copying 
and pasting, except you use the Cut command instead of the Copy command. 
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7.6  Maintaining Estimate Data 
7.6.3  Deleting Estimates and Cells 

You can delete an entire estimate, individual monthly estimates, or a cell or group of 
adjacent cells. Adjacent cells can run across one or more WBS elements. 

Deleting Estimates 
To delete one or more resource estimates: 

1. Select a single estimate by clicking on the row number in the left most column, 
or select multiple estimates by holding down the left mouse button and dragging 
across the row numbers. 

 
Figure A. You can delete one or more estimates. 

2. To delete the estimate, do one of the following: 

 From the Edit menu, choose Delete Estimate(s). 
 Press the Delete key. 

 Depending on the options set, MPM may ask you to confirm the delete and ask if 
you want to make the same changes to the ETC, or immediately delete the 
estimate. 
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Deleting Cells 
To delete one or more cells: 

1. Select the cell(s) you want to delete. 

 To select more than one cell, hold down the left mouse button and drag across the 
cells. 

 
Figure A. You can delete one or more cells. 

2. To delete the cell(s), do one of the following: 

 From the Edit menu, choose Delete Cell(s). 
 Press the Delete key. 

 Depending on the options set, MPM may ask you to confirm the delete and ask if 
you want to make the same changes to the ETC. 
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7.7  Adding, Editing, and Viewing Task Descriptions 
When you create a WBS for a project, you can add descriptions for each of the WBS 
elements. If a WBS element has a task description, MPM displays the  symbol to the 
left of the row number for the element. In Figure A, row 16 shows this symbol. A task 
description is a free-form description of the element. You can view the description by 
double-clicking the icon or choosing Task Description from the Tools menu. 

If an element does not currently have a description, you can add a description from the 
Integrated Planning window. 

 
Figure A. You can add, edit, or view a description for a WBS element or 
summary. 

Viewing and Editing a Task Description 
To view or edit a task description, do one of the following: 

 Double-click the  icon next to the WBS element row number. 
 Select the WBS element or summary and choose Task Description from the 

Tools menu. 
When MPM displays the Task Description window, make any edits required. To save the 
changes, click OK. 
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Adding a Task Description 
To add a description for a WBS element: 

1. Select the WBS element and choose Task Description from the Tools menu. 

 MPM displays the Task Description dialog box shown in Figure A. 

2. Enter a description. 

 The description can be up to 100 lines long. 

3. To accept the description, choose OK. 
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7.8  Changing the Baseline Display 
The Baseline display follows the standard MPM conventions for grids. The tools 
available for changing the display are described briefly in this chapter. For more 
information on changing the display, see the MPM Getting Started manual. 

Filtering Data 
Filtering is used to limit the amount of data 
displayed in the grid. You can apply a filter to the 
Baseline data by clicking on the Filter button  or 
by choosing Filter from the Tools menu. MPM 
displays the Filter dialog box shown in Figure A 
where you can type in an entry or select an entry 
from the drop-down list box.  

 
Figure A. Filter dialog box 

The filter function filters all resource estimates. You 
can apply one filter at a time. They are not cumulative. To display all resource estimates, 
select All Data from the drop-down list box in the Filter dialog box. 

Hiding and Showing Estimates 
You can expand and collapse the resource estimates under each WBS element using the 
Toolbar buttons  shown below or the commands under the Tools menu. 

Displaying and Hiding Columns 
You can display and hide any combination of columns 
using the Column Hide command under the Format menu. 
In the Column Hide dialog box shown in Figure B, you can 
select and deselect columns to hide using the Shift+Click 
and Ctrl+Click combinations. Selected columns will be 
hidden in the display. 

 
Figure B. Hiding columns 
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Sorting WBS Elements 
You can sort on the WBS elements, but not the 
resource estimates in a Baseline view. Sorts apply 
to all resource estimates regardless of the current 
selection. To sort the WBS elements, click the Sort 
button  in the Toolbar, or choose Sort from the 
Tools menu. MPM displays the Sort dialog box 
shown in Figure C. To return the display to its 
original order (by WBS ID), choose Reset in the 
Sort dialog box. 

Changing the Periods 
You can change the periods displayed in the 
Values sheet columns to month, quarter, or year. 
To select a period, choose Period from the View menu. 

 
Figure C.  Sort dialog box 

Showing Apportioned Estimates 
To show apportioned estimates, choose Apportioned Estimates from the View menu. The 
estimates are displayed at the bottom of the WBS elements, but before the Replan 
estimates. For more information on Apportioned Estimates, see topic 7.4  Creating 
Apportioned Estimates. 

Show Replan Estimates 
To show replan estimates, choose Replan Estimates from the View menu. The estimates 
are displayed at the bottom of the WBS elements and after the Apportioned estimates. 
For more information on Replan estimates, see Chapter 12: Replanning Projects. 
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7.9  Basis of Estimates 
Basis of Estimates (BOEs) describe the methodology used to estimate the resources 
included in a work package. They are a text narrative and cannot exceed 100 lines. 

You can create BOEs for resources and for WBS elements. There are two types of BOEs: 
Resource and Summary. When a BOE has been defined for a resource, a BOE symbol  
is placed in front of the row number. To edit an existing resource BOE, you can double-
click on the symbol. Resource Basis of Estimates are described in this topic. Summary 
Basis of Estimates are described in the next topic. 

 
Figure A. When a Resource BOE has been defined, a BOE 
symbol is placed in front of the row number. 

Creating a Resource Basis of Estimate 
A Resource Basis of Estimate is defined for a specific resource assigned to a WBS 
element.  

To define a Resource BOE: 

1. Select the resource and do one of the following: 

BOE symbol 

 Click the Resource BOE button  in the Toolbar. 
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 Open the Tools menu and choose Resource Basis of Estimate. 
 MPM displays the Resource BOE dialog box shown in Figure A. 

2. Enter the description. 
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7.10  Summary Basis of Estimate 
You can define a Summary Basis of Estimate for any level of the WBS. For a general 
explanation of estimates, see topic 7.9  Basis of Estimates. 

Procedure 
To define a Summary BOE: 

1. Select a WBS element, open the Tools menu, and choose Summary Basis of 
Estimate. 

 MPM displays the Summary Basis of Estimate dialog box shown in Figure A. 

 
Figure A. You can define a BOE for WBS elements. 

2. Select the department(s) to be covered by the BOE. 

 Leaving the Department field blank selects all departments. Selecting <Empty> 
from the list, selects all estimates which do not have a Resource Department 
assigned. You can also use a wildcard character (asterisk *) to select departments 
that start with certain characters. For example, 10* would select all estimates for 
departments 101, 102 and 1001, etc. 
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3. Select the EOCs (elements of cost) to be covered by the BOE. 

 Leaving the EOC field blank will include estimates for all EOCs and the selected 
departments. 

4. Click on the Add/Edit button.  

 If a Summary BOE already exists for the Department/EOC combination entered, 
it will be displayed. The Estimates Included section will fill in with all estimates 
which will be covered by the Summary Basis of Estimate being entered. 

5. Enter the basis of estimate in the text field. 

6. To accept the description, click OK. 
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7.11  Baseline Calculations and Formulas 

EQP Calculation 
Equivalent persons (EQP) is calculated based on the calendar selected when a project is 
first defined in the Project Maintenance window. 

Calendar Calculation based on: 
Resource Work Hours, converted from the Hours/Day and 

Days/Week field identified in the Resources 
window. 

Equivalent 
Person Months 

Equivalent Person Month hours entered in the 
fiscal calendar 
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EQP Formulas 
MPM uses the following formulas when calculating equivalent persons. 

Calculation Equation 
Standard Hours Hours x (Efficiency / 100) / (1 + Scrap & Rework / 100) 
Hours Standard hours x (1 + Scrap & Rework / 100) / (Efficiency / 100) 
Person Months for 
reporting purposes 
only 

Person hours / Equivalent person month hours entered in the Fiscal 
Calendar 

Person Months for 
estimating purposes 
only 

Hours / Hours per day / Days per week / (52 / 12) 

Equivalent Persons 
if Resource Work 
Calendar was 
selected in Project 
Maintenance.  

Hours in estimate / (resource hours per day x number of work days in 
estimate) 

Equivalent Persons 
if Equivalent Person 
Month Hours 
Calendar was 
selected in Project 
Maintenance. 

Hours in estimate / ((calendar days in estimate / calendar days in 
month) x equivalent person month hours entered in the fiscal 
calendar) 

 

For reporting, the Person Months are always calculated using the number of calendar 
hours entered in the Equivalent Person Month Hours field of the Fiscal calendar. If all 
months in the calendar are zero, Person Months are not shown on the reports. 

For reporting, the Equivalent Persons calculation always reflects the project’s Calendar 
designation (Resource Work or EQPM Hours) which was saved at the time resources 
were estimated. It is not recalculated at report run time. If the designation of Resource 
Work or EQPM Hours was changed in the Project Maintenance window after estimating, 
the change is not reflected on the report unless the estimate itself is changed or the project 
is repriced.  
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7.12  Previewing and Printing Baseline Estimates 
At any time, you can preview and print the baseline estimates. The basic report includes 
all currently displayed rows and columns. You have the option of adding task 
descriptions, Resource BOEs, and timephased values. You may also choose to include 
timephased values and specify From and Through dates. 

Previewing Estimates 
To preview the baseline estimates onscreen: 

1. Do one of the following: 

 Choose the Print Preview button  in the Toolbar. 

 From the File menu, choose Print Preview. 
 MPM displays the Print Preview dialog box shown in Figure A. 

 
Figure A. Select the information 
you want included. 

2. Select the information you want included in the report. 

3. To display the report, click OK. 
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Printing Estimates 
To print a baseline estimate: 

1. Do one of the following: 

 Choose the Print button  in the Toolbar. 

 From the File menu, choose Print. 
 MPM displays the Print dialog box shown in Figure B. 

 
Figure B. Select the information 
you want included. 

2. Select the information you want included in the report. 

3. To print the report, click OK. 

 MPM displays the standard Windows print dialog box shown in Figure C. 

 
Figure C. Select the print options. 

4. Select the appropriate options and click OK. 
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7.13  Recommended Baseline Reports 
There are several standard MPM reports that you can use to review baseline information. 
The reports are listed below. For information on the reports, see the MPM Standard 
Reports manual. 

 Resource Detail 
 Resource Summary 
 Element of Cost 
 Manpower Detail 
 Manpower Summary 
 WBS Recap by Element of Cost 
 EOC/Class Detail 
 Responsibility Assignment Matrix 
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8.1  Introduction to Forecasting 
After you have completed the baseline estimate, you can create a revised version of the 
baseline using the Estimate to Complete (ETC) view in the Integrated Planning window. 
Changes you make to the ETC do not change the baseline estimate, making it possible to 
compare current estimates to the original baseline estimates. 

The original monthly baseline estimate data is automatically maintained by MPM to 
provide performance measurement of the baseline plan. Baseline and ETC dates are 
displayed in various Gantt and Time Analysis reports. 

When you have created the ETC, MPM can use it to: 

 Generate Estimate to Completion reports 
 Generate Latest Revised Estimate (LRE) reports 
 Graph LRE data in Graphic Drill Down (GDD) 
 Calculate Estimate at Completion (EAC) reports 

Baseline and ETC Relationship 
There are two ways to create the ETC: 

 Save the resources estimates to the ETC as you create the Baseline. This 
approach is described in this chapter. 

 Copy the Baseline estimates to the ETC using the Project Replan function (see 
Chapter 12: Replanning Projects) 

Accessing the ETC View 
To access the ETC view: 

1. From the Menu Manager window, do one of the following: 

 Select the Integrated Planning icon. 
 From the File menu, select Projects|Integrated Planning. 

 MPM displays the Integrated Planning Open dialog box shown in Figure A. 

2. Select the WBS elements you want downloaded. 

3. Select ETC as the starting view. 

For details on opening the ETC view, see Chapter 6: Integrated Planning – An Overview. 
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Figure A. To open the ETC view, select Integrated Planning from the 
Menu Manager. 
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8.2  Orientation to the ETC View 
The ETC view is identical to the Baseline view. The Resource Sheet and Values Sheet 
have the same fields. However, changes you make to one view are not reflected in the 
other view. For example, you can hide different columns and change column widths in 
each view. For information about the view, see topic 7.2 Orientation to the Baseline 
View. 

 
Figure A. The ETC view is divided into two panes: the Resource Sheet and the 
Values Sheet. 

Resource Sheet 

Estimate Type 

Values Sheet 

Window Separator Bar 

Total 
Values 
Row 
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Editing Data 
As the work progresses in a project, you can edit the data in the ETC view without 
affecting the original baseline data. However, if you change the data in the ETC view, the 
data for the edited cells are no longer linked to the baseline data. If you subsequently 
make changes in the baseline data, the changes will not be reflected in the ETC view. 
You can also add estimates directly in the ETC view that are not included in the baseline. 

You use the same procedures to edit the data in the ETC view that you use for the 
Baseline view. For information on editing data, see Chapter 7: Estimating the Project 
Baseline. 
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8.3  Creating an ETC as You Create the Baseline 
The easiest way to create an Estimate to Complete (ETC) is to have MPM enter the ETC 
data at the same time you enter the baseline data. To do this, you select one of three 
appropriate storage options shown in Figure A. 

 
Figure A. To create the ETC at the 
same time as the baseline, select the 
second or third option. 

Three Options 
There are three Integrated Planning storage options available: 

Option Result 
Save Baseline only MPM saves the baseline data only. 
Save Baseline and ETC MPM saves the baseline data and saves the 

corresponding changes in the ETC data. 
Prompt for ETC save MPM saves the baseline data and displays the dialog box 

below asking if you want to save the corresponding 
changes in the ETC data. 
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To create the ETC data at the same time as the baseline data, you can select the Save 
Baseline and ETC or the Prompt for ETC Save option. 

Procedure 
To set the storage option: 

1. From any MPM window, open the Tools menu and select Options. 

 MPM displays the Options dialog box shown in Figure A. 

2. Select the Integrated Planning Tab. 

3. Select the appropriate option. 

Other Procedures Identical to Baseline 
The procedures for adding, editing, and deleting information in the ETC window are 
identical to the procedures for the Baseline window. This includes: 

 Adding resource estimates 
 Entering estimate values using autospread 
 Entering information using autofill 
 Copying and pasting estimates 
 Copying and pasting cells 
 Deleting estimates and cells 
 Creating apportioned estimates 
 Previewing and printing estimates 

For information on these procedures, see Chapter 7: Estimating the Project Baseline. 
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8.4  Recommended ETC Reports 
There are several standard MPM reports that you can use to review ETC information. 
The reports are listed below. For information on the reports, see the MPM Standard 
Reports manual. 

 Actuals by EOC 
 Actuals by Charge Number 
 Resource Detail - Actuals 
 Resource Summary - Actuals 
 Budget/Actuals Recap by EOC 
 Element of Cost - LRE 
 Resource Detail - Budget/LRE 
 Project Comparison - LRE 
 Resource Detail - ETC 
 Resource Summary - ETC 
 Element of Cost - ETC 
 EOC/Class Detail - ETC 
 Burden and Fee Detail - ETC 
 Burden and Fee Summary - ETC 
 Work Status Document - Bud/LRE 
 Apport’d Est Relationships - ETC 
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9.1  Introduction to Tracking Project Milestones 
The Integrated Planning Milestones window provides activity work-in-progress 
assessment capability. Milestones for each WBS element are represented graphically in a 
Gantt chart. You can status the milestones and review the resulting changes in the 
updated fields. 

Each milestone is assigned a unique identifier, making it possible to export and import 
data keyed to specific milestones. 

 
Figure A. Milestones let you track a project. 
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Accessing the Milestones View 
To access the Milestones View: 

1. From the Menu Manager window, do one of the following: 

 Select the Integrated Planning icon. 
 Open the File menu and select Projects|Integrated Planning. 

 MPM displays the Integrated Planning Open dialog box shown in Figure B. 

2. Select the WBS elements you want downloaded. 

3. Select Milestones as the starting view. 

For details on opening the Baseline view, see Chapter 6: Integrated Planning – An 
Overview. 

 
Figure B. To open a Milestone view, select Integrated Planning from the 
Menu Manager. 
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9.2  Orientation to the Milestones View 
The Milestone view is divided into two windows: a Milestone sheet and a Gantt chart. 
You use the Milestone sheet to enter milestones. You can use the Gantt chart to review 
and adjust the scheduled dates. 

 
Figure A. The Milestones view is divided into a Milestones Sheet and a Gantt chart. 

Milestone Sheet 
The Milestone sheet displays the WBS elements and their milestones. The columns 
display information including, but not limited to, a description, the Earned Value Method 
(EVM), scheduled and forecast completion dates, and percent complete. You can scroll 
the window to bring columns into the viewing area. You can customize the window by 
displaying or hiding the columns. 

Gantt Chart 
The Gantt chart displays milestone information graphically, including: 

Milestone Sheet Gantt Chart Window Separator Bar

 WBS start and complete 
 Last statused date 
 Baseline Gantt: WBS Start and Complete 
 ETC Gantt: ETC Start and Complete 
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 Milestone 
 Completed milestone 
 Revised milestone 
 Current system date 

 
Figure B. Gantt chart of milestones 

WBS Total Window 
The WBS Total window shown in Figure A gives you a summary of the WBS element 
under which you are adding milestones. The window floats above the Milestones window 
so it is always visible. You display the window by clicking the Total button  in the 
Toolbar. You can move the window by dragging the Title bar. 

WBS start and complete

Last date statused 

ETC start and complete 

Current system date 

Completed milestone 

Revised milestone 

Milestone 

Timephased BCWS Window 

 
Figure C. 

The Timephased BCWS Window shows the timephased information 
for the currently selected WBS element. Like the Total window, the 
Timephased BCWS window floats above the Milestones window. 
You can resize the window by dragging the sides and corners, and 
move the window by dragging the Title bar. You display the window 
by clicking the Show Timephased BCWS button  in the Toolbar. 
An example of the window is shown in Figure C. 
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9.3  Creating Milestones 
You create milestones by selecting a WBS element and inserting milestone rows. Each 
milestone must be assigned a unique milestone ID. 

 
Figure A. Each milestone must be assigned a unique milestone ID. 

The basic steps for creating a milestone are described in this topic. More detailed 
information on specific steps is provided in the topics that follow in this chapter. 

Key Steps 
The key steps to create a milestone are: 

1. From the EVM field drop-down list box, choose an Earned Value Method 
(EVM) for the WBS element that will contain the milestone. 

2. If using Apportioned Weights, select the base WBS before selecting an EVM. 

3. Select a BCWP Base from the drop-down list box. 

4. Insert the milestone, enter the milestone ID, and add a description. 

5. Enter the scheduled date and choose a Gantt chart symbol to represent the date. 

6. Enter weights for the milestone if applicable. 

7. Save the milestones by doing one of the following: 

 Click on another WBS element in the window. 
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 Click on the Save button  in the Toolbar. 
 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save. To undo the entry before saving, 
press Esc. 

Preparing the Display to Create Milestones 
You need only a handful of required fields for creating a milestone, even though you can 
display most of the WBS fields. To simplify data entry, use the Column Hide feature to 
display only the following columns: 

 WBS ID  Schedule Date 
 Milestone ID  Weight 
 Description  Symbol 
 EVM  Base WBS 
 BCWP Unit 

 
 

When you are done, the Milestones sheet should look like Figure B. Note no milestones 
have been added yet. 

 
Figure B. To prepare the window for entering milestones, display the columns 
shown. 
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9.3  Creating Milestones  
9.3.1  Choosing an Earned Value Method 

The Earned Value Method (EVM) you specify is used by MPM to calculate the Budgeted 
Cost of Work Performed (BCWP) for each milestone. You can select a different EVM for 
each WBS element, but the EVM you choose for a WBS element applies to all milestones 
assigned to that element. 

When you first select an EVM for a WBS element, MPM automatically adds Start and 
Complete milestones to the element. In Figure A, this is illustrated by WBS ID 4.X.1. For 
a complete description of all EVMs available, see topic 9.3.2 Earned Value Method 
Descriptions. 

 
Figure A. When you first select an EVM for a WBS element, MPM automatically 
adds Start and Complete milestones to the element. 

The EVM you select is displayed in the WBS element rows, not in the milestone rows. 

If possible, you should consider using the Milestone Weights EVM. With this method, 
you can target specific accomplishments in the project, and get compensated accordingly. 
It also gives you the most accurate way to track a project. 
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Procedure 
To choose an EVM for a WBS element: 

1. Click on the EVM field for the WBS element. 

2. Open the drop-down list box and select an EVM. 

 When you select the EVM, MPM automatically adds Start and Complete 
milestones to the element as shown in Figure A. 

3. If you selected the Apportioned EVM, you must select a base WBS that MPM 
will use to determine the percent complete for the milestone. You select the WBS 
from the Base WBS field. MPM displays the Base WBS dialog box shown in 
Figure B where you can select the WBS element to be used.  

 
Figure B. If you select the Apportioned 
EVM, you must choose a base WBS. 
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9.3  Creating Milestones  
9.3.2  Earned Value Method Descriptions 

This topic describes each of the Earned Value Methods (EVMs) available in MPM. You 
must specify an EVM if you want MPM to calculate Budgeted Cost of Work Performed 
(BCWP). 

No EVM Required 
No earned value computation is required. Use this option only when you want to display 
milestones on the Gantt chart but EVM does not apply to the WBS element. When you 
select this EVM, the BCWP Base defaults to Total Dollars and cannot be changed 
without first changing the EVM. 

% Start / % Complete 
There are four different % Start / % Complete EVMs available. They are usually applied 
to work packages with a duration of not more than two accounting months. The methods 
earn the specified start percentage when the activity begins, and the specified complete 
percentage when the activity is completed. The four methods are: 

 0/100 (This EVM is used for work packages planned to start and complete in 
one accounting month.  When you select EVM 0/100, the BCWP Base defaults 
to Total Dollars and cannot be changed unless you first select a different EVM.) 

 25/75 
 40/60 
 50/50 

% Complete 
Lets you manually enter a cumulative percentage for the WBS element. Budget value is 
earned based on the percent complete as determined by you. The percent complete is 
applied to the Budget at Complete (BAC) to determine BCWP. 

Level of Effort (LOE) 
Monthly budget value is earned with the passage of time and is equal to the monthly 
scheduled amount (BCWP=BCWS). This method usually is used for accounts that are 
more time related than task oriented. Usually there is no measurable output related to 
these accounts. When you select this EVM, the BCWP Base defaults to Total Dollars and 
cannot be changed without first changing the EVM. 
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Earned Standards 
Earned standards (standard cumulative hours complete) is used to determine earned value 
for tasks whose budget value was derived using standard hours. To use this method, you 
must establish standards for all tasks using historical data, time and motion studies, and 
other statistical information. This method is used often for high-volume production 
environments. 

Before you select Earned Standards as the EVM, you must first select Standard Hours as 
the Estimate Type when estimating the WBS baseline. When you select Earned 
Standards, MPM sets the BCWP Base field to Hours. You cannot change this setting 
without first changing the EVM. 

Milestone Weights 
Budget value is earned based on the proportional weight you assign to each milestone. 
The BCWP calculation used with this method is BAC (Milestone weight/Total Milestone 
weights). For information on assigning weights, see topic 9.4  Entering Weights. 

BCWP Entry 
Select this option when you will be entering BCWP (Budgeted Cost of Work Performed) 
as a cumulative lump sum. When you status the WBS element, you enter cumulative 
BCWP in whatever base you selected. MPM calculates the percent complete by dividing 
the cumulative BCWP by the BAC (Budget at Completion). 

Apportioned 
The Apportioned EVM is used to calculate earned value for tasks that are related in direct 
proportion to some other work package. Apportioned Effort is also referred to as Factored 
Effort and Factored Method. 

When you select this EVM, you must also select a Base WBS that will be used to 
determine the percent complete for the WBS element. Percent complete for an 
apportioned effort task is always equal to the percent complete of its Base WBS. 
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Milestone Weights with % Complete 
This EVM is the same as Milestone Weights except you can enter a percent complete for 
each individual milestone instead of just the WBS element. You can also have MPM 
calculate the weights by using the Autoweight option under the Tools menu. 

Key Event 
The Key Event EVM is a variation on Level of Effort (LOE). A work package earns 
budget as long as milestones are completed on time. Additional value is earned when 
milestones are completed ahead of schedule.  When you select EVM Key Event, the 
BCWP Base defaults to Total Dollars and cannot be changed unless you first select a 
different EVM.) 

When you use the Key Event EVM: 

 The work package must have at least one milestone in order to earn BCWP. 
 If a month has more than one milestone, all milestones must be completed to 

earn BCWP. 
 No BCWP is earned for any months between two incomplete milestones. 
 Milestones do not have to be completed in chronological order to acquire earned 

value.  
For example, you might have a work package that begins January 1 and ends May 
31, with milestones in February, April, and May. You could earn value for the April 
milestone by completing it in March, even though you didn’t complete the February 
milestone. If this happened, earned value would be LOE for January and March, 
plus BCWP for April. 
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9.3  Creating Milestones  
9.3.3  Selecting a BCWP Base 

After selecting an EVM for the WBS element, you must select a BCWP Base. The 
BCWP Base shows which unit MPM will use to calculate the BCWP for a WBS element. 
The BCWP Base unit should match the Estimate Type in the Integrated Planning 
Baseline window. You can choose from five base units:  

 Hours/Units 
 Prime Dollars 
 Total Burdened (Prime + Overhead) 
 Total Cost (Total Burdened + G&A) 
 Total Dollars (Total Cost + COM) 

 
Total Dollars is the default value. 

 
Figure A. Select a BCWP Base. 

Procedure 
To select the BCWP Base: 

1. Click the BCWP field to display the drop-down list box shown in Figure A. 

2. Select a BCWP Base from the list. 
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9.3  Creating Milestones  
9.3.4  Inserting a Milestone 

When you first select an EVM for a WBS element, MPM automatically adds Start and 
Complete milestones below the WBS. You can accept these milestones, change their 
names, or delete them. You can add additional milestones by selecting the WBS and 
pressing the Insert key. 

 
Figure A. You add milestones to each WBS element. 

MPM lists milestones by their scheduled completion date. You can sort them by other 
fields if you wish. 

Procedure 
To insert a new milestone: 

1. Select a WBS element and do one of the following: 

 Press the Insert key. 
 From the Edit menu, choose Insert Milestone(s). 
 Type a milestone ID number in the WBS Milestone ID field and press Enter. 

 MPM inserts a new line at the end of the list of milestones for the WBS element 
with the following information: a Milestone ID, the WBS’s Baseline start date in 
the Schedule Date field, and the default Gantt chart symbol in the Symbol field. 

2. If you wish, you can change the milestone ID number by typing over the old 
number. 
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 MPM sorts the milestones chronologically by their Schedule Date, not by the 
milestone ID number. 

3. Enter a description (maximum of 40 characters) in the Description field. 

4. Enter a Schedule Date. 

5. Select a Gantt chart symbol. 

6. To save the milestone, do one of the following: 

 Click on another WBS element in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save. 

 To undo the entry before saving, press Esc. 
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9.4  Entering Weights 
Budget value is earned based on the weight designated for each milestone. The weight is 
a proportion of the total work for all milestones assigned to a WBS element. Milestone 
weights are expressed in the base unit you have selected for the WBS element. The unit 
should match the Estimate Type for your Baseline. For example, if the Budgeted Cost of 
Work Performed (BCWP) is Total Cost, you would specify the milestone weights as 
Total Cost. Equivalent units, Budgeted Cost of Work Scheduled (BCWS) hours or 
dollars, or any other values may be entered in the weight field. 

 
Figure A. The weight assigned to a milestone is a proportion of the total 
work for all milestones assigned to a WBS element. 

Milestone weights must represent 100% of the work required to complete a task, but they 
do not have to equal 100. 

How Weights are Handled 
How MPM handles weights depends on the Earned Value Method (EVM) you selected 
for the WBS element.  

 If you selected Milestone Weights or Milestone Weights with % Complete for 
the EVM, you can enter custom weights for each milestone.  
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 If you selected one of the % Start / % Complete EVMs, MPM automatically fills 
in the matching percentages for the Start and Complete milestones. You cannot 
edit these percentages. You can add other milestones to the WBS element, 
however, you will not be able to enter weights for them. 

 If you selected any of the other EVMs, the Weight field is left blank. 

Manual vs. Automatic Weighting 
If you selected Milestone Weights or Milestone Weights with % Complete for the EVM, 
you can enter custom weights for each milestone manually. You also have the option of 
using the Autoweight Milestones function to have MPM automatically calculate weights. 

The Autoweight Milestones function calculates weights using the timephased budget 
(BCWS) and the BCWP Base Unit defined for a WBS element. If weights are already 
entered for a milestone, the calculated weights overwrite the existing weights. 

Manual and automatic weighting are discussed in the following topics: 

9.4.1  Entering Weights Manually 
9.4.2  Entering Weights Automatically 
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9.4  Entering Weights 
9.4.1  Entering Weights Manually 

If you selected Milestone Weights or Milestone Weights with % Complete for the EVM, 
you can enter custom weights for each milestone manually. Milestone weights must 
represent 100% of the work required to complete a task, but they do not have to equal 
100. 

 
Figure A. The Timephased BCWS and Total windows provide useful information 
when you are entering milestone weights. 
 

MPM provides two additional windows that provide summary information about the 
WBS element and the weighted values. 

Timephased BCWS Window 
The Timephased BCWS (Budgeted Cost of Work Scheduled) window shows the 
weighted costs by month. The display is not impacted by the period selected for the Gantt 
chart. To display the window, click the Show Timephased BCWS button  in the 
Toolbar. 
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WBS Total Window 
The WBS Total window shows summary information for the selected WBS element. To 
display the window, click the Show Total Window button  in the Toolbar. 

Procedure 
To enter weights manually: 

1. Select the Weight field for a milestone. 

2. Type in a value. 

3. Save the entry by doing one of the following: 

 Click on another WBS element in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save. 

 To undo the entry before saving, press Esc. 
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9.4  Entering Weights 
9.4.2  Entering Weights Automatically 

If you selected Milestone Weights or Milestone Weights with % Complete for the EVM, 
you have the option of using the Autoweight Milestones function. The function 
automatically calculates weights for a WBS. After MPM calculates the weights, you can 
modify them manually. You can autoweight one or more WBS elements at the same time. 

The Autoweight Milestones function calculates weights using the timephased budget 
(BCWS) and the BCWP Base Unit defined for a WBS element. If weights are already 
entered for a milestone, the calculated weights overwrite the existing weights. 

 
Figure A. You can autoweight milestones. 

Autoweight Options 
When you autoweight the milestones for a WBS, you have two options. 

 Milestone Weights Applied to a Fraction of a Month 
Budgeted Cost of Work Scheduled (BCWS) in the Budgeted Cost of Work 
Performed (BCWP) base unit is applied proportionately to each milestone 
occurring in the month. Workdays between milestones are factored against 
available workdays in the month. 
For example, assume there are two milestones for a WBS element: one on the 5th 
workday of the month, and one on the 20th workday of the month. The WBS 
element requires 100 hours of work. If there are 20 work days in the month, the 
first milestone would be assigned 25% ( 5 workdays = ¼ of total workdays = 
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25%) of the hours and the second milestone would be assigned 75% of the 
hours. 

 Milestone Weights Applied to a Whole Month 
Budgeted Cost of Work Scheduled (BCWS) in the Budgeted Cost of Work 
Performed (BCWP) base unit is applied equally among all milestones occurring 
in the month. BCWS is applied to the next month’s milestones if there are no 
milestones in the month. 
Using the same example above, assume there are two milestones for a WBS 
element: one on the 5th workday of the month, and one on the 20th workday of 
the month. The WBS element requires 100 hours of work. If there are 20 
workdays in the month, the first and second milestones would each be assigned 
50% of the hours. 

Procedure 
To autoweight milestones for a WBS element: 

1. Select a WBS element. 

 You can select more than one WBS element if you wish. If you edit one WBS 
element at a time, you have the opportunity to edit the assigned autoweights 
before they are saved. If you edit two or more WBSs at the same time, the 
autoweights assigned are saved automatically. 

2. From the Tools menu, select Autoweight. 

 MPM displays the Autoweight dialog box shown in Figure A. 

3. Select one of the two options and click OK. 

 If you applied the autoweight function to only one WBS, MPM leaves the WBS 
milestones in edit mode. You can save, change, or press Esc to cancel the weights 
assigned.  
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9.5  Statusing Milestones 
As a project progresses and milestones are met, you status the project in MPM to 
generate a percent that represents the work that has been completed. You will usually 
status a project at the end of a fiscal period. The method you use to status the project 
depends on the earned value method you selected for each WBS element. If work has not 
started on a WBS element, making a change is straight forward. If a WBS element is 
already in progress (has BCWP), making changes can impact the BCWP. Changing 
elements in progress is described in topic 9.6 Modifying Milestone Information for Work 
in Progress. 

Preparing the Display for Statusing Milestones 
There are only a handful of fields required for statusing milestones, even though you can 
display most of the WBS fields. To simplify data entry, use the Column Hide command 
under the Format menu to display only the following columns: 

 WBS ID  Weight 
 Milestone ID  Complete 
 Description  % Complete 
 Schedule Date  Cum BCWP 
 Forecast Date 

 
 

It is useful to keep the Total Window displayed for reference. When you are done, the 
Milestones sheet should look like Figure A. 
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Figure A. When you status milestones, you should display the columns shown 
above and the Total window. 

Key Steps 
The key steps in statusing a milestone are: 

 Specify the As Of Month. 
 Revise the forecast date (if needed). 
 Status the milestone. 
 Calculate the Budgeted Cost of Work Performed (BCWP). 

The first three topics are described in the sub-topics that follow. Calculating the Budgeted 
Cost of Work Performed (BCWP) is covered in topic 11.6 Calculating BCWP. 
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9.5  Statusing Milestones 
9.5.1  Specifying the As Of Month 

When you status a WBS element, you select a month to which the status information will 
be assigned using the As Of Month dialog box shown in Figure A. 

 
Figure A. Set the As Of Month before statusing a milestone. 

Setting the As Of Month accomplishes three things: 

Last statused 
date 

 It accumulates the BCWP amount for statused activity in the As Of fiscal 
accounting month for all EVMs except LOE, Key Event, and Apportioned. 

 It documents the last time the WBS element was statused. 
 It places a “tick” mark on the Gantt chart display and the Milestone Barchart 

report indicating the last statused date. 

Procedure 
To set the As Of Month: 

1. Display the As Of Month dialog box by choosing the As Of Month option from 
the View menu or by pressing Ctrl+M.  MPM displays the dialog box shown in 
Figure A above. 

2. Use the up and down arrows to select a month. 
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3. To accept the setting and close the dialog box, click the X in the top right-hand 
corner of the box. 

 
As Of Month Required 
If a WBS element has task work in progress (has existing BCWP for the current or prior 
periods), you must set the As Of Month before doing any of the following: 

 Claiming a milestone as complete by putting a check mark in the Complete field 
 Entering a new figure in the % Complete field 
 Entering a new figure in the Cum BCWP field 
 Inserting or deleting a milestone 
 Changing the weight on a milestone 

 
If you try to do any of the above without first setting the As Of Month, MPM displays the 
As Of Month dialog box shown in Figure B requiring you to select a month. 

 
Figure B. You must set the As Of Month 
before performing a statusing action. 
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9.5  Statusing Milestones 
9.5.2  Revising the Forecast Date 

If the project slips, you will need to reflect the slip in schedule by entering a date in the 
Forecast Date field. The Forecast Date defaults to the Schedule date until it is modified. 
When the milestone is 100% complete, you can enter the completion date in this field. 

When you revise a forecast date, the original planned date is displayed in the Gantt chart 
as a diamond. The original milestone symbol (a triangle by default) will be used for the 
revised forecast date. 

 
Figure A. If the project slips, you can change the Forecast Date. 

Forecast DateSchedule Date
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Procedure 
There are two ways to revise a Forecast Date: 

 Select the Forecast Date field and type in a new date. MPM accepts most 
formats and converts them to the dd-mmm-yy format. 

 Choose the milestone symbol in the Gantt View and drag the symbol to the new 
date. MPM changes the Schedule Date to a diamond and displays the Forecast 
date as the selected milestone symbol. 

When a Milestone is 100% Complete 
When a milestone is 100% complete, you should enter the actual completion date in the 
Forecast field if it is different from the schedule date. This will create a more accurate 
Earned Value Planning and Analysis report. 
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9.5  Statusing Milestones 
9.5.3  Statusing the Milestone 

After selecting the As Of Month, and entering a revised Forecast Date if necessary, you 
can status the milestone by doing one of the following: 

 Mark the milestone as complete by double-clicking in the Complete field. MPM 
will place a check mark in the field as shown in Figure A. 

 
Figure A. Statusing a milestone 

 If the EVM you selected requires cumulative BCWP, enter cumulative BCWP 
amounts in the Cum BCWP field on the WBS element row. 

 If the EVM you selected requires the percent complete, enter cumulative percent 
complete in the % Complete field on the WBS element row. 

Which action you take depends on the EVM you selected for the WBS element. The 
actions required for each type of EVM are described below. 

After you have statused all WBS elements that are in process, run the Calculate BCWP 
process to calculate and determine BCWP values for the period being statused. For 
information on calculating BCWP, see topic 11.6 Calculating BCWP. 

No EVM 
This selection does not compute BCWP. Use this option when you want the WBS 
element displayed on the Gantt chart, but the element does not represent budget 
information. If you want the milestone symbol on the Gantt chart to be shaded, check the 
Complete field. For example, you may be in the proposal stage and no work has been 
completed for a WBS element. Or you may be using a Planning Package resource to store 
unallocated budget and you do not want it to show on the Gantt chart. 
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0/100, 25/75, 40/60, 50/50 
To status a milestone when one of these EVMs has been selected: 

1. When work has started on the milestone, enter a check in the Complete column 
for the Start milestone. 

 MPM will use the first figure to represent the amount of the scheduled budget 
earned. For example, if you selected 25/75, 25% of the budget will be counted as 
earned. 

2. When work is 100% complete, enter a check in the Complete column for the 
complete milestone. 

 MPM will use the second figure to represent the amount of the scheduled budget 
earned. For example, if you selected 25/75, 75% of the budget will be counted as 
earned. 

% Complete 
In the % Complete field of the WBS row, enter the cumulative percent complete for the 
overall WBS element for the As Of Month being statused. The cumulative percent 
complete reflects the status of the WBS through the As Of Month. 

Level of Effort 
You do not have to enter data for this EVM. MPM will automatically calculate the earned 
value for the fiscal periods where work (BCWS) is scheduled. BCWP = BCWS for all 
months for which BCWP is calculated. If you want the milestone symbol on the Gantt 
chart to be shaded, check the Complete field. 

Earned Standards 
In the Cum BCWP field on the WBS row, enter the cumulative standard hours completed 
for the overall WBS. 

MPM uses the figures you enter in the Cum BCWP field to calculate the cumulative 
percent complete. The formula is:  

BCWP standard hours / BAC standard hours 
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MPM applies the cumulative percent complete to BAC and the cumulative BCWP is 
displayed and stored in Standard Hours for the As Of Month. The Estimate Type for 
BCWS must also be set to Standard Hours so the BAC is in standard hours. If these are 
not the same, BCWP will not calculate accurately. 

Milestone Weights 
To claim a milestone as 100% complete for the As Of Date being statused, place a check 
mark in the Complete field. 

When milestone weights are used, MPM uses the following formula to calculate a 
cumulative percent for the WBS: 

(Weight of completed milestones / total weight for all milestones) x 
BAC (in base unit selected) 

The calculation is for the month in which the milestone is statused as complete. As 
milestones are accomplished, the WBS cumulative percent complete is adjusted based on 
the milestone weight ratios. 

BCWP Entry 
In the Cum BCWP field on the WBS row, enter the cumulative BCWP value for the 
overall WBS task in the base unit selected. The value you enter is stored in the As Of 
Month. MPM calculates percent based on the Cum BCWP you enter divided by BAC in 
the base unit set in the Estimate Type field of the Baseline window in Integrated 
Planning. 

Milestone Weights with % Complete 
If the milestone is 100% complete for the As Of period being statused, place a check 
mark in the Complete field to claim the milestone. 

If the milestone is not 100% complete, enter the percent complete in the % Complete 
field and revise the forecast date to the planned completion date. 

MPM calculates the BCWP in the same way it calculates Milestone Weights, except it 
adds percent complete of all completed milestones plus percentage weight of all partially 
earned milestones before dividing by total weight. 
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Key Event 
Place a check mark in the Complete field to claim a milestone as complete. 

This EVM allows a work package to earn LOE (Level of Effort) value for all months up 
to the first month with an incomplete milestone. This includes, but does not go beyond, 
the current month. In addition, value is earned for any future months in which all 
milestones are completed. 

The basic criteria for this EVM are: 

 The work package must have at least one milestone in order to earn BCWP. 
 If a month has more than one milestone, all milestones must be completed to 

earn BCWP. 
 No BCWP is earned for any months between two incomplete milestones. 
 Milestones do not have to be completed in chronological order to acquire earned 

value. For example, you might have a work package that begins January 1 and 
ends May 31, with a milestone in February, April, and May. You could earn 
value for the April milestone by completing it in March, even though you didn’t 
complete the February milestone. If this happened, earned value would be LOE 
for January and March, plus BCWP for April. 

When MPM calculates BCWP, it stores the value in the month entered by you in the 
Compute BCWP Through Which Month field. This differs from other EVM calculations 
where the value is stored in the As Of Month. 

Apportioned 
You do not have to enter data for this EVM. 

MPM first calculates BCWP for all WBS IDs except apportioned effort. After completing 
those calculations, MPM calculates BCWP for all apportioned effort WBS elements. 

MPM calculates BCWP by copying the cumulative earned value percent complete from 
the Base WBS, applying it to the apportioned WBS, and then calculating the dollar value 
of BCWP based on the Apportioned WBS’s base unit divided by BAC. 

Calculating BCWP 
After you have statused all WBS elements that are in process, run the Calculate BCWP 
process to calculate and determine BCWP values for the period being statused. For 
information on calculating BCWP, see topic 11.6 Calculating BCWP. 
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9.6  Modifying Milestone Information for Work in 
Progress 

You may find you need to make changes to a milestone after the work has begun on the 
WBS element. For example, you may have to add a WBS element, change the scope of 
work, change the EVM specified, or correct an error. 

When you change a WBS element with work in progress, you must use caution because 
the change may impact the earned value results for the WBS element’s Budgeted Cost of 
Work Performed (BCWP). Changes that can impact the earned value include: 

 Changing the EVM 
 Changing the BCWP Base Unit 
 Changing a milestone weight 
 Inserting a new milestone 
 Deleting a milestone 

If a change will impact the earned value of a WBS element, MPM displays the Integrated 
Planning message shown in Figure A. 

 
Figure A. If a change will impact the earned value of a WBS 
element, MPM displays the Integrated Planning dialog box. 

Sub-Topics 
The following sub-topics describe the changes that you can make: 

9.6.1  Changing an Earned Value Method (EVM) 
9.6.2  Changing the BCWP Base 
9.6.3  Changing a Milestone Weight 
9.6.4  Modifying an Element’s Prior Status 
9.6.5  Changing an Element’s Budget at Completion (BAC) 
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9.6  Modifying Milestone Information for Work in Progress 
9.6.1  Changing an Earned Value Method 

If you change the EVM of a work package that is in progress and already has earned 
value (BCWP), MPM will use the new earned value method and modify the milestones if 
required. 

For example, if the EVM is Milestone Weights and you switch the EVM to Milestone 
Weights with % Complete, the milestones will remain unchanged. But if you change 
EVM Milestone Weights to EVM 0/100, MPM will remove the existing milestones and 
replace them with only Start and Complete milestones. 

When milestones are changed, we recommend restatusing all milestones for prior months 
and recalculating BCWP so that the proper earned value is earned based on the new 
EVM. 
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9.6  Modifying Milestone Information for Work in Progress 
9.6.2  Changing the BCWP Base 

For all Earned Value Methods (EVMs) except BCWP Entry, if you change the BCWP 
Base Unit and recalculate BCWP, the recalculated BCWP will reflect the new base unit. 
If you change the BCWP Base Unit, we recommend you recalculate the weights for the 
milestones in accordance with the new Base Unit in addition to recalculating BCWP. 

If a WBS element has an earned value method of BCWP Entry and you change the 
BCWP Base Unit, the direct entry values in the BCWP file must be recalculated to reflect 
the new BCWP Base Unit. The % Complete field must be filled in for this calculation to 
take place, which means BCWP must have been previously calculated filling the % 
Complete field with a value. 

In other words, if you have to change the base unit for a WBS element with an EVM of 
BCWP Entry, follow these steps: 

1. Be sure BCWP has been calculated for all WBS elements. 

2. Change the base unit. 

3. Recalculate BCWP. 

 MPM will recalculate BCWP in the new base unit and store the value 
accordingly. 
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9.6  Modifying Milestone Information for Work in Progress 
9.6.3  Changing a Milestone Weight 

MPM computes the percent complete for the WBS element based on the milestone 
weights entered for the following EVMs: 

 0/100, 25/75, 40/60, 50/50 
 Milestone Weights 
 Milestone Weights with % Complete 

 
You may need to adjust the milestones if: 

 You discover that weights are not correct 
 You have to add new milestones 
 You have to delete a milestone 

 
After you adjust the milestone weights, you should restatus milestones for prior months 
and recalculate BCWP to correctly reflect the new milestones in your BCWP value. See 
topic 9.6 Modifying Milestone Information for Work in Progress. 
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9.6  Modifying Milestone Information for Work in Progress 
9.6.4  Modifying an Element’s Prior Status 

You modify a WBS element’s prior status using the same procedure used to modify the 
current status. When you modify status for a WBS element using an EVM other than Key 
Event, the As Of Month must be the same as the month used for the original status. 

For Key Event EVMs, you use the BCWP Compute Through month to determine the 
month used for the original status. 

You can review prior status dates using the Earned Value Planning & Analysis Report or 
by Exporting using BCWP Status. 

Example 
For example, assume you originally statused WBS 1X in Jan97, Feb97, and Mar97 as 
follows: 

As Of Month: Jan97 
Milestone ID Complete 

101  

102  

103  

As Of Month: Feb97 
Milestone ID Complete 

101  

102  

103  
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As Of Month: Mar97 
Milestone ID Complete 

101  

102  

103  

 

Then you discover that Milestone ID 102 was not actually completed until March. Since 
March status already reflects Milestone ID 102 as complete, only the February status 
must be modified. 

To modify the status, you would: 

1. Go to WBS 1X on the Milestone sheet. 

2. Change the As Of Month date to Feb97. 

 The Milestone sheet will display the last status of all milestones. 

3. Change all milestones for WBS 1X to reflect the cum-to-date status as it should 
have been in Feb97. 

As Of Month: Feb97 
Milestone ID Complete 

101  

102  

103  

4. Save the modified status for February by selecting Save from the File menu or 
pressing Ctrl+S. 

5. Calculate BCWP for the project. 

The Milestone Complete field always contains the last status update. If you were to view 
a bar chart after making the above changes, Milestone ID 102 and Milestone ID 103 
would not be shaded (claimed) even though the WBS ID’s BCWP is 100% complete. To 
display the current status, resave the milestone status using an As Of Month of Mar97. 
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9.6  Modifying Milestone Information for Work in Progress 
9.6.5  Changing an Element’s Budget at Completion 
(BAC) 

You can directly change the BAC of a WBS element even though the element has work 
in-progress milestones that have already been claimed. However, be sure you want to 
change a WBS element’s BAC, as the change will affect the BCWP for that element. 

Because the BCWP of a WBS element is stored as a percentage of the BAC, changing a 
WBS element’s BAC value will affect the BCWP of all claimed milestones to date for 
that WBS. 

How previous BCWP values are affected depends on the EVM used. 

EVMs Except BCWP Entry, Earned Standards, and Key Event 
When you change the BAC, and BCWP is recalculated, the percent complete for each 
month remains constant but the value it represents will change. For all months that you 
compute BCWP, the BCWP values will change to reflect the stored percentages of the 
new BAC. 

EVM of BCWP Entry or Earned Standards 
Because an EVM of BCWP Entry or Earned Standards requires you to directly enter 
BCWP values, these values are saved as discreet values, not as a percentage of the total 
BAC. 

If you increase the BAC for a WBS element and recalculate the BCWP, the direct entry 
value will not be changed (providing the base unit has not changed and BAC was not 
reduced), and the percent complete for each month is recalculated based on: 

BCWP in base unit / BAC in base unit 

However, if the BAC was reduced, BCWP is recalculated to avoid the BCWP at the end 
of the project being greater than the BAC. 

This also works for Earned Value Method Standard Hours entry. Entry of Cum BCWP in 
standard hours results in a calculated percent complete, which is then applied to both 
BAC of Hours and the Cum BCWP (which is stored in Hours rather than Standard 
Hours). 



MPM Projects   255 

EVM of Key Event 
Prior month BCWP values and BCWP percent complete will not be modified if you 
change a WBS element’s BAC. Any changes to BAC will not be reflected in prior month 
calculations. 

Prior month percent complete values will always represent percent complete of BAC at 
the time that month was calculated. 

Modifying an existing estimate after statusing the WBS will impact the calculation of 
BCWP values. 
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9.7  Impact of Budget Changes on BCWP Values 
Any change you make to the budget after you status WBS elements will have an impact 
on the calculation of BCWP. 

 Cumulative BCWP Value through a Month = (Cumulative % Complete through 
the Month) x (Budget at Completion). 

 Each time BCWP is computed (for all EVMs except Key Event) all monthly 
values within the range of the selected Calculate From month and the Calculate 
Through month are recalculated.  

 For the EVM of Key Event, a budget change will only affect cumulative values 
in the Calculate Through month. Historical BCWP is not recalculated. 

 For each WBS element, the BCWP is computed using either BCWP Value or 
BCWP % Complete. Which is used depends on the EVM selected. 

These EVMs: Use: 

Earned Standards 
BCWP Entry 
Key Event 

BCWP Value 

All others BCWP % Complete 
 

 For all EVMs except Key Event, if BAC is changed (any change to the budget) 
after a WBS element has been statused, BCWP Value or BCWP % Complete 
will change for all previously statused months when you recalculate BCWP. 

Examples 
To illustrate the impact of budget changes, assume BAC = 1000 and BCWP is statused as 
follows: 

 JAN  FEB 

Cum %  50  100 

Cum $  500 1000 

 

 

 

 



MPM Projects   257 

If an EVM of Earned Standards or BCWP Entry is used and BAC is increased to 2000, 
the new values after calculating BCWP will be: 

 

 JAN  FEB 

Cum %  25  50 

Cum $  500 1000 

If an EVM of Earned Standards or BCWP Entry is used and BAC is reduced to 500, the 
new values after calculating BCWP will be: 

 JAN  FEB 

Cum %  100  100 

Cum $  500  500 

If an EVM other than Earned Standards or BCWP Entry is used and BAC is increased to 
2000, the new values after calculating BCWP will be: 

 JAN  FEB 

Cum %  50  100 

Cum $ 1000 2000 
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9.8  Entering Information Using Autofill 
Drawing on its similarity to a spreadsheet, MPM provides autofill features for replicating 
data down adjacent cells in the Milestones sheet. You are restricted to autofilling within 
the milestones for a single WBS element. 

 
Figure A. You can use the autofill feature to replicate data down adjacent cells. 

Procedure 
To autofill data down adjacent cells: 

1. Select the source cell or cells and the adjacent target cells. 

 In the Milestones sheet, you can only autofill down a column and within the 
milestones for a single WBS. 

2. To fill down, do one of the following: 

 From the Edit menu, select Fill Down. 
 Press Ctrl+D. 

 Note the cells will not reflect the change until you click on another cell. 
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9.9  Milestone Field Descriptions 
The fields (columns) in the Milestone sheet provide information about the milestones. 
MPM displays <Required> in fields that are required. You can display or hide the fields 
using the Column Hide command on the Format menu. 

Most of the WBS fields can be displayed in the Baseline view. However, they cannot be 
edited and initially they are hidden in the view. For a description of the fields, see topic 
5.7 WBS Field Descriptions. 

The important fields are described on the pages that follow. They are listed in the order 
they appear in the window. 

Level 
Level is a read-only field that displays the hierarchical level of the WBS element and 
shows the relationship of the element to its parent. The top element, or project level, in 
the WBS has a value of 1. 

WBS ID 
The WBS ID is a unique number assigned to each element of the WBS when the WBS is 
created. You cannot edit this field. 

Milestone ID 
This is a unique code that you enter for each milestone. It can be up to 10 characters. The 
ID must be unique across the entire project. The same ID cannot be used for a different 
work package. MPM does not sort the milestones by the Milestone ID. 

Description 
On a WBS row, the description is read-only and is taken from the WBS. On a milestone 
row, the description is a free form field that accepts up to 15 characters. 

EVM 
Earned Value Method (EVM) is a field on a WBS row that displays the method used to 
calculate BCWP for the WBS element. You select the method from the drop-down list.  

If you delete an EVM from a WBS element, MPM removes all milestones from the WBS. 
If you assign an EVM to a WBS element that does not currently have any milestones, 
MPM adds default Start and Complete milestones to the WBS. You can accept, edit, or 
delete these default milestones. 
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BCWP Base 
BCWP Base is a WBS field that shows which unit is to be used when calculating the 
BCWP for a WBS element. You can choose from five base units to be used to calculate 
BCWP: Hours/Units, Prime Dollars, Total Burdened, Total Cost, or Total Dollars. Total 
Dollars is the default value.  

The BCWP Base unit should match the Baseline Estimate Type you selected in the 
Integrated Planning window. For example, if the estimates are being recorded as Hours, 
then the BCWP Base unit should also be Hours.  

Schedule Date 
The Schedule Date is the original date on which a milestone should be completed. The 
date must fall within the WBS Start and Complete dates. If you enter a Fiscal Period in 
the field, MPM will use the Fiscal Start date (day, month, year) from the Fiscal calendar. 

If you change the Schedule Date and the Forecast Date for the milestone is blank, MPM 
changes the Forecast Date to match the Schedule Date. 

Forecast Date 
The Forecast Date is a revised Schedule Date for the milestone. If you enter a Fiscal 
Period in this field, MPM will use the Fiscal Complete date (day, month, year) from the 
Fiscal calendar. The Forecast Date defaults to the Schedule Date until it is modified. 

Weight 
The Weight field displays the milestone’s weight, where weight represents the amount of 
an element’s cost that is earned when the milestone is met. The field can be changed only 
if the EVM for the element is Milestone Weights or Milestone Weights with % 
Complete. 

Symbol 
Identifies the symbol used for the milestone’s schedule/forecast date on the Gantt chart. 
You pick the symbol from the field’s drop-down list box. The default symbol is the Up 
Triangle. 
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Complete 
A check mark in this field indicates that the milestone has been completed. When a 
milestone is marked completed, the symbol on the Gantt chart is shaded. To check or 
uncheck this field, double-click on the field, press the spacebar, or click on the check 
button at the end of the field. 

For EVMs other than No EVM Required, Level of Effort (LOE), Key Event, and 
Apportioned, when you update the field MPM updates the milestone’s % Complete field 
appropriately and calculates a new percent complete and cumulative BCWP for the WBS. 

% Complete 
This field shows the cumulative percent complete. 

WBS Row:  The % Complete field shows the cumulative percent complete for a WBS 
element if the WBS element has an EVM assigned other than No EVM Required. N/A 
(Not Applicable) will display for WBS elements that use an EVM of Level of Effort or 
Key Event. 
Milestone Row:  If the milestone is checked as complete, the % Complete field will 
display 100%. If an EVM of Milestone Weights with % Complete is used, this field holds 
the current percent complete value for each milestone up to 100% and will accept up to 
three characters of input. If you set the % Complete field to 100%, MPM will place a 
check mark in the Complete field. If you set the % Complete field to less than 100%, 
MPM will remove the check mark from the Complete field. If you update this field, 
MPM will calculate a new percent complete and cumulative BCWP for the WBS. 
The percent complete value displayed is the most recent non-zero month of status, not 
necessarily the latest percent complete. For example, assume the percent complete values 
after statusing several months are: Jan 10%, Feb 20%, Mar 10%, and Apr 0%. The 
percent complete displayed would be March’s 10%. 

Cum BCWP 
The Cum BCWP field displays the most recent cumulative BCWP value for the WBS 
element when the element has an assigned EVM. If no EVM is selected, or EVM is equal 
to No EVM Required, the field will be blank. 

If a WBS element has been assigned an EVM of BCWP Entry or Earned Standards, you 
must enter a value in this field to status the element. For an EVM of BCWP Entry, 
updating the Cum BCWP will cause MPM to calculate a new percent complete for the 
WBS element. For an EVM of Earned Standards, updating the field will cause MPM to 
calculate a new percent complete for the WBS element, then apply that percent to the 
BAC of Hours to calculate a new cumulative BCWP for the WBS in Hours. 
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Baseline Start 
The Baseline Start field displays the earliest start date of any baseline resources for the 
WBS. This field is read-only. 

Baseline Complete 
The Baseline Complete field displays the latest complete date of any baseline resources 
for the WBS. This field is read-only. 

Last Statused Date 
The Last Statused Date field displays the date that the work package was last statused 
(the last day of the fiscal month selected for the As Of Month while statusing). This date 
is stored by MPM and is read-only. This date is displayed on the Gantt chart as an upside 
down red triangle above the Gantt bar. 

Base WBS 
The Base WBS is required when the Apportioned EVM is used. You enter the Base WBS 
ID by clicking on the  button at the end of the field and selecting a WBS ID from the 
hierarchy dialog box displayed, or by typing in the WBS ID. 

You cannot use any of the following as the Base WBS ID: 

 A WBS designated as an apportioned effort task 
 A distributed WBS 
 The Project Level WBS 
 The WBS element you are working in 

Other Fields 
Most of the WBS fields can be displayed in the Milestone sheet. However, they cannot be 
edited and initially they are hidden in the view. For a description of the fields, see topic 
5.7 WBS Field Descriptions. 



MPM Projects   263 

9.10  Maintaining Milestones 
Most of the fields in the Milestone display are read only, with the information pulled 
from other areas of MPM. The editable fields are: 

 Milestone ID  Forecast Date 
 Description  Weight 
 EVM  Complete 
 BCWP  % Complete 
 Schedule Date  Cum BCWP 

 

Editing a Milestone 
To edit a milestone: 

1. Select the field you want to edit. 

2. Make the change. 

 When you change a field value, MPM changes the color of the text of the WBS 
and the text of all of the milestones for the WBS to blue. The blue color indicates 
a milestone has been changed but not saved. 

3. To save the change, do one of the following: 

 Click on another WBS element row in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save. 

If you do not want to save the changes, press Esc. 
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Sub-Topics 
Other editing functions are covered in the following sub-topics: 

9.10.1 Copying and Pasting Milestones 
9.10.2  Copying and Pasting Cells 
9.10.3  Deleting Milestones 
9.10.4  Deleting Cells 
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9.10  Maintaining Milestones 
9.10.1  Copying and Pasting Milestones 

You can copy and paste milestones from one WBS element to another WBS element 
using the Copy and Paste commands under the Edit menu. If you have two Integrated 
Planning windows open, you can copy and paste milestones between the windows. When 
you copy milestones, MPM automatically assigns unique Milestone IDs to the new 
milestones. Copying milestones is a fast way to enter new milestones if the milestones are 
similar. You can also copy individual cells. Copying cells is described in topic 9.10.2  
Copying and Pasting Cells. 

 
Figure A. You can copy milestones. 
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Procedure 
To copy and paste a milestone: 

1. Select a single milestone by clicking on the row number in the left most column, 
or select multiple milestones by holding down the left mouse button and 
dragging across the row numbers. 

 You can select multiple milestones across two or more WBS elements. 

2. Place the milestone(s) on the clipboard by doing one of the following: 

 Click the Copy  button. 

 From the Edit menu, select Copy Milestone(s). 
 Press Ctrl+C. 

3. Select the WBS element where you want to paste the milestone(s) and do one of 
the following: 

 Click the Paste  button. 

 From the Edit menu, select Paste Milestone(s). 
 Press Ctrl+V. 

 MPM may display the dialog box shown in Figure B asking you to confirm the 
paste. 

 
Figure B. You may be asked to 
confirm the paste. 

4.  To confirm the paste, choose Yes. 

Cutting and Pasting 
If you want to remove milestones from one WBS element and place them in another 
WBS element, you can use the Cut and Paste commands. The procedure is the same as 
the procedure outlined above for copying and pasting, except you use the Cut command 
instead of the Copy command. 
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9.10  Maintaining Milestones 
9.10.2  Copying and Pasting Cells 

You can copy and paste cells in the Milestone sheet. If you have two Integrated Planning 
windows open, you can copy and paste cells between the windows. Copying cells is a fast 
way to enter milestone information. You can also copy entire milestones. Copying 
milestones is described in topic 9.10.1  Copying and Pasting Milestones. 

 
Figure A. You can copy one or more cells. 

Procedure 
To copy one or more cells: 

1. Select the cell(s) you want to copy. 

 To select more than one cell, hold down the left mouse button and drag across the 
cells. 
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2. Place the cell(s) on the clipboard by doing one of the following: 

 Click the Copy  button. 

 From the Edit menu, select Copy Cell(s). 
 Press Ctrl+C. 

3. Select the cell where you want to paste the information and do one of the 
following: 

 Click the Paste  button. 

 From the Edit menu, select Paste Cell(s). 
 Press Ctrl+V. 

 MPM may display the dialog box shown in Figure B asking you to confirm the 
paste. 

 
Figure B. You may be asked to 
confirm the paste. 

4.  To confirm the paste, choose Yes. 

Cutting and Pasting 
If you want to remove estimates from one WBS element and place them in another WBS 
element, you can use the Cut and Paste commands. The procedure is the same as the 
procedure outlined above for copying and pasting, except you use the Cut command 
instead of the Copy command. 
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9.10  Maintaining Milestones 
9.10.3  Deleting Milestones 

You can delete one or more milestones. If the milestone has earned value, you will be 
asked to confirm the delete. 

Deleting Milestones 
To delete one or more milestones: 

1. Select a single milestone by clicking on the row number in the left most column, 
or select multiple milestones by holding down the left mouse button and 
dragging across the row numbers. 

2. To initiate the delete, do one of the following: 

 From the Edit menu, choose Delete Milestone(s). 
 Press the Delete key. 

 
Figure A. You can delete a milestone. 

 If the milestone has earned value, MPM displays the dialog box shown in 
Figure A. If you choose to delete the milestone, you will have to recalculate 
BCWP. For information on calculating BCWP, see topic 11.6 Calculating BCWP 
in the MPM Projects manual. 
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3. To confirm the delete, click Yes. 

4. To save the change, do one of the following: 

 Click on another row in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

You may be asked to confirm the delete. 
If you do not want to save the changes, press Esc. 
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9.10  Maintaining Milestones 
9.10.4  Deleting Cells 

You can delete one cell or a group of adjacent cells. Adjacent cells can run across one or 
more WBS elements. 

Procedure 
To delete one or more cells: 

1. Select the cell(s) you want to delete. 

 To select more than one cell, hold down the left mouse button and drag across the 
cells. 

2. To initiate the delete, do one of the following: 

 From the Edit menu, choose Delete Cell(s). 
 Press the Delete key. 

 If the cell affects status (Complete and % Complete fields), and you have not yet 
set the As Of Month, MPM will display the As Of Month dialog box shown in 
Figure A. 

 
Figure A. Set the As Of Month. 

 If the cell affects earned value (Weight field), MPM displays the dialog box 
shown in Figure B. 
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Figure B. Confirm the delete. 

3. Take the appropriate action depending on the dialog box displayed. 

4. To save the change, do one of the following: 

 Click on another row in the window. 
 Click on the Save button  in the Toolbar. 

 From the File menu, choose Save. 
 Press Ctrl+S. 

 You may be prompted to confirm the save. 

If you do not want to save the changes, press Esc. 
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9.11  Changing the Milestone Display 
The Milestone display follows the standard MPM conventions for grids. The tools 
available for changing the display are described briefly in this chapter. For more 
information on changing the display, see the MPM Getting Started manual. 

Filtering Data 
You can apply a filter to the milestone 
data by clicking on the Filter button  
or by choosing Filter from the Tools 
menu. MPM displays the Filter dialog box 
shown in Figure A where you can select a 
field to filter. When you click OK, MPM 
displays the second dialog box where you 
can type in an entry or select an entry 
from the drop-down list box.  

The filter function filters all resource 
estimates. You can apply only one filter at 
a time. They are not cumulative. To 
display all resource estimates, select All 
Data from the Tools|Filter menu, or from 
the drop-down list box in the Filter dialog box. 

 
Figure A. Filter dialog box 

Hiding and Showing Milestones 
You can expand and collapse the milestones under each WBS element using the Toolbar 
buttons  or the commands under the Tools menu. 
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Displaying and Hiding Columns 
You can display and hide any combination of columns 
using the Column Hide command under the Format menu. 
In the Column Hide dialog box shown in Figure B, you can 
select and deselect columns to hide using the Shift+Click 
and Ctrl+Click key combinations. Selected columns will be 
hidden in the display. To display all columns, click on one 
of the columns in the list, Ctrl+Click on the same column 
to deselect it, then click OK. 

 
Figure B. Hiding columns 

Sorting WBS Elements 
You can sort on the WBS elements, but not the milestones 
in a Milestones view. Sort applies to all WBS elements 
regardless of the current selection. To sort the WBS 
elements, click the Sort button  in the Toolbar, or 
choose Sort from the Tools menu. MPM displays the 
Sort dialog box shown in Figure C. To return the 
display to its original order (by WBS ID), choose 
Reset in the Sort dialog box. 

 
Figure C.  Sort dialog box 

Changing the Periods 
You can change the periods displayed in the Gantt 
chart to month, quarter, or year. To select a period, 
choose Period from the View menu. 
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9.12  Previewing and Printing Milestones 
At any time, you can preview and print the milestones sheet. Note you cannot print the 
Gantt chart directly from the Milestones window. However, you can print a Milestone 
Barchart report from the Reports tab in the Menu Manager window. 

Previewing the Milestones Sheet 
To preview the milestones sheet onscreen: 

1. Do one of the following: 

 Choose the Print Preview button  in the Toolbar. 

 From the File menu, choose Print Preview. 
 MPM displays the Print Preview dialog box shown in Figure A. 

 
Figure A. Select the information 
you want included. 

2. Select the information you want included in the report. 

3. To display the report, click OK. 

 For information on using the Print Preview window, see the MPM Getting 
Started manual. 

Printing the Milestones Sheet 
To print a Milestones sheet: 

1. Do one of the following: 

 Choose the Print button  in the Toolbar. 

 From the File menu, choose Print. 
 MPM displays the Print dialog box shown in Figure B. 
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Figure B. Select the information 
you want included. 

2. Select the information you want included in the report. 

3. To print the report, click OK. 

 MPM displays the standard Windows print dialog box shown in Figure C. 

 
Figure C. Select the print options. 

4. Select the appropriate options and click OK. 
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9.13  Recommended Milestone Reports 
There are several standard MPM reports that you can use to review milestone 
information. The reports are described briefly below. For detailed information on the 
reports, see the MPM Standard Reports manual.  

 Milestone Barchart 
 Milestone Status Turnaround Document 
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10.1  Introduction to Actuals 

You can enter or import the actual costs incurred by the project into MPM for analysis 
and comparison with the budget. This is an optional feature provided by MPM.  

Actuals are not collected by MPM. Your accounting system provides the actuals, which 
you can either input manually or import directly. MPM sorts and summarizes actual costs 
by WBS/OBS and then provides comparative reports and graphs. 

You must have already entered your accounting system identifier in the Charge 
Number field in the WBS window, or MPM will not allow the entry or importation of 
actuals into that WBS. 

Actuals may be collected by Element of Cost or by Resource at any level of the WBS. If 
you collect actuals at the control account level and calculate BCWS and BCWP at the 
work package level and you want to set BCWS and BCWP equal to actuals when running 
the Replan utility, you must set it at the level of the WBS where actuals exist.  This will 
clear your variances at the control account level, and retain the variances at the work 
package level.  

Totals of Actuals  
Whether you manually enter or import actuals, the dollar amounts are automatically 
accumulated using the following formulas: 

 Prime + Overhead = Total Burden 
 Total Burden + G&A = Total Cost 
 Total Cost + Cost of Money = Total Dollars 
 Total Dollars + Fee = Total Price 

These totals are rolled up in each WBS parent automatically. If you are entering actuals 
manually and this automatic rollup is slowing you down, see topic 10.4  Creating Actuals 
for details about turning off the Rollup Toggle. 
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Comparing Budget to Actuals 
Once you have entered your actuals, you can run several reports and graphs to compare 
your actuals to your budget and try to predict the costs and schedule required to finish the 
project. The graph below shows the SPA Line Graph, which compares BCWS, BCWP, 
ACWP (Actuals), Schedule Variance, and Cost Variance. See Chapter 14: Analyzing the 
Project Graphically (GDD) for details on generating this graph. 

 
Figure A. An SPA Line Graph 

Actuals Repricing 
You can revise actuals in one process using the Reprice utility. Repricing is usually 
performed when there are major modifications to burden templates or rate tables. Using 
the utility can save a great deal of time over modifying each estimate separately. You can 
also use the Reprice utility to run “what if” scenarios against copies of your project. You 
can easily shift resources and change direct or indirect rates to produce different pricing 
scenarios. 

You should run the Actuals Reprice if the Resource Code or Resource Department has 
changed for Resource Actuals, or the EOC code has changed for EOC Actuals. See 
Chapter 11: Utilities for details. 
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10.2  Accessing Actuals 

You open the Actuals window from the MPM Menu Manager. When you open the 
Actuals window, you select the project you want to view and the data to download. 

 
Figure A. Accessing the Actuals Window 

Procedure 
To open the Actuals window from the Menu Manager window shown in Figure A: 

1. Do one of the following: 

 Select the Projects tab and choose the Actuals icon 
 Choose Actuals from the File|Projects menu 

MPM displays the Actuals Open dialog box shown in Figure B. 

2. Choose a project from the Project drop-down list box. 
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Identify the
Project

Filter by
WBS Leg

Filter WBS
by Manager

Filter WBS by
Element Type

 
Figure B. Select a project and the data to download. 

3. To select the data to be downloaded, specify one or more of the following: 

 Filter by WBS Leg 
Click the check mark box next to the desired WBS Leg(s), using the  and   
bo

 

 

xes to expand or collapse the legs if necessary. 
 Filter by WBS Manager 

Using the Shift and Ctrl keys, click the particular Manager(s) who are 
assigned to the WBS elements you want to download. 

 Filter by WBS Element Type 
Select the type(s) of WBS elements you want to download. 

4. To accept the selections and display the Actuals window, click OK.  

When the Actuals window opens, the WBS elements you selected here are downloaded. 
Note that unlike the WBS window, you cannot download additional data once you click 
OK here, so be sure to download all necessary WBS elements prior to clicking OK. 
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10.3  Orientation to the Actuals Window 

You use the Actuals window to manually enter, edit and review actuals data. A toolbar 
gives you quick access to common tasks. The Actuals window has two window panes. 
The left pane shows the resource or EOC data, and the units of actuals being attributed to 
the current WBS element. The right pane shows all the months of the fiscal calendar for 
the selected project and contains the actuals data. Data is shown beginning two months 
prior to the current accounting month. See Figure A. 

Resource/
EOC Data

Actuals
DataSeparator Bar

Resource View

EOC View

Units of
Actuals for this
Resource/EOC

WBS Data

 
Figure A. The Actuals Window 

Resource and EOC Views 
To enter actuals data by resource, click the Resource tab in the left window pane. To 
enter actuals data by EOC, click the EOC tab.  

Going Quickly to Actuals Start 
MPM has a quick way to scroll the right window pane to the fiscal month where the 
actuals data starts.  

 To scroll to the start of the WBS, click the WBS and choose Go To WBS Start 
from the Edit menu, or press Ctrl +G.  

 To scroll to the start of the Resource, click the Resource and choose Go To 
Resource Start from the Edit menu, or press Ctrl +G.  

 To scroll to the start of the EOC, click the EOC and choose Go To EOC Start 
from the Edit menu, or press Ctrl+G.  
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Searching Actuals  
To search through your actuals, choose Find from the Edit menu. MPM displays the Find 
Options window. Enter the text to be found, whether you want to try to match all or part 
of the entire cells contents against the text, and whether to match upper/lower case. Click 
Find Next and MPM attempts to locate that string. MPM always searches the left window 
pane from the current cell, from top to bottom, left to right. The search does not wrap to 
the top of your data. 

Checking the Totals Window 
At any point in your editing process, you can easily check your totals by looking at the 
Totals window. Bring up the Totals window by either choosing Totals window from the 
Tools menu, or clicking the Total button . The window is a floating toolbox that is 
always on top. You can leave it up while you continue your editing, or close it. The menu 
option shows  if the Totals window is toggled on.  

If a cell is currently selected on the left window pane, the grand totals displayed are for 
the entire Resource/EOC. If a cell is currently selected on the right window pane, the 
middle column shows the monthly totals, and totals for the entire Resource/EOC. 

This window shows current and cumulative Budget at Complete (BAC) totals for the 
following fields: Hours/Units, Prime, Overhead, Total Burdened, G&A, Total Cost, Cost 
of Money, Total Dollars, Fee, and Total Price.  

Printing/Previewing Actuals Elements 
You can preview or print actuals data using the options on the File menu. For complete 
details on using these options, see Using MPM in Getting Started. When you select Print 
Preview or Print, MPM displays the Print/Preview dialog shown in Figure B, where you 
can choose whether to include Task Descriptions and/or Timephased Values. 

 
Figure B. The Print/Preview dialog 
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10.4  Creating Actuals 

Inserting New Actuals 
1. To indicate the WBS element to which you want to add actuals, click anywhere 

in its grayed row.  

2. To add a new resource, click the Resource tab. To add a new EOC, click the 
EOC tab. 

3. To insert a new block (the six rows inserted are referred to as a block in this 
document), press the Insert key or choose Insert from the Edit menu.  

MPM adds a new actuals block after the last block for the current WBS element, 
and puts the entire block (six rows) in edit (blue) mode. 

4. Select the Resource/EOC code using the drop-down list box in that cell. 

5. Enter actual values for the Resource/EOC in the right grid, in the row appropriate 
for the units you are entering (Hours/Units, Prime, Overhead, GA, COM, Fee), 
and in the column for the month(s) in which the actuals were accrued. For 
example, to enter $5,000 Prime dollars for October 1999, find the Prime row, the 
Oct 99 column, and enter 5000 in that cell. 

Importing Actuals from Outside MPM 
Actuals can also be imported in batch mode from a batch file provided by your 
accounting system can create an import file in a CSV, comma delimited format.  Actuals 
entered in import mode can be manually overwritten.  Actuals are imported by month; 
MPM computes cumulative totals.  If collecting Actuals by Resource, you can optionally 
auto-burden them. See Chapter 16: Importing Data for a detailed explanation. 

Saving the Data 
When you are finished editing the Resource/EOC actuals, select Save from the File 
menu, press Ctrl+S, or click the Save  button. If you click outside the six-row block, or 
insert another cell, MPM prompts you to save the current six-row block, unless the 
Resource/EOC is still set as <Required>, in which case MPM prompts you to fill the 
<Required> fields before your data can be saved. To discard changes you have made to 
an actuals block, or remove a newly added actuals block, press ESC. MPM prompts to 
discard changes to the actuals.  
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Rollup Processing 
Your Resource/EOC entries are rolled up as you enter them into the Actuals window. If 
you have a large amount of data, this may slow down data entry. You can optionally 
suspend automatic processing by turning off the Rollup Processing toggle. See Chapter 
2: Creating and Maintaining Project Settings for instructions on using the toggle. 

The Rollup Processing Toggle suspends rollup processing of entries until you manually 
choose to process the rollups. If Rollup Processing is turned OFF, MPM stores all actual 
values you enter, but does not rollup or accumulate the values into the totals until you 
choose to do the processing.  This simplifies input of high volumes of estimate and/or 
actuals data with improved performance, especially if you have an extensive or complex 
WBS Tree. But you must later run the rollup processing, or your totals will be incorrect! 

There are two settings which you can turn off: EOC and Summary processing. EOC 
processing rolls up EOC data. Summary processing creates summary data which is used 
by several reports. 

 To see the current setting, check Rollup Toggle Status from the View menu. You 
must have been granted access to this toggle to be able to change it. 

 To change the EOC or Summary toggle, you must exit the Actuals window, and 
in the Project Maintenance window, choose Rollup Processing on the View 
menu, and check or uncheck the desired toggle.  

 To perform the Rollup Processing for actuals when you have set the EOC or 
Summary toggle OFF, in the Project Maintenance window, choose Rollup 
Processing on the View menu and choose to roll up actuals by clicking the check 
box.  
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10.5  Actuals Field Descriptions 

For each WBS element you selected in the Actuals Open dialog box, the Actuals window 
displays a gray row, showing the WBS and its associated fields, which is read-only 
reference information about the WBS. See Chapter 5: Creating the WBS for details about 
the WBS fields. 

Blocks of Actuals by Unit 
When you enter actuals against the current WBS element, each Resource or EOC is given 
six rows in the grid, for each of the units that may be affiliated with the actuals 
(Hours/Units, Prime, Overhead, G&A, Cost of Money, and Fee). Those six rows of data 
are referred to as a block in this document. The units of actuals data (Hours/Units, Prime, 
Overhead, G&A, COM, Fee) each have their own row, which is extended in the right 
window pane across all the fiscal months in the project.  Here you enter the number of 
hours, units, or dollars for the current resource or EOC into the appropriate month. You 
can enter values in decimals; MPM will round off the value and display the whole 
numbers, but the values are stored in their full precision.  

These are the fields or columns displayed in the Actuals Sheet. Fields which are required 
display <Required> in the cell. These fields must be filled. You can change the columns 
that are displayed using Column Hide. See Using MPM in the Getting Started manual for 
details.  

 Resource Code 

 Resource Description 

 Resource Dept 

 XREF-EST 

 Overtime 

 Unit 

 EOC Code 

 EOC Description 
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10.5  Actuals Field Descriptions 

10.5.1  Resource Actuals Field Descriptions 
When entering Actuals by Resource, enter the number of hours, units, or dollars for the 
current resource into the appropriate fiscal month. You must first select the Resource 
Code from the list box, and you can optionally fill in Resource Department and Overtime. 
These entries can only be made on the first line of the block. See Figure A. 

WBS data

Resource Code

Resource Desc

Units of Actuals
one row per unit
6 rows = 1 block

Enter the Actuals for the appropriate
unit under the applicable fiscal month

Enter Actuals
by Resource

 
Figure A. Resource Fields 

Unique Resource Actuals 
Each block of resource actuals data is identified by a unique combination of Resource 
Code, Resource Dept, and Overtime. Each block must contain a unique combination of 
these fields to uniquely identify that block. For example, if you are reporting actuals 
hours data for Resource Code ENGE in Department LAB1 with OT for the months of 
August, September, and October 1998 for WBS 100-10, you cannot report multiple sets 
of hours data for ENGE in LAB1 with OT in Aug-Oct. 1998 for WBS 100-10. 
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Resource Code 
This required field contains the code of the resource for which actuals are being entered. 
Select the code from a drop-down list box of resources.  

Resource Description 
On a Resource row, this field contains the resource description as defined for the 
Resource Code in the Resources and Burdens window. 

Resource Dept 
On a Resource row, this optional field contains the department of the resource for which 
actuals are being entered. Select from a drop-down list box of available performing 
departments. 

XREF-EST 
On a Resource row, use this optional identifier as a wild card for reporting, exporting, or 
onscreen filtering to match a specific group of data.  

Overtime 
On a Resource row, click this optional check mark to show that actuals represent 
overtime rates. 

Unit 
Indicates which of the six units show in the right window pane. MPM displays 
Hours/Units on the same row with the Resource/EOC code; all others are on the next five 
rows, in this order: Hours/Units, Prime, Overhead, G&A, Cost of Money, Fee. These 
fields cannot be edited or deleted. 
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10.5  Actuals Field Descriptions 

10.5.2  EOC Actuals Field Descriptions 
When entering actuals by EOC, enter the number of hours, units, and/or dollars for the 
current EOC into the appropriate fiscal month. See Figure A below. You must first select 
the EOC Code from the drop-down list box. 

WBS data

EOC Code

EOC Desc

Units of Actuals
one row per unit
6 rows = 1 block

Enter the Actuals for the appropriate
unit under the applicable fiscal month

Enter Actuals
by EOC

 
Figure A. EOC Fields 

Unique EOC Actuals 
Each block of EOC actuals data is uniquely identified by the EOC Code. For example, if 
you are reporting actuals hours data for EOC Code LABOR for the months of August, 
September, and October 1998 for WBS 100-10, you cannot report multiple sets of hours 
data for LABOR for Aug-Oct. 1998 for WBS 100-10. 
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EOC Code 
This required field contains the code of the EOC for which actuals are being entered. 
Select the code from a drop-down list box of EOC codes.  

EOC Description 
On an EOC row, this field contains the EOC description as defined for the EOC code in 
the Elements of Cost window. 
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10.6  Maintaining Actuals 

Editing Actuals  
When entering or editing actuals in the right window pane, you are in Edit Mode.  In Edit 
Mode, the text in the current block in both window panes is blue. Choose the row for the 
appropriate unit of actuals, and the column for the period when those units were 
accumulated.  When a cell is edited, the values you enter are displayed in full precision 
based on the units for that cell. Negative numbers are normally displayed in red, but 
when you are in Edit Mode, they are blue. When you are finished editing the actuals, 
click to advance to the next Actuals field, or press the tab, Up or Down Arrow key.  

Deleting Actuals 
To delete an Actual amount in the right window pane, go to the desired cell and press the 
Delete key, or choose Delete on the Edit menu. MPM clears the amount in the cell. 

To delete more than one actual at one time, select the desired elements by clicking and 
dragging the mouse to highlight the cell(s), or by using the Shift and Ctrl keys when 
clicking the mouse button, and then press the Delete key, or choose Delete Cells on the 
Edit menu. MPM clears the amount in the cell(s). 

You cannot delete or edit cell data on WBS rows. They are read-only reference. 

If you delete one or more actuals cells, MPM prompts to save the changes.  

To delete an entire resource or EOC block of actuals, highlight any row in the desired 
block by clicking the row number, and then press the Delete key or choose Delete on the 
Edit menu. MPM removes the entire actuals block. 
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Repricing Actuals 
You can revise actuals in one process using the Reprice utility. Repricing is usually 
performed when there are major modifications to burden templates or rate tables. Using 
the utility can save a great deal of time over modifying each estimate separately. You can 
also use the Reprice utility to run “what if” scenarios against copies of your project. You 
can easily shift resources and change direct or indirect rates to produce different pricing 
scenarios. 

The fee calculation method selected for a project determines whether fee is 
generated when using the Reprice utility. Repricing actuals will not generate fee 
if the WBS option is selected; reprice calculates fee only if the Resource option 
for fee calculation is selected.  See topic 2.4.4, Selecting a Fee Calculation 
Method, for details. 

 You should run the Actuals Reprice if the Resource Code or Resource Department has 
changed for resource actuals, or the EOC code has changed for EOC actuals. See Chapter 
11: Utilities for details. 
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10.7  Changing the Actuals Display 

Filtering Actuals 
When you opened the actuals in the selected project, you selected the WBS elements (by 
leg, manager, and/or element type) on which to enter and edit actuals. To change the 
WBS leg(s) selected, choose Open on the File menu to access the Actuals Open dialog 
and select different or additional WBS leg(s). 

Showing/Hiding Actuals 
These options show resource if using the Resource tab, or EOC if using the EOC tab.  

 To expand the display to show all actual rows of the selected WBS, use Show 
Actuals on the Tools menu. 

 To collapse the display to hide the actual rows of the selected WBS, use Hide 
Actuals on the Tools menu. 

 To show all actuals of all WBSs, use Show All Actuals on the Tools menu. 
 To hide all Actual rows of all WBSs, use Hide All Actuals on the Tools menu.  

Note that row numbers do not reorder when you change the actuals being shown. You 
can use this to know at a glance when rows are not being displayed. You can also check 
the Tools menu; the show/hide options that are set are disabled. 



296   Chapter 10: Entering the Project Actuals 

Displaying/Hiding Actuals Fields 
You can display or hide any or all of the columns in the left pane of the Actuals window 
using Column Hide on the Format menu. Use the Shift and Ctrl keys to select and 
deselect the desired columns. The highlighted fields are hidden; the non-highlighted 
fields are displayed. See Using MPM in Getting Started for more information. 
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10.8  Recommended Actuals Reports and Graphs 

There are several standard MPM reports that you can use to review actuals information. 
The reports are listed below. For detailed information on the reports, see the MPM 
Standard Reports manual.  

 Element of Cost Table Report, which includes: 
o Actuals by EOC Report 
o Actuals by Charge Number Report 
o Budget/Actuals Recap by EOC Report 
o EOC - LRE Report 
o SPA Tabular Report by EOC 
o SPA Recap by EOC Report 

 Resource Report, which includes: 
o Resource Detail - Actuals Report 
o Resource Detail - Budget/LRE Report 
o Resource Summary - Actuals Report 

 Work Status Document - LRE Report 
 NASA and DOD/DOE Reports 
 Graphs (see Chapter 14 for details on creating these graphs) 

o S/P/A X-Y Graph 
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11.1  Introduction to Utilities 

Even the most carefully planned project will require changes throughout its life span. 
MPM provides several utilities that facilitate making changes across an entire project, or 
selected WBS elements and legs. The utilities are: 

Reprice Revises baseline, ETC, or actuals based on changes in 
burden templates and rate tables. 

Estimate Adjust Revises baseline estimates and ETC based on a fixed 
percentage or target value. 

Estimate Rename Renames resource codes or resource departments for 
estimates, and reprices. 

Date Shift Shifts the estimate start and complete dates, and reprices. 

Calculate BCWP Updates the BCWP figures. 

Post Weekly Data Provides means to calculate, store and report earned 
value on a weekly basis. 

Project Replan Formally reprograms or replans a project. 

 

Each of the utilities, except Project Replan, is described in this chapter. Project Replan is 
described in Chapter 12: Replanning Projects. 

Backing Up Your Project Data Before Using Utilities 
Before using any of the Utilities, you should request a full backup of the MPM database. 
If one of the utilities is interrupted in the middle of executing, the database will be 
corrupted. The only way to correct this is to restore the database from the backup. 
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Accessing the Utilities 
You access the utilities from the Tools menu in the Project Maintenance window shown 
in Figure A. 

 
Figure A. Access the utilities from the Tools menu. 
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11.2  Repricing Data 

You can revise baseline estimates, ETC, or actuals in one process using the Reprice 
utility. Repricing is usually performed when there are major modifications to burden 
templates or rate tables. For example, overhead rates might change because of a new 
union contract. The new rates would affect existing baseline estimates and ETC 
projections, and any existing actuals. They would all need to be recalculated based on the 
new rates. 

You can also use the Reprice utility to run “what if” scenarios against copies of your 
project. You can easily shift resources and change direct or indirect rates to produce 
different pricing scenarios. 

When repricing, you can apply the following restrictions: 

 Reprice baseline and/or ETC, or actuals 
 Limit the repricing to one or more legs of a WBS 
 Limit the repricing to a specific performing, responsible, or resource department 
 Specify a time period 
 Target the repricing by element of cost (EOC), class of cost (COC), or resource 

 
Figure A. You can limit repricing using the options. 
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Reprice Conditioning 
You use the Reprice Conditioning grid in the Reprice dialog box to select the elements of 
cost, classes of costs, or resources to be included in the reprice, and specify the value(s) 
to hold constant during the reprice. 

Special Guidelines 
MPM uses the appropriate (baseline, ETC, or actuals) rate table designated for the project 
in the Project Maintenance window. If you want to use a different rate table, make the 
change in the Project Maintenance window before running the Reprice utility. If you 
change a rate table, MPM uses that rate table for all functions from that point forward.  

If your project is using Fee by WBS, you should not hold price constant when repricing. 
If you do, new fee rates may not be applied. 

Estimate Reprice modifies the entire estimate for any WBS elements you select that fall 
within the specified time frame. Estimates prior to the current date (history) will be 
recalculated if they fall within the specified time frame and meet the other conditions set 
in the Estimate Reprice conditioning grid. 

Actuals Reprice 
Actuals Reprice searches for the burden template from the resource entered for the 
Actual, and if that doesn’t exist, searches for the department entered for the Actual. Once 
the right burden template is selected, the Actuals Reprice functions the same as the 
Estimate Reprice. Actuals Reprice only modifies the detail actuals; it does not affect the 
estimates. Actuals Reprice only allows you to hold Hours, Prime, or Hours and Prime 
constant. If no date range is defined, the reprice begins with the start of the earliest detail 
actuals and continues until the end of the latest detail actuals (based on any other 
selections such as WBS Leg). Actuals Reprice does not perform date rollup. Only actuals 
entered by resource will be repriced. If actuals were entered by EOC only, they will not 
be repriced. 

Sub-Topics 
Additional information is presented in the following sub-topic: 

11.2.1  Repricing Procedure 
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11.2  Repricing Data 

11.2.1  Repricing Procedure 
The procedure for repricing is described below. 

 
Figure A. There are several options you can use to limit repricing. 

To reprice a project: 

1. Select a project in the Project Maintenance window by clicking on the row 
number. 

2. From the Project Maintenance window, open the Tools menu and select Reprice. 

 MPM displays the Reprice dialog box shown in Figure A. 

3. Select the data you want to reprice: baseline, ETC, actuals. 

4. Select the WBS leg you want to reprice by clicking the Browse button. 

5. Select the type of department you want to use to limit the reprice: Performing, 
Responsible, or Resource. 



MPM Projects   305 

 If you select Performing or Responsible, MPM ignores WBS elements that do 
not match. If you select Resource, MPM ignores estimates that do not match that 
resource. 

6. After selecting the type of department, select a specific department from the 
drop-down list box. 

7. If you want to restrict the reprice to a specific time period, enter From and 
Through dates. 

 To reprice the selected project data from start to finish, leave these fields blank. 

8. Choose to condition the estimate by Element of Cost (EOC), Class of Cost 
(COC), or Resource. 

 When you select one of the above options, MPM displays all elements defined 
for the category in the Reprice Grid on the right side of the dialog box. For 
example, if you select Element of Cost, MPM displays all elements of cost in the 
grid. 

9. Select the item(s) you want to include in the reprice by clicking the 
corresponding check box in the Include column. 

 MPM will place a check mark in the fields you select. To clear the selection, 
click the field again. 

10. For each item you include, select the value you want to hold constant during the 
reprice from the corresponding Maintain field drop-down list box in the grid. 

11. To begin the reprice, click OK. 

 If MPM encounters an error in the data, you are given the opportunity to 
terminate or continue the process. After the process has completed or been 
terminated, MPM produces the Reprice Error Report listing all errors 
encountered. 
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11.3  Adjusting Baseline and ETC Estimates 

You can revise baseline and ETC estimates in one process using the Estimate Adjust 
utility. The Estimate Adjust utility uses a fixed percentage or target value to adjust the 
estimates, and it uses the underlying rate tables. Estimate Adjust is most useful in cost 
proposal/bid development to produce “what if” scenarios. For example, you can use the 
Estimate Adjust to bring a bid price into line with a specific price. 

 
Figure A. There are several options you can use to limit 
estimate adjustments. 

When adjusting, you can apply the following restrictions: 

 Adjust the baseline estimates, ETC estimates, or both. 
 Limit the adjustment to one or more legs of a WBS. 
 Specify a time period. 
 Target the adjustment by Element of Cost (EOC), Class of Cost (COC), or 

Resource. 
 If adjusting by Element of Cost (EOC), you can set a target value and select the 

Unit Value (hours, total cost, etc.). 

Special Guidelines 
 Estimate Adjust makes permanent changes to the project data. If processing fails 

part way through the procedure, you will need to restore the data from the most 
recent backup. 
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 MPM uses the rate tables designated for the project in the Project Maintenance 
window. If you want to use a different rate table, make the change before running 
the Estimate Adjust utility. If you change a rate table, MPM uses that rate table 
for all functions from that point forward. 

 Estimate Adjust modifies only the portion of a WBS that falls within the time 
frame selected. 

Sub-Topics 
Additional information is presented in the following topics: 

11.3.1  Estimate Adjust Procedure 

11.3.2  Entering Adjustment Units 
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11.3  Adjusting Baseline and ETC Estimates 

11.3.1  Estimate Adjust Procedure 
The procedure for adjusting estimates is described below. Estimate Adjust is similar to 
Reprice except you specify a percentage factor or target amount for the adjustment. 

 
Figure A. There are several options you can use to limit estimate 
adjustments. 

Procedure 
To adjust an estimate: 

1. Select a project in the Project Maintenance window by clicking the row number. 

2. From the Project Maintenance window, open the Tools menu and select Estimate 
Adjust. 

 MPM displays the Estimate Adjust dialog box shown in Figure A. 

3. Select the estimates you want to adjust: baseline, ETC, or both. 

4. Select the WBS leg you want to adjust by clicking the Browse button. 

5. Select the type of department you want to use to limit the adjustment: 
Performing, Responsible, or Resource. 
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 If you select Performing or Responsible, MPM ignores estimates for WBS 
elements that do not match. If you select Resource, MPM ignores estimates that 
do not match the selected resource department. 

6. After selecting the type of department, select a specific department from the 
drop-down list box. 

7. If you want to restrict the adjustment to a specific time period, enter From and 
Through dates. 

 To adjust the project from start to finish, leave these fields blank. 

8. Choose to condition the estimate by Element of Cost , Class of Cost, or 
Resource. 

 When you select one of the above options, MPM displays all elements defined 
for the category in the Adjust Conditioning grid in the dialog box. For example, 
if you select Element of Cost, MPM displays all elements of cost in the grid. 

9. Select the items you want to include in the adjustment by clicking the 
corresponding check box in the Include column. 

 MPM will place a check mark in the fields you select. To clear the selection, 
click the field again. 

The next step is to specify the value and units used to adjust each item. These steps are 
described in the next topic. 
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11.3  Adjusting Baseline and ETC Estimates 

11.3.2  Entering Adjustment Units 
When you run an Estimate Adjust, your options for conditioning the adjustment depend 
on whether you are adjusting by EOC, COC, or Resource. 

 
Figure A. Your options for conditioning the adjustment depend 
on whether you are adjusting by EOC, COC, or Resource. 

If you are adjusting by EOC, you can condition by percentage, or specify a target value. 
If you are adjusting by COC or Resource, you can condition by percentage only. 

Adjusting by Percentage 
When you adjust by percentage, you can include decimals and specify a positive or 
negative percentage. Examples: 

10 -10 5.5 -5.5 

To specify the adjustment value: 

1. For each item you include, enter a Unit Value by which the item should be 
increased or decreased. 

2. Select Percentage as the Unit Type. 

3. To initiate the Estimate Adjust, choose OK. 
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Adjusting by Target Value 
If you are adjusting by EOC, you have the option of specifying a target value for the 
adjustment. The target values can be: 

 Hours 
 Prime Dollars 
 Total Burdened 
 Total Cost 
 Total Dollars 
 Total Price 

For example, if you want to adjust the estimate so that Prime Dollars for labor remains 
constant at $100,000, enter 100000 and select Prime Dollars as the Unit Type. Numbers 
are entered without commas. 

To specify the adjustment value: 

1. For each item you include, enter a target value. 

2. Select a unit type from the Unit Type drop-down list box. 

3. To initiate the Estimate Adjust, choose OK. 
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11.4  Renaming Resource Codes and Departments 

If you want to rename resource codes or resource departments in the baseline and ETC 
estimates for a project, you can use the MPM Estimate Rename utility. The utility 
renames and reprices at the same time.  

 
Figure A. You can rename resource codes and departments. 

When renaming, you can apply the following restrictions: 

 Rename the baseline estimates, ETC estimates, or both 
 Limit the renaming to one leg of a WBS 
 Target the renaming by element of cost (EOC) 

Special Guidelines 
 A unique estimate is made up of four elements: WBS ID, Resource code, 

Resource Department, Overtime factor. 
During the renaming process, MPM will reject your rename conditioning if it 
would result in two estimates having the same data in all four elements. If this 
happens, MPM generates an error and reports that the proposed renamed estimate 
already exists. 

 MPM uses the rate tables designated for the project in the Project Maintenance 
window. If you want to use a different rate table, make the change before running 
the Estimate Rename utility. If you change a rate table, MPM uses that rate table 
for all functions from that point forward. 
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 Because each Resource Basis of Estimate is tied to a specific baseline estimate, 
Resource BOEs will be renamed only if you rename baseline Estimates. If you 
only rename ETC estimates, Resource Basis of Estimates will not be renamed. 

 Summary Basis of Estimates are not renamed. However, individual estimates may 
be removed from a Summary BOE if they are renamed and no longer fit the 
criteria that define the Summary BOE. Also, individual estimates may be added to 
a Summary BOE if the renaming process causes them to fall within the criteria 
that define the Summary BOE. 

Sub-Topics 
Additional information is presented in the following sub-topics: 

11.4.1  Renaming Procedure 

11.4.2  Impact on Summary BOE  
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11.4  Renaming Resource Codes and Departments 

11.4.1  Renaming Procedure 
The procedure for renaming resource codes and departments is described below. 

 
Figure A. You can rename resource codes and departments. 

Procedure 
To rename resource codes and departments: 

1. In the Project Maintenance window, select a project. 

2. Open the Tools menu and select Estimate Rename. 

 MPM displays the Estimate Rename dialog box shown in Figure A. 

3. Select the estimates you want the rename to affect: baseline, ETC, or both. 

4. Select the WBS leg you want to affect by clicking the Browse button and 
selecting a WBS leg. 

 To rename the entire project, leave this field blank. 

5. From the Current group box, select the resource code and resource department 
you want to rename. 
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 Leaving the Resource Code an Resource Department fields blank will rename all 
items. If you select <Empty> for the Resource Department, MPM will rename 
only those items with no resource department assigned to them.  

“Blank” and <Empty> are different. 

6. If appropriate, enter the current overtime entry for the resource, or select one 
from the drop-down list. 

 To rename estimates with no overtime entry, select <Empty>. To rename all 
estimates with any type of overtime entry, leave the field blank. 

7. From the Rename To group box, select the new resource code name. 

8. From the Rename To group box, select the new department name. 

 If you select <Empty>, the resource department will be cleared for all selected 
estimates. 

9. From the Rename To group box, enter a new overtime value for the resource if 
appropriate. 

 If you want to maintain the same overtime factor, leave the field blank. If you 
want to clear all current overtime factors, select <Empty>. 

10. For each EOC listed in the Rename Conditioning grid, select the element you 
want to maintain constant during the rename. 

 The Original Estimate Type option will keep constant the estimate type assigned 
to the resource at the time the resource was added to the baseline and ETC 
estimates. 

11. To accept the settings and initiate the rename, choose OK. 

 When the process has completed or been terminated, MPM produces the Rename 
Error Report listing all errors encountered. 
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11.4  Renaming Resource Codes and Departments 

11.4.2  Impact on Summary BOE 
When you perform an Estimate Rename, Summary Basis of Estimates are not renamed. 
However, individual estimates may be removed from a Summary BOE if they are 
renamed and no longer fit the criteria that define the Summary BOE. Also, individual 
estimates may be added to a Summary BOE if the renaming process causes them to fall 
within the criteria that define the Summary BOE. 

Two examples are presented below. In these examples, assume the Summary BOE will 
include all estimates that meet the following criteria: 

 WBS ID: 1.1 
 Resource Department: 1001 
 EOC: (any value) 

Example 
In this example, the rename process results in an individual estimate being removed from 
the Summary BOE. 

Existing Estimates 

WBS ID Res Code EOC Res Dept. Overtime 

1.1 LAB1 L 1001 1.5 

1.1 LAB1 L 1002 1.5 

1.1 LAB2 L 1001  

1.1 MAT1 M 1001  
 

Rename Criteria 

Field Renamed 
From 

Renamed 
To 

Resource Code LAB2 LAB2 

Resource Department 1001 1002 

Overtime Factor   
 



MPM Projects   317 

Estimates Included in the Summary BOE Before Rename 

WBS ID Res Code EOC Res Dept. Overtime 

1.1 LAB1 L 1001 1.5 

1.1 LAB2 L 1001  

1.1 MAT1 M 1001  
 

Estimates Included in the Summary BOE After Rename 

WBS ID Res Code EOC Res Dept. Overtime 

1.1 LAB1 L 1001 1.5 

1.1 MAT1 M 1001  
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11.5  Shifting the Dates for a Project 

If you want to change the start 
date for a project, or part of a 
project, you can use the MPM 
Project Date Shift utility. The 
function changes dates and 
reprices. 

When changing the start date, 
you can apply the following 
restrictions: 

 Change the baseline date, 
ETC dates, or both 

 Limit the date changes to 
one or more legs of a 
WBS 

Figure A. Shifting project dates  

 Change milestone schedule dates, forecast dates, or both 
 Target the repricing by Element of Cost (EOC) 

Special Guidelines 
 MPM uses the rate tables designated for the project in the Project Maintenance 

window. If you want to use a different rate table, make the change before running 
the Estimate Reprice utility. If you change a rate table, MPM uses that rate table 
for all functions from that point forward. 

 Project Date Shift shifts days based on work days. A resource having a four-day 
work week will be shifted to a later date than a resource having a five-day work 
week. 

 Project Date Shift does not shift baseline estimates and milestone schedule dates. 
 When you shift baseline and/or ETC estimates and also shift milestones, both are 

shifted the number of work days between the original start date and the new start 
date. Each time you exercise the Shift Milestones option, MPM moves the 
milestones. 
If you shift baseline estimates and ETC estimates at different times, and use the 
Shift Milestones option both times, the milestones will be shifted twice. For this 
reason, when shifting baseline and ETC estimates separately, use the Shift 
Milestones option only the first time you shift. 
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 Project Date Shift makes permanent changes to the project data. If processing fails 
part way through the procedure, you will need to restore the data from the most 
recent backup. 

 If you use Project Date Shift to shift an estimate that was originally estimated by 
equivalent persons, spread non-linearly, and used the calendar equivalent person 
hours, the result will be a linear respread. This linear respread could give a 
different number of hours calculated for the estimate. 

 Project Date Shift does not affect the contract start and complete dates recorded in 
the Project Maintenance window. 

 If a WBS element and/or its children has one or more replan estimates, Date Shift 
does not shift baseline estimates and milestone schedule dates. 

Procedure 
To change the start and complete dates for a project: 

1. In the Project Maintenance window, select a project, open the Tools menu and 
select Project Date Shift. 

 MPM displays the Project Date Shift dialog box shown in Figure A. 

2. Select the estimates you want the date shift to affect: baseline, ETC, or both. 

3. Select the WBS leg you want to affect by clicking the Browse button and 
selecting a WBS leg. 

4. Enter the new start date. 

 MPM accepts most date formats and converts them to the format shown in 
Figure A. 

5. Choose whether to shift the milestone Schedule dates, Forecast (revised) dates, or 
both. 

6. For each EOC listed in the Reprice Conditioning grid, select the element you 
want to maintain constant during the reprice. 

 Select the Original Estimate Type option to keep the estimate type originally 
assigned to the resource when the resource was added to the baseline and ETC 
estimates. 

7. To accept the settings and initiate the date shift, choose OK. 

 When the process has completed or been terminated, MPM produces the Reprice 
Error Report listing all errors encountered. 
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11.6  Calculating BCWP 
Whenever you need to calculate Budgeted Cost of Work Performed (BCWP), you use the 
Calculate BCWP utility in Project Maintenance. 
For example, whenever you modify milesto
information in Integrated Planning, you will want 
to calculate a new BCWP

ne 

.  

 Select different sets of WBS elements 

WBS Element Options 

When calculating BCWP, you can apply the 
following restrictions: 

 Limit the date range 

Figure A. Calculating BCWP  

If you select this option: MPM calculates BCWP for: 

All WBS elements All WBS elements 

Statused, LOE, Key Event & hat has an estimate saved or 

ince the 

ilestone changes 

E, and Key 

Apportioned WBS Elements 
Any WBS element t
imported since the last BCWP calculation 
Any WBS element that has been repriced s
last BCWP calculation 
Any WBS element that has had m
saved since the last BCWP calculation 
All WBS elements with apportioned, LO
Event EVMs 

Only Statused & Apportioned , except LOE and Key Event elements 
WBS Elements 

Same as above
are included only if they have been statused. 

Special Guidelines 
e BCWP, Fee is not calculated because it does not apply to 

ays calculates a WBS percent complete for all elements in the WBS 

tatused will have an impact on 

 When you calculat
BCWP. 

 MPM alw
hierarchy regardless of the WBS Element option you choose. 

Impact of Budget Changes on BCWP Values 
Any change to the budget after WBS elements have been s
the calculation of BCWP. For information on budget changes, refer to section 9.7 Impact 
of Budget Changes on BCWP Values. 
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Procedure 
To calculate BCWP for a project: 

1. In the Project Maintenance window, select a project. 

2. Open the Tools menu and select Calculate BCWP. 

MPM displays the BCWP dialog box shown in Figure A. 

3. Enter the From and Through dates. 

Enter the dates in the MMM YY format. Note, MPM will accept most date 
formats and convert them to this format. 

4. Select one of the WBS element options. 

5. Initiate the calculation by choosing OK. 
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11.7  Posting Weekly Data 

The Post Weekly Data utility enables you to more closely manage budget, performance 
and actuals for each project. With this utility you can spot negative trends more quickly 
and take corrective action.  It provides the means to calculate, store and report earned 
value on a weekly basis.  You can track hours and dollars for BCWS, BCWP, ETC and 
ACWP for a three-month window that you define.  

 
 

 

 

 

 

 

 

 

 

 

Figure A. The process of posting weekly data begins with this dialog box. 

Only authorized users may access and use this feature.  You must have been granted 
access to the project and to the Post Weekly Data feature within the project.  Security for 
this feature is listed under the Project Maintenance options. (For details on setting up 
security for this feature, see Global Files, Chapter 8, Controlling Security Access to 
MPM.)  

Before you post weekly data, the Weekly Data Information section of the Calendar Setup 
must be completed.  On the Calendar Setup dialog box you indicate whether your 
organization’s calendar uses whole weeks or partial weeks.  If partial weeks are selected, 
you select the starting day for each week and enter the number of hours in your workday.  
(For details on setting up your calendar, see Global Files, topic 2.4, Creating, Changing 
and Saving Calendars.) 
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The posting start date, posting period, data types to be posted and the spreading method 
are specified on the Post Weekly Data dialog box shown in Figure A.  You can also limit 
the weekly posting to a specified WBS leg.  You then run the Post Weekly Data utility. 

Once your weekly data has been calculated and stored, you can: 

 Report the data with the Weekly Performance Report and Weekly EOC Report.   
 Export the data. Two formats are provided for exporting weekly data. You may 

select either WBS or EOC format. 
 Read the weekly table using Microsoft Access.   

Three Month Window Start 
The Three Month Window Start drop-down list box contains the fiscal months in the 
project calendar. The initial Three Month Window Start default that appears before any 
data is posted is the previous fiscal month. The default month may be changed by 
selecting a different month from the drop-down list.  After a week is posted, the start 
month is displayed to the right of the list box. 

 

Weekly data is stored in a rolling three month window.  When the dates of the three 
month window change, stored data falling outside the window is removed from the 
weekly table. 

Posting Period 
The Posting Period drop-down list box contains the week beginning and end dates in the 
three month window. The initial default date range that appears in the Posting Period box 
before any data is posted is the beginning and end date of the first week in the three 
month window. The default week may be changed by selecting a different week from the 
drop-down list.  After a week has been posted, the Posting Period defaults to the last 
week posted. The last posted week is displayed to the right of the list box as the Last 
Posting Period. 

Data Types to Post 
You can post weekly data for Baseline, BCWP, Actuals or ETC.  If you want to include 
BCWP in the data you are posting, you must calculate BCWP in the usual manner before 
you begin the posting process. If you want to include Actuals in the data you are posting, 
you must first import or manually enter the Actuals for that month. 
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Baseline/ETC Spreading Method 
When posting the weekly data, there are two spreading methods available for posting 
Baseline and ETC: Linear or Milestone.  When you access the Post Weekly Data 
window, the system will always default to the last spreading method selected.  

 Linear: The Linear method uses the earliest resource start and the latest resource 
complete to determine the start and end of the spread.  Each month’s budget is 
spread linearly based on the available weeks and workdays in the month. 

 Milestone:  The Milestone method checks the earned value method (EVM) for 
each WBS included in the data to be posted.   
 
If the WBS is using a milestone EVM (Milestone Weights, 0/100, 25/75, 40/60, or 
50/50), MPM determines the percentage for each milestone by looking at the 
weight and date of the milestone. The percentage is determined by dividing the 
total weight for all milestones in the month by the weight of the milestones that 
fall within each week being posted.  The resulting weekly percentage is then 
multiplied by the Baseline/ETC in the month to arrive at the weekly budget 
spread.   
 
Even though you select Milestone as the spread method, the data being posted 
may consist of WBS elements using a variety of EVMs; some EVMs with 
milestones and some without.  In that case, data is spread linearly for any WBS 
using the following EVMs:  Milestone Weights with Percent Complete, % 
Complete, BCWP Entry, Level of Effort, Earned Standards, or Key Event. 

Special Guidelines 
 In order to generate accurate data, the posting of weekly data should always be 

done sequentially.  Process Week 1, Week 2, etc. in sequence rather than 
processing Week 2 and then Week 1, Week 3, etc. 

 Once data for any given week has been posted, no changes should be made to the 
data.  If changes are necessary: 
o Data must be posted in sequence again, beginning with the week in which 

changes to the data were made; or 
o You can make the change as of time now and see the change reflected in the 

current week. The cumulative for the month will be accurate. 
 If you skip Week 1 and then process for Week 2, BCWS/ETC will be spread for 

the entire three month window including Week 1 and Week 2 but all BCWP and 
Actuals will appear only in Week 2. There will be no BCWP and Actuals in Week 
1. 
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 For LOE EVM, if no BCWS is posted for the three month window, then only 
posting BCWP would not show any BCWP values since there is no BCWS. 

o For LOE WBS ID's Weekly BCWP = Weekly BCWS through the posted week 
no matter what the monthly BCWP value is. 

Procedure 
Before you begin posting weekly data, make sure you have completed the Weekly Data 
Information section of the Calendar Setup dialog. 

To post weekly data for a project:  

1. In the Project Maintenance window, select a project. 

2. Open the project by clicking on the yellow folder icon adjacent to the project 
name. 

3. Open the Tools menu and select Post Weekly Data. 
MPM displays the Post Weekly Data dialog box shown in Figure A. 

4. Select the Three Month Window Start from the list box. The dates that appear in 
the list box are derived from the project calendar. 

5. Select the Posting Period from the list box.  The dates that appear in the list box 
are derived from the project calendar and the defined three month window. 

6. If appropriate, limit the posting by clicking the Browse button and selecting a 
WBS element from the Limit to WBS Leg box. 

7. Check the types of data you want to post.  You may select any or all of the data 
types.  If you want to include BCWP in the data you are posting, you must 
calculate BCWP in the usual manner before you begin the posting process. If you 
want to include Actuals in the data you are posting, you must first import or 
manually enter the Actuals for that month. 

8. Select either Linear or Milestone as the Spreading Method. 

9. To accept the settings you have selected and begin posting, click OK. 
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11.8  Audit Trail 

The Audit Trail of Estimates creates an audit log for every estimate change that occurs.  
The level at which changes are tracked is dependent on the method used for updating the 
estimate.   

For example, a change made in Integrated Planning Baseline will track to the 
WBS/Resource level whereby an Import will be tracked at the project level…not at the 
detail level.   

This audit log helps system and project administrators track who made what change to 
what data in the system.  It also assists in tracking down change control problems.  When 
changes are occurring in the database, the database administrators can go to this log and 
see who made what changes when. 
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11.8  Audit Trail 

11.8.1  Setting the Security Audit Trail Options 
To allow a user access to the Audit Trail options, you will need to give them access in the 
Project Features dialog of the Security module. The Project Features dialog box is used to 
assign the features a user will be able to access. It works in the same way as other 
hierarchy dialog boxes in MPM. 

There are three places that you can give them access: 

 Project Maintenance | Audit Trail 
 Project Maintenance | Delete Project Audit Trail 
 Exports  | Audit Trail 

Note: If you do not select any items in the Project Features dialog box, the user will have 
access to all features. 

Setting the Project Maintenance Security Audit Trail options 
1. Select a project and do one of the following: 

 Click the Project Features button  in the Toolbar. 
 Select Tools | Project Features. 

MPM displays the Project Features dialog box. 

2. Now do one of the following: 

2.1. Project Maintenance | Audit Trail Option: 

2.1.1. Select the plus sign  next to the Project Maintenance option to 
expand the view. 
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2.1.2. Click the box next to Audit Trail to select it. 

2.2. Project Maintenance | Delete Project Audit Trail Option: 

2.2.1. Select the plus sign  next to the Project Maintenance option to 
expand the view. 

2.2.2. Click the box next to Delete Project Audit Trail to select it. 
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2.3. Exports  | Audit Trail Option 

2.3.1. Select the plus sign  next to the Project Maintenance option to expand 
the view. 

2.3.2. Click the box next to Audit Trail to select it. 

 
3. To save the selections, choose OK.  
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11.8  Audit Trail 

11.8.2  Setting the Audit Trail Options in Project 
Maintenance 

Set the Audit Trail options in Project Maintenance using the Audit Trail options dialog 
box. This option will be grayed out if a user does not have security access to this (see 
11.8.1 Setting the Security Audit Trail Options). 

Setting Audit Trail Options 
1. In the Project Maintenance screen, select Tools | Audit Trail.  

 
The Audit Trail Options dialog displays. 

 
2. Select the options that you wish to use for Audit Trail: 
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 Audit Trail – Check this box to have the Audit Trail on, or deselect this box to 
turn the Audit Trail off. 

 Estimates to Audit – Select either Baseline or ETC, or select both. 

 Document Audit Trail Entry – Check this box to allow the user to enter text 
descriptions regarding the current changes. 

 Dollar Level – Select which dollar level you would like the Audit Trail to track. 
The options are: 

o Prime 

o Total Burden 

o Total Cost 

o Total Dollars 

o Total Price 

3. Select OK to save the changes. 
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11.8  Audit Trail 

11.8.3  Deleting Audit Trail Data in Project 
Maintenance 

Delete the Audit Trail data in Project Maintenance using the Delete Project Data dialog 
box.  This option will be grayed out if a user does not have security access to this (see 
11.8.1 Setting the Security Audit Trail Options). 

The Delete Project Data Dialog box 
You can choose to delete Audit Trail data for a specific date range for a specific project. 

1. In the Project Maintenance screen, select a project then click Edit | Delete Project 
Data 

 
 

 

 

 

 

 

 

 

 

The Delete Project Data dialog displays. 
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2. Place a check in the Audit Trail box and type in From and Through Dates. If date 

fields are left blank, then the entire Audit Trail file for that project is deleted. 

3. Select OK to continue with the deletion, or Cancel to cancel the deletion and return to 
the Project Maintenance screen. 
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12.1  Introduction to Replanning 
During the life of a contract, changes may take place that make the available contract 
budgets for the remaining work insufficient. When this happens, it is no longer practical 
to measure performance against the available budgets. Under these circumstances, you 
should formally reprogram or replan the project. 

 
Figure A. Project Replan dialog box 

Formal reprogramming by a contractor may include replanning future work, replanning 
in-process work, or adjusting cost and/or schedule variances. Reprogramming allows the 
contractor to adjust the amount of budget for the remaining work to a more practical 
amount that provides realistic budget objectives, work control, and performance 
measurement. 

The MPM replanning function conforms to government requirements, and can be tailored 
to meet the needs of the contracting parties. All changes to baseline budgets are fully 
documented and traceable. 
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Applications 
Using the MPM replanning function, you can: 

 Replan an entire project, or specific WBS elements and legs 
 Replan smaller projects that do not require earned value 
 Nullify a cost variance 
 Nullify a schedule variance 
 Nullify cost and schedule variances 
 Establish ETC after entering baseline estimates 
 Set ETC equal to baseline after replanning the baseline 

Accessing the Replan Function 
To access the Replan function: 

1. Open the Project Maintenance window and select a project. 

2. From the Tools menu, select Project Replan.  
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12.2  Replanning Rules and Assumptions 
To use MPM’s Replanning function effectively, you should understand how it works and 
the assumptions that the function makes. There are exceptions to these rules if you are 
setting baseline equal to actuals when there is no established baseline. 

WBS Requirements 
You can replan a project only if the following criteria are met: 

 The WBS element(s) must have at least one estimate, even if the estimate has a 
zero balance. If there are no estimates, MPM skips the WBS element when it 
performs the replan. 

 If there are estimates, the WBS element(s) must have appropriate cumulative 
values through the replan month. If there are no cumulative values, MPM skips 
the WBS element(s) when it performs the replan. 

In-Process or Completed Work Packages Only 
You can perform a replan on in-process and completed work packages only. You cannot 
replan future projects that have not started. 

In-process work packages have one or more of the following: 

 Cumulative BCWS (Budgeted Cost of Work Scheduled) 
 Cumulative BCWP (Budgeted Cost of Work Performed) 
 Cumulative ACWP (Actual Cost of Work Performed) 

Work packages are defined as completed when the WBS percent complete equals 100%. 

When replanning, no assumptions are made about future BCWS or the milestones for 
BCWP. It is your responsibility to replan future work by manually adjusting BCWS and 
milestone weights for BCWP after replanning. 

What Happens During a Replan 
When you perform a replan, the following happens: 

 Replan estimates are stored in the format Replan *EOCcode (for example, 
Replan *L). 

 BCWS is adjusted at all costing levels (equivalent persons, hours through total 
price). 

 BCWP is adjusted at costing levels hours through total dollars. 
 Standard hours are not calculated. 
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 BCWS is summed at each burden level if you are setting Baseline = Earned 
Value or Actuals. Therefore, detailed burdening information for a replan 
estimate is not available. 

Restoring Data to Its “Before Replan” State 
If you want to restore your data to its “before replan” state, it is always best to go to the 
backup you made of the data prior to the replan. If, for some reason, you cannot go to the 
backed up data, you may use the procedures below for the options listed. 

If you perform a replan using the Set Basline = Actuals or Set Baseline = Earned Value 
option, replan estimates can be deleted using the Delete Project Data option in Project 
Maintenance. 

If you have incorrectly performed a replan using Set Earned Value = Actuals and want to 
restore the date to its “before replan” state, you can restatus and recalculate BCWP in the 
replan month. 

If you perform a replan using the Set Baseline and Earned Value = Actuals option, you 
can delete replan estimates using the Delete Project Data option in Project Maintenance, 
then restatus and recalculate BCWP in the replan month. 

Distributed Elements 
Distributed elements may not be replanned. Replanning should be done within the sub-
project and results will be rolled up and transferred via the normal distributed update 
cycle. 

Other Guidelines 
Replans can be performed more than once on a WBS. If you perform a replan more than 
once in the same month, the earlier value is cleared and the new replan is performed. 

If you have performed one or more replans and then go back and make changes to data 
that occurred prior to the replan, you must also go back and redo the replans from the 
earliest to the latest in sequence. 

All replans are calculated by adjusting cumulative values through the month and year 
specified for the replan. 

The Replanning function is designed to be used when the WBS elements being replanned 
have BCWS, BCWP, and ACWP loaded at the same level of the WBS tree. If estimates 
and actuals are entered at different levels, you must replan the project manually. 
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12.3  How Replanning Affects Other MPM Functions 
Replanning affects many of the other MPM functions.  

WBS Tree 
Replan values are rolled up the WBS hierarchy in the same manner as other values. 
However, start and complete replan dates for a replan estimate are not rolled up the 
hierarchy. 

Estimating ETC 
Replanning does not apply to ETC because it affects baseline estimates only. 

Apportioned Estimates 
A replan estimate cannot be a base estimate (an estimate used to create an apportioned 
estimate), or an apportioned estimate. 

Estimate Reprice, Adjust, and Rename 
Replan estimates are not repriced, adjusted, or renamed. 

Project Date Shift 
If a WBS element and/or its children has one or more replan estimates: 

 Date Shift does not shift baseline estimates and milestone schedule dates. 
 Date Shift does shift ETC estimates and milestone forecast dates. 

Resource BOE 
You can enter or import a Resource BOE (Basis of Estimate) against a replan estimate. 

Data Export 
Replan estimates can be exported in the same manner as other estimates. 
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Data Import 
Replan estimates cannot be imported. 

Reports 
Replan *EOCcode is a valid resource code selection for report conditioning. 
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12.4  General Replan Procedure 
When you replan a project, you use the Project Replan dialog box shown in Figure A. 
Before replanning any project, always backup the project data. 

 
Figure A. Project Replan dialog box 

Procedure 
To replan a project: 

1. Select a project in the Project Maintenance window. 

2. From the Tools menu, select Project Replan. 

3. Select one of the Replan options. 

 The options are described in detail in the next topic. 

4. Select the If no Baseline, Set Baseline=Actuals option if it is appropriate and 
available. 

 This option is described in detail in the next topic. 

5. If appropriate, limit the replan by clicking the Browse button and selecting a 
WBS element from the Limit to WBS Leg dialog box. 
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 If you select an element, the replan is applied to the element and its children. If 
you leave this field blank, all WBS elements are included in the replan. For more 
information on using the Limit to WBS Leg dialog box, see topic 12.6  Selecting 
a WBS Leg. 

6. Select In-process, Completed elements, or both. 

 In-process work packages have either cumulative BCWS or ACWP through the 
replan month. Completed elements have a WBS percent complete equal to 100%. 

7. (Optional) Enter an identifier into the XREF-EST field if it is available.  

 This option is described in detail in the next topic. 

8.  Set the replan month. 

 The replan month is the month in which the replan will occur. All replan 
adjustments are cumulative through the replan month. Replan estimates will be 
reported and displayed on reports in the month and year you enter here. Replan 
estimate start and complete dates are not rolled up through the WBS hierarchy. 

9. Select the EOCs (Elements of Cost) you want included in the replan by double-
clicking the Include field in the Condition by EOC grid. 

 To deselect an EOC, double-click it again. 

10. To accept the settings and begin the replan, click OK. 

 MPM performs the replan and generates the Processing Result Report. The report 
lists any WBS elements that could not be processed. 

Special Guidelines 
 Always make a backup of the project before performing a replan. 
 To do a before and after comparison, run a report before and after performing 

the replan that shows the data you are replanning through the replan month. For 
example, you could run the S/P/A Recap by EOC or CPR report. 
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12.5  Selecting a Replan Option 
When you replan a project, you select one of five options. The option you select impacts 
how MPM replans the project.  

 
Figure A. The Replan option you choose impacts how MPM replans a 
project. 

Options Purposes 
The options and their purposes are: 

This option: Is used to: 

Set Baseline equal to Actuals Replan smaller projects that do not require 
calculation of earned value 

Set Earned Value equal to Actuals Nullify a cost variance 

Set Baseline and Earned Value equal 
to Actuals 

Formally reprogram a project and nullify both cost 
and schedule variances 

Set Baseline equal to Earned Value Nullify a schedule variance 

Set Estimate to Complete (ETC) 
equal to Baseline 

Establish ETC estimates based on baseline estimates 
or set ETC equal to baseline after replanning 
baseline estimates 
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If No Baseline Option 
If there is no baseline established for the project, you can select the If No Baseline, Set 
Baseline = Actuals option. The option is available for the following Replan options: 

 Set Baseline = Actuals 
 Set Baseline and Earned Value = Actuals 

This option is generally used for negotiated or undefined work where a contractor has 
been asked to begin work and report Actual Cost of Work Performed (ACWP) only. 

If this option is not checked, the WBSs with no baseline will be skipped in the replan. If 
the option is checked, the actuals data will be copied to the baseline, even if no baseline 
exists. 

Following is an example of a scenario and result that would occur if this option was used. 
Note the variance (difference) between Rollup BCWS and Rollup ACWP is zero. 

 Detail 
BCWS 

Detail 
ACWP 

Rollup 
BCWS 

Rollup 
ACWP 

WBS A.1     

  Work Package before replan 0 200 0 200 

  Work Package after replan 200  200 200 

XREF-EST Field 
The XREF-EST field is enabled when the following Replan Options are selected: 

 Set Baseline = Actuals 

 Set Baseline and Earned Value = Actuals  

 Set Baseline = Earned Value 

This is an optional 20-character user-defined field. It is provided as an additional 
identifier. The XREF-EST field is used during reporting, exporting, or onscreen filtering 
as a wild card, to match a specific group of data. 

Sub-Topics 
The Replan options are described in the following sub-topics: 

12.5.1  Set Baseline Equal to Actuals 
12.5.2  Set Earned Value Equal to Actuals 
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12.5.3  Set Baseline and Earned Value Equal to Actuals 
12.5.4  Set Baseline Equal to Earned Value 
12.5.5  Set Estimate to Complete (ETC) Equal to Baseline 
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12.5  Selecting a Replan Option 
12.5.1 Set Baseline Equal to Actuals  

The Set Baseline = Actuals (BCWS = ACWP) option is ideal for replanning smaller 
projects that do not require earned value. 

 
Figure A. Set Baseline=Actuals option 

Special Guidelines 
 The If No Baseline option is available. For an explanation of this option, see 

topic 12.5  Selecting the Replan Options. 

 The XREF-EST option is available. For an explanation of this option, see topic 
12.5  Selecting the Replan Options. 
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Example 
In the following example, there are actuals against only one EOC: Labor. 

 JAN FEB MAR APR MAY JUN 

BCWS Cum 10 20 30 40 50 60 

ACWP Cum 20 40 60 80 100 120 

Replan *L    40   
 

In the example, a new resource estimate (Replan *L) is added to the BCWS for Labor and 
the estimate has only one value (40), the cumulative difference between BCWS and 
ACWP. The replan estimate will contain adjusted values at all costing levels (hours, OH, 
etc.) 

If you recalculate BCWP after performing a replan using this scenario, you should 
specify the month of May as the Calculate BCWP From month to ensure that past history 
is not changed due to the adjustment to BCWS. 
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12.5  Selecting a Replan Option 
12.5.2 Set Earned Value Equal to Actuals  

The Set Earned Value Equal to Actuals (BCWP = ACWP) option is used to nullify a 
cost variance. 

 
Figure A. Set Earned Value = Actuals option 

Special Guidelines 
 Back up your data before performing the replan. 
 There is no EOC conditioning available for this option. All EOCs defined for 

the project are displayed in the Condition by EOC table, but they cannot be 
selected or deselected. 

 This Project Replan option is designed to be used when the WBS elements being 
replanned have BCWS, BCWP, and ACWP loaded at the same level of the WBS 
tree. If estimates, earned value, and actuals are entered at different levels, you 
must manually replan your project. 

 The If No Baseline option is not available. For an explanation of this option, see 
topic 12.5  Selecting the Replan Options. 

 The XREF-EST option is not available. For an explanation of this option, see 
topic 12.5  Selecting the Replan Options. 
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Examples 
In the following example, there are actuals against only one EOC: Labor.  
The BAC = $210. 

 JAN FEB MAR APR MAY JUN 

BCWP Cum 10 20 30 40 50 60 

ACWP Cum 30 60 80 100 200 300 

Replan *L    60   
 

When MPM performs the replan, the cumulative BCWP total dollar amount for the 
replan month is updated in the BCWP file to be equal to ACWP, then a new percent for 
April is calculated. All costing levels are adjusted (hours, prime, overhead, etc.) except 
fee and equivalent persons.  

Results 
The values are then rolled up through the WBS hierarchy for that month with the 
following results. 

 
 
 
 
Yr/Mo 

BCWP File Content 

Before Replan After Replan 

Cum 
Percent 

Cum 
Dollars 

Cum 
Percent 

Cum 
Dollars 

199801 .0476 10 .0476 10

199802 .0952 20 .0952 20

199803 .1428 30 .1428 30

199804 .1904 40 .0476 100

199805 .2380 50 .2380 50

199806 .2857 60 .2857 60

 

After you replan BCWP = ACWP, replan future work by manually adjusting the BCWS 
and the milestone weights for BCWP. If you recalculate BCWP after performing a replan 
using the above scenario, specify the month of May as the Calculate BCWP From month 
to ensure that past history is not changed due to the adjustment to BCWP. 
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12.5  Selecting a Replan Option 
12.5.3 Set Baseline and Earned Value Equal to Actuals  

The Baseline and Earned Value Equal to Actuals (BCWS & BCWP = ACWP) option is 
used to formally reprogram a project. It nullifies both cost and schedule variances. 

 
Figure A. Set Baseline and Earned Value = Actuals 

Special Guidelines 
 Back up your data before performing the replan. 
 There is no EOC conditioning available for this option. All EOCs defined for 

the project are displayed in the Condition by EOC table, but they cannot be 
selected or deselected. 

 When MPM performs this replan, it processes data in the following order: 
- It sets BCWS equal to ACWP. 
- It sets BCWP equal to ACWP. 

 This Project Replan option is designed to be used when the WBS elements being 
replanned have BCWS, BCWP, and ACWP loaded at the same level of the WBS 
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tree. If estimates, earned value, and actuals are entered at different levels, you 
must manually replan your project. 

 The If No Baseline option is available. For an explanation of this option, see topic 
12.5  Selecting the Replan Options. 

 The XREF-EST option is available. For an explanation of this option, see topic 
12.5  Selecting the Replan Options. 

Example 
In the following example, there are actuals against only one EOC: Labor.  

 JAN FEB MAR APR MAY JUN 

BCWS Cum 10 20 30 40 50 60 

Replan *L    60   

ACWP Cum 30 60 80 100 200 300 

BCWP 5 5 10 20 25 30 

Adjust 
Labor Value 
of BCWP 

   80   

 

After performing the BCWP = ACWP replan, it is your responsibility to replan future 
work by manually adjusting the BCWS and the milestone weights for BCWP. 

If you recalculate BCWP after performing a replan using the above scenario, you should 
specify the month of May as the Calculate BCWP From month to ensure that past history 
is not changed due to the adjustment to BCWP. 
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12.5  Selecting a Replan Option 
12.5.4 Set Baseline Equal to Earned Value  

The Set Baseline Equal to Earned Value (BCWS = BCWP) option is used to nullify a 
schedule variance. 

 
Figure A. Set Baseline = Earned Value 

Special Guidelines 
 Back up your data before performing the replan. 
 In-process work packages are defined as work packages that have either 

cumulative BCWS or cumulative BCWP through the replan month. 
 MPM performs a replan only if there is cumulative BCWS or BCWP through 

the replan month on the WBS. If an EOC does not have cumulative BCWS or 
BCWP through the replan month, that EOC will be skipped during the replan. 

 The If No Baseline option is not available. For an explanation of this option, see 
topic 12.5  Selecting the Replan Options. 

 The XREF-EST option is available. For an explanation of this option, see topic 
12.5  Selecting the Replan Options. 
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Example 
In the following example, there are actuals against only one EOC: Labor. 

 JAN FEB MAR APR MAY JUN 

BCWS Cum 10 20 30 40 50 60 

BCWP Cum 5 5 10 10 20 30 

Replan *L    -30   
 

In the example, a new resource estimate (Replan *L) is added to the BCWS for labor and 
the estimate has only one value (-30), the cumulative difference between BCWP and 
BCWS. The replan estimate (Replan *L) will contain adjusted values at all costing levels 
(hours, overhead, etc.) except fee. 

If you recalculate BCWP after performing a replan using this scenario, you should 
specify the month of May as the Calculate BCWP From month to ensure that past history 
is not changed due to the adjustment to BCWS. 
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12.5  Selecting a Replan Option 
12.5.5 Set Estimate to Complete Equal to Baseline  

When you are entering baseline estimates for a project (ETC = BCWS), you have the 
option of entering the estimates as ETC as well. If you set the option to save baseline 
only, you can use this replanning method to establish ETC estimates for the project 
without going back and re-entering all the estimates. 

 
Figure A. Set Estimate to Complete = Baseline 

Special Guidelines 
 Back up your data before performing the replan. 
 When you select the Estimate to Complete = Baseline option, MPM inactivates 

all other options in the Project Replan dialog box. 
 All baseline estimates are copied to the ETC. 
 The system ignores the ETC Rate Table specified in the Project Maintenance 

window and sets ETC equal to BCWS. 
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12.6 Selecting a WBS Leg 
You can limit the replan to a WBS element and its children using the Limit to WBS Leg 
option. The option is available for all replans except Set Estimate to Complete = 
Baseline.  

Figure A. You can limit a replan to a specific WBS leg. 

Expand/Collapse button 
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Procedure 
To select a WBS leg: 

1. After selecting a replan option, click the Browse button in the Limit to WBS Leg 
group box. 

 MPM displays the Limit to WBS Leg dialog box shown in Figure A. 

2. Expand and collapse the legs by clicking the Expand/Collapse buttons. 

 If you select a collapsed parent element, the parent element and its children will 
be included in the replan. If you select a child element, only that child element 
will be included in the replan. 
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13.1  Introduction to the Program Log 

The Program Log provides a synergistic link between budget data and the internal control 
procedures and practices that implement budget changes. 

The Program Log is used to record total budget and all customer-directed changes that 
affect the baseline. Changes are identified as negotiated changes or authorized unpriced 
updates. The Program Log contains the status of the Management Reserve (MR) and 
Undistributed Budget (UB). 

The values recorded on the Program Log are displayed on the Headers dialog when you 
access it in preparation for generating a C/SSR or CPR.  The table shown in Figure A 
lists the values for each report that are derived from the Program Log.  

Header Values Derived from Program Log 

Values C/SSR CPR 1 CPR 2 CPR 3 
Original Target Cost     
Negotiated Cost     

Negotiated Contract Change     
Current Target Cost     
Authorized Upriced Work     
Contract Budget Base     
Target Profit Amount     

Estimated Price     

Target price     

Management Reserve (BCWS)     
Management Reserve (LRE)     

Undistributed Budget (BCWS)     

Undistributed Budger (LRE)     

Figure A.  Values that appear in these fields on reports are derived from the Program Log 
and/or the Headers conditioning window. 

By entering new values for the above fields on the Headers dialog, you can override the 
values derived from the Program Log.  However, if your organization uses the Program 
Log to record contract data, we recommend that changes to these values be made using 
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the Program Log so as to maintain its accuracy.  When changes are made on the Headers 
window, the changes appear only on the report currently being generated and do not 
change the values previously recorded on the Program Log.  

The Role of the Program Log in Government Reporting 
If your project requires submittal of the C/SSR and CPR government reports, it is very 
important to create and maintain Program Log to satisfy control and audit requirements 
for government contracting. MPM uses the values you enter in the Program Log to 
perform calculations, which in combination with header values you also enter, result in 
computed fields displayed on the C/SSR and CPR report headers.  See Figure B. 

Program Log +
CPR Header

values you enter
Calculated values
on CPR Reports=

Program Log +
C/SSR Header

values you enter
Calculated values
on C/SSR Report=

 
Figure B. Calculations Used in Government Reporting.  

Contract Budget Base (CBB) and Total Allocated Budget (TAB) 
The Contract Budget Base (CBB) represents two things on a contract: 1) the total amount 
of work authorized and 2) the amount of budget allocated to accomplish the work. 

CBB = Negotiated Cost + Authorized Unpriced Work 

The Total Allocated Budget (TAB) is the sum of the Total Dollars in the budget, the 
Management Reserve (MR) and the Undistributed Budget (UB).  

TAB = Total Dollars + MR + UB 

To keep your project in balance: 

 The CBB should equal the TAB 
 The TAB shown in the Program Log should equal the MPM derived data  

Figure C illustrates the relationship between the different components which make up the 
Program Log. 
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Figure C. The balancing act between CBB and TAB 

Creating CBB Transactions 
When you first initiate your project, enter a Program Log transaction for the original 
contract price (less the contract fee), which becomes the beginning CBB. Then as time 
goes on, enter additional transactions to document changes in your contract. MPM 
automatically calculates the new CBB total, which you can compare to the TAB total. 

Creating TAB Transactions 
To distribute CBB to the budget, MR and UB, enter transactions for these amounts. If 
desired, you can monitor prime, overhead, total burden, G&A, and COM coming from 
your MPM project and enter those budget values into the Log. The Element of Cost 
(Baseline – Recap) Report provides all these values. To incorporate them into your Log: 

1. Run the Element of Cost (Baseline – Recap) Report prior to entering Logs. 

2. Incorporate budget changes in the WBS. 

3. Rerun the Element of Cost (Baseline – Recap) Report and enter G&A and COM 
amount differences in the G&A and COM fields in the Program Log. 

4. Enter the total burden amount (distributed budget) differences that can be derived 
by comparing the two Element of Cost (Baseline – Recap) reports. 

If differences exist between the CBB total and the TAB total, adjustments must be made to 
the Log. The Element of Cost (Baseline – Recap) Report can show where discrepancies 
exist, or where budget adjustments are needed, by comparing the total costs. 
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13.2  Accessing the Program Log Window 

You open the Program Log window from the MPM Menu Manager. When you open the 
Program Log window, you select the project you want to view. 

Procedure 
To open the Program Log window: 

1. From the Menu Manager window shown in Figure A, do one of the following: 

 Select the Projects tab and choose the Program Log icon  
 Choose Projects|Program Log from the File menu.  

MPM displays the Program Log Open dialog box. 

  
Figure A. Select the Program Log icon. 

2. Choose a project from the Project list box. 
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3. To accept the selections and display the Program Log window shown in Figure B, 
click OK. 

 
Figure B. The Program Log window 
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13.3  Orientation to the Program Log Window 

You use the Program Log Window to edit and view the Program Log transactions. A 
toolbar gives you quick access to common tasks, and an optional Total window shows 
the CBB and TAB totals. The Program Log grid displays the information about each 
Program Log transaction. Each transaction is represented by a single row. 

Transaction rows Sub-totals

Total window

Filter button

 
Figure A. The Program Log window 

Program Log Listing 
MPM automatically sorts all Program Log transactions by transaction date each time you 
open the Program Log window.  

Navigating the Program Log Grid 
To navigate through the fields in the Program Log grid: 

 To advance to the next or previous field, press the Tab/Shift+Tab or Arrow keys.  
 To move between rows, use the Up and Down Arrow keys.  
 Use the horizontal scroll bar to bring additional columns into view. When 

dragging the horizontal scroll bar, a 
pop-up displays the current Log field. 

 Use the vertical scroll bar to bring additional rows into 
view. When dragging the vertical scroll bar, a pop-up 
displays the current Program Log row and number.  

 To move to any cell, click the cell with the mouse.  
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Displaying and Hiding Program Log Fields 
MPM displays the Program Log fields as columns in the Program Log grid. You can 
display or hide any or all of the columns, using Column Hide on the Format menu. To 
select a column, click in the column’s heading. To select or deselect multiple columns, 
use the Shift key while clicking the mouse button as you normally would within 
Windows. 

Filtering Program Log Transactions 

Figur
to fi

e B. Enter a range of Log Dates
lter the Log Transactions.

You can filter the Program Log to display only the transactions you need to see. To do 
this, use Filter on the Tools menu (or click the 
Filter button) to select a subset of transactions by 
customer reference, internal reference, or a range 
of log dates. Selecting one of the menu options 
brings up a dialog box with a list box of available 
values to choose from. In Figure B, the user 
filtered to see only log transactions in the date 
range 1-Aug-97 to 1-Sep-97. To turn off 
filtering, choose All Data. 

Checking the Totals Window 

Figure C. Check the Totals Window.

At any point in your editing process, you can easily check your totals by looking at the 
Totals window. Bring up the Totals window by either choosing Total Window from the 
View menu, or clicking the Total button . 
This window is a floating toolbox that is 
always on top. You can leave it up while you 
continue your editing, or close it. The menu 
option shows  if the Totals Window is 
toggled on. This window shows CBB, TAB, 
and the variance between them (CBB - TAB).  

Previewing and Printing Program Log Transactions 
You can preview and print the Program Log data using the options on the File menu. For 
complete details on using these options, see Using MPM of the Getting Started manual. 
Note that Print and Preview only show the columns and Program Log transactions which 
you have displayed on the Program Log grid.  
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13.4  Creating the Program Log 

You use the Program Log grid to create and edit the Program Log transactions. MPM 
supplies powerful spreadsheet-like controls to make it easy. Most operations can be 
performed in several different ways, using either the keyboard, the mouse, or both.  

 
Figure A. To create a new transaction, press the Insert key.  

To add a new Program Log transaction, press the Insert key or choose Insert Log from 
the Edit menu. MPM inserts a new row after the current transaction. In Figure A, the new 
line has been added after 1-Aug-97. The <Required> Program Log field awaits entry. 

Required Entries 
You must fill in the Log Date field when creating new Program Log transactions. See 
topic 13.5  Program Log Field Descriptions for detailed information. 

Entering Transactions 
To enter a Negotiated Cost transaction, enter the Negotiated Contract Change. 

To enter an Authorized Unpriced Work transaction, enter the Authorized Unpriced Work 
amount. 

To enter a Management Reserve (MR) transaction, enter the Management Reserve 
amount, and optionally, a description of the MR transaction. MR identifies contract 
budget set aside for contingencies. MR is always maintained at the total cost level. 
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Figure B. Entering data 

To enter an Undistributed Budget (UB) transaction, enter the Undistributed Budget 
amount, and optionally, a description of the UB transaction. UB identifies budget not yet 
distributed to control accounts, usually as a result of contract changes, and is normally a 
temporary repository for unallocated budget. UB is always maintained at the total cost 
level. 

To maintain the Total Allocated Budget (TAB) with a greater level of detail, you can also 
enter transactions which contain Prime, Overhead, Total Burdened, G&A, COM, Total 
Cost, and Total Dollars from the Element of Cost (Baseline – Recap) report. 

Entering Numeric Values 
When entering numeric values for contract changes, enter positive values preceded by a 
plus (+) sign or without a precedent; enter negative values preceded by a minus sign (-). 

Saving Program Log Information 
To save the Program Log data, do one of the following: 

 Click the Save button  
 Choose Save from the File menu or press Ctrl+S 

If Prompt for Save has been set, MPM prompts for verification.  
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13.5  Program Log Field Descriptions 

These are the fields on the Program Log grid. Several fields are required entries, and 
display <Required> in the cell until you fill them. You can change the columns that are 
displayed using Column Hide on the Tools menu. 

 Log Entry Number — This read-only field shows the Log Entry Number, which 
MPM automatically generates. 

 Log Date — This required field contains the Program Log date of this 
transaction, in DDMMMYY format. 

 Customer Reference — This optional field provides a 10-character customer 
reference to this transaction.  

 Internal Reference — This optional field provides a 10-character internal 
reference to this transaction. 

 Negotiated Contract Change — When entering a Negotiated Contract Change 
transaction, enter the amount of the change. If entering the first transaction for 
this contract, enter the entire contract price less the contract fee. 

 Authorized Unpriced Work — When entering an Authorized Unpriced Work 
transaction, enter the amount of the authorized unpriced work. 

 Prime — You can optionally enter the prime dollars value shown in the Element 
of Cost (Baseline – Recap) report for totaling the TAB.  

 Overhead — You can optionally enter the overhead dollars value shown in the 
Element of Cost (Baseline – Recap) report for totaling the TAB.  

 Total Burdened — The Total Burdened value is a display-only field showing 
Prime + Overhead.  

 G&A — You can optionally enter the G&A dollars value shown in the Element 
of Cost (Baseline – Recap) report for totaling the TAB.  

 Total Cost — The Total Cost value is a display-only field showing Total 
Burdened + G&A.  

 COM — You can optionally enter the COM dollars value shown in the Element 
of Cost (Baseline – Recap) report for totaling the TAB.  
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 Total Dollars — The Total Dollars value is a display-only field showing Total 
Cost + COM.  

 Management Reserve — When entering a Management Reserve transaction, 
enter the amount of the transaction. 

 Undistributed Budget — When entering an Undistributed Budget transaction, 
enter the amount of the transaction. 

 Management Reserve Description — When entering a Management Reserve 
transaction, enter a description of the transaction. 

 Undistributed Budget Description — When entering an Undistributed Budget 
transaction, enter a description of the transaction. 
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13.6  Maintaining the Program Log 

Editing the Program Log 
To change information for an existing transaction, perform the following steps:  

1. Click on any field in the Program Log grid. 

If necessary, use the horizontal scroll bar to show the desired field to be changed. 
If a field you need is not displayed, use Column Hide on the Format menu to 
change the displayed fields. 

2. Change the data in one or more editable fields in the current row. Press the Tab 
or arrow keys to continue editing other fields or rows. 

3. To save your changes, click the Save button  or press Ctrl+S.  

Deleting a Single Program Log Transaction 
To delete a single Program Log transaction: 

1. Highlight the entire Program Log row by clicking the row number. In Figure A, 
row 2 is selected. 

 
Figure A. Select the entire Program Log row to be deleted. 

2. Press the Delete key or choose Delete from the Edit menu. 

If the Prompt for Save option has been set, MPM prompts you to confirm the 
delete. 
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Deleting Several Program Log Transaction 
To delete more than one Program Log at one time: 

1. Highlight the desired transaction using the Shift key when clicking the row 
number. 

2. Press the Delete key or choose Delete from the Edit menu. 

If the Prompt for Save option has been set, MPM prompts you to confirm the 
delete. 

Modifications to the Program Log will automatically update the computed 
values displayed on the C/SSR, CPR, and NASA reports. 
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13.7  Program Log Recommended Reports 

Use these standard MPM reports to check your Program Log: 

 Element of Cost (Baseline – Recap) Report 
A summary of proposal or baseline budget with EOC reconciliation. Includes 
subtotals for individual EOCs and totals for the entire project. Recommended if 
tracking TAB. 

 Program Log Report 
The historical record of contract budget baseline and total allocated budget, 
integrated with Undistributed Budget and Management Reserve logs. 

 Management Reserve Log Report 
The historical record of all Management Reserve transactions, integrated with 
Program Log. 

 Undistributed Budget Log Report 
The historical record of all Undistributed Budget transactions, integrated with 
Program Log. 
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14.1  Introduction to Graphic Drill Down 

Graphic Drill Down™ (GDD) is a management tool that provides the ability to 
graphically display and explore data created in MPM. GDD provides a wide range of 2-D 
and 3-D charts, graphs, and grids. You can graph schedule, cost, actuals, variances, and 
condition the data in many powerful ways, to represent and analyze the data in your 
project. 

Drilling Down 
By displaying your project’s data as a graph, you can drill down (display additional detail 
information) into the data by clicking on a portion of a graph. For example, assume you 
are viewing a horizontal bar graph that displays timeframe cumulative BCWS in Total 
Dollars (see Figure A).  

 
Figure A. Viewing Timeframe Cumulative BCWS in Total Dollars 
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For example, to drill down into a time period, click on the bar representing June 1997 to 
view a breakdown of cumulative BCWS data through that fiscal month (see Figure B).  

 
Figure B. Drilling Down to June 1997 

To drill down into a WBS leg, click on the bar representing WBS Leg 4.X to view a 
breakdown of the cumulative BCWS through June 1997 for the children of 4.X (see 
Figure C). Notice that we had selected the WBS drill down method (radio button in the 
left window pane). 

 
Figure C. Drilling Down to WBS 4.X 
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14.2  Accessing the GDD Window 

To open the GDD window from the Menu Manager, do one of the following: 

� Choose Graphic Drill Down from the File|Projects menu. 
� Select the Projects tab and double-click on the Graphic Drill Down icon shown in 

Figure A below. 

 
Figure A. Accessing the GDD Window 
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MPM displays the Graphic Drill Down (GDD) window, as shown in Figure B below. 

 
Figure B. The Graphic Drill Down Window 
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14.3  Orientation to the GDD Window 

You use the GDD window to drill down and manipulate the data and the resulting 
graphic in many powerful ways. A toolbar gives you quick access to the graph controls. 
This window is split into two panes. The left pane contains the data conditioning 
controls. The right pane contains the graph, chart, or grid. Use the pane separator bar to 
display more or less of either pane. 

 
Graph Types Data Types Units

Navigation buttons

Time-Phased
Display 

Project

Drill Down 
Method 

Separator Bar

Graph Period 
Scroll Bar  

Figure A. The Graphic Drill Down Window 

Controlling the Content of the Graph 
To control the content of the graph: 

� Select the type of graph using the Graph Type buttons 
� Select the project using the Project list box 
� Specify the units of data to be displayed using the Units list box 
� Choose the Drill Down method using the radio buttons 
� Specify the type of data to include using the Data Type buttons 
� Choose the Timeframe display using the Display list box 
� Condition the timeframe using the Graph Period scroll bar 
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Selecting the Project 
To select the project to be graphed, use the Project list box. The list box contains all 
MPM projects to which you have been granted access. When you start GDD, the last 
project used in MPM is automatically selected. 

Specifying the Units of Data 
To specify the units to be used, use the Units drop-down list, or choose Units from the 
View menu. Choose from: Hours, Prime, OH (Overhead), Total Burdened, G&A 
(General & Administrative), Total Cost, COM (Cost of Money), Total Dollars, Fee, or 
Total Price. If you select Fee or Total Price, data types BCWP, SV, and CV are disabled. 

Automatically and Manually Redrawing the Graph 
GDD automatically redraws the graph every time any data source, display type, data 
type, unit, period, or graph type item is changed. If redrawing the graph takes a long time 
on your computer, if you are working with a large amount of data, or if you want to set 
several parameters before the graph is redrawn, you can set the Manual Redraw toggle to 
stop the automatic redraw and only redraw on demand. See topic 14.9  Outputting the 
Graph for details on setting this toggle. When you are ready to redraw the graph, click 
the Draw Graph Now  button. 

Drilling Up 
When you are ready to drill back up after you have drilled down, click the Drill Up  
button. Drill Up uses the same method you chose for Drill Down. For example, if you view 
a graph with the Drill Down method WBS and drill down into several levels of a WBS leg, 
you can click the Drill Up button to progressively retrace your steps until you reach the 
Project Level WBS element. See topic 14.6  Drilling Methods for more information. 

Resetting the Graph 
To return the graph to the default settings, click the Reset Graph  button. 

Viewing the Previous or Next Page 
To see additional data, click the Previous Page   and Next Page  buttons to view 
the entire graph. 
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14.4  Selecting the Graph 

The graph type buttons on the tool bar select the type of graph desired. Selecting the 3D 
button adds a third dimension to the type of graph you have selected (bar, line, area, etc.) 
You can also select the Graph Type using the View menu. 

Adding the Third Dimension 
To make your graph three dimensional, click the 3D  button.  Viewing graphs 
in 3D makes it easier to click and drill down into a portion of the graph. The 
sample shows a 3D vertical bar graph. 

Bar Charts 

  

To select a horizontal bar chart, click the Horizontal Bar  button. 
This chart is best for viewing one or more elements with period values.  
The sample shows 2D and 3D horizontal bar charts. 

  

To select a vertical bar chart, click the Vertical Bar  button. This 
chart is best for viewing one or more elements with period values. The 
sample shows 2D and 3D vertical bar charts. 

To select a stacked vertical bar chart, click the Stacked Bar  button. 
This chart is best for viewing one element and its components. This chart 
only displays a single data type at a time, and cannot display negative 
numbers. The sample shows 2D and 3D stacked bar charts. 

  

Line Charts 

  
To select a line chart, click the Line Chart  button. A line chart is 
best for viewing trends and multiple elements. The sample shows 2D 
and 3D line charts. 

You can also view a 2D line chart with symbols which indicate the type of data 
represented on each line. To add symbols to a line chart, select 2D Line Graph Symbols 
in the GDD Options window. The following symbols are displayed: 

t BCWS z Latest Revised Estimate 
u BCWP + Schedule Variance 
 � ACWP × Cost Variance 
 � ETC ⌧ Other Variance 
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Area Charts 

  

To select an area chart, click the Area Chart   button. An area chart 
is best for proportional timephased totals. An area chart only displays a 
single data type at a time, and cannot display negative numbers. The 
sample shows 2D and 3D area charts. 

To select a stacked area chart, click the Stacked Area  button. A 
stacked area chart is best for proportionally viewing timephased totals 
and their components. A stacked area chart cannot display negative 
numbers. The sample shows 2D and 3D stacked area charts.    

Grids 
To view data as a table of numbers, click the 
Grid  button. Use the Grid when you 
need to see the exact values from which a 
graph was derived. This graph is not 
available to display Stacked Bar or Stacked 
Area Chart values, and cannot be seen in 3D. 
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14.5  Conditioning the Timeframe 

Use the Display field to select the type of timeframe 
display. Use the Rpt Month, Gate Month, and/or Cum 
From date to specify a range of fiscal period(s) used 
with the selected timeframe display. 

 
Selecting the Timeframe Display 
There are five types of timeframes to choose from. 

Option Description 

Single Period 
Incremental  

Displays data for one period only.  When this option is 
selected, the LRE data type is unavailable. 

Single Period 
Cumulative  

Displays cumulative data through one period only.  
When this option is selected, the LRE data type is 
unavailable. 

Timephased Incremental  Displays 12 periods of values. 

Timephased Cumulative  Displays 12 periods of cumulative values. 

At Complete Displays At Complete values for the selected data types. 
This is just like a Single Period Cumulative graph 
except data is always cumulative from the first 
accounting month of the project through the last 
accounting month of the project and is not controlled by 
changing the graph timeframe scroll bar or the Cum 
From option. 

� Rpt Month — The Report Month is the last month for which actuals and BCWP 
values are reported (usually the previous month). 

� Gate Month — The Gate Month is only used in conjunction with the LRE data 
type. For LRE, actuals are reported through the Gate Month, and ETC values are 
reported after the Gate Month. 

� Cum From — The Cum From month is the month from which graphed values 
should be cumulated.  This does not affect At Complete graphs. 

Changing Graph Periods 
To change the amount of time that constitutes a period, select Periods from the View 
menu, then select Month, Quarter, or Year. 
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Quarter and Yearly periods are calculated by starting at the first month of the fiscal 
calendar.  For example, if the fiscal calendar starts in October, then the first quarterly 
period would include October, November, and December. The year displayed is the year 
of the last month in the fiscal year. 

For more information about MPM fiscal calendars, see Chapter 3: Calendars in the MPM 
Globals manual. 

Using the Graph Period Scroll Bar 
The period to be graphed defaults to the current accounting period (the period containing 
the current accounting month). To change which periods are displayed in the current 
graph, use the Graph Period Scroll Bar, which is located directly below the graph. When 
you drag the button on the scroll bar, MPM displays a popup label  which shows 
the periods you are scrolling through. When you release the mouse button, the graph 
displays the period shown in the box. You can define the period as Month, Quarter, or 
Year by selecting Periods from the View menu. 

The Scroll Bar is used to change the period (month, quarter, or year) of the graph. Do not 
use the Scroll Bar to view multiple page graphs.  To view multiple pages, use the 
Previous and Next Page buttons.  

If you are viewing a timephased graph and you drag the button on the scroll bar, when 
you release the mouse button, the period you selected will be in the center of the graph. 

Going Quickly to WBS Start 
To change the graph period to the start month for the currently selected WBS element, 
select Go to WBS Start from the Edit menu or press Ctrl+G. 
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14.6  Drilling Methods 

Drilling down into your data is a powerful way to view and analyze your project. You 
can drill down using one of three methods:  

Drilling Down by WBS 
Drilling down by WBS takes you into lower levels of your WBS Tree each time you 
click. Starting at the Project Level with Drill Down by WBS selected, you can click 
either on the desired WBS Leg in the Tree pictured in the lower left part of the GDD 
window, or click on the desired WBS where it appears in the graph. In Figure A, to drill 
into WBS 2.X.1, click on the horizontal bar next to the WBS ID. When viewing WBS 
2.X.1, you can drill down into 2.X.1.1, 2.X.1.2, etc. If you click on a WBS ID with no 
children, the drill down method changes to EOC, and EOCs are displayed. 

 
Figure A. You can drill down by WBS. 

Drilling Down by EOC 
Drilling down by EOC takes you into the resources. With Drill Down by EOC selected, 
you can click either in the EOC list box, or click on the EOC where it appears in the 
graph. In Figure B, to drill into the Labor EOC, click on the horizontal bar next to Labor. 
When you drill into a specific EOC, you begin drilling into the resources for that EOC. 
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click here to drill
into Labor EOC

 
Figure B. You can drill down by EOC. 

Drilling Down by Resource 
Drilling down by Resource takes you into the individual resources. Starting at the Project 
Level with Drill Down by Resource selected, you can click either on the Resource list 
box in the left pane of the GDD window, or click on the resource where it appears in the 
graph. In Figure C, to drill down into the Resource ADMIN, click on the bar next to 
ADMIN.  

click here to drill into ADMIN

 
Figure C. You can drill down by resource. 
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14.6  Drilling Methods  

14.6.1  Specifying the Drill Down Method 
To specify the Drill Down method desired, you can: 

� Select View By on the View menu and choose WBS, EOC or resource.  
� Click the appropriate radio button: WBS, element of cost, or resource. See 

Figure A.  

Drill Down by
WBS Tree

radio button

Drill Down by
Element of Cost

radio button

Drill Down by
Resource

radio button

 
Figure A. Selecting a drill down method 

Specifying Drill Down by WBS 
To specify Drill Down by WBS, click the WBS button. To select a WBS element and all 
of its children, click the WBS Leg. To expand or collapse WBS legs, click the  and  
boxes. To select the entire WBS and all of its children, click the  box in front of Project 
Level. 

Specifying Drill Down by Element of Cost 
To specify Drill Down by EOC, click the Element of Cost radio button. To select a specific 
EOC to graph, select an EOC shown in the EOC list box. 
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Specifying Drill Down by Resource 
To specify Drill Down by Resource, click the resource radio button. To select a specific 
resource to graph, select a resource shown in the Resource list box. You cannot drill 
down by resource when displaying BCWP, SV or CV data. 

[Other] EOCs or Resources 
If you see an element of cost or resource listed as [Other], this means that there is data 
which is not associated with a specific EOC or resource. This can happen: 

� if Summary or EOC rollup toggles were set to OFF when you entered estimates or 
actuals data, and that data has not been rolled up yet. See Chapter 2: Creating and 
Maintaining Project Settings for details about using the Rollup Toggles. 

� if an EOC or resource is deleted when it has existing estimates assigned to it. We 
suggest that you export estimates and examine the text in a word processor. 
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14.6  Drilling Methods  

14.6.2  Drilling Down Bar or Line Graphs 
These graphs contain a separate bar or line for every type of data (S/P/A/…) selected. To 
drill down into these graphs, click on the line/bar that represents the desired data.  

Drilling Into Timephased Bar or Line Graphs 
If you have selected a timephased graph, MPM displays additional bars/lines for every 
time period. When you drill into a specific time period, MPM changes to a Single Period 
Incremental/Cumulative graph for that single time period using the drill down method. 
When drilling into Timephased data…

  

MPM changes display to Single Period

 

Drilling Into Single Period Bar or Line Graphs 
When drilling down into a specific WBS, MPM displays its children. If the selected WBS 
has no children, MPM displays all EOCs for that WBS and begins to drill down by EOC. 
Drilling into a WBS Leg with no children

  

MPM begins drill down by EOC

 
When drilling down by EOC, if you drill into a specific EOC, MPM displays the 
resources that apply to that EOC and changes the Drill Down Method to Resource. 
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When drilling into the Labor EOC…

  

MPM displays Resources in Labor EOC

 
When drilling down by resource, if you drill into a specific resource, MPM displays that 
one resource in the graph. 

When drilling into the ADMIN Resource…

  

MPM displays detail about the Resource

 

Drilling Into At Complete Bar or Line Graphs 
If you have selected At Complete, MPM displays the same graph as Single Period 
Incremental, except that the single period is the end of the project, and the numbers 
reflect the values at completion. 
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14.6  Drilling Methods  

14.6.3  Drilling Down Stacked Bar Graphs 
To drill down into Stacked Bar Graphs, click on the segment of the bar which 
corresponds to the WBS/EOC/resource you want to see. You can only select one type of 
data (S/P/A/…) at a time. When drilling down into a Stacked Bar Graph, each section of 
the bar represents a WBS, an EOC, or a resource, depending on the drill down method. 

Drilling Into Timephased Stacked Bar Graphs 
If you have selected a Timephased Incremental or Timephased Cumulative Stacked Bar 
graph, to drill into the graph, you click once on the bar that represents the single period 
period and the desired WBS/EOC/resource. MPM changes to a Single Period Incremental 
or Cumulative graph for that single time period.  

When drilling into Timephased data…

  

MPM changes to Single Period, shows the WBS/EOC/Res

 

Drilling Into Single Period Stacked Bar Graphs 
When drilling down by WBS, if you drill into a specific WBS, MPM displays its 
children. If the selected WBS Leg does not have any children, MPM displays all 
Elements of Cost for that WBS and begins to drill down by EOC. 

Drilling into a WBS Leg with no children…

  

MPM begins drill down by EOC
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When drilling down by EOC, if you drill into a specific EOC, MPM displays the 
resources that apply to that EOC and changes the Drill Down Method to Resource. 

When drilling into the Labor EOC…

  

MPM displays Resources in Labor EOC

 
When drilling down by resource, if you click to drill into a specific time period, MPM 
displays the resources for the selected WBS. If you click to drill into a specific resource, 
MPM displays that one resource in the graph. 

clicking on the PROG MGR Resource…

  

MPM displays detail about the Resource

 

Drilling Into At Complete Stacked Bar Graphs 
If you have selected At Complete, MPM displays the same graph as Single Period 
Incremental, except that the single period is the end of the project, and the numbers 
reflect the values at completion.  
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14.6  Drilling Methods  

14.6.4  Drilling Down Stacked Area Graphs 
To drill down into Stacked Area graphs, click on the colored bar which corresponds to 
the WBS/EOC/resource to display. You can only select one type of data (S/P/A/…) at a 
time. When drilling down into a Stacked Area Graph, each bar represents a WBS Leg, an 
element of cost, or a resource, depending on the selected drill down method. 

Drilling Into Timephased Stacked Area Graphs 
If you have selected a Timephased Incremental or Timephased Cumulative Stacked Area 
graph, you drill into the WBS/EOC/resource by clicking on the color that represents the 
WBS, EOC or resource. MPM shows the WBS/EOC/resource selected.  
When drilling into Timephased data…

  

MPM shows the WBS/EOC/Resource

 

Drilling Into Single Period Stacked Area Graphs 
When drilling down by WBS, if you drill into a specific WBS, MPM displays its 
children. If the selected WBS Leg does not have any children, MPM displays all 
Elements of Cost for that WBS and begins to drill down by EOC. 

Drilling into a WBS Leg with no children…

  

MPM begins drill down by EOC
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When drilling down by EOC, if you drill into a specific EOC, MPM displays the 
resources that apply to that EOC and changes the Drill Down Method to resource. 

When drilling into the Labor EOC…

  

MPM displays Resources in Labor EOC

 
When drilling down by resource, if you click to drill into a specific time period, MPM 
displays the resources for the selected WBS. If you click to drill into a specific resource, 
MPM displays that one resource in the graph. 

clicking on the PROG MGR Resource…

  

MPM displays detail about the Resource

 

Drilling Into At Complete Stacked Area Graphs 
If you have selected At Complete, MPM displays the same graph as Single Period 
Incremental, except that the single period is the end of the project, and the numbers 
reflect the values at completion. 
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14.6  Drilling Methods  

14.6.5  Drilling Down Area Graphs or Grids 
You cannot drill down into Area Graphs or Grids.  

When displaying Area Graphs using timephased display, the drill down method is 
ignored, and the points in the graph reflect the fiscal periods. 

  
Figure A. Sample Area Graphs Showing Timephased Incremental and Cumulative 

When displaying Area Graphs using Single Period display, you can specify the Drill 
Down Method, which is used to display all or selected WBSs, EOCs or resources. 

  
Figure B. Sample Area Graphs Showing WBS and EOC data for a Single Period 
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Area Graphs using At Complete values use the selected Drill Down Method in the same 
way as Single Period displays. 

 
Figure C. Area Graph Showing At Complete 

Grids show the numeric values of Single periods, At Complete or Timephased values, 
and also utilizes the selected Drill Down Method to select the data to be displayed. 

 
Figure D. Sample Grid Showing 
Resources BCWS At Complete Values 
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14.7  Selecting the Data to Include 

The data type buttons control the type of data displayed in the graph. You can also select 
data types by choosing Data Type on the View menu and selecting the desired type. 

� BCWS represents the Budgeted Cost of Work Scheduled. Click the BCWS  
button to include BCWS values in your graph. If selecting Single Period 
Cumulative or Timephased Cumulative graphs, the Cum From date is used to 
calculate displayed values. The Rpt Month and Gate Month have no effect on 
BCWS.  

� BCWP represents Budgeted Cost of Work Performed. Click the  button to 
include BCWP values in your graph. If selecting Single Period Cumulative or 
Timephased Cumulative graphs, the Cum From date and the Rpt Month are used 
to calculate displayed values. The Gate Month has no effect on BCWP.  

� ACWP represents the Actual Cost of Work Performed. Click the  button to 
include ACWP values in your graph. If selecting Single Period Cumulative or 
Timephased Cumulative graphs, the Cum From date and the Rpt Month are used 
to calculate displayed values. The Gate Month has no effect on ACWP.  

� ETC represents the Estimate to Complete the project. Click the  button to 
include ETC values in your graph. If selecting Single Period Cumulative or 
Timephased Cumulative graphs, the Cum From date is used to calculate displayed 
values. The Gate Month and the Rpt Month have no effect on ETC.  

� LRE represents the Latest Revised Estimate of the entire project. Click the  
button to include LRE values in your graph. This option is unavailable when 
displaying Single Period graphs. If selecting Timephased or At-Complete graphs, 
the LRE includes actual costs up to the Gate Month and ETC after the Gate 
Month. The Cum From date and Rpt Month have no effect on LRE.  

Showing Variance 

To include Schedule Variance in your graph, click the  button. Schedule Variance 
represents the variance between the work performed and the work scheduled (BCWP – 
BCWS). If selecting Single Period Cum or Timephased Cum graphs, the Cum From date 
and the Rpt Month are used to calculate displayed values. The Gate Month has no effect 
on SV. 

To include Cost Variance in your graph, click the  button. Cost Variance represents 
the variance between the cost of the work performed and the actual costs (BCWP – 
ACWP). If selecting Single Period Cum or Timephased Cum graphs, the Cum From date 
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and the Rpt Month are used to calculate displayed values. The Gate Month has no effect 
on Cost Variance.  

You can also display the variance between two data types. When graphing variance data, 
you can either graph the variance with the values that are being compared, or graph the 
variance alone. To display the values you selected compared with the variance, select 
Include Data with Other Variance from the View menu. To display the variance alone, 
select Include Data with Other Variance from the View menu again. 

To show variances between two selected data types, click the  button after clicking 
the other two data types. The table below shows the effects of selecting various 
combinations of data types. 

Selected Variance Calculation Comments

  
BCWP – BCWS Same as SV - shows variance between work 

performed and work scheduled. 

  
BCWS – ACWP Show variance between work scheduled and 

actual costs incurred. 

  
BCWS – ETC Shows variance between work scheduled and 

estimates of remaining work. 

  
BCWS – LRE Shows variance between work scheduled and the 

latest revised estimate of final project costs. 

  
BCWP – ACWP Same as CV - shows variance between work 

performed and actual costs incurred. 

  
 Not available 

  
 Not available 

  
ETC – ACWP Shows variance between estimates and actual 

costs incurred. 

  
LRE – ACWP Shows variance between final projections and 

actual costs incurred. 

  
 Not Available 



400   Chapter 14: Analyzing the Project Graphically (GDD) 

14.8  Changing the GDD Display 

Changing the Decimal Display 
To specify how many decimal places should be displayed on the graph for dollar and 
non-dollar (hours) numeric data, select Dollars or Non-Dollars on the Format menu, and 
then select one of the following options (you can have different options for each): 

Option Description 

1,235 No decimal places 
1,234.6 One decimal place 
1,234.57 Two decimal places 

Displaying IDs and/or Descriptions 
To change the GDD options, select Options from the Tools menu. MPM displays the 
GDD Options window.  

 
Figure A. GDD Options Window 
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The following Graphic Drill Down options are available on the GDD Options Window: 

Field  Option Description 

Legends and 
Labels 

ID Only The graph displays only the element ID (identification) of 
the WBS, element of cost, or resource elements.  This is 
useful when you are graphing elements with long 
descriptions. 

 Description 
Only 

The graph displays only the description of the WBS, 
element of cost, or resource elements. 

 ID and 
Description 

The graph displays both the element ID and the description 
of the WBS, element of cost, or resource elements. 

Graph Draw Automatic GDD automatically re-draws the graph every time any data 
source, display type, data type, unit, period or graph type 
item is changed. 

 Manual GDD does not automatically re-draw the graph every time 
a graph element is changed.  This is useful when you need 
to set several parameters before viewing the final graph.  

Use the Draw Graph Now  button when you want the 
system to re-draw the graph. 

2D Line Graph 
Symbols 

On or Off Adds symbols on 2D Line Graphs to differentiate the data 
types. See topic 14.6.2  Drilling Down Bar or Line Graphs. 
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14.9  Outputting the Graph 

To speed up the graphing process so the graph is not redrawn after every change, set 
graph drawing to Manual by selecting Options from the Tools menu and setting Graph 
Draw under the GDD Tab to Manual.  

You can then redraw the graph by clicking the Draw Graph Now  button or by 
choosing Draw Graph Now on the View menu. 

Previewing and Printing the Graph 
You can preview or print the graph using the options on the File menu. Print and Print 
Preview show the graph exactly as displayed in the GDD window. For complete details 
on using these options, see Using MPM in the Getting Started manual. 

To preview your graph, do one of the following: 

� Click the Print Preview button  
� Choose Print Preview on the File menu 
� Press Alt+F, and then V 

To print your graph, do one of the following: 

� Click the Print button  
� Choose Print on the File menu 
� Press Ctrl+P 

MPM displays the standard Windows dialog box asking you for number of copies, etc. 
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Copying/Exporting Graph Data 
You can copy a graph (and/or graph data) to the Windows clipboard, if you wish to paste 
the data into another Windows application. 

If you are viewing a graph, select Copy Graph on the Edit menu, or press Ctrl+C. Both 
the graph, and the data the graph was derived from the graph, are copied to the clipboard. 
If the application you are pasting the graph into has Paste Special capabilities, you can 
choose whether to paste the graph or the text. 

If you are viewing a grid, select the information to copy by clicking the mouse button and 
dragging it through the desired rows and columns. Then select Copy Cells on the Edit 
menu, or press Ctrl+C. If at least one entire row or one entire column is selected, the 
column and row titles are also copied to the clipboard.  

This option is unavailable if the Draw Graph option is set to Manual and the graph is not 
current. 
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14.10  Creating Common Graphs 

The sub-topics that follow describe how to create the most frequently used graphs. 

14.10.1  Creating an SPA Line Graph 

14.10.2  Creating an EOC/Resource Usage Graph 

14.10.3  Examining Work Done 

 
Figure A. The SPA Line Graph. 

 
Figure B. The BCWS versus LRE Graph. 
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Figure C. Display the EOC Usage graph. 

 
Figure D. Stacked Area Actuals Graph by WBS 
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14.10  Creating Common Graphs 

14.10.1  Creating an SPA Line Graph 
To create an SPA line graph: 

1. Access GDD from the Menu Manager on the Projects tab.  

2. Select a project from the Project list box. 

3. Select Timephased Incremental from the Display list box. 

4. Set the Rpt Month to the last month for which WBS data has been entered.   

5. To select a Line Graph, click the Line Graph  button.  

6. To add BCWS, BCWP, and ACWP data to the graph, click the    
buttons, and ensure that no other data type buttons are selected. 

7. Set Units to Total Dollars.   

8. Check the GDD Options window and ensure that Display Symbols under the 2D 
Line Graph section of the GDD tab has been selected. 

9. To add Schedule Variance and Cost Variance, click the  and  buttons. 

MPM displays the SPA line graph. An example is shown in Figure A. 
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Figure A. The SPA Line Graph. 

To view the data used to derive the current graph, click the Grid  button.  

 
Figure B. The Grid Data Used to Generate the SPA Line Graph. 
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14.10  Creating Common Graphs  

14.10.2  Creating an EOC/Resource Usage Graph 
To create an Element of Cost or Resource Usage graph: 

1. If you had created a graph previously, click the Reset   button.  

2. To select a Stacked Bar Graph, click the Stacked Bar Graph  button. 

3. To graph BCWS data, click the  button. 

4. To make the graph three-dimensional, click the 3D  button. 

5. Select Timephased Cumulative from the Display list box. 

6. Select Drill Down by Element of Cost to view EOC usage. 

MPM displays the EOC Usage graph shown in Figure A. 

 
Figure A. Display the EOC Usage graph. 

See topic 14.6.3  Drilling Down Stacked Bar Graphs for complete instructions on 
how to drill down into this graph. 
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7. Select Drill Down by Resource to view resource usage. 

MPM displays the Resource Usage graph shown in Figure B. 

 
Figure B. Drilling Down by Resource and Fiscal Period. 

See topic 14.6.3  Drilling Down Stacked Bar Graphs for complete instructions on 
how to drill down into this graph. 
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14.10  Creating Common Graphs  

14.10.3  Examining Work Done  
You use the actuals graphs to examine work that has already been completed. To create 
the actuals graphs: 

1. If you created a graph previously, click the Reset  button.  

2. To select a Stacked Area Graph, click the Stacked Area Graph  button. 

3. To graph ACWP (actuals) data, click the  button. 

4. To make the graph three-dimensional, click the 3D  button. 

5. Select Timephased Cumulative from the Display list box. 

6. Select Drill Down by WBS. 

MPM displays the graph: 

 
Figure A. Stacked Area Actuals Graph by WBS 

See topic 14.6.4  Drilling Down Stacked Area Graphs for complete instructions 
on how to drill down into this graph. 

The largest colored bar (in the graph above, WBS 2.X) represents the most 
expensive task in the project. 
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7. Select Drill Down by Resource. MPM displays the graph: 

 
Figure B. Stacked Area Actuals Graph by Resource 

8. Select a resource in the list box, or drill into the graph by selecting a colored bar. 

The largest colored bar (in the graph above, Resource ENGE) represents the most 
expensive resource in the project. MPM displays the graph: 

 
Figure C. Stacked Area Actuals Graph for Selected Resource 
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15.1  Introduction to Reports 

MPM provides a variety of tabular and graphic standard reports, specifically designed to 

meet government reporting requirements and your in-house reporting and analysis needs. 

You can condition each report to select its content and format for a specific purpose. 

Because MPM is so flexible, the options in the conditioning can produce numerous 

reports. The table below describes how to receive the desired report.  

Procedure 

1. Find the report you want in the first column. 

2. Access the icon in the second column from the Menu Manager under the Reports 

tab (see topic 15.2  Accessing the Report Conditioning Windows for instructions). 

3. Choose the designated Data Type in the third column in the conditioning window 

(see topic 15.3  Orientation to the Report Conditioning Windows for instructions). 

Report Description Report Name on icon Data Type  

Accounting Calendar Accounting Calendar n/a 

Analyze Distributed Project Imoort Analyze Distributed Project Import n/a 

Apportioned Estimates Relationships – Baseline 
Apportioned Estimates Relationships – ETC 

Apportioned Estimates Baseline 
ETC 

Resource Basis of Estimate 

Summary Basis of Estimate 

Basis of Estimate Resource 

Summary 

Burden and Fee Detail – Baseline 

Burden and Fee Detail – ETC 
Burden and Fee Summary – Baseline 

Burden and Fee Summary – ETC 

Burden and Fee Detail - Baseline 

Detail - ETC 
Summary - Baseline 

Summary - ETC 

CLIN Table Contract Line Items n/a 

CLIN/SOW/WBS CLIN/SOW/WBS n/a 

Compare Detail versus EOC Rollup 
Compare Detail versus Summary Rollup 

Compare Detail and Rollup EOC Rollup 
Summary Rollup 

Control Account Plan Control Account Plan n/a 

CPR Format  1 CPR Format 1 n/a 

CPR Format  2 CPR Format 2 n/a 

CPR Format  3 CPR Format 3 n/a 

CPR Format  4 CPR Format 4 n/a 

C/SSR CSSR n/a 

DD 1861 DD 1861 n/a 

DD 1921 DD 1921 n/a 

Detail Variance Analysis Detail Variance Analysis n/a 

EAC Comparison EAC Comparison n/a 

Actuals by EOC 

Actuals by Charge Number 

Element of Cost 
WBS Recap by EOC 

Budget/Actuals Recap by EOC 

Element of Cost Actuals by WBS 

Actuals by Charge Number 

Baseline 
Baseline – Recap 

Budget/Actuals – Recap 
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Report Description Report Name on icon Data Type  

Element of Cost/Class Detail   

Element of Cost/Class Detail – ETC 

Element of Cost – ETC 
Element of Cost – LRE 

S/P/A Tabular by EOC 

S/P/A Recap by Element of Cost 

Element of Cost EOC/Class – Baseline 

EOC/Class – ETC 

ETC 
LRE 

S/P/A Tabular  

S/P/A Recap 

Element of Cost/Class Element of Cost Table n/a 

EVM Planning & Analysis EVM Plan and Analysis n/a 

Labor/Price Summary by WBS 

Labor/Price Summary by CLIN 

Labor/Price Summary WBS  

CLIN 

Program Log 
Management Reserve Log 

Undistributed Budget Log 

Logs Program Log 
Management Reserve Log 

Undistributed Budget Log 

Manpower Detail 

Manpower Summary 

Manpower  Detail 

Summary 

Milestone Barchart Milestone Barchart n/a 

Milestone Status Turnaround Document Milestone Status Turnaround Document n/a 

NASA533 M NASA 533 M n/a 

NASA533 P NASA 533 P n/a 

NASA 533 Q NASA 533 Q n/a 

OBS Indented OBS Indented n/a 

OBS Burden Templates OBS Burden Template N/a 

Price/Usage Variance Analysis Price/Usage Variance Analysis n/a 

Project Comparison 

Project Comparison LRE 

Project Comparison Baseline 

LRE 

Proposal Summary by WBS 

Proposal Summary by CLIN 

Proposal Summary WBS 

CLIN 

Resource Detail 

Resource Detail – Actuals 
Resource Detail – ETC 

Resource Detail – Budget/LRE 

Resource Summary 
Resource Summary – Actuals 

Resource Summary – ETC 

Resource  Detail - Baseline 

Detail - Actuals  
Detail -ETC 

Detail - Budget/LRE  

Summary - Baseline 
Summary - Actuals 

Summary –ETC 

Resource Department Summary Resource Department Summary n/a 

Resources and Burdens Resources and Burdens n/a 

Responsibility Assignment Responsibility Assignment n/a 

Responsibility Assignment Matrix Responsibility Assignment Matrix n/a 

SF 1411 SF 1411 n/a 

Spread Curves Spread Curve n/a 

Task Description Task Description n/a 

Variance Analysis Turnaround Document Variance Analysis Turnaround 

Document 

n/a 

WBS Hierarchy WBS Hierarchy n/a 

WBS Indented WBS Indented n/a 

Weekly - Performance 
Weekly - EOC Detail 

Weekly - EOC Rollup 

Weekly   
 

Performance 
EOC Detail 

EOC Rollup 

Work Authorization Document Work Authorization Document n/a 

Work Status Document – EV 
Work Status Document – Budget/LRE 

Work Status Document Earned Value 
Budget/LRE 
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15.2  Accessing the Report Conditioning Windows 

You open the Report Conditioning windows by clicking the Reports tab on the MPM 

Menu Manager. When you access the Reports tab, all reports to which you have been 

granted access are listed. Double-click the desired report icon.  

Each report has a window which contains the conditioning options that modify the 

report. Every available conditioning option for the specified type of report is shown. 

 

Figure A. Double-click the icon on the Reports tab of the MPM Menu Manager. 

Procedure 

To run the desired report: 

1. From the Menu Manager window shown in Figure A, do one of the following: 

 Select the Reports tab and double-click the icon for the desired report. 

 Choose Reports | [report] from the File menu. 

MPM displays the Report Conditioning window for the selected type of report. 

Figure A shows the Accounting Calendar Report Conditioning window. 
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2. If the report contains more than one Report Type (refer to topic 15.1  

Introduction to Reports), select the desired report type. 

MPM displays the Report Conditioning for the select report type (if different than 

the default). 
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15.3  Orientation to the Report Conditioning Windows 

You use the Report Conditioning window to select the content and format for a specific 

report. A toolbar gives you quick access to common tasks. The Report Conditions grid 

displays the information about the report.  

Report Conditions Grid 

In every Report Conditioning window, the left pane of the window displays the icon(s) 

for the selected type of report, and the right pane displays the conditioning information 

about the report. The right pane is divided into two columns. The Filter column shows 

the report condition field to be specified, such as Project. The Criteria column contains 

the list boxes, check mark boxes, or text entry boxes in which you enter the criteria for 

the condition. The rows are grouped into categories. Category headings are shown in 

gray for reference. 

Required Entries 

Most Report Conditioning windows have at least one required entry; some have several. 

Figure A below shows the Management Log Report Conditioning window. All entries are 

entered or selected in the Criteria column of a conditioning window. Those containing 

required entries show <Required> in the Criteria column. The default project is the first 

project in the PROJ.DAT to which you have been granted access. 

Specify the timeframe

Type of report

Select the project

Specify the data

conditioning options

Filter column Criteria column

Specify the output options

Specify the output file

 

Figure A. Management Log Report Conditioning Window 
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Running the Report 

To set up and run the report: 

1. Choose a project from the Project list box. 

The Criteria box for the project contains a list box of available projects. 

2. Specify the report data conditioning. 

Many reports have several conditioning options to choose from. 

3. Enter the report timeframe information. 

If applicable, provide starting and ending periods to be included in the report. 

You can enter formulated dates here, if desired. See topic 15.6.1 Using 

Formulated Dates for instructions. 

4. Select the output option. 

You can send this report directly to the printer, view it in the Report Viewer (see 

topic 15.5.1  Orientation to the Report Viewer Window), or save it in several 

formats. You can also change report heading and other formatting options. 

5. If desired, you can change the current date by clicking the Set Date  button, 

or by selecting Set Current Date on the Tools menu. 

6. To accept the selections and run the report, do one of the following: 

 Click the Run button  

 Choose Run Report on the Tools menu, or press Ctrl+R. 

Previewing and Printing Report Conditioning 

You can preview and print the report conditioning data using the options on the File 

menu. For complete details on using these options, see Using MPM of the Getting 

Started manual. Note that the Print and Preview only show the report conditioning 

criteria which you have displayed on the grid. It does not display the results for running 

the conditioning.  

Saving the Report Conditioning 

To save the Report Conditioning data, do one of the following: 

 Click the Save button  

 Choose Save from the File menu, or press Ctrl+S 

MPM prompts for the location and file name to be saved. See topic 15.6  Batch Report 

Processing for details on using saved conditioning. 
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Figure A. WBS Leg Dialog Box

15.3  Orientation to the Report Conditioning Windows 

15.3.1  Conditioning the Report 

When reporting MPM data, most reports contain these conditioning options: 

 Global ID: On all Global reports, specify the Global File in which the data to be 

reported resides, from a drop-down list of Global IDs. 

 Project ID: On all Project reports, specify the Project in which the data to be 

reported resides, from a drop-down list of Project IDs. 

 Report Timeframe Information: To change the timeframe to be reported, 

specify the Report From/Start dates or the Report Period From/Through dates. 

Dates can be entered in the usual formats, or as Formulated Dates. See topic 

15.6.1 Using Formulated Dates for instructions on using Formulated Dates. 

 WBS fields: On most Project reports, 

you can specify a particular WBS Leg 

or Level to be included, or select a 

subset of data using the WBS fields 

Alias, Manager, Cross Reference, 

Element Type, Performing/Responsible 

OBS, CLIN. 

 WBS Leg (optional): To report a 

particular WBS Leg, enter the WBS ID, 

or click the  button which is added to 

the WBS Leg criteria box when clicked. 

MPM displays the WBS Leg dialog box 

shown below. Highlight the desired leg, 

expanding the levels if necessary. The 

WBS ID selected is inserted in the 

Criteria box. 

 WBS Level (optional): Enter a value from 1 through 99 to export WBS elements 

at the level entered. If a WBS leg is entered, the WBS level will validate the 

lowest level of that leg. 

 Type of Data: On most Project reports, you can choose to include Incremental, 

Cumulative, and/or At Complete values in the report. 

 Level of Detail: You can choose to include data rolled up to the EOC, COC, or 

Resource level. You can also choose to include summary or detail data on some 

reports. 
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 Additional Data: You can add information to some reports such as Task 

Descriptions, BOEs, Milestones, Performance Summaries, Financials, Recap, and 

many other special processing options. Some are unique to the report you 

requested. See the MPM Standard Reports manual for details. 
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15.3  Orientation to the Report Conditioning Windows 

15.3.2  Outputting the Report 

MPM offers several options for outputting the report. You can send it to: 

 a local or network printer, plotter, or other output device. 

 the Report Viewer, which allows you to edit, rearrange, and reformat the report 

before printing it. 

 a file saved on your local machine or network. 

Sending the Report to a Printer 

To print the report: 

1. Enter the report conditioning options. 

2. Under Output Options, select Printer for the Output Format conditioning option. 

3. Click the Run  button. 

Choosing Print on the File menu will only print your report options! 

4. If you have left any required entries blank, MPM prompts you to enter them. 

5. MPM displays the setup options for the printer, such as page number range, 

number of copies, etc. Make any desired changes.  

6. If desired, you can click Setup to change other setup options for the printer, such 

as page orientation, print quality, etc. 

7. Click OK.  

MPM sends the report to the printer as requested. 

Sending the Report to a Plotter or Other Output Device 

To send the report to something other than a printer, first choose Print on the File menu, 

and click Setup. Choose any other installed device listed. If necessary, click Network to 

scan the network for other devices on your network. Click OK.  

Then follow the rest of the steps above. MPM uses the drivers for the selected output 

device, and will prompt you for device-specific information in Steps 6 and 7. 



MPM Projects   423 

Sending the Report to the Report Viewer 

To send the report to the Report Viewer: 

1. Enter the report conditioning options. 

2. Under Output Options, select Viewer for the Output Format conditioning option. 

3. Click the Run  button. 

MPM compiles the report and displays the data in the Report Viewer. In the Viewer, 

you can rearrange, change, or reformat the report as desired. See topic 15.5  Viewing 

and Editing Reports for instructions on using the Viewer. 

Sending the Report to a Saved File 

To save the report to a file: 

1. Enter the report conditioning options. 

2. Under Output Options, select one of these values for the Output Format 

conditioning option: 

 UN/CEFACT (*.XML) for a UN/CEFACT standard XML file (CPR1 through 
CPR4 only). 

 Comma-Separated Values (*.CSV) for a text file with values separated by 

commas. 

 Excel 95 (*.XLS) for an Excel spreadsheet in Excel 95 format. 

 Excel 97 – 2000 (*.XLS) for an Excel spreadsheet in Excel 97-2000 Format. 

 Tab-Separated Values (*.TXT) for a text file with values separated by tabs. 

 HTML (*.HTM) for an HTML file which you can view in an Internet 

browser program like Netscape or Internet Explorer. 

3. Specify the saved file name and location. 

When you click in the Criteria box for the Output Filename, a  button is added 

to the box. Use this button to bring up the standard Windows browse window for 

finding the correct folder. This is the text file to be created by MPM. 

4. Click the Run  button. 
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15.4  Creating Government-Required Reports 

MPM provides a standard set of reports which can be used for reporting your project to 

U.S. government agencies in prescribed formats. These reports include data which is 

outside of MPM which these reports require, including headers, thresholds, variances, 

and Cost of Money overrides. See topic 15.4.1  Entering Government Report Data for 

instructions on entering this data. 

CPR Reports for DoD/DoE Reporting 

The CPR reports are used primarily for reporting cost and schedule progress to the 

government or government contractors on specific procurements. There are four CPR 

reports, each of which can be printed in one of three formats. The 1989 format report 

complies with OMB No. 22R0327. The 1995 format report complies with OMB No. 

0704-0188 and DID No. DI-MGMT-81466. The 2005 format report complies with DID 

No. DI-MGMT-81466A.  Please refer to your contractual reporting requirements for the 

appropriate use and application of the various versions of the CPR. 

There is an additional output option for CPR1 through CPR4 reports called  

“UN/CEFACT (*.XML)”. The UN/CEFACT XML schemas are an international data 

exchange standard format that replaces the older ANSI X12 electronic data interchange 

(EDI) format such as the 839 transaction set, used to submit Contract Performance 

Reports (CPRs) electronically to government customers.  

These schemas are designed to support the exchange of program management related cost 

and schedule data between all project stakeholders. For more information about the 

schemas, see the UN/CEFACT web site (www.unece.org/cefact/) or the Defense Contract 

Management Agency (DCMA) web site 

(www.dcma.mil/divisions/dcmaa/LosAngeles/XSD/index.htm). The DCMA web site 

includes industry guidelines for using the schemas. 

 CPR1 – Cost Performance Functional Categories Report in three formats 

This report includes current period, cumulative, and At complete values for each 

WBS element, and contains header data showing quantity, targets, ceilings, and 

Management Estimate At Completion (MEAC) calculations. This report also 

contains computed and overridden data about budget, price, Management Reserve 

(MR), Undistributed Budget (UB), and MEAC cases.  

 CPR2 – Cost Performance Organizational Categories Report in three formats 

This report includes current period, cumulative, and At complete values for each 

Organization (Performing or Responsible), and contains header data showing 

quantity, targets, ceilings, and MEAC cases. This report also contains computed 

http://www.unece.org/cefact/
http://www.dcma.mil/divisions/dcmaa/LosAngeles/XSD/index.htm
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and overridden data about budget, price, Management Reserve (MR), Undistributed 

Budget (UB), and MEAC cases.  

 CPR3 – Cost Performance Baseline Report in three formats 

This report displays a forecast of monthly changes to the Baseline, Management 

Reserve, and Undistributed Budget for the entire project, and contains header data 

showing schedule dates for the contract and the project.  

 CPR4 – Cost Performance Manpower Loading Report in three formats 

This report displays a forecast of hours and person-months by organization 

(Performing/Responsible), and contains header data showing schedule dates for the 

contract and the project. This report also contains program variance thresholds for 

month, cumulative, and at-complete percents and values. 

C/SSR Reports for DoD/DoE Reporting 

The C/SSR (Cost/Schedule Summary) report is used primarily for reporting cost and 

schedule summary data to the government or contractors on specific procurements. This 

report can be printed in one of three formats. The 1989 OMB format report complies with 

OMB No. 22R0327. The 1995 DID report complies with OMB No. 0704-0188 and DID 

No. DI-MGMT-81466. Definitions and instructions for these reports can be found in the 

DoDI publication 5000.2. 

This report includes cumulative and At complete summaries for each WBS element, and 

contains header data showing contractor and contract information, and MEAC 

calculations. This report also contains computed and override data about contract price, 

budget, Management Reserve (MR), Undistributed Budget (UB), and MEAC cases. 

Reports for NASA Reporting 

The NASA reports are used primarily for reporting contractor financial management to 

NASA. MPM offers three NASA 533 formats: 533-M (Monthly), 533-Q (Quarterly), and 

533-P (Monthly Performance Analysis).  Definitions and instructions for these reports 

can be found in the NASA publication NHB 9501.2b.  

These reports include cumulative and ETC summaries for each WBS element, and 

contain header data showing contract information and billing data. You can also select 

detail increments by month, quarter or year.  
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Contract Proposal Reports for DoD Reporting 

The SF1411 (Contract Pricing Proposal Cover Sheet) report is used by DoD contractors 

for providing all required information for your proposal, sorted by CLIN (Contract Line 

Item). This report is available in new or old (pre-1995) formats. 

The DD1921 (Cost Data Summary) report is used by DoD contractors for reporting cost 

data summaries for providing all required information for your proposal, sorted by CLIN 

(Contract Line Item) in OMB format. This report has header data showing contract price, 

ceiling, type, fiscal year funding, and contractor data. 

The DD1861 (Contract Facilities Capital and COM) report is used by DoD contracts for 

reporting methods of allocation of contractor facilities costs. This report is available as a 

monthly or yearly report, and has header data showing Treasury rate, proposal, and 

contract data. 
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15.4  Creating Government-Required Reports 

15.4.1  Entering Government Report Data 

The MPM government-required reports contain data which is not tracked by MPM. You 

must enter these values separately. You can enter values for the Header, Threshold, 

Variance, and COM data on the Headers dialog.  However, some of the values for the 

C/SSR and CPR reports that appear on the Headers dialog are derived from the Program 

Log.  See Special Guidelines in this section for additional details.  

To set up government-required reports, follow these steps: 

1. On the Menu Manager with the Reports tab showing, double-click the desired 

government-required report.    

 

Figure A. Select the desired government report  

MPM displays the Report Conditioning window for the report you selected. 
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 To enter headers, click here 

 
Figure B. Inside the Report Conditioning window. 

2. Click the  icon next to the Project drop-down list box to access the Headers 

dialog. You can also access the Headers dialog from the Tools Menu of the 

Project Maintenance window.  

 

Figure C. Entering Headers for a report. 

3. In the Value column, enter the Header, Variance, and any other data necessary 

for this government report. The drop-down list box at the top shows the selected 

report.  

 



MPM Projects   429 

Special Guidelines 

 The values that appear on the Headers dialog are saved with the project. You can 

then use those values repeatedly on multiple reports. The values appear as the 

default when requesting reports that use them.  

 If exporting CPR 1 through CPR 4 reports via the UN/CEFACT format refer to 

the MPM Standard Reports CPR 1 through CPR 4 sections for required entries in 

the Type field. 

 If MPM‟s Program Log is used in your organization, the values derived from the 

Program Log take precedence over values entered on the Headers dialog.  When 

changes to previously recorded Program Log values are made on the Headers 

window, the changes appear only on the report currently being generated and are 

not saved with the project. If your organization is not using the Program Log, all 

values entered on the Headers dialog are saved with the project. 

 If your organization uses the Program Log to record contract data, we recommend 

that changes to the values shown in Figure D be made using the Program Log so 

as to maintain its accuracy.  

 The values recorded on the Program Log are shown on the Headers dialog when 

you prepare to generate a C/SSR or CPR.  The table shown in Figure D lists the 

values in each report that are derived from the Program Log.  
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Headers Values Derived from Program Log 

Values C/SSR CPR 1 CPR 2 CPR 3 

Original Target Cost 
   

 

Negotiated Cost  
   

Negotiated Contract Change 
   

 

Current Target Cost 
   

 

Authorized Upriced Work 
    

Contract Budget Base 
    

Target Profit Amount  
   

Estimated Price  
   

Target price  
   

Management Reserve (BCWS) 
   

 

Management Reserve (LRE) 
    

Undistributed Budget (BCWS) 
    

Undistributed Budger (LRE) 
    

Figure D.  Values that appear in these fields on reports are derived from  

the Program Log and/or the Headers conditioning window. 

 

For a complete listing of fields necessary for each report, refer to the MPM Standard 

Reports manual. 
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15.4  Creating Government-Required Reports 

15.4.2  Cost of Money Override 

You can use the Cost of Money (COM) processor to override computed COM values for 

CPRs and C/SSR. Recall that MPM computes COM values during estimating based on 

COM burden rates in the Burdens window. 

The computed values can be overridden using the Cost of Money Override section of the 

Headers report conditioning window shown in Figure A. 

 

Figure A. You can override computed COM values for CPRs and C/SSR. 

Value Column 

You can enter override values in any or all of the fields in the Value column. The 

override values affect only the CPRs and C/SSR. The COM previously established and 

stored in the project will not be affected. In order to zero out COM on C/SSR and CPR 

reports, you must enter „.1‟ in the Value Column. 

Computed Values 

The values in the Computed column are computed by MPM using the COM data stored 

in the project. You cannot edit these values. 
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Compute Cost of Money Through 

In the Compute Cost of Money Through field, enter the month and year in MMMYY 

format for which the CPR is to be produced. You must enter this value each time you run 

the report. The Value and Computed columns will be filled in with the computed values 

based on the date you enter. 

LRE Gate Month 

Enter the month and year in MMMYY format. The data is used to calculate Cost of 

Money LRE values. If you enter a date in this field, Cost of Money LRE = CUM ACWP 

through Gate Month + ETC. You must enter these values each time you run a report. The 

Value and Computed columns will be filled in with the computed values based on the 

date you enter. 

BCWP and ACWP Values 

The BCWP values for COM are proportional to the total project BCWP. The ACWP 

values are derived from the Actuals function. You can accept the calculated COM values 

or enter override values for inclusion on the final customer report. 

At Complete Budget 

If you enter a value in the At Complete Budget field, the CPR Format 3 report values will 

be at the Total Cost Level and a separate line item will be added to the Totals Section 

called Cost of Money. This is because the input value on the COM Override is not 

timephased. 

If the field is left blank, the reporting level for the CPR is at Total Dollar and no separate 

line appears at the bottom for COM. 
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15.5  Viewing and Editing Reports 

The Report Viewer in MPM allows you to view, change, redirect, export and summarize 

your MPM reports.  

Accessing Report Viewer From the Individual Report 

To launch the Report Viewer with your report‟s data in it, follow these steps: 

1. All reports have a condition under Other Options called Output Options, and its 

default is Viewer. See Figure A. 

 

Figure A. Select the Report Viewer output option. 

2. Run your report. MPM launches the Report Viewer.  
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In Figure B, you can see the Report Viewer displaying the Resource BOE report. 

 

Figure B. The Report Viewer editing the Resource BOE Report output. 
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15.5  Viewing and Editing Reports  

15.5.1  Orientation to the Report Viewer Window 

You use the Report Viewer window to edit and view the data in your report. To access 

this window, select Viewer in the Output Options on the report conditioning window.  

 

Figure A. The Report Viewer Window. 

Report Viewer Window Grid 

This window works much like a spreadsheet. The rows and columns contain the generated 

report data and headings. You can use the Toolbar and status bar toggles on the View menu 

to show or hide either bar. See Figure A. Your report is displayed in the Report Viewer 

grid. Each field in the report is displayed as a column numbered A-Z, and each row 

represents a record of data numbered numerically. The column (field) headings are shown 

above a black bar. If your report contains totals, they are shown in a row at the bottom 

under another black bar. To see more data, use the horizontal or vertical scroll bars. 

This window allows you to edit, reformat, add calculations, reorganize, or selectively 

display or save your report data. You can also export the report data using a number of 

different formats. 
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Saving/Exporting the Report Data 

To save the report data to a file: 

1. Edit the data in the Viewer as desired. 

2. Select File | Save As. 

MPM displays the standard Windows Save dialog. 

3. Enter a file name. 

4. Select the type of Save/Export using the Save As Type list box. 

 UN/CEFACT (*.XML) for a UN/CEFACT standard XML file (CPR1 through 
CPR4 only). 

 Comma-Separated Values (*.CSV)  for a text file with values separated by 

commas. 

 Excel 95 (*.XLS) for an Excel spreadsheet in Excel 95 format. 

 Excel 97 – 2000 (*.XLS) for an Excel spreadsheet in Excel 97-2000 Format 

 Tab-Separated Values (*.TXT) for a text file with values separated by tabs. 

 HTML (*.HTM) for an HTML file which you can view in an Internet 

browser program like Netscape or Internet Explorer. 

5. Click Save. 

Printing/Previewing From Report Viewer 

 To preview the report, choose File | Print Preview. 

 To change the print options, choose File | Print Setup. 

 To send the report to the printer, choose File | Print. 

Changing the Page Format 

To change the page format, choose File | Page Setup. Use this dialog box to change 

headers, footers, scale, grids, margins, page order, and alignment. 
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15.5  Viewing and Editing Reports 

15.5.2  Editing Report Data 

You can use the Report Viewer to edit, reformat, or change anything in the report. 

Editing Cell Data 

To edit the data inside the cells (either headings or data values), position the cursor over 

the cell box, click the mouse button, and type the new data. 

 

Figure A. To edit data, click the cell and type the new data. 

Inserting Rows 

To insert a new row (which pushes the current row down), click the number of the row 

where you want to insert the row and choose Insert on the Edit menu. 

Replicating Report Data 

To move data from selected cell(s) to a new location: 

1. Highlight the desired cell(s). 

2. Choose Cut from the Edit menu.  

3. Click the cursor in the new cell location. 

4. Choose Paste from the Edit menu. 
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To copy data from selected cell(s) to another location: 

1. Highlight the desired cell(s). 

2. Choose Copy from the Edit menu.  

3. Click the cursor in the new cell location. 

4. Choose Paste from the Edit menu. 

To paste the new data into the new cell(s) without copying the formatting: 

1. Choose Paste Values from the Edit menu instead. 

To copy data from a selected cell to fill a lot of cells in the same column: 

1. Highlight the desired cell to be copied and the target cells below it to be filled. 

2. Choose Copy Down from the Edit menu, or press Ctrl+D. 

To copy data from a selected cell to fill a lot of cells in the same row: 

1. Highlight the desired cell to be copied and the target cells to its right to be filled. 

2. Choose Copy Right from the Edit menu, or press Ctrl+R. 

Deleting Report Data 

 To delete a single or multiple cells, highlight the cell(s) and choose Delete from 

the Edit menu or press Ctrl+K.  

 To delete an entire row, highlight the row by clicking on the row number and 

choose Delete from the Edit menu or press Ctrl+K.  

 To clear all the values in a cell or row, highlight the cell(s) or row and choose 

Clear from the Edit menu or press the Delete key. A dialog box prompts you to 

select All, Formats, or Values. To clear the format changes you made, select 

Formats.  

 To delete the values in the cells but keep the formatting, select Values.  

 To delete both values and formatting, select All.  

Finding/Replacing Cell Data 

 To find cell data, use the Find dialog box. Access the Find dialog box by 

choosing the Find option on the Edit menu or pressing Ctrl+F.  

 To search down, choose Search By Rows. To search to the right, choose Search 

by Columns.  

 To look in the cell data for the search string, choose Look in Values.  

 To look in the formulas the report contains for the string, choose Look in 

Formulas.  

 To replace the text that was found, click the Replace button on the Find dialog, or 

by choosing the Replace option on the Edit menu or pressing Ctrl+H. You can 

replace one occurrence at a time, or choose Replace All. 
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Figure B. Border Dialog Box.

Figure A. Alignment Dialog Box.

Figure C. Pattern Dialog Box.

15.5  Viewing and Editing Reports 

15.5.3  Formatting Cell Content Output 

To change the format of an entire row, highlight the row by clicking the row number. 

You can change the row height and hide or display the entire row using the options on the 

Format|Row menu option. 

To change the format of an entire column, highlight the column by clicking the column 

number. You can change the column width and hide or display the entire column using 

the options on the Format|Column menu option. 

Setting the Alignment 

To specify the horizontal and vertical alignment of 

data in the selected cells, choose Alignment on the 

Format menu. MPM displays the alignment dialog 

box shown in Figure A.  

Changing the Font 

To change the font of the selected cell(s), use the 

Font option on the Format menu. 

Note: MPM is designed to use True Type fonts for printing, scaling, scale, etc.  
If you select non-True Type fonts, these attributes may be adversely affected. 

Border 

To change the border design or color of 

the selected cell(s), use the Border option 

on the Format menu. MPM displays the 

Border dialog box shown in Figure B. 

Pattern 

To change the fill pattern and/or color of the selected 

cell(s), use the Format|Pattern menu option. MPM 

displays the Pattern dialog box shown in Figure C. 
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Custom Numbers 

Use the Numbers option on the Format menu to create a custom number format. The 

following list shows the results of applying different formats to a positive number (3), a 

negative number (-3), and a decimal number (.3). 

Category Format 3 -3 .3 
Currency $#,##0_);($#,##0) $3 ($3) $0 

 $#,##0_);[RED]($#,##0) $3 ($3) $0 

 $#,##0.00_);($#,##0.00) $3.00 ($3.00) $0.30 

 $#,##0.00_);[RED]$(#,##0.00) $3.00 ($3.00)  $0.30 

Fixed 0 3 -3 0 

 0.00 3.00 -3.00 0.30 

 #,##0 3 -3 0 

 #,##0.00 3.00 -3.00 0.30 

 #,##0_);(#,##0) 3 (3) 0 

 #,##0_);[RED](#,##0) 3 (3)  0 

 #,##0.00_);(#,##0.00) 3.00 (3.00) 0.30 

 #,##0.00_);[RED](#,##0.00) 3.00 (3.00)  0.30 

Percent 0% 300% -300% 30% 

 0.00% 300.00% -300.00% 30.00% 

Fraction # ?/? 3 -3 2/7 

 # ??/?? 3 -3 3/10 

Scientific 0.00E+00 3.00E+00 -3.00E+00 3.00E-01 
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15.5  Viewing and Editing Reports 

15.5.4  Report Viewer Sheets 

Sheets are a great way to split up your data into logical, separate pieces. 

Inserting Additional Sheets 

To insert a new sheet, choose Insert Sheet on the Sheet menu. MPM displays the Report 

Viewer window with a new, empty sheet and a new tab labeled Sheet2 as shown in 

Figure A. You can then add new data or replicate data from Sheet1 using Copy | Paste if 

desired. 

 

Figure A. Inserting a New Sheet. 
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To rename the sheet, double-click the desired sheet tab. In Figure A, the Sheet2 tab was 

double-clicked. MPM displays the Sheet Name dialog box as shown in Figure B. 

 

Figure B. Renaming the sheet 

Deleting Sheets 

To delete a sheet, click the sheet‟s tab and choose Delete Sheet on the Sheet menu.  

Note: You will not be prompted for confirmation of the delete, and you cannot 
undo the deletion, so be sure you are deleting the correct sheet before selecting 
this option! 

You cannot delete the last sheet in the Report Viewer; an error message will result. 

 



MPM Projects   443 

Figure A. The Page Setup Dialog Box.

15.5  Viewing and Editing Reports 

15.5.5  Setting the Report Viewer Output 

Selecting the Print Area 

You can select only a portion of the current data to be printed, by setting the Print Area. 

This can be very useful if you only need to print part of one column, or just the totals, etc. 

To do this, highlight the cell(s) you want to print, and choose Set Print Area on the Sheet 

menu, and then Print from the File menu. MPM uses the titles, header, footer, and other 

settings to print a report which only contains the data in the selected print area. 

Changing the Header or Footer 

To change the header or footer, 

choose the Page Setup option on 

the File menu. MPM displays 

the Page Setup dialog box 

shown in Figure A. Use the 

Header text box to enter your 

page header. Use the Footer text 

box to enter your page footer.  

To insert variables such as Page 

Number or Today‟s Date, use 

these Format Codes. Codes and 

text are, by default, centered 

unless &L or &R is specified. 

Code Description 

&L Left-aligns the characters that follow. 

&C Centers the characters that follow. 

&R Right-aligns the characters that follow. 

&D Prints the current date. 

&T Prints the current time. 

&F Prints the workbook name. 

&A Prints the worksheet name. 

&P Prints the page number. 

&P+# Prints the page number plus a number you enter (for example,, &P+1.) 

&P-# Prints the page number minus a number you enter (for example, &P-1.) 

&& Prints an ampersand. 

&N Prints the total number of pages in the document. 
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The following font codes must appear before other codes and text or they are ignored. 

The alignment codes (for example, &L, &C, and &R) restart each section; new font 

codes can be specified after an alignment code. 

&B Makes text bold. 

&I Makes text italicized. 

&U Underlines the header. 

&S Strikeout the header. 

&fontname Use the specified font. 

&nn Use the specified font size - must be a two digit number. 

Changing the Margins, Page Range, Scale, and Column Headers 

To change any of these options, access the Page Setup dialog box as described above. 

Setting and Removing Page Breaks 

To set a page break, click the cell or row and choose Set Page Break on the Sheet menu. 

To remove a page break, click the cell and choose Sheet | Remove Page Break. 

Fixing and Releasing Rows/Columns 

To fix a row at the top of the screen that you will continue to see when scrolling down, 

click the row number(s) and choose Fix Rows on the Sheet menu. 

To fix a column at the left edge of the screen that you will continue to see when scrolling 

to the right, click the column number(s) and choose Fix Columns on the Sheet menu. 

To release the fixed row/column(s), select it and choose Sheet | Unfix Rows/Columns. 

Inserting a Formula 

To insert a formula, click the desired cell and begin the entry with an equal sign (=). You 

can perform the following types of calculations:  

+ (addition) - (subtraction) / (division) * (multiplication) 

Use  % to indicate percentage, ^ (exponentiation), & (concatenation).  

To perform comparisons, use = (equal to), > (greater than), <  (less than), >= (greater 

than or equal to), <= (less then or equal to), <> (not equal to).  

To identify the cells in a formula, refer to the row and column headings of the cell. A1 

refers to the cell in row 1, column A. To reference a range of cells, use a colon (:). For 

example, A1:C3 refers to all cells in columns A, B, and C of rows 1, 2, and 3. 

You can also enter functions into a formula, such as SUM, AVERAGE, COUNT. For 

example, to sum the first 10 cells of column A, enter the formula =SUM(A1:A10). 
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15.6  Batch Report Processing 

Many MPM users run the same set of reports every month as part of their monthly status 

processing. To set up a batch report process that runs several reports, create a Batch 

Report file.  

Creating a Batch Report File 

There are two ways to create a Batch Report File: 

 On the Menu Manager with the Reports tab selected, double-click the icon for the 

first report to be performed. Inside the Report Conditioning window, click in the 

left window pane and choose Add Report on the Edit menu. MPM displays a list 

of all available reports. Double-click the next report to be added. 

 On the Menu Manager with the Reports tab selected, use the Shift and Ctrl keys to 

select more than one type of report. Double-click on the last icon selected. 

Figure A shows a Batch Report file with the four CPR reports. 

 

Figure A. Creating a Batch Report File to process four CPR reports. 

The icons in the left window pane show you the report(s) you have added to this Batch 

Report File. When you click on an icon in the left pane, the right pane shows the Report 

Conditioning for that report.  

In Figure A, CPR1 is selected and the CPR1 Report Conditioning is displayed. If you 

click the CPR2 icon, the CPR2 Report Conditioning would be displayed in the right pane. 

Enter the desired report conditions.  
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To accept the selections and run the selected reports, do one of the following: 

 Click the Run button  

 Choose Run Report on the Tools menu, or press Ctrl+R 

To save the Report Conditioning data, do one of the following: 

 Click the Save button  

 Choose Save from the File menu, or press Ctrl+S 

MPM prompts for the location and file name to be saved. The default location will be a 

directory called REPORTS located under the WINMPM directory. Saved reports are 

given the name report.MFR. Once you have saved a report, MPM adds a Saved Reports 

tab to the Menu Manager, where all saved reports can be accessed later. 

Adding Additional Reports 

To add additional reports, in the Report Conditioning window with the left window pane 

selected, choose Add Report on the Edit menu, or press the Insert key. MPM displays the 

Add Report dialog. 

Accessing Saved Reports 

When you save your Batch Report file, MPM adds a tab to the Menu Manager next to 

Reports called Saved Reports, which shows an icon for every saved Batch Report file you 

have created. (Issue the Edit|Refresh command to display the Saved tab.) In Figure B, 

you can see several saved Batch Reports. To access a 

saved Batch Report file, double-click its icon. 

MPM displays the Report Conditioning window with 

icons for all the reports in the selected Batch Report 

file. Change any options as desired and run the report 

when ready. 

 

Figure B. Viewing Batch 
Report Files  
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Deleting Batch Reports 

To delete a Batch Report from the Saved Reports tab, do one of the following: 

 Right click on the report then select Delete Item. 

 Select the report then choose Edit|Delete Item. 

 Delete the corresponding report.MFR file from the Reports folder in the 

WINMPM directory. 

In Menu Manager, open the View menu and choose Refresh. 

MPM removes the batch report icon from the Saved Reports tab. If the batch 

report is the last icon on the tab, MPM also removes the Saved Reports tab. 



448   Chapter 15: Reports 

15.6  Batch Report Processing 

15.6.1 Using Formulated Dates 

In all Report Conditioning options that require a date, instead of entering an actual date, 

you can enter a date formula. A date formula is a calculation based on the current date. If 

you have a standard set of reports that are run every month, using this feature will save 

you a lot of time, because you can reuse the report conditioning without modifying it for 

the current period. 

The current accounting period is substituted in any report conditioning criteria when you 

enter =<CURRENT>, based on your system date or the date you enter in Set Current 

Date on the Tools menu. To substitute other dates, modify the date formula by adding or 

subtracting d)ays, m)onths, p)eriods, or y)ears. 

In conditioning options that require a date (for example, 17-JUL-97), you can use d)ays 

or y)ears in your formula. For example, if today is July 17
th
, 1997: 

 =<CURRENT> + 3y  would be calculated as July 18
th
, 2000 

 =<CURRENT> + 60d would be calculated as Sept 15
th
, 1997  

In conditioning options that require a period (for example, JUL-97), you can use m)onths 

or p)eriods in your formula. For example, if the current period is JUL-97: 

 =<CURRENT> + 3p would be calculated as OCT-97 

 =<CURRENT> - 2m would be calculated as MAY-97 

Once you enter a formulated date and move to another field on the Report Conditioning 

window, the date is calculated based on the current date and displayed in brackets next to 

the formula in the Criteria box. See Figure A. The Gate Month entered is three fiscal 

months after the current month. 

Using formulated dates is extremely valuable when you save report conditioning for later 

batch processing, especially when a Batch Report file contains multiple reports. Each 

time you run the same report(s), the dates will be recalculated based on the current date 

without you having to re-enter the new dates.  

Always be sure that the Current Date is set correctly before running the report, either in 

the system date or by using Set Current Date, so that your formulated dates are calculated 

correctly. 

You cannot use formulated dates on Headers. 
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Entering the formula for

a different Gate Month

 

Figure A. Setting the Gate Month using a Formulated Date which is three months later 
than the current fiscal month. 
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16.1  Introduction to Data Imports 

Use Data Imports to bring data into the various MPM modules. Many customers import 

some of their cost or scheduling data from other software systems, such as accounting or 

personnel systems. There are also customers who export their MPM data, make some 

change to it, and then import it back into MPM. 

Types of Imports 

MPM allows import of the following types of data: 

 A

ctuals 

 B

CWP 

 D

istributed Projects 

 E

stimates 

 G

lobal File Data 

 F

iscal and Holiday Calendars 

 E

OC Tables 

 B

urden Codes and Rates 

 R

esource Codes and Rates 

 B

urden Templates 

 M

ilestones 

 O

rganizational Breakdown Structure (OBS) 
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 T

ask descriptions 

 B

asis of Estimate 

 D

escriptive WBS data 

 W

BS Schedule data 
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16.1  Introduction to Data Imports 

16.1.1  General Import Steps 

To import data into MPM from an outside spreadsheet, accounting system, or other 

system, follow these general steps: 

1. Create the import file in comma-delimited, ASCII format. 

If your system does not provide exports, or if the available file formats differ 

from the format described in this chapter, you will need to use a file editor, such 

as Windows Notepad or a spreadsheet package, to edit the file. The import file 

must be formatted exactly as described, or errors may result causing data 

corruption! Be sure to read the guidelines in topic 16.4 Creating Import Files. 

2. Backup your MPM data before running the import! 

3. Access the correct Import Conditioning window as described in topic 16.2  

Accessing the Import Conditioning Windows. 

4. Fill in the import conditions for that particular import, as described in topics 16.6 

through 16.14. 

5. Run the import as described in topic 16.3  Orientation to the Import Conditioning 

Windows. 
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16.2  Accessing the Import Conditioning Windows 

You open the Import Conditioning windows by clicking the Imports tab on the MPM 

Menu Manager. When you access the Imports tab, all imports to which you have been 

granted access are listed. Double-click the desired import icon. 

 

Figure A. Select the icon on the Imports tab of the 
MPM Menu Manager. 

Procedure 

To open the desired Import window: 

1. From the Menu Manager window shown in Figure A, do one of the following: 

 Select the Imports tab and choose the icon for the desired type of import. 

 Choose Imports from the File menu and select from the list of imports 

available. 
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Each import has a window which contains the conditioning options that modify the 

import. MPM displays the Import Conditioning window for the selected type of import. 

Figure B below shows the Actuals Import Conditioning window. 

 

Figure B. Select a project and other options. 

To run more than one import at once, see topic 16.5  Batch Import Processing. 
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Select the project 

Specify the import 
file name/location 

Specify any 
additional import 
options 

Criteria Column 

Filter Column 

Type of Import 

16.3  Orientation to the Import Conditioning Windows 

You use the Import Conditioning windows to setup an import of data into MPM. A 

toolbar gives you quick access to common tasks. The Import Conditions grid displays the 

information about the import. 

Figure A. Selecting the Import Conditions. 

Import Conditions Grid 

In every Import Conditioning window, the left pane of the window displays the icon(s) 

for the selected type of import, and the right pane displays the conditioning information 

about the import. The right pane is divided into two columns. The Filter column shows 

the import condition field to be specified. The Criteria column contains the list boxes, 

check mark boxes, or text entry boxes in which you enter the criteria for the condition. 

The rows are grouped into categories; category headings are shown in gray for reference. 

In every import conditioning window, you must specify the name of the project and the 

name and location of the import file. You enter this criteria in the white boxes under the 

gray categories Project Selection and Filename Selection. Some Import Conditioning 

windows only contain these two conditions. Other Import Conditioning windows, such 

as Actuals shown in Figure A, contain additional conditions which are specific to that 

type of import and may be required. These conditions are shown under an additional 

category named Import Options. 
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Running the Import 

To set up and run the import: 

1. From the Menu Manager window, select the Imports tab and double-click the 

icon for the desired import. MPM displays the Import Conditioning window for 

the selected type of import. 

2. The Criteria box for the project contains a list box of available projects. To view 

this list, click in the Criteria column on row 2. Choose a project from the list box. 

3. Specify the import file name and location. 

When you click in the Criteria box for the import file, a  button is added to the 

box. Use this button to bring up a browse window for finding the correct file.  

4. Select other options (if applicable). 

5. If desired, you can change the current date by clicking the Set Date  button, 

or by selecting Set Current Date on the Tools menu. 

6. To accept the selections and run the import, do one of the following: 

 Click the Run button . 

 Choose Run Import on the Tools menu, or press Ctrl+R. 

Previewing and Printing Import Conditioning 

You can preview and print the import conditioning data using the options on the File 

menu. For complete details on using these options, see Using MPM of the Getting 

Started manual. Print and Preview only show the conditioning which you have entered 

on the grid. They do not display the results of running the import.  

Saving the Import Conditioning 

To save the Import Conditioning data, do one of the following: 

Click the Save button . 

Choose Save from the File menu, or press Ctrl+S. 

MPM prompts for the location and file name to be saved. See topic 16.5  Batch Import 

Processing for details on using saved conditioning. 
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Processing Report 

When the import is processed, a report is produced which lists items that were updated or 

added to the project along with errors encountered (if any) during the import.  You can 

select from the following options when generating the processing report: 

Output Options: The report can be viewed (default), printed, or saved as a .CSV file. 

Output File Name: If you select CSV as your output option, you must enter a name for 

your file with the three-character extension of .CSV. 

Append to Existing File: This option allows you to append multiple processing reports 

to one file.  This option is used for batch imports or to keep a running log of import 

processing. 
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Figure A. WBS Leg Dialog Box

16.3  Orientation to the Import Conditioning Windows  

16.3.1 Import Data Conditioning 

There are import conditioning options that are specific to particular imports. When 

specifying your selections on these options, choose the values from the drop-down list 

available for the option. See the topic later in this chapter that describes the particular 

import in more detail.  

Conditioning Global Data Imports 

When importing Global data, one or more of the following data conditioning options will 

be available: 

Global ID (required) - On all Global imports, specify the Global File from which the 

data is to be imported, from a drop-down list of Global File IDs. 

Report Timeframe Information (optional) - Dates can be entered in the usual formats, 

or as Formulated Dates. See topic 16.5.1 Using Formulated Dates for instructions on 

using Formulated Dates. 

There are import conditioning options that are specific to these imports. When specifying 

your choice for these options, select from drop-down lists of all possible values. See the 

topic later in this chapter that describes the desired import for more detail.  

Conditioning Project Data Imports 

1. When importing Project data, one or more of the following data conditioning 

options will be available: 

Project Selection (required) - For all imports, 

specify the Project from which the data is to be 

imported, choose from a drop-down list of 

Project IDs.  

Report Timeframe Information (optional) - 

Dates can be entered in the usual formats, or as 

Formulated Dates. See topic 16.5.1 Using 

Formulated Dates for instructions on using 

Formulated Dates. 
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WBS Leg (optional) - To import a particular WBS Leg, enter the WBS ID, or click the 

 button which is added to the WBS Leg criteria box when clicked.  

MPM displays the WBS Leg dialog box shown in Figure A.  

Highlight the desired leg, expanding levels if necessary.  

The WBS ID selected is inserted in the Criteria box.  

WBS Level (optional) - Enter a value from 1 through 99 to import WBS elements at the 

level entered. If a WBS leg is entered, the WBS level will validate the lowest level of that 

leg. 

WBS Manager (optional) - To import only WBS elements assigned to a specific 

Manager, enter or select the Manager‘s name from the drop-down list box. 

XREF, Alias, Element Type (optional) - To select data to be imported using any of 

these fields, click in the Criteria box and select from the drop-down list containing all 

possible values. 

Recurring/Non-recurring (optional) - To select Recurring or Non-recurring WBS 

elements, select either option on the drop-down list in the Criteria box.  

OBS (optional) - To select the WBS elements assigned to either the Performing or 

Responsible OBS departments, select either option on the list in the Criteria box. 

Department (optional) - To select data assigned to a particular OBS Department, enter 

the Department. 

CLIN (optional) - To select data assigned to a particular Contract Line Item (CLIN) 

Table, click in the Criteria box and select from the list containing all possible CLINs. 
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16.4 Creating Import Files 

When creating import files, follow these important guidelines: 

Files must be created in ASCII format. 

Each file is made up of a number of records (or rows), separated by a carriage return.  If 

you are creating your import files in a word processor, be sure to save the file as a .TXT 

(text) file, not .DOC (document). Most spreadsheet packages offer an option to save the 

file in both a CSV and comma delimited format which is an acceptable file format for 

importing. 

Each record must start on a new row/line. 

Each record must have commas as column separators; all fields in the record (even blank 

fields) must be separated from the next field by a comma. 

Avoid using commas in all text fields (for example, do not include commas in the 

Resource Code Description).  If a text string field contains one or more commas, 

surround the field with quotation marks.  For example, ―21-100,A‖ or ―21,100‖. 

Do not use commas in writing numerical values (i.e., write 10000 not 10,000), or dollar 

signs in dollar amounts (i.e., write 10000 not $10000). 

Use decimal points when writing dollar amounts (i.e., DO write 10000.00). 

Use the minus symbol (-) preceding dollar amounts to indicate negative values.  To 

indicate positive values, enter the numbers without a symbol or precede the dollar 

amounts with the plus symbol (+). 

Numeric fields equal to zero can be designated by a zero or a blank.  For example, you 

may enter either the delimiting comma for the previous field, a zero and the delimiting 

comma for the next field (,0,) or enter two commas together (,,).  (This does not apply to 

date fields.) 

Valid date formats:  

M/D/YY DD/MMM/YY MM-DD-YY 

M/DD/YY DD/MMM/YYYY D-MMM-YYYY  

M/D/YYYY M-D-YY DD-MMM-YY  

M/DD/YYYY M-DD-YY DD-MMM-YYYY  

MM/D/YY M-D-YYYY DMMMYY 

MM/DD/YY M-DD-YYYY DMMMYYYY 
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MM/D/YYYY  MM-D-YY DDMMMYY 

MM/DD/YYYY  MM-D-YYYY DDMMMYYYY 

D/MMM/YY MM-DD-YYYY  YYMMDD*  

D/MMM/YYYY D-MMM-YY  YYYYMMDD 

* The YYMMDD date format is not a valid format for the BCWP import. 

If no data is to be input in a field, you must still enter a comma as a column separator to 

indicate the blank field. For example, in the import record CAL,01FEB94,,172 there is a 

blank field between 01FEB94 and 172. 

Any special characters that result in binary characters (for example, ―em dash‖ (–)) are 

not to be used in MPM as they may cause problems in reports. 

Fields will be truncated if they exceed the maximum size specified for that field. 

Import File Formats Legend 

Many of the topics that follow describe the file formats for imports. The formats are 

presented in tables with the following columns: 

Field Position - Each record (row) is broken into a number of fields, separated by 

commas. The Field Position column describes where each field should be located in the 

record. 

No. of Chars - This column lists the maximum number of characters this field may 

contain. If the Fee field contains 12 characters, you can enter less than 12 characters, but 

not more. MPM knows how long the field is because it starts and ends with a comma. 

Type - This column shows the type of data you should enter into this field. The field 

types in the import files are listed with the following abbreviations:   

A Alphanumeric 

N Numeric  

Y/N Yes/No  (field would contain Y or N only) 
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Field Content - This column describes the general content of the field‘s data, which 

should correspond to a field on the window for that data type. For example, the Resource 

Code field in the actuals import file corresponds to the resource code that you would 

enter into the Actuals window. To find more information about that field, refer to the 

chapter about the window. 

Fields marked with  are mandatory fields. You must provide data in these fields or you 

will receive an error when you run the import and the record will not be imported. 
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Figure A. Creating a Batch Import File to 
process WBS Descriptive and Schedule 
Data. 

16.5  Batch Import Processing 

Many MPM users perform the same set of imports every month as part of their monthly 

status processing. To set up a batch import process which performs several imports, 

create a Batch Import file.  

Creating a Batch Import File 

There are two ways to create a Batch Import File: 

On the Menu Manager with the Imports tab selected, double-click the icon for the first 

import to be performed. Inside the Import Conditioning window, click in the left window 

pane and choose Add Import on the Edit menu. MPM displays a list of all available 

imports. Double-click the next import to be added. 

On the Menu Manager with the Imports tab selected, use the Shift and Ctrl keys to select 

more than one type of import. Double-click on the last icon selected. 

In the example in Figure A, we have 

created a Batch Import file with two 

imports: WBS Schedule data and WBS 

Descriptive data.  

The icons in the left window pane show 

you the import(s) you have added to this 

Batch Import File. When you click on an 

icon in the left pane, the right pane shows 

the Import Conditioning for that import. 

In Figure A, WBS Schedule is selected 

and the WBS Schedule Import 

Conditioning is displayed. If you click 

the WBS Descriptive icon, the WBS 

Descriptive Import Conditioning would 

be displayed in the right pane. Enter the 

desired import conditions.  

To accept the selections and run the import, do one of the following: 

Click the Run button . 

Choose Run Import on the Tools menu, or press Ctrl+R. 

The Processing Result Report prints as it does after every import. 

To save the Import Conditioning data, do one of the following: 
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Click the Save button . 

Choose Save from the File menu, or press Ctrl+S. 

MPM prompts for the location and file name to be saved. The default location will be a 

directory called IMPORTS located under the DELTEKMPM directory. Saved imports 

are given the name import.MFI. Once you have saved an import, MPM adds a Saved 

Imports tab to the Menu Manager, where all saved imports can be accessed later. 

Accessing Saved Conditioning 

When you save your Batch Import file conditioning, MPM adds a tab to the Menu 

Manager next to Imports called Saved Conditioning, which shows an icon for every 

saved Batch Import file you have 

created. In Figure B, you can see several 

saved Batch Imports. To access any of 

the saved Batch Import files, double-

click the icon. 

MPM displays the Import Conditioning 

window with icons for all Batch Import 

Files. Change any conditioning as 

desired, and run the import when ready. 

Deleting a Batch Import 

To delete a batch import from the Saved Imports tab, do one of the following: 

 Right click on the import then select Delete Item. 

 Select the import then choose Edit|Delete Item. 

 Delete the corresponding .MFI file from the Imports subdirectory in the 

DELTEKMPM directory. In Menu Manager, open the View menu and choose 

Refresh. 

MPM removes the batch import icon from the Saved Imports tab. If the batch import is 

the last import icon on the tab, MPM also removes the Saved Imports tab. 

 

Figure B. Viewing Batch Import Files on the 
Menu Manager 
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16.5  Batch Import Processing 

16.5.1 Using Formulated Dates 

In all Import Conditioning options that require a date, instead of entering an actual date, 

you can enter a date formula. A date formula is a calculation based on the current date. If 

you have a standard set of imports that are run every month, using the date formula 

allows you to reuse the import conditioning without having to modify it for the current 

period. 

The current accounting period is substituted in any import conditioning criteria when you 

enter =<CURRENT>, based on your system date or the date you enter in Set Current 

Date on the Tools menu. To substitute other dates, modify the date formula by adding or 

subtracting d)ays, w)eeks, p)eriod, or y)ears. 

When filling conditioning options that require a date (for example, 17-JUL-97), you can 

use d)ays or y)ears in your formula. For example, if today is July 17
th
, 1997: 

 =<CURRENT> + 3y  would be calculated as July 18
th
, 2000 

 =<CURRENT> + 60d would be calculated as Sept 15
th
, 1997  

When filling conditioning options that require a period (for example, JUL-97), you can 

use m)onths or p)eriods in your formula. For example, if the current period is JUL-97: 

 =<CURRENT> + 3p would be calculated as OCT-97 

 =<CURRENT> - 2m would be calculated as MAY-97 

Once you enter a formulated date and move to another field on the Import Conditioning 

window, the date is calculated and displayed in brackets based on the current date. See 

Figure A. The Gate Month entered is three fiscal periods after the current period. 

Using formulated dates is extremely valuable when you save import conditioning for later 

batch processing, especially when a Batch Import file contains multiple reports. Each 

time you run the same report(s), the dates will be recalculated based on the current date 

without you having to re-enter the new dates.  

Always be sure that the Current Date is set correctly before running the report to ensure 

that your formulated dates are calculated correctly. The date can be set by updating the 

system date or by using Set Current Date on the Tools menu. 
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Entering the formula for

a different Gate Month

 

Figure A. Setting the Gate Month using a Formulated Date 
based on the current period. 
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16.5  Batch Import Processing 

16.5.2 Batch Import Conversion Utility 

The Batch Import Conversion Utility (BICU) provides another way to create saved 

imports in MPM. Saved exports and saved imports used with distributed projects can also 

be created using this utility. You can create Comma Separated Value (.CSV) files outside 

of MPM and then use BICU to convert them into saved import (.MFI) and saved export 

(.MFE) files used in MPM. 

Parameters 

The BICU accepts these parameters: 

Input file name 

Output file name 

/D Distributed project file 

/O Processing report file name 

Input File Name Parameter 

This parameter is the batch file that will be converted into the .MFI or .MFE file. See the 

section on Batch Import Conversion Utility (BICU) File Formats for more information. 

The input file must be in Comma Separated Value (CSV) format. The file name must 

have an extension. If no extension is given, the system defaults to CSV. You can specify 

the drive and path for the file.  

For example: 

BICU C:\BATCH\STANDARD.CSV 

Output File Name Parameter 

This parameter is the batch import file (and batch export file when using the Distributed 

parameter) that will be created in MPM. The output file name must be a valid DOS name 

with a maximum of eight characters. It is not necessary to include an extension because 

the BICU will automatically add the extension .MFI.  

You can specify the drive and path for the file, if you wish. If you do not specify a drive 

and path, the BICU automatically places the file in the Imports subdirectory under the 

MPM executable directory. If the Imports subdirectory does not exist, the utility creates 

it. If you place the file in a directory other than Imports, the file does not appear on the 

Saved Imports tab in Menu Manager. 
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When converting a Distributed file, a batch export file with an extension of .MFE is 

created in the Exports subdirectory. The same rules that apply for the batch import file 

apply to the batch export file. 

BICU C:\BATCH\STANDARD.CSV STANDARD 

If the input file contains fewer options than required by the .MFI file, the BICU adds the 

MPM default values for the options. 

If a file already exists in the target directory with the same name as the output file, the 

existing file will be overwritten. 

For Admin/Workstation Installations, the .MFI and .MFE files need to be copied to the 

Imports and Exports folders under the Working directory on every user‘s hard drive. 

/D Distributed Project File Parameter 

If you are using a distributed project batch file, you must add the /D parameter at the end 

of the command line. For example: 

BICU C:\BATCH\DISTRIB.CSV DISTRIB /D 

This creates a batch import and batch export file that can be used in MPM for Windows. 

/O Processing Report File Name Parameter 

Use this optional parameter in order to specify an output file name for the Import 

Processing report.  The file name must be a valid DOS name with a maximum of eight 

characters. The file name must have an extension. If no extension is given, the system 

defaults to CSV. The file will be placed in the MPM System folder. 

BICU C:\BATCH\STANDARD.CSV STANDARD /O REPORT 

BICU C\BATCH\DISTRIB.CSV DISTRIB /D /O REPORT 

The Append to Existing File option is automatically selected in the Import Conditioning 

window.  Therefore, you can report multiple imports on the same processing report 

without entering a new file name.  If you want a separate processing report on each 

import, clear the Append check box and enter a new file name for each import.   

If this parameter is not used, then the Import Processing report is output to the Report 

Viewer. 
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Running the Batch Import Conversion Utility 

To run the BICU: 

1. Run the BICU.EXE executable file from the command prompt, specifying the 

input and output file names. 

 As the Utility begins executing, it displays a message confirming the type of 

input file being converted. 

BICU: This batch import conversion is for distributed project(s). 

or 

BICU: This batch import conversion is for standard import(s). 

 

As the Utility converts the records in a Distributed Project batch file to a batch 

import file, it displays the following confirmation message for each record. 

BICU: Converted Source Project: <source project>; Transfer 

File Name: <transfer file name> 

 

As the Utility converts the records in a Distributed Project batch file to a batch 

export file, it displays the following confirmation message for each record. 

BICU: Converted Project (export): <source project>; Transfer 

File Name: <transfer file name> 

 

As the Utility converts the records in a Standard batch import file, it displays the 

following confirmation message for each record. 

BICU: Converted Project: <project>; Import ID: <import type>; 

File Name: <import file name>. 

 

If an error occurs during the conversion process, the BICU displays an error 

message, aborts the conversion, and deletes the .MFI file it created. See the 

Troubleshooting subheading below for a description of the most common error 

messages. 

2.  Check the target directory to confirm that the file was created. 
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Troubleshooting 

If an error occurs during the conversion process, the utility displays an error message. 

The most common error messages are described below. 

BICU: Usage: bicu <InputFile> <OutputFile> [/D] [/O <Filename>] 

Indicates the number of arguments on the command line is less than three or greater than 

four. 

BICU: This batch import conversion is for standard import(s). 

BICU: Conversion process failed. Please check <InputFile> for errors. 

The input file is a distributed project batch file, but the /D parameter was not specified on 

the command line.  Add the /D parameter and run the utility again. 

 BICU: This batch import conversion is for distributed project(s). 

 BICU: Conversion process failed. Please check <InputFile> for errors. 

The input file is a standard batch import file, but the /D parameter was specified on 

the command line.  Remove the /D parameter and run the utility again. 

 BICU: Failed to create IMPORTS directory. 

The BICU was not able to create the IMPORTS subdirectory.  

 BICU: Failed to open file. <InputFile>. 

The Utility could not open the file. Check the format of the file and try running the 

utility again. 

 BICU: File size is zero. <InputFile>. 

Indicates the input file is empty. Check the file contents and run the utility again. 

 BICU:Conversion process failed. Please check <InputFile>, for errors. 

The conversion process failed. Check the input file for errors and run the utility again 
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Batch Import Conversion Utility (BICU) File Formats 
 
The following tables contain file formats used in the Batch Import Conversion Utility 

(BICU).  

  

Use the following tables to create Comma Separated Value (.CSV) file equivalents of 

batch import and distributed batch import/export files. BICU can then be used to 

convert them into saved import (.MFI) and saved export (.MFE) files used with 

MPM.  

 

In the Type column, A = alphanumeric and Y/N = Yes/No (field would contain Y or 

N only). 
 

Actuals Batch Import File Format 

Each record must contain three commas as column separators, one after each field except the 

last field.  

Example: projname,ACTUALS,filename,A  

Example: projname,ACTUALS-A,filename,A  

 

 

 

 

 
Field 
Position  

No. of 
Chars 

Type  Field Content  

1  20  A  Project Name  

2  7  A  Import ID for Autoburden option. Valid entries are: ACTUALS = 

Autoburden disabled ACTUALS-A = Autoburden enabled  

3  30  A  Import File Name  

4  1  A  If duplicate actuals are encountered, define handling. Valid entries are: A 

= Update file with new values B = Accumulate old values and new 

values C = Ignore the new values  
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Basis of Estimate Batch Import File Format 

Each record must contain two commas as column separators, one after each field except the 

last field.  

Example: projname,BOE,filename  

BCWP Batch Import File Format  

 
Each record must contain two commas as column separators, one after each field except the last field.  

Example:  projname,BCWP,filename  

 

Estimates Batch Import File Format 

 
 
Each record must contain three commas as column separators, one after each field except the last field. 

Example: projname,ESTIMATES-M,filename,A  

Example: projname,ESTIMATES-A,filename,A 

 

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  11  A  Import ID to specify monthly or autospread values.  Valid entries are:   

ESTIMATES-M = Monthly Values   ESTIMATES-A = Autospread  

3  30  A  Import File Name  

4  1  A  Import Estimate Data for Baseline, ETC, or Both Baseline and ETC.  Valid 

entries are:   A = Baseline Estimates   B = ETC Estimates   C = Both  

 

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  4  A  Import ID (BCWP)  

3  30  A  Import File Name  

 

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  3  A  Import ID (BOE)  

3  30  A  Import File Name  
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Milestone Batch Import File Format 

 
Each record must contain five commas as column separators, one after each field except the last field.  

Example: projname,MILESTONES,filename,S,Y,01-JUN-02 

 

OBS Batch Import File Format 

Each record must contain three commas as column separators, one after each field except the last field.  

Example: projname,OBS,filename,P 

 

Task Description Batch Import File Format 

 
Each record must contain two commas as column separators, one after each field except the last field.  

Example:  projname,TD,filename  

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  2  A  Import ID (TD)  

3  30  A  Import File Name  

 

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  3 A  Import ID (OBS)  

3  30  A  Import File Name  

4 1 A Organization Type 

P = Performing 

R = Responsible 

 

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  10  A  Import ID (MILESTONE)  

3  30  A  Import File Name  

4  1  A  Identify Milestones by ID, Description, or by Symbol, Description and 

Schedule Date.  Valid Entries are: I = Milestone ID   D = Milestone 

Description   S = Symbol + Description + Schedule Date  

5  1  Y/N  Update BCWP Status = Y or N  

6  9  A  Fiscal Status As Of Date (DD-MMM-YY)  
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WBS Descriptive Batch Import File Format 

 
 

Each record must contain two commas as column separators, one after each field except the last field.  

Example: projname,WBS-DESC,filename  

 
WBS Schedule Batch Import File Format 

 
Field 
Position 

No. of 
Chars 

Type Field Content 

1  20  A  Project Name  

2  9  A  Import ID (WBS-SCHED)  

3  30  A  Import File Name  

4  9  A  TIME Now Date (DD-MMM-YY)  

5  1  Y/N  Update Baseline Dates from early or Late = Y or N  

6  1  Y/N  Shift Resources = Y or N  

7  1  A  Update Baseline Dates from Early or Late = E or L  

8  1  Y/N  Shift Resources = Y or N  

9  1  Y/N  Shift Milestones Schedule Dates = Y or N  

10  1  Y/N  Shift Milestone Forecast Dates = Y or N  

*11-23  1  A  Hold constant Value for the number of EOCs you have in your library; 

include a Hold Constant Value for each EOC to be included in the 

import.  Valid entries are:   H = Hours   E = Equivalent Men   P = Prime 

Dollars   B =Total Burdened   C = Total Cost   D = Total Dollars T = 

Total Price   O = Original Estimate Type  

*If you have elected to Shift Resources by entering Y in Fields 6 and/or 8, then you must also select a 

Hold Constant Value for each EOC in your library (Fields 11 through 23.)  

 

 
Field 
Position  

No. of 
Chars  

Type  Field Content  

1  20  A  Project Name  

2  8  A  Import ID (WBS-DESC)  

3  30  A  Import File Name  
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Each record must contain twenty-two commas as column separators, one after each field except the last 
field. 

Example: projname,WBS-SCHED,filename,01-JUN-02,E,Y,E,Y,Y,Y,H,P,O,,,,,,,,,, 

 

Distributed Project Batch File Format 

 
Each record must contain eight commas as column separators, one after each field except the 

last field. 

Example: sourceproj,sourcewbs,targetproj,targetwbs,YYYYYY,C,transferfilename,ABC,COM 
 

 

 
Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

1  20  A  Source Project  

2  40 A  Source WBS  

3  20  A  Target Project  

4  40 A  Target WBS  

5   

 

 

 

Import Filters: Place a Y or N in each of six positions for the import 

options depicted below.  Example YYYYYY would be used to include all 

import options. Position Import Option 1  BCWS Data 2  BCWP Data 3  

ACWP Data 4  ETC Data 5  Schedule Dates 6  Milestones  

6  1  A  Transfer File Drive Letter  

7  30  A  Transfer File Name  

8  10  A  Export Conversion Code  

9  10  A  Import Conversion Code  
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16.6 Importing Actuals 

You use the Actuals window to import actual costs from outside MPM, typically from 

your accounting system. This feature eliminates the necessity of manually entering actual 

cost data. Your import file should contain monthly values; MPM then calculates 

cumulative totals such as Total Burdened, Total Dollars, etc. actuals may be imported by 

Resource or EOC. Actuals by Resource may optionally be autoburdened. 

Access the Actual Import Conditioning window by selecting Actuals on the Imports tab. 

MPM displays the Actual Import Conditioning window shown in Figure A. 

 

Figure A. To import Actuals, select the Actuals Import on the Menu Manager. 

The actuals import has two additional options on the Import Conditioning window: 

Autoburden and Duplicate Value.  

Import Actuals with Autoburdening 

To add burdening automatically to your actuals while importing, click the  check 

mark box in the Criteria column. This option calculates burden values for actuals 

imported by Resource. Using the Prime Dollars you supply in the import file, MPM 

calculates Overhead, G&A, COM, and Fee using the Burden Template assigned to each 

Resource. If the Burden Template contains more than one burden of the same type (for 

example, OH1, and OH2), they are both used and a total Overhead is accumulated. 

This option defaults to no autoburden. If you are not autoburdening, your import file must 

contain any applicable burden values for Overhead, G&A, COM, and Fee. If you do 

select autoburdening, these values are automatically calculated and are ignored if entered 

in your import file.  
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Duplicate Values Processing 

When importing your actuals, there is a possibility that MPM may encounter an actual 

value that already exists in your project under the specified WBS/Resource/fiscal period. 

The Duplicate Value option tells MPM how to handle duplicate actual values.  Select one 

of the following options: 

Update file with new value(s) - If you select this option, any duplicate values in the 

project are overwritten with the import value. 

Accumulate old and new value(s) - If you select this option, any duplicate values in the 

imported data are added to the value in the project. If actuals are imported more often 

than once a month, this is usually the best option. 

Ignore the new value(s) - If you select this option, any duplicate values in the imported 

data are ignored. 

This option defaults to Update File With New Value(s). 

Import Processing of Actuals 

When you import monthly actual values, the following values are calculated 

automatically: Total Burdened, Total Cost, Total Dollars, and Total Price. These values 

cannot be imported. If you choose to add autoburdening, Overhead, G&A, COM, and Fee 

are also calculated. If you are not autoburdening, you must supply these values in the 

import file. 

The WBS ID to which you are adding actuals must contain a Charge Number, or an error 

will result and the imported actuals will be ignored. See Chapter 5: Creating the WBS for 

details. The Charge Number cannot be imported with this import, but can be imported 

using the WBS Descriptive import. See topic 16.14  Importing WBS Descriptive Data for 

details. 
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16.6  Importing Actuals 

16.6.1 Actuals Import File 

Actuals Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project 

 2 10 A Resource Code or *EOC Code; must exist in the 

global files but need not exist as an estimate for this 

WBS. 

If importing EOC Codes, you must precede the EOC 

Code with an asterisk. 

3 10 A Resource Department; must exist in OBS (leave blank 

if import is by EOC Code) 

4  1 Y/N Overtime Factor 

Enter Y or a valid numeric value if the imported actual 

data is overtime.  This value will be changed to 1.5 

upon import and will appear as such on reports. 

Enter N if the imported actual data is not O/T; appears 

as blank on reports. 

 5  6 N Month/Year (YYYYMM) 

6 12 N Hours/Units 

7 12 N Prime dollars 

8 12 N Overhead dollars 

9 12 N G&A dollars 

10 12 N Cost of money dollars 

11 12 N Fee 

12 20 A XREF-EST* 

 

*XREF-EST Field — The XREF-EST import field is an optional field that can be 

used to make the Actuals record unique.  
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MPM considers records as duplicates if they have the same values for the following 

fields: 

 Period 

 WBS ID 

 Resource Code 

 Resource Department 

 XREF-EST 

 Overtime 

 

 Using the optional XREF-EST field — each record must contain 11 commas, one 

after each field except the last field (even those being left blank), and end with a 

carriage return. 

 Not using the optional XREF-EST field — each record must contain 10 commas, 

one after each field except the last field (even those being left blank), and end with a 

carriage return. 

 

Example Imports 

This record imports actuals into WBS element AA for Resource ENG1 from Dept 200, 

for the month of January 2008. The values being imported are not overtime values. The 

Resource worked 200 hours, which was calculated as 30000 Prime, and burdened as 

10000 OH, 500 G&A, 100 COM and 1500 Fee. 

AA,ENG1,200,N,200801,200,30000,10000,500,100,1500 

This record imports actuals into WBS element AA for EOC Labor, for the month of 

January 2008. Remember you must add an asterisk if this is an EOC Code. The values 

being imported are not overtime values, and EOC cannot be autoburdened. LABOR 

totaled 800 hours, which was calculated as 120000 Prime, and burdened as 40000 OH, 

2000 G&A, 400 COM and 6000 Fee. 

AA,*L,,N,200801,800,120000,40000,2000,400,6000 
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16.7  Importing BCWP 

You use the BCWP window to import BCWP from outside MPM. Your import file 

should contain monthly values; MPM then calculates cumulative BCWP or Percent 

Complete, based on your Earned Value Method (EVM).  

Access the BCWP Import Conditioning window by selecting BCWP on the Imports tab. 

MPM displays the BCWP Import Conditioning window shown in Figure A. 

 

Figure A. To import BCWP, select the BCWP Import on the  
Menu Manager. 

The BCWP import has no additional options on the Import Conditioning window. The 

BCWP import file contains the WBS ID, Status Date, Cum Percent Complete, and Cum 

BCWP Amount fields.  

Importing Cumulative Percent Complete 

If your WBS is set for the Percent Complete EVM, you can import Cumulative Percent 

Complete values for a given fiscal month. MPM then calculates Cumulative BCWP.  

Importing Cumulative BCWP 

If your WBS is set for either the Earned Standards or BCWP Entry EVM, you can import 

Cumulative BCWP values for a given fiscal month. MPM then calculates Cumulative 

Percent Complete. 
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Import Processing of BCWP 

The BCWP database stores only cumulative values. Therefore, the BCWP records being 

imported must contain cumulative BCWP values. When you import BCWP, MPM 

always refers first to the EVM (Earned Value Method) that you have specified in 

Integrated Planning for the WBS to which you are importing values. To check the current 

EVM, access the WBS window. To change your EVM, access the Integrated Planning -

Milestone window.  

Since each record (row) in your import file contains the WBS ID, your import file can 

contain either or both types of BCWP import data, and each record will be processed 

individually for that WBS. 

For each record (row) in your import file, if the WBS ID is set for the Percent Complete 

EVM, MPM will use the Cumulative Percent Complete value in the import file for the 

specified fiscal month, and calculate the Cumulative BCWP. If you supply a Cum BCWP 

value in the import file, it is ignored. 

If the WBS ID is set for either the Earned Standards or BCWP Entry EVM, MPM will 

use the Cumulative BCWP value in the import file for the specified fiscal month, and 

calculate the Cumulative Percent Complete. If you supply a Cum Percent Complete value 

in the import file, it is ignored. 

If the WBS ID is set for an EVM other than Percent Complete, Earned Standards or 

BCWP Entry, that entire record (row) in the import file is ignored. 

Only the values for the specified fiscal month are recomputed. All other monthly BCWP 

values remain unchanged. 

Updating Milestone Status 

Importing cumulative BCWP or Percent Complete does not cause milestone status to be 

updated. To update milestone status, you can: 

Use the Integrated Planning - Milestones window to manually update milestones 

Use Import Milestones ( See Importing Milestones) 

Note: Whenever this import is used, you must always recompute BCWP. 
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16.7  Importing BCWP 

16.7.1 BCWP Import File 

BCWP Import File Content 

In the table below, an * indicates a required field. In the Type column, A = alphanumeric, 

N = numeric, and Y/N = Yes or No. 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

1* 40 A WBS ID; must exist in the project 

2* 6/8 A Status Date; date may be entered in year/month format 

or year/month/day format.  If year/month format is 

used, date defaults to last day of fiscal month.  (The 

full date is used only to set the "last status" tick mark 

on barcharts.). Note that the YYMMDD date format is 

not a valid format for BCWP Import. 

Valid date formats: See topic 16.14  Importing WBS 

Descriptive Data for details.  

 

3* 6 N Cumulative Percent Complete; must be expressed in 

percent format (i.e., 50.50% = 50.50). 

4* 12 N Cumulative BCWP Amount; value must be expressed 

in the base unit specified for the WBS in Plan 

Milestones Function. 

 

The WBS ID, Status Date, and Cum Percent Complete fields are mandatory when 

importing to WBS elements which use the Percent Complete EVM. 

The WBS ID, Status Date, and Cum BCWP fields are mandatory when importing to 

WBS elements which use Earned Standards or BCWP Entry EVM. 

Each record must contain three commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 
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Example Imports 

This record updates WBS 1X using Percent Complete EVM 50.50%, as of the status date 

March 31, 1998. Since the full date was used, the "last status" tick mark on barcharts is 

set also. 

1X,19980331,50.50,  

This record updates WBS 1X using BCWP Entry EVM; as of the status date March, 

1998, $15,175.50 of BCWP have been earned.  

1X,199803,,15175.50 
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16.8  Importing Distributed Projects 

You use the Distributed Projects window to import Distributed Project data into the 

superproject, from a previously exported distributed subproject. See Chapter 19: 

Distributed Projects for more detailed information about Distributed Projects. 

Access the Distributed Projects Import Conditioning window by selecting Distributed 

Projects on the Imports tab. MPM displays the Distributed Projects Import Conditioning 

window shown in Figure A. 

 

Figure A. To import Distributed Projects, select Distributed Projects Import on 
the Menu Manager. 

The Distributed Projects import file contains the data from the subproject, which you 

should be importing into the superproject. See Chapter 19: Distributed Projects for more 

information about super- and subprojects. 

When you specify the Target Project, MPM searches the project for the word 

DISTRIBUTED in the XREF-1 field. It must already be specified in the lowest level of 

your WBS, otherwise an error will result.  

Analyzing the Import File 

We recommend that you analyze your import file (and always back up your data) before 

running the import. To analyze your import file, run the Analyze Distributed Project File 

report. See Chapter 19: Distributed Projects in this manual for complete details on this 

report. 
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Importing Using Conversion Codes 

Use these optional codes to apply timephased factors while importing (or exporting) 

Distributed Projects. The conversion uses the resource rates you entered in the Global 

Resources & Burdens window. See Chapter 5: Defining Resources and Burdens in the 

Globals manual for details. Please note that the Baseline Rate Table is used for Baseline, 

ETC and Actuals. 

Specifying the Data to be Imported 

When importing Distributed Project data, you can import the following types of data: 

BCWS, BCWP, ACWP, ETC, Schedule Dates, and Milestones. To import any or all of 

these data types, click the  check mark box in the Criteria column of the desired 

data type. 

Distributed Project File Format 

The Distributed Project transfer file is internally created and cannot be externally created. 

The only way to create a Distributed Project import file is by exporting Distributed 

Project data. See Chapter 17: Exporting Data for details. 

When you enter the name of the Distributed Project transfer file, MPM displays an 

additional button  which allows you to check the information in the transfer file. 

 

MPM displays a dialog box with the following information: Source Project, Source WBS, 

Target Project, Target WBS, Export Conversion Code, and Import Conversion Code. 

Import Processing of Distributed Project Data 

When you export Distributed Project data from the subproject, MPM exports the rolled 

up data at the top level within the subproject. Therefore, when you open the superproject 

and import the subproject‘s data, only the rolled up data (not the detail) is imported. 

Detail reporting is not available at the superproject level. See Chapter 19: Distributed 

Projects for more information about super- and subprojects. 
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16.9  Importing Estimates 

You use the Estimates window to import monthly estimate values from outside MPM. 

You can replace all existing values, or partial values based on a date range. 

Access the Estimates Import Conditioning window by selecting Estimates on the Imports 

tab. MPM displays the Estimates Import Conditioning window shown in Figure A. 

 

Figure A. To import Estimates, select Estimates Import on the Menu Manager. 

The Estimates import has three additional options on the Import Conditioning window:  

 I

mport Type 

 R

eplace Values (and the related Import From and Import Through options) 

 D

uplicate value 

 

Import Type 

You can choose to import estimates of monthly values that are not autospread, or choose 

to autospread estimates as they are imported. 
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The Monthly Values option imports the monthly values you supply, and calculates 

burden values just as it does in Integrated Planning (see below). 

The Autospread option automatically burdens the monthly values you supply and spreads 

the value using the spread curve you specify in the import file. 

Replace Values 

If you choose the Complete option, the imported estimate will replace completely the 

estimate currently in the database. 

If you choose the Partial option, the imported data is restricted to the dates you specify in 

the Import From and Import Through fields. You can also choose to replace the old 

values with the new values (Update), or add the new values to the old values 

(Accumulate). For processing details on these options, see topic 16.9.2 Importing Partial 

Estimates. 

Duplicate Values 

When you are doing a partial import, you must use the Duplicate Values field to choose 

replacement of the old values with the new values (Update), or addition of the new values 

to the old values (Accumulate). 

MPM considers records as duplicates if they have the same values for the following 

fields: 

 P

eriod 

 W

BS ID 

 R

esource Code 

 R

esource Department 

 X

REF-EST 

 O

vertime 

Estimates to Import 

With the Estimates to Import option you can import and update baseline data, ETC data, 

or both provided you are importing complete estimates.   
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If you are importing partial estimates, you can import and update baseline data, ETC 

data, but not both. 
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16.9  Importing Estimates 

16.9.1  Importing Complete Estimates 

MPM identifies each different combination of WBS ID, Resource Code, Resource 

Department, and Overtime as a unique estimate. If the same combination already exists in 

the project, the import records will replace the entire existing estimate. We recommend 

that you group records by WBS ID and Resource in the import file. If you enter records 

out of order, entries for the same WBS ID will overwrite the earlier entries. 

Estimate imports must include one record (row) in the import file for each month to be 

imported, and the start and complete dates must include the widest range of all months 

being imported for that particular estimate. If your import includes more than one month, 

records should be created in order by date. When updating existing estimates, keep in 

mind that the entire current estimate is replaced with the new estimate being imported, 

regardless of the date range. For example, an existing estimate which spanned the months 

of January through December would be entirely deleted and replaced with an imported 

estimate even if the new estimate only covered January through February. 

MPM burdens the monthly values supplied in the import file in the same manner as when 

they are entered in Integrated Planning. See Chapter 7: Estimating the Project Baseline 

for details about this process. 

MPM uses the rate table specified for the resource when calculating burdens. If you have 

set the Allow Rate Table Override field in the Project Maintenance window to on by 

placing a check mark in the column, you can specify a different rate table in the import 

file. Otherwise, if the Rate Table Override field is blank and you specify a rate table in 

the import file, it is ignored. 

MPM also uses the burden template specified for the resource when calculating burdens. 

If you have set the Allow Burden Template Override field in the Project Maintenance 

window to ON by placing a check mark in the column, you can specify a different burden 

template in the import file. Otherwise, if the Burden Template Override field is blank and 

you specify a burden template in the import file, it is ignored. 

When importing Baseline only, or Baseline and ETC values, Baseline is priced against 

the Baseline Rate Table and ETC is priced against the ETC Rate Table specified in the 

Project Maintenance window. 

If the calendars are changed after an estimate is automatically spread, you must re-enter 

the estimates. Or you can export the estimates and then import them with the new dates. 

If you include an estimate in the import file which matches an existing apportioned 

estimate, an error will result. Replan estimates cannot be imported. 
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16.9  Importing Estimates 

16.9.2  Importing Partial Estimates 

If you choose a partial import of estimates, the system scans the import file and only 

imports those records that are within the Import From and Import Through dates 

specified in the Report Conditioning window. The from and through dates are validated 

against the period (YYYYMM) of the import file. 

Estimate Types 

If you choose the Monthly, Partial, and Accumulate options, only the following estimate 

types will be imported: 

(1) Standard Hours 

(2) Hours 

(3) Prime 

(8) EQP 

(9) Units 

The numbers in parentheses represent the estimate type codes entered in the import file. 

All other estimate types will not be imported, assuming the estimate already exists and 

you are adding to the estimate using the Accumulate option. If there is no existing 

estimate, any estimate type will be imported. 

If the estimate type in the import file is different than the original estimate type, the 

estimate type in the database will be changed to the estimate type in the import file. The 

Processing Report displays the message: "The estimate type has been changed from 'x' to 

'y'." 

If the estimate type being imported is Standard Hours, the original estimate must be in 

standard hours. If the original estimate type is something other than standard hours, the 

record(s) will be rejected and an error message will be displayed, "Estimate Type cannot 

be changed to/from Standard Hours." 

If the estimate type being imported is Hours, Standard Hours or EQP, the resource must 

be a labor resource or it is ignored and the following message is logged: 'Estimate Type 

'X' cannot be used for Non-Labor Resource 'X''. 

If the estimate type being imported is Units, the resource must be a non-labor resource or 

it is ignored and the following message is logged: 'Estimate Type 'X' cannot be used for 

Labor Resource 'X''. 
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Replace Values 

If you choose the Complete option, the imported estimate will replace completely the 

estimate currently in the database. 

If you choose the Partial option, the imported data is restricted to the dates you specify in 

the Import From and Import Through fields. You can also choose to replace the old 

values with the new values (Update), or add the new values to the old values 

(Accumulate). 

Duplicate Values 

When you are doing a partial import, you must use the Duplicate Values field to choose 

replacement of the old values with the new values (Update), or addition of the new values 

to the old values (Accumulate). 

MPM considers records as duplicates if they have the same values for the following 

fields: 

 Period 

 WBS ID 

 Resource Code 

 Resource Department 

 XREF-EST 

 Overtime 

Rate Table 

If the import file contains a rate table override value, the override value will be ignored 

upon import.  If the estimate already exists, the rate table saved with the original estimate 

will be used. If the estimate does not exist, a new estimate will be created using the 

default rate table in Project Maintenance.  
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Burden Templates 

The process for handling changes in burden templates is as follows: 

If the import file contains a burden template override value, the override value will be 

ignored upon import. The estimate will not price against this burden template. 

Upon importing of partial estimates, MPM will compare the burdening structure of the 

saved estimate to what the current burden template (the default template or the 

overridden burden template) contains. If there is a difference, the entire estimate will be 

repriced to the new burden structure.  

The only time that this situation would exist is if the burden structure has been changed 

and reprice has not been run. The Processing Report displays the message: ―The entire 

estimate has been repriced to the current burden template structure.‖ 

Estimate Start Date 

If an estimate start date in the import file does not match that of the estimate in the 

database, the system will display the following message on the Processing Report:  

―Estimate Start date of Import is different than the Estimate Start date of existing 

Estimate. Estimate Start Date is not updated.‖ 
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Estimate Completion Date 

The table below outlines the actions MPM takes based on the relationship between the 

import completion date and the existing estimate completion date. 

IF the import completion date is: THEN MPM performs the following 
functions: 

Earlier than the existing estimate 

complete date 
Updates any existing values contained in the 

import file (based on the Import From and 

Through dates). 

Deletes any value that was in the original estimate 

later than the complete date contained in the 

import file. 

Changes the existing estimate complete date to the 

imported completion date. 

Later than the existing estimate 

complete date 
Updates any existing values contained in the 

import file (based on the Import From and 

Through dates). 

Adds new values (if any) from the import file into 

the existing estimate (based on the Import From 

and Through dates). 

Changes the existing estimate complete date to the 

imported completion date. 

The same as the existing estimate 

complete date 
Updates any existing values contained in the 

import file (based on the Import From and 

Through dates). 

If the monthly value being imported is not within the estimate start/complete dates, it is 

not imported and the following message is displayed: ―Month/year outside of Estimate 

Start/Complete time-frame.‖ 

Change of Element of Cost/Class of Cost  

Upon import the system will validate the element of cost and class of cost on the existing 

estimate to those of the global files. If the element of cost or class of cost on the Resource 

code has changed (in the global file) the import will unroll all the values of the old 

estimate and reroll the entire estimate (including the new values from the import) to the 

new element of cost/class of cost. 
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16.9  Importing Estimates 

16.9.3 Estimates Import File 

Estimates Import File Content 
Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project 

 2 10 A Resource Code; must exist in the global file.  

3 10 A Resource Department; must exist in the OBS 

4 20 N Overtime Factor. If you are importing overtime values, enter the 
appropriate value; otherwise, leave blank. 

5 9 A Start Date of estimate 

Valid date formats:  See topic 16.14  Importing WBS 

Descriptive Data for details for details. 

6 9 A Completion Date of estimate 

Valid date formats:  Same as Start Date 

7 1 N Estimate Type (enter 1-9 or A-J) 

If entering monthly values, enter a manual estimate 

type (1-9) for this field. 

If autospreading values, enter an autospread 

estimate type (A-J) for this field. 

Estimate Type  Manual      Autospread 

Standard Hours 1 A 
Hours 2 B 
Prime Dollars 3 C 
Total Burdened 4 D 
Total Cost 5 E 
Total Dollars 6 F 
Total Price 7 G 
EQP 8 H 
Person Months n/a I 
Units 9 J 

8 3 N Efficiency: This is a percentage factor; applies only if using 

Standard Hours as the estimate type. 

9 3 N Scrap & Rework: This is a percentage factor; applies only if using 

Standard Hours as the estimate type. 

10 6 N If entering monthly values, enter the year and month (YYYYMM) 

for which this value is being imported. 

If entering autospread values, enter the identifier for the Spread 

Curve to use; must be an existing Spread Curve. If this field is left 

blank, it defaults to a linear curve. 
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Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

11 12 N Estimate Value, expressed in the same units as the estimate type 

(hours, prime dollars, total burdened dollars, total dollars) 

If entering monthly values, enter the total value for the 

resource for the month specified. 

If autospreading values, enter the total estimate value for this 

resource for the month(s) specified. 

12 20 A Rate Table (enter only if you want to override current Table)  

13 20 A Burden Template (enter only if you want to override current 

Template)  

14 20 A XREF-EST* 

 

*XREF-EST Field — The XREF-EST import field is an optional field that can be used 

to make the estimate unique.  

 

 Using the optional XREF-EST field — each record must contain 13 commas, one 

after each field except the last field (even those being left blank), and end with a 

carriage return. 

 Not using the optional XREF-EST field — each record must contain 12 commas, 

one after each field except the last field (even those being left blank), and end with a 

carriage return. 

Example Imports 

These records update an estimate for WBS 1X using Resource ENG1 in Department 

ENG with monthly values. This estimate starts January 1, 1997 and goes through April 1, 

1997, and does not contain overtime, using Rate Table 001 and Burden Template ENG, 

with 80% efficiency. We are reporting $504,944.25 in Prime Dollars (Estimate Type 3) 

for Jan-97, $499,395.93 for Feb-97, and $522,333.29 for Mar-97. 

1X,ENG1,ENG,,19970101,19970401,3,,,199701,504944.25,001,ENG 

1X,ENG1,ENG,,19970101,19970401,3,,,199702,499395.93,001,ENG 

1X,ENG1,ENG,,19970101,19970401,3,,,199703,522333.29,001,ENG  

This record updates an estimate for WBS 1X using Resource ENG1 in Department ENG 

with autospread values. This estimate starts January 1, 1997 and goes through April 1, 

1997, and does not contain overtime, using Rate Table 001 and Burden Template ENG, 

with 80% efficiency.  
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We are reporting $1,526,673.47 in Prime Dollars (Estimate Type C), using Spread Curve 

2 (Bell Curve). MPM will autospread $1,526,673.47 across January through April. 

1X,ENG1,ENG,,19970101,19970701,C,,,2,1526673.47,001,ENG  
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16.10  Importing Global Files 

Use the Global Files Import window to import global files from outside MPM. You can 

import any or all global types of data: Calendars, EOCs, Resource or Burden Codes or 

Rates, or Burden Templates, with one or more global import files. 

Access the Global Files Import Conditioning window by selecting Global Files on the 

Imports tab. MPM displays the Global Files Import Conditioning window. See Figure A. 

 

Figure A. To import Globals, select Globals Files from 
the Import Tab on the Menu Manager. 

The Global Files import has no additional options on the Import Conditioning window. 

The global import file contains fiscal or holiday calendars, EOCs, resource or burden 

codes or rates, or burden templates to be imported. The Record Type field in the import 

file identifies the type of global file to be imported. 
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16.10  Importing Global Files 

16.10.1  Importing Fiscal Calendars 

If you have a fiscal calendar already in your global file, MPM completely overwrites it 

with the imported fiscal calendar. If a problem occurs during the import, the fiscal 

calendar import is aborted and no fiscal calendar data is imported. 

The records in the fiscal calendar import file must be arranged in ascending date order. 

The month label is included only in the first fiscal calendar record. MPM automatically 

assigns subsequent month labels in consecutive order. 

Fiscal Calendar Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 3 A Global import type: enter CAL for Fiscal Calendars 

 2 9 A Fiscal Start Date; enter the first day of the fiscal month.  

Valid date formats:  See topic 16.14  Importing WBS 

Descriptive Data for details. 

  5 A Month label. Months must be in MMMYY format only, 

where MMM=month and YY=year of first month of the 

calendar. Include this label in the first record only. 

4 7 N Equivalent person month hours; enter a value of zero 

through 9999.99. 

Each record must contain three commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports the fiscal month of January 2007 that starts on 01-Jan-07 and 

contains 160 equivalent person month hours. 

CAL,01-JAN-07,JAN07,160 
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16.10  Importing Global Files 

16.10.2  Importing Holiday Calendars 

Use this format to import holiday calendar dates which occur during the contract period. 

The Holiday Calendar Import differs from the Fiscal Calendar Import in that only new or 

changed holidays are added or replaced by the import file. An existing holiday calendar 

will not be replaced, in its entirety, when a new holiday calendar is imported. Any 

holiday dates not affected by the import file remain unchanged by the import. 

The description of a holiday date replaces an existing holiday description only if the 

holiday description field does not match. A blank holiday description field will not 

replace an existing one. 

Holiday Calendar Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 3 A Global import type: enter HOL for Holiday Calendars 

 2 9 A Holiday Date to be added or updated 

Valid date formats:  See topic 16.14  Importing WBS 

Descriptive Data for details. 

 20 A Holiday description 

Each record must contain two commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports the Independence Day holiday on 04-Jul-07. 

HOL,04-JUL-07,Independence Day 
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16.10  Importing Global Files 

16.10.3  Importing Elements of Cost 

Use this format to import elements of cost (EOC) and classes of cost (COC) from outside 

MPM. You can create new EOCs or update existing EOCs. Importing an EOC table will 

not replace an existing EOC table in its entirety. Any EOCs not affected by the import 

file remain unchanged by the import. 

The EOC code, COC code, and EOC description act as unique identifiers for each record 

imported. If the same combination already exists in the EOC table, the import record will 

replace the existing EOC in its entirety. To enter an EOC code, you must enter the EOC 

Code, and the Labor Flag. To enter a COC code, you must enter the EOC Code and the 

COC Code. 

Elements of Cost Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 3 A Global import type: enter EOC for Elements of Cost 

 2 1 A Element of Cost Code 

  3 A Class of Cost Code. This field is mandatory for a COC 

record. 

 20 A Description 

  1 Y/N Labor Flag. This field is mandatory for an EOC record. 

Each record must contain four commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports the Labor Element of Cost L. 

EOC,L,,Labor,Y 

 This record imports the Class of Cost MFG into the Labor EOC. 

EOC,L,MFG,Engineering Labor, 
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16.10  Importing Global Files 

16.10.4  Importing Burden Codes 

Use this format to import burden codes from outside MPM. You can create new or update 

existing burden codes. Importing Burden Codes will not replace existing burden codes in 

their entirety. Any burden codes not affected by the import file remain unchanged by the 

import. 

Burden Code (type ―C‖) records must be imported before Burden Rate (type "R") records 

in your import file. 

Field Positions 5 through 9 are ignored and should be left blank. Be sure you have the 

correct number of commas. 

Burden Code Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A Global import type: enter C for Burden Codes 

 2 10 A Burden Code 

 3 1 A Burden Type: 

O = Overhead 

G = G&A 

C = Cost of Money 

F = Fee 

 20 A Description 

 0  Ignored (leave blank) 

 0  Ignored (leave blank) 

 0  Ignored (leave blank) 

 0  Ignored (leave blank) 

 0  Ignored (leave blank) 

Each record must contain eight commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports the Overhead burden named EOH. 

C,EOH,O,Eng Overhead,,,,, 
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16.10  Importing Global Files 

16.10.5  Importing Burden Rates 

Use this format to import burden rates from outside MPM. You can create new or update 

existing burden rates. Importing Burden Rates will not replace existing burden rates in 

their entirety. Any burden rates not affected by the import file remain unchanged by the 

import. 

Burden Code (type ―C‖) records must be imported before Burden Rate (type "R") records 

in your import file. 

The burden code being assigned a rate must already exist in the database. If it does not 

already exist, add a Type "C" record prior to the Type "R" record to create the burden 

code. 

Burden Rate Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A Global import type: enter R for Burden Rates 

 2 10 A Burden Code 

 3 20 A Burden Rate Table ID 

  6 N Rate Period: enter the period for which this rate applies, in 

YYYYMM format. 

 10 N Rate Amount 

Each record must contain four commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports a rate of 25.7% for January 2007 into Rate Table 1 for the EOH 

burden.  

R,EOH,1,200701,25.7 



506   Chapter 16: Importing Data 

16.10  Importing Global Files 

16.10.6  Importing Burden Templates 

Use this format to import an entire burden template which has been created using a 

software application outside MPM. You can create new or update existing burden 

templates. Importing Burden Template data does not completely replace a burden 

template. Any burden templates not affected by the import file remain unchanged by the 

import. 

Burdens should be imported in the burden template import file in the order you want 

them applied against the resource. 

Importing a burden template for an existing burden template will not replace the entire 

burden template. Only the requested fields are updated. 

Fields 4 and 5 may be repeated to include a maximum of ten burden codes in each burden 

template. 

Burden Template Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 3 A Global import type: enter TMP for Burden Templates 

 2 20 A Burden Template ID 

 40 A Burden Template Description 

 10 A Burden Code; must already exist 

 1 N Apply burden rates against: 

1 = Hours 

2 = Prime Dollars 

3 = Previous Subtotal 

4 = Previous Burden Amount 

5 = Total Burdened 

6 = Total Cost 

7 = Previous, Previous SubTotal 

8 = Previous, Previous Burden Amount 

Each record must contain a minimum of four commas, one after each field except the last 

field (even those being left blank), and end with a carriage return. 
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Example Imports 

This record imports the ENG1 burden template which applies the EOH burden against 

Prime, the FOH burden against Previous Subtotal, the G&A burden against Total 

Burdened, the COM burden against Total Cost, and the LF burden against Total Cost.   

TMP,ENG1,Engineering Burden,EOH,2,FOH,3,G&A,5,COM,6,LF,6 
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16.10  Importing Global Files 

16.10.7  Importing Resource Codes 

Use this format to add or update resource codes from outside MPM. Importing resource 

codes will not replace the existing global file in its entirety. Any resources not affected by 

the import remain unchanged by the import. 

Resource Code (type ―C‖) records must be imported before Resource Rate (type "R") 

records in your import file.  

See Chapter 5: Defining Resources in the MPM Globals manual for details about the 

fields in this import. 

Resource Code Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A Global import type: enter C for Resource Codes 

 2 10 A Resource Code 

 3 1 A Resource Type: enter R 

 20 A Description 

 20 A Burden Template ID; must already exist 

 3 A EOC Class; must already exist 

 1 A EOC Code; must already exist 

 4 N Hours per day; may be entered in whole numbers or 

decimals 

 1 N Days per week; enter 1 - 7 

Each record must contain eight commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports the ENGE resource that uses the ENG1 burden template, the 

MFG class of cost, and Labor EOC. 

C,ENGE,R,Engineer,ENG1,MFG,L,8,5 
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16.10  Importing Global Files 

16.10.8  Importing Resource Rates 

Use this format to import resource rates from outside MPM.  You can create new or 

update existing resource rates. Importing resource rates will not replace existing resource 

rates in their entirety. Any resource rates not affected by the import file remain 

unchanged by the import. 

Resource Code (type ―C‖) records must be imported before Resource Rate (type "R") 

records in your import file. 

The resource code being assigned a rate must already exist in the database. If it does not 

already exist, add a Type "C" record prior to the Type "R" record to create the resource 

code. 

Resource Rate Import File Content 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A Global import type: enter R for Resource Rates 

 2 10 A Resource Code 

 3 20 A Resource Rate Table ID 

  6 N Rate Period: enter the period for which this rate applies, in 

YYYYMM format. 

 10 N Rate Amount 

Each record must contain four commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example Imports 

 This record imports a rate of $37.50 for January 2007 into Rate Table 1 for 

the ENGE resource. 

R,ENGE,1,200701,37.5 
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16.11  Importing Milestones 

Use the Import Milestones window to import new milestones for a WBS element or 

update existing milestones from files created outside MPM. After importing milestones, 

you must recalculate BCWP to reflect the changes resulting from your import.  

During the milestone importing process, MPM looks for a match on selected fields. If a 

match is found, the other fields for that milestone are updated with the imported data; if 

there is no match, a new milestone is inserted based on the Identify Milestones By field. 

To update an existing milestone, the milestone being imported must match exactly.  

 

Figure A. To import milestones, select Milestones on the Menu Manager. 

Accessing the Import Milestones Window 

To access the Import Milestones window, double-click the Milestones icon on the Menu 

Manager with the Imports tab showing. MPM displays the Import Milestones window. 
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Additional Options 

The Milestones import has three additional options on the Import Conditioning window: 

Identify Milestones By, Update BCWP Status, and Fiscal Status As Of Date. These 

options are described in the next module. 

Sub-topics 

Additional information about importing milestones is presented in two sub-topics:16.11  
Importing Milestones 

 16.11.1  Setting the Import Milestones Options 

 16.11.2  Milestone Import File Format 
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16.11  Importing Milestones 

16.11.1  Setting the Import Milestones Options 

The Milestones import has three additional options on the Import Conditioning window: 

Identify Milestones By, Update BCWP Status, and Fiscal Status As Of Date.  

 

Figure A. There are three options you can use on 
milestone imports 

Identifying Milestones By Option 

This option determines the method for matching the milestones in the import file with the 

milestones in your MPM project. There are three methods to choose from: 

ID - This method matches milestones by their Milestone ID. The first milestone 

encountered in the project with the same ID as the ID in the import file is updated with 

the imported data. If that exact Milestone ID is not found, the data is imported and added 

as a new milestone.  

If the import file includes a WBS ID with a Milestone ID that exists on another WBS, the 

milestone is added to the WBS ID specified in the import file and removed from the 

WBS ID where it previously existed. When using this option for matching, the Milestone 

ID field is a required field in the import file. If you are updating an existing Milestone ID, 

the WBS ID is not a required field in the import file. 
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Description - This method matches milestones by their WBS ID and Milestone 

Description. The first milestone encountered within the WBS ID specified with the same 

description as the import is updated with the imported data.  

If that exact description is not found, the data is imported and added as a new milestone. 

If the Milestone ID is blank or contains a duplicate of an existing Milestone ID, MPM 

generates a new unique ID for the milestone contained in the import file. 

Symbol/Description/Schedule Date - This method matches milestones by their WBS 

ID, Symbol, Milestone Description and Schedule Date. The first milestone encountered 

within the given WBS with the same symbol, description and schedule date as the import 

is updated with the imported data.  

If that exact combination of symbol, description and schedule date is not found, the data 

is imported and added as a new milestone. If the Milestone ID is blank or contains a 

duplicate of an existing Milestone ID, MPM generates a new unique ID for the milestone 

contained in the import file. 

Update BCWP Status (Cumulative Percent Complete) Option 

To update BCWP status (recalculate percent complete) when importing milestones, place 

a check mark in the Update BCWP Status field. MPM will re-evaluate the status of all the 

milestones on the WBS element and calculate a new cumulative percent complete to be 

stored in the designated fiscal As Of Month field for the WBS. If the Update BCWP 

Status field is not checked, the new milestone status will be imported but BCWP will not 

reflect the new status.  

To use the Update BCWP Status option, your WBS must use one of these Earned Value 

Methods (EVM): 0/100, 25/75, 40/60, 50/50, Milestone Weights, Milestone Weights with 

% Complete, or Key Event. 

After performing the import, you must recalculate BCWP for the project if you want 

BCWP to be based on the new percent complete. 

Fiscal Status As Of Date Option 

If you elected to update BCWP status, enter the date for the fiscal month for which 

BCWP is to be statused. If you elected not to update BCWP status, this field is ignored. 

Retaining Percent Complete 

If you want to retain percent complete when importing milestones, you must: 

 Set the Identify Milestones by option to Descriptive. 

 Check the Update BCWP Status option. 

 



514   Chapter 16: Importing Data 

16.11  Importing Milestones 

16.11.2  Milestone Import File Format 

Import Milestones File Format 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project. This field is mandatory except 

when you identify Milestones by ID and the record is for an 

existing milestone. 

2 10 A Milestone ID 

3 1 A Milestone Symbol 

1 = Up arrow  

2 = Down arrow 

3 = Up triangle (default) 

4 = Down triangle 

5 = Square 

6 = Octagon 

7 = Diamond 

8 = Hourglass 

9 = Bowtie 

NASA Symbols 

A = Down triangle (NASA approved schedule) 

B = Down triangle (contractor work schedule) 

4 40 A Milestone Description 

5 8 N Milestone Weight 

  6 9 A Schedule Date 

Valid date formats:  See topic 16.14  Importing WBS 

Descriptive Data for details. 

Note: This field is required when importing new milestones. 

  7 9 A Forecast Date 

8 1 Y/N Is the milestone complete? If you enter Y, MPM sets percent 

complete to 100% during import. 

9 3 N Percent complete (Note that you may enter up to three characters. 

A decimal place counts as one character); this field applies to 

EVM Milestone Weights and Milestone Weights with % Complete 

only.  If you enter 100, MPM sets Milestone Complete to Y during 

import. 

Each record must contain eight commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 
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Example Milestones Import 

To illustrate how this import works, consider the following example, assuming: 

There are four milestones; one each in January, February, March and April. 

The January milestone was completed in January. 

The March milestone was completed in March. 

BCWP has been computed through March. 

o And these are the current Milestone Settings: 

Milestone ID Status Date Weight Status Flag 
Cum BCWP 
% Complete 

1 JAN98 100 Y 25% 

2 FEB98 100 N 25% 

3 MAR98 100 Y 50% 

4 APR98 100 N  

Assume the February milestone had actually been completed in February but we had 

neglected to status it.  It is erroneous to assume that all we have to do is import the 

February milestone with a Y flag and an As Of month of February.  If we had done that, 

the results would have been as follows: 

Milestone ID Status Date Weight Status Flag 
Cum BCWP 
% Complete 

1 JAN98 100 Y 25% 

2 FEB98 100 Y 75% 

3 MAR98 100 Y 50% 

4 APR98 100 N  

Because the import evaluates ALL milestones with their current flag settings, the 

February cumulative BCWP will be too high because the system would interpret the 

March milestone as having been completed in February. 

The correct way to resolve this situation would be: 

Manually change the March milestone flag back to N. 

Import the February milestone as Y with an As Of month of February with Update 

BCWP Status turned on. 

Manually reset the March milestone to Y then recalculate BCWP if you want to reflect 

the changes made to your milestones in your BCWP values 
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16.12  Importing OBS 

Use the Import OBS window to import Organizational Breakdown Structure (OBS) data 

from outside MPM. Both Performing and Responsible department structures can be 

imported. Additionally, use Import OBS to add or modify the OBS, or move the OBS to a 

new parent. 

Access the Import OBS window by double-clicking the OBS icon on the Imports Tab in 

Menu Manager. MPM displays the Filter and Criteria window shown in Figure A. 

 

Figure A. To import OBS, double-click the OBS icon. 

The OBS import has an additional option on the Import Conditioning window: 

Organization Type.  

Import OBS with Organization Type 

To add or modify your OBS, select the value from the Organization Type as Performing 

or Responsible.  

Performing  

This option imports the data into the Performing organizational structure. This is the 

default value.  

Responsible 

This option imports the data into the Responsible organizational structure.  

 

 

 



MPM Projects PR16 Importing Data   517 

OBS File Format 

In the table below, in the Type column, A = alphanumeric, N = numeric, and Y/N = Yes 

or No. 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 10 A Department Identifier (ID) 

    2 20 A Description of the Department 

   3 20 A Manager 

 10 A Burden Template 

 5 10 A Parent Department (Enter* for all departments that have the 

top level as the parent) 

 

Each record must contain four commas, one after each field except the last field (even 

those being left blank), and end with a carriage return. 

Example OBS Import 

In the following example, the Department 111 is imported, the description of the 

Department is Mechanical Engineer, the Manager is E.Levert, the Burden template is not 

specified, and the Parent Department is 110. 

111,Mechanical Engineer,E.Levert,,110 
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16.13  Importing Task Descriptions and Basis of 

Estimates 

Use the Import TD/BOE window to import Task Descriptions (TD) or Basis of Estimates 

(BOE), both Resource BOEs and Summary BOEs. You can use any word processing 

application outside of MPM to create the text, and then import the text into the project. In 

addition, you can edit the word processing file as necessary to add, modify and delete 

TDs and BOEs for import into any number of projects.  Once a library of TDs and BOEs 

has been created, it is no longer necessary to re-enter them each time a new project is 

begun. You must already have created the WBS before importing TDs and BOEs. For 

Resource BOEs, the WBS must have at least one existing resource estimate. Summary 

BOEs may be defined for a grouping of resource departments and/or elements of cost, but 

at least one resource estimate must exist on the WBS or a child in that WBS leg.  

Access the Import TD/BOE window by double-clicking the TD/BOE icon on the Menu 

Manager with the Imports tab showing. MPM displays the Import TD/BOE window.  

 

Figure A. To import Task Descriptions or Basis of Estimates,  
select the TD/BOE Import on the Menu Manager. 

Import Processing of TDs and BOEs 

 If importing TDs, any existing TD will be automatically replaced in its entirety 

when a new TD is imported. 

 If importing BOEs, any existing BOE will be automatically replaced in its entirety 

when a new BOE is imported. 

 An estimate must already exist before importing a Resource BOE. 
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 An import file can contain text for TDs or BOEs for one or more WBS elements. 

Each TD or BOE must be followed by an asterisk on a separate line. 
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16.13  Importing Task Descriptions and Basis of Estimates  

16.13.1  Task Description Import File Format 

Import TD File Format 

Each TD imported can contain up to 102 records (rows). The first record must be 

formatted as follows: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project 

Up to 100 records (rows) of TD text for that WBS must be formatted as follows: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

N/A 78 A Task Description text. Text may be in upper or 

lowercase. More than 100 rows or 78 characters on one 

row will be truncated. 

The last record, signifying the end of the data, must contain a single asterisk: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A * 

 
Example When Importing Task Descriptions 

This text becomes the task descriptions for WBS 21-100 and WBS 21-200. 

21-100 

The Design Detail portion of designing the X20 prototype 

is part of Contract #97-CAF-45747.  

* 

21-200 

The component testing will be handled by the 

subcontractor. 

* 
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16.13  Importing Task Descriptions and Basis of Estimates  

16.13.2  Resource BOE Import File Format 

Import Resource BOE File Format 

Each Resource BOE imported can contain up to 102 records (rows). The first record 

(row) must contain four commas; in subsequent lines, commas are ignored. The first 

record must be formatted as follows: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project 

 2 10 A Resource Code; must exist in the global file 

 10 A Resource Department; must exist in the OBS 

4 20 A Overtime Factor.  If you are importing overtime values, 

enter the appropriate value of 0.00 through 10.00. If 

you are using the Overtime field as a cross-reference 

field, enter up to 20 alpha characters. 

5 20 A XREF-EST* 

 

*XREF-EST Field — The XREF-EST import field is an optional field that can be used 

to uniquely identify the estimate.  Each XREF-EST record must contain 4 commas those 

without XREF-EST must contain 5 commas. These commas are used as column 

separators, one after each field except 

Up to 100 records (rows) of BOE text for that WBS must be formatted as follows: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

N/A 78 A BOE text. Text may be in upper- or lowercase. More 

than 100 rows or 78 characters on one line will be 

truncated. 

The last record, signifying the end of the data, must contain a single asterisk: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A * 
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Example When Importing Resource BOEs 

This text becomes the Resource BOE for the overtime Engineering resource in 

Department 2000 under WBS 21-100. 

21-100,ENG,2000,1.5,ABC 

The Design Detail portion of designing the X20 prototype 

is subcontracted to McAfee & Co. 

* 
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16.13  Importing Task Descriptions and Basis of Estimates  

16.13.3  Summary BOE Import File Format 

Import Summary BOE File Format 

The first record (row) must contain three commas; in subsequent rows, commas are 

ignored. Each BOE imported can contain up to 102 records (rows). 

The first record must be formatted as follows: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project 

 2 2 A Enter an asterisk (*) to include all EOCs; enter specific 

EOC after the asterisk to limit import to one EOC. The 

EOC entered must already exist in the global file. 

 10 A Enter a specific Resource Department to include BOEs 

for one department. The Department entered must 

already exist in the OBS. Enter an asterisk to include 

BOEs for all departments. If the field is left blank, the 

report will include all BOEs that have no Resource 

Department defined. 

To include BOEs for a specific group of departments, 

enter a ―wildcard‖ of up to nine match characters plus 

an asterisk.  For example, enter LA* and your report 

will include summary BOEs for all departments that 

begin with LA. 

Up to 100 records (rows) of BOE text for that WBS must be formatted as follows: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

N/A 78 A BOE text. Text may be in upper- or lowercase. More 

than 100 rows or 78 characters on one line will be 

truncated. 

 

The last record, signifying the end of the data, must contain a single asterisk: 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 1 A * 
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Example When Importing Summary BOEs 

This text becomes the Summary BOE for WBS 21-100, limited to Labor EOCs for 

Department 2000. 

21-100,*L,2000 

The Design Detail portion of designing the X20 prototype 

is subcontracted to McAfee & Co., who are providing  

estimates based on available resources in the Waco, Texas 

branch office. 

* 
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16.14  Importing WBS Descriptive Data 

Use the Import WBS Descriptive window to create new WBS elements or build onto an 

existing WBS leg by importing new WBS elements from outside MPM. This import 

differs from the WBS Schedule Data Import only in that the import file contains different 

types of WBS information. 

Access the Import WBS Descriptive window by double-clicking the WBS Descriptive 

icon on the Menu Manager with the Imports tab showing. MPM displays the Import 

WBS Descriptive window. 

 

Figure A. To import WBS Descriptive Data, select 
the WBS Descriptive import on the Menu Manager. 

Import WBS Descriptive Options 

There are no additional options on the WBS Descriptive Import Conditioning window. 
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Import Process 

WBS elements created by the import will have Start and Complete dates which default to 

their parent dates. 

This import cannot be used to change a parent code for an existing child. When creating 

import records for WBS descriptive data, parent WBS IDs must be imported before their 

children. 

The order in which elements are imported is the order that they will appear on reports.  

Elements should be sorted into the desired order before importing. 

Data for the following fields in the WBS window cannot be imported: Revision Letter 

Date and Schedule Reference Date. 

If your WBS is currently empty, all import records are added to the WBS. 

If a WBS ID already exists in your WBS, any fields included in the import record are 

updated except for the parent WBS ID. Any existing fields not included in the import will 

not be changed.  

Do not include commas in the WBS description. MPM views commas as field separators 

and will read the input as separate fields if it contains a comma as part of the text.  If the 

description does contain commas, then enclose the field with quotation marks. 

Any Fee Limit Amount values imported are assigned to the specific WBS element; 

however, those fields in children of the specified WBS are not modified.   

CLIN, Recurring/Nonrecurring and/or Fee % values imported are assigned to the specific 

WBS element and all of its children. 
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16.14  Importing WBS Descriptive Data  

16.14.1 Import WBS Descriptive File Format 

Import WBS Descriptive File Format  

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID 

2 100 A WBS Description 

3 20 A Alias 

4 20 A User-defined XREF1 

5 20 A User-defined XREF2 

6 20 A User-defined XREF3 

7 20 A User-defined XREF4 

8 20 A User-defined XREF5 

9 20 A User-defined XREF6 

10 20 A User-defined XREF7 

11 20 A User-defined XREF8 

12 20 A User-defined XREF9 

13 20 A User-defined XREF10 

14 20 A Manager 

15 20 A Charge Number 

16 10 A Performing Department 

17 10 A Responsible Department 

18 1 C/W/P/

O/blank 

Element Type  
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Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

19 1 A Earned Value Method 

Use the following codes: 

   0:  No EVM Required 

   1:  0/100 

   2:  25/75 

   3:  40/60 

   4:  50/50 

   5:  % Complete 

   6:  LOE 

   7:  Earned Standards 

   8:  Milestone Weights 

   9:  BCWP Entry 

   A:  Apportioned Effort 

   P:  Milestone Weights with % Complete 

   K:  Key Event 

20 8 A CLIN 

21 1 R/N Recurring or non-recurring 

22 6 N Fee % 

23 9 N Fee Limit Amount 

24 1 H/P/B/ 

C/D 

BCWP Base Unit (Hours/Units, Prime, Total 

Burdened, Total Cost, or Total Dollars) 

 25 40 A Parent‘s WBS ID (enter * if top level) 

26 20 A Base WBS; used if EVM is apportioned 

 

Example WBS Descriptive Import 

In this example, WBS 21-100 is updated, assuming it already exists in the WBS. The 

Manager becomes Bob, the EVM becomes 8, the CLIN becomes 002, the BCWP units 

becomes H(ours), and the Parent WBS is ignored.  (If the Parent WBS ID is not 2X, it 

will not change it.) 

21-100,,,,,,,,,,,,,Bob,,,,,8,002,,,,H,2X, 
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16.15  Importing WBS Schedule Data 

Use the Import WBS Schedule window to import new WBS schedule data from outside 

MPM. Optionally, you can also shift resources and/or milestones to new dates for WBS 

elements based on the imported dates.  

Access the Import WBS Schedule window by double-clicking the WBS Schedule icon on 

the Menu Manager with the Imports tab showing. MPM displays the Import WBS 

Schedule window.  

 

Figure A. To import WBS Schedule Data, select the Import WBS 
Schedule import on the Menu Manager. 

The WBS Schedule import file contains the WBS ID, Baseline, ETC, Early, and Late 

start and complete dates. If you do not select any of the conditioning options, MPM 

copies the Early and Late start and complete dates from the import file, inserts them into 

the WBS element‘s Early and Late dates, and ignores any Baseline or ETC dates included 

in the import file. 

Time Now Date 

To specify the point in time where updating dates and shifting resources begins, enter the 

Time Now Date. MPM uses this optional field to determine whether to update the 

specified WBS elements. Only those WBS elements whose early start date is after the 

Time Now Date are updated. If this field is left blank, then all dates are updated. 

MPM will not update WBS elements which have already started, or if they contain 
actuals or BCWP data. 
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Updating the Baseline 

To update the baseline dates in MPM, choose Update Baseline Dates From. This option 

determines which dates in the import file are used to update the baseline dates.  

Import – uses the baseline start and complete dates in the import file 

Early – uses the early start and complete dates in the import file 

Late  – uses the late start and complete dates in the import file 

MPM sets the baseline start and complete dates equal to the imported/early/late dates in 

the import file. If a WBS element has no resource estimates, its start date is set equal to 

the imported/early/late start date (whichever was selected), and the complete date is set 

equal to the imported/early/late finish date.  

If a WBS element contains resource estimates, click the Shift Baseline Resources  

check mark box to shift baseline resource estimates from their planned start to the new 

start date. Further, because the completion of a WBS element is determined by the length 

of its estimates, only the start date will be set equal to the imported/early/late start date; 

the duration of the estimate will be maintained. 

Updating the ETC 

To update the ETC dates in MPM, choose Update ETC Dates From. This option 

determines which dates in the import file are used to update the ETC dates.  

Import – uses the ETC start and complete dates in the import file 

Early – uses the Early start and complete dates in the import file 

Late  – uses the Late start and complete dates in the import file 

MPM sets the ETC start and complete dates equal to the imported/early/late dates in the 

import file. If a WBS element has no resource estimates, its start date is set equal to the 

imported/early/late start date, and the complete date is set equal to the imported/early/late 

finish date.  

If a WBS element contains resource estimates, click the Shift ETC Resources   

check mark box to shift ETC resource estimates from their planned start to the new start 

date. Further, because the completion of a WBS element is determined by the length of 

its estimates, only the start date will be set equal to the imported/early/late start date; the 

duration of the estimate will be maintained. 
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16.15  Importing WBS Schedule Data 

16.15.1  Shifting Milestones 

If you shifted Resources, you may also want to shift your Milestone schedule and 

forecast dates to correspond to the new start and complete dates.  

Shift Milestones - Schedule Dates 

To shift the milestone schedule dates, click the Shift Milestones – Schedule Dates  

check mark box. To leave the schedule dates unchanged, leave this box empty. This 

option is only available if you selected Shift Baseline or ETC Resources. 

If you select Baseline Update and Shift Milestones, the milestone dates are shifted the 

same number of days that the baseline has been shifted. 

If you select ETC Update and Shift Milestones, the milestone dates are shifted the same 

number of days that the ETC has been shifted. 

If you select both Baseline and ETC Update and Shift Milestones, the milestone dates are 

shifted the same number of days that the baseline has been shifted. 

Shift Milestones - Forecast Dates 

To shift the milestone forecast dates, click the Shift Milestones – Forecast Dates  
check mark box. To leave the schedule dates unchanged, leave this box empty. This 

option is only available if you selected Shift Baseline or ETC Resources. 

If you select Baseline Update and Shift Milestones, the milestone dates are shifted the 

same number of days that the baseline has been shifted. 

If you select ETC Update and Shift Milestones, the milestone dates are shifted the same 

number of days that the ETC has been shifted. 

If you select both Baseline and ETC Update and Shift Milestones, the milestone dates are 

shifted the same number of days that the baseline has been shifted. 
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Repricing Estimates 

If you have elected to update and shift resources, MPM must reprice after it shifts the 

estimates.  To carry out the repricing, MPM displays the Project Date Shift dialog:  

 

Figure A. Project Date Shift Dialog 

The Reprice Conditioning portion of this dialog contains two columns: EOC and 

Maintain. All EOCs stored in the EOC Table are displayed. For each EOC, one of the 

following values must be maintained for repricing: Hours, Equivalent Men, Prime 

Dollars, Total Burdened, Total Cost, Total Dollars, Total Price, and Original Estimate 

Type. These values appear in the Maintain column as a list box next to each EOC. For 

each EOC, enter one of the above values and MPM holds that value constant. See the 

Project Date Shift and Estimate Reprice topics of the Repricing Estimates section of 

Chapter 11: Utilities for details on how reprices are performed. 

Import Processing of WBS Schedule Data 

If dates are being updated for WBS elements with no estimates (no shift required), only 

those WBS elements that start after Time Now are updated. If dates are being updated for 

WBS elements with estimates and resources are also being shifted, only those estimates 

that start after Time Now are shifted. 

MPM will not shift resources if the Rollup Processing Toggle is Off. 
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16.15  Importing WBS Schedule Data 

16.15.2  Import WBS Schedule File Format 

Import WBS Schedule File Format 

Field 
Position 

No. of 
Chars 

 
Type 

 
Field Content 

 1 40 A WBS ID; must exist in the project.  

2 9 A Baseline Start 

Valid date formats:  See topic 16.14  Importing WBS 

Descriptive Data for details. 

3 9 A Baseline Complete 

4 9 A ETC Start 

5 9 A ETC Complete 

6 9 A Early Start 

7 9 A Early Finish 

8 9 A Late Start 

9 9 A Late Finish 

10 6 N Total Float 

Example WBS Schedule Import 

In this example, WBS 21.1 is updated, assuming it already exists in the WBS. The 

Baseline Start Date is 15-Apr-98; Baseline Complete is 30-Jun-98; ETC Start is 15-May-

98; ETC Complete is 30-Jun-98; Early Start is 01-Jan-98; Early Complete is 01-Jun-98; 

Late Start is 01-May-98; Late Finish is 01-Jul-98; Float is 30 days.  

21.1,19980415,19980630,19980515,19980630,19980101,19980601,19980501,19980701,30 

If we did not select the Update Baseline or Update ETC options:  

 W

BS Early Start is set to 01-Jan-98; WBS Early Complete is 01-Jun-98;  

 W

BS Late Start is 01-May-98; WBS Late Finish is 01-Jul-98; 

 B

aseline and ETC start and complete are unchanged 
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If we selected to Update Baseline with import dates: 

 W

BS Early Start is set to 01-Jan-98; WBS Early Complete is 01-Jun-98;  

 W

BS Late Start is 01-May-98; WBS Late Finish is 01-Jul-98; 

 B

aseline Start is 15-Apr-98; Baseline Complete is 30-Jun-98; 

 E

TC Start and Complete are unchanged 

If we selected to Update Baseline with early dates: 

 W

BS Early Start is set to 01-Jan-98; WBS Early Complete is 01-Jun-98;  

 W

BS Late Start is 01-May-98; WBS Late Finish is 01-Jul-98; 

 B

aseline Start is 01-Jan-98; Baseline Complete is 01-Jun-98; 

 E

TC Start and Complete are unchanged 

If we selected to Update Baseline with late dates: 

 W

BS Early Start is set to 01-Jan-98; WBS Early Complete is 01-Jun-98;  

 W

BS Late Start is 01-May-98; WBS Late Finish is 01-Jul-98; 

 B

aseline Start is 01-May-98; Baseline Complete is 01-Jul-98; 

 E

TC Start and Complete are unchanged 

If we selected to Update ETC with import dates: 

 W

BS Early Start is set to 01-Jan-98; WBS Early Complete is 01-Jun-98;  
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 W

BS Late Start is 01-May-98; WBS Late Finish is 01-Jul-98; 

 B

aseline Start and Complete are unchanged; 

 E

TC Start is 15-May-98; ETC Complete is 30-Jun-98 
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16.16  Automating Data Imports 

In addition to using the MPM interface for importing data it is also possible to automate 

the import process outside of MPM using customer developed code and the MPM 

Importer dynamic link library (dll), MPMImporter.dll. 

The MPMImporter dll provides a programming interface between customer or 3
rd

 party 

software and the various MPM import modules. Any language capable of accessing 

Microsoft Active X objects can be used. Visual Basic, Visual C, C++ and other object 

oriented languages are excellent candidates. 

Potential uses and advantages of the MPMImporter dll include: 

 Automation of repetitive data imports from external systems without the need to 

invoke the full MPM product. 

 Ability to create (program) a true database to database import solution using the 

logic and user interface the customer desires. 

 Full MPM data validation including processing report 

 Support for following imports: 

o Actuals 

o Basis of Estimates 

o BCWP 

o Distributed Projects 

o Estimates 

o Global Files 

o Milestones 

o OBS 

o Task Descriptions 

o WBS Descriptive Data 

o WBS Schedule Data 

Requirements 

Use of the MPM Importer is considered an advanced operation and should only be 

attempted by someone with a sound background in programming Microsoft COM 

objects.  
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The MPMImporter DLL is preinstalled with the MPM executable files. In order to 

interact correctly with the MPM import modules it must remain in this directory. 

Any programming language which can call and set Microsoft COM object properties and 

methods may be used to develop the customer‘s interface. Visual Basic, Visual C, C++ 

are typical languages. 

Please note that MPMImporter only provides a direct link to the various MPM import 

dlls. Your application, in addition to calling this dll must provide the following: 

 Any User Interface to select specific imports and / or allow user choice of input 

files etc. 

 Validation of all parameters passed to the dll since the application is bypassing the 

MPM program which would normally qualify these values. 

 Any validation or error feedback. The individual import dlls will provide a results 

report to the file location specified in the .ReportFileName property as described 

in section 16.3.  

Sample Code Example 

To use the MPMImporter, client software will instantiate an instance of the 

MPMImporter class, assign values to the instantiated object‘s properties and execute its 

single method, Process. 

Note: Failure of records to be successfully imported is handled by the appropriate import 

module and reported in the Report File. 

The following sample code written in Microsoft Visual Basic executes a WBS Schedule 

import: 

Dim MPMObject as Object 

Set MPMObject =CreateObject(“MPMImporter.cImporter”) 

With MpmObject 

 .UserName = “Bob” 

 .ProjectorGlobal = “SVIIBL3” 

 .Datapath = “C:\DELTEKMPM” 

 .ImportFileName = “A:\Oct Schedule.csv” 

 .ReportFileName = “C:\DELTEKMPM\Results\Results.csv” 

 .ImportCategory = 2      

 „WBS Schedule 

 .Options = “25-Sep-97,E,N,L,N,N” 

End With 

MpmObject.Process 
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The code above creates an instance of the MPMImporter class, sets its properties 

according to the specific import desired and executes the import by calling the Process 

method. 

Typically the user will imbed the above code in an application which might provide for a 

user interface to select import type and set options, as well as display import results. 

Alternately the same code might be used within a fully automated application which 

creates the import data from an external source, schedules the import, and sends the 

import result to an administrator.  

Common Properties 

The following properties are common to all import categories: 
 

PROPERTY DATA TYPE DESCRIPTION EXAMPLE 

ProjectorGlobal String MPM Project or Global 

Name 

SVIIBL3, DEFAULT 

UserName String Valid 8 character MPM user 

name as stored in 

MPMUsers.Dat 

Sysadmin, Bob, Frank 

DataPath String Data path to MPM 

executable files 

C:\DeltekMPM 

ReportFileName String Name and path of file to store 

import module result 

information. Note: File 

extension must be .csv 

C:\DeltekMPM\ 

Importinfo\Results.csv 

ImportCategory Integer Specifies type of import 

1 – WBS Description 

2 – WBS Schedule 

3 – Estimates 

4 – Basis of Estimate 

5 – Globals 

6 – Milestones 

7 – BCWP 

8 – Actuals 

9 –Distributed Project 

10 –Task Description 

11 – OBS 

1,2,3,4,5,6,7,8,9 or 10 

ImportFileName String Name and path of import file A:\OctEst.csv 
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Options Property 

In addition to the common properties, the options property must be set for the import 

category specified. This provides the conditioning normally applied through the MPM 

user interface. The property is a comma-delimited string. For those imports which do not 

require this additional conditioning the value should be set to blank (―‖). 
 

Import 

Category 

Condition Value(s) Example 

WBS Schedule Time Now User defined point in time where 

updating dates and shifting 

reports begin 

21-SEP-06 

Base Date Possible values: 

(I)mport. This option is selected 

when using Data Import function 

to import a file. 

(E)arly. This option sets baseline 

start dates equal to early start date 

contained in the import file. 

(L)ate. This option sets baseline 

start dates equal to late start dates 

contained in the import file. 

I or E or L 

Base Shift (Y)es or (N)o Y or N 

ETC Date Possible values: 

(I)mport. This option is selected 

when using Data Import function 

to import a file. 

(E)arly. This option sets ETC 

start dates equal to early start date 

contained in the import file. 

(L)ate. This option sets ETC start 

dates equal to late start dates 

contained in the import file. 

I or E or L 

ETC Shift (Y)es or (N)o Y or N 

Sched Shift (Y)es or (N)o Y or N 

Force Shift (Y)es or (N)o Y or N 
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Import 

Category 

Condition Value(s) Example 

 EOCs 26-byte string, first 13 represent 

EOCs in order listed on import 

screen. Second 13 are value to be 

‗held‘. If blank then no value 

type to be held. Possible values 

are: 

(H)ours  (C) total cost 

(E)qp     (D) total $ 

(P)rime   (T)otal Price 

(O)riginal Estimate 

(B)urden 

0123456789LMOHP

POOOO OOOOO 

Estimates Autospread (Y)es or (N)o Y or N 

Partial Y = Partial N = Complete  Y or N 

From Import From Date (if partial, 

otherwise blank) 

21-SEP-06 

Thru Import Through (if partial, 

otherwise blank) 

02-DEC-06 

Update Option A= Accumulate  

R = Replace 

A or R 

Import Type B – Baseline 

E – ETC 

A – Both 

B or E or A 

 

Milestones Identify 

Milestones by 

I = ID 

D = Description 

S = Symbol/Description/Schedule 

Date 

I or D or S 

Update BCWP  

Status 

(Y)es or (N)o Y or N 

As of Date Fiscal Status as of Date YYYYMMDD 

Actuals Auto Burden Y = Import with Autoburdening 

N = Import without 

Autoburdening 

Y or N 

Duplicate 

Actuals 

A =  Update with new values 

B =  Accumulate old and new 

values 

C =  Ignore new values 

A or B or C 
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Import 

Category 

Condition Value(s) Example 

Distributed 

Project 

BCWS Include BCWS data Y or N 

BCWP Include BCWP data Y or N 

ACWP Include ACWP data Y or N 

ETC Include ETC data Y or N 

Schedule Dates Include Schedule Dates Y or N 

Milestones Include Milestones Y or N 

OBS Organization 

Type 

P = Performing Department 

R = Responsible Department 

P or R 

 

Note that actual option settings must match those in the above table and are not 

necessarily the same characters used in the MPM Import conditioning screen. 

Programming and Installation notes 

Use of the MPMImporter DLL does not alter or bypass any of the MPM production 

import functionality. 

User must provide own security surrounding execution of an application based upon the 

use of MPMImporter DLL. Although a user name is required to be passed to the object 

there is no corresponding requirement or check for a valid password. 

The MPMImporter DLL expects to be located in the same directory as the MPM import 

DLLs i.e. MPM executables.  

Depending on system environment settings it may be necessary to either copy 

MFPAD.DLL and MFREPORT.MFL to the \Windows\System32 directory or add the 

MPM executable directory to the system environment path.        
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17.1 Introduction to Data Exports 

Use Data Exports to save MPM data to an external file. Many customers export some of 
their cost data for use in other software systems, such as accounting or personnel systems. 
There are also customers who export their MPM data, make some change to it, and then 
import it back into MPM. To export data, you use the exports available on the Exports tab in 
Menu Manager.  

 
Figure A. Exports available in MPM 

Types of Exports 
MPM can create export files for the following kinds of global data: 

Fiscal Calendar Holiday Calendar 
Burden Templates Element of Cost (EOC) Table 
Resources & Burdens  

MPM also can create export files for the following kinds of project data: 

Actuals by WBS Milestones 
Audit Trail Resource BOE 
BCWP Status Task Descriptions 
Distributed Project WBS 
EOC Rollup by WBS Weekly Data  
Estimates by WBS   
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Single and Batch Exports 
You can export a single data file, or build a batch export that exports two or more data files. 
You can save single and batch export definitions. 

General Export Procedure 
To export data from MPM for an outside accounting system, spreadsheet, or other system, 
follow these general steps: 

1. Back up your MPM data before running the export. 

2. Access the correct export conditioning window as described in topic 17.2  Accessing 
the Export Conditioning Windows. 

3. Fill in the export conditions for that particular export. 

4. If required, specify or create a format file. See topic 17.7.1  Creating Format Files. 

5. Run the export as described in topic 17.3  Orientation to the Export Conditioning 
Windows. 
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17.2 Accessing the Export Conditioning Windows 

You open the Export Conditioning windows by clicking the Exports tab on the MPM Menu 
Manager. When you access the Exports tab, all exports to which you have been granted 
access are displayed. Double-click the export icon to open the desired Export Conditioning 
window. In Figure A, the Actuals export window has been opened. 

 
Figure A. Select the icon on the Exports tab of the MPM Menu 
Manager. 

Procedure 
To open the desired Export window, do one of the following from the Menu Manager 
window: 

Select the Exports tab and choose the icon for the desired type of export. 
Choose Exports|[Type of export] from the File menu. 
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Conditioning Options 
Each export has a window which contains the conditioning options that determine the 
information included in the export. The options vary with the type of export. 
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17.3 Orientation to the Export Conditioning Windows 

You use the Export Conditioning windows to setup the data to be exported from MPM. A 
toolbar is available to give you quick access to common tasks. The Export Conditions grid 
displays the information about the export.  

 
Figure A. Each conditioning category (for example, File 
Name Selection) can be expanded to display conditioning 
options. 

Export Conditions Grid 
In every Export Conditioning window, the left pane of the window displays the icon for the 
selected type of export or exports. In Figure A, the icon is for BCWP Status. The right pane 
displays the conditioning information for the export. The conditioning information is 
different for each type of export. 

The right pane is divided into two columns: Filter and Criteria. The Filter column shows the 
export condition categories and options to be specified. Categories are displayed on a gray 
background, options on a white background. Each category can be expanded to display 
conditioning options. You expand and collapse the categories using the corresponding 
buttons  in the toolbar. For example, in Figure A, the File Name Selection 
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category has been expanded to display the Export File Name and Format File Name 
conditioning options.  

The Criteria column contains list boxes, checkmark boxes, or text entry boxes in which you 
enter the criteria for each conditioning option. For example, in Figure A, Viewer has been 
selected for Output Format. 

In every export conditioning window, you must specify the name of the project and the 
name and location of the export file. You enter this criteria in the white boxes under the 
gray categories Project Selection and Filename Selection. Some export conditioning 
windows only contain these two conditions. Other export conditioning windows, such as 
BCWP shown in Figure A, contain additional conditions which are specific to that type of 
export and may or may not be required. These conditions are shown under an additional 
category named Export Options. 

Running an Export 
After specifying the export conditions, you can the export by doing one of the 

following: 

 Click the Run  button. 
 Choose Run Export on the Tools menu. 
 Press Ctrl+R. 

Previewing and Printing Export Conditioning 
You can preview and print the export conditioning data using the options on the File menu 
or by clicking the Print button  and Preview button  on the toolbar. For complete 
details on using these options, see Using MPM in the Getting Started manual. Print and 
Preview only show the export conditioning criteria displayed on the grid. They do not 
display the output generated by the export.  

Saving the Export Conditioning 
To save the Export Conditioning data, do one of the following: 
Click the Save button . 
Choose Save from the File menu, or press Ctrl+S. 
MPM prompts for the location and file name to be saved. See topic 17.8  Batch Export 
Processing for details on using saved conditioning. 
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17.4 Global Export Conditioning Options 

The conditioning options are different for each type of export. However, there are several 
options that are used by the majority of global or project exports. This topic describes the 
global conditioning options. The next topic describes the project conditioning options. 

Global Exports 
Conditioning options are shared by all global exports: 

Burden Templates  Holiday Calendar 
Element of Cost (EOC) Table Resources & Burdens 
Fiscal Calendar  

Common Global Export Categories and Options 
The global exports share one or more of the conditioning categories and options listed in the 
table below. 

Category Conditioning Option Criteria Column 
Global Selection Global A drop-down list of all available global 

sets. 
Report Timeframe 
Information 

Report Period From Fields accept dates in the usual formats, or 
you can use formulated dates. For 
information on formulated dates, see topic 
17.7  Using Format Files. 

Report Period Through 

Output Options Output Format A drop-down list of available formats. 
File Name 
Selection 

Export File Name When you click the criteria box for this 
option, the Browse button  is displayed 
at the end of the box. Click the button to 
display the standard Windows browse 
dialog box where you can enter a file name 
and select a folder. This field is active if 
you select an output format other than 
Viewer. 

Append to Existing File When checked, the export data will be 
added to an existing file rather than 
overwriting the data in the file. 

 
Unique conditioning options for each export are described later in this chapter. 
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17.5  Project Export Conditioning Options 

The conditioning options are different for each type of export. However, there are several 
options that are used by the majority of global or project exports. This topic describes the 
project conditioning options. The previous topic describes the global conditioning options. 

Project Exports 
Conditioning options are shared by all project exports: 

Actuals by WBS Milestones 
Audit Trail Resource BOE 
BCWP Status Task Descriptions 
Distributed Project WBS 
EOC Rollup by WBS Weekly Data 
Estimates by WBS  

Common Project Export Categories and Options 
The project exports share one or more of the conditioning categories and options listed in the 
table below. Required options are marked with an asterisk in the table. 

Category Conditioning Option Criteria Column 
Project Selection Project* A drop-down list of all available projects 

to which you have access. 
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Category Conditioning Option Criteria Column 
Data Conditioning WBS Leg To export a particular WBS Leg, enter the 

WBS ID, or click the  button which is 
added to the WBS Leg criteria box when 
clicked. MPM displays the WBS Leg 
dialog box shown below. Highlight the 
desired leg, expanding levels if necessary. 
The WBS ID selected is inserted in the 
Criteria box. 

 
WBS Level Enter a value from 1 through 99 to export 

WBS elements at the level entered. If a 
WBS leg is entered, the WBS level will 
validate the lowest level of that leg. 

Alias A drop-down list of all available aliases 
assigned to WBS elements. 

WBS Manager A drop-down list used to export WBS 
elements assigned to a specific Manager. 

Xref-1 through Xref-10 Drop-down lists of all available values 
assigned to WBS elements in these fields. 
The names of the fields can be changed by 
the user in Project Maintenance. 
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Category Conditioning Option Criteria Column 
Data Conditioning 
(continued) 

Recur A drop-down list used to select Recurring 
or Non-recurring WBS elements. 

Element Type A drop-down list used to select a WBS 
element type. 

OBS A drop-down list used to select the WBS 
elements assigned to either the Performing 
or Responsible OBS departments. 

Department ID A drop-down list used to select data 
assigned to a particular OBS department. 

CLIN A drop-down list used to select data 
assigned to a particular Contract Line Item 
(CLIN). 

Report Timeframe 
Information 

Report Period From Fields accept dates in the usual formats, or 
you can use formulated dates. For 
information on formulated dates, see topic 
17.7  Using Format Files. 

Report Period Through 

Output Options Output Format A drop-down list of available formats. 
File Name 
Selection 

Export File Name When you click the criteria box for this 
option, the Browse button  is displayed 
at the end of the box. Click the button to 
display the standard Windows browse 
dialog box where you can enter a file name 
and select a folder. This field is active if 
you select an output format other than 
Viewer. 

Format File Name The format file determines the fields 
exported and their order. You can select a 
predefined format file, or create a custom 
file. For more information, see topic 17.7  
Using Format Files. 
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Category Conditioning Option Criteria Column 
Export Options Include Header When checked, includes the column and 

report headings in the export data. 
 Include Project Name When checked, includes the project name 

in the first column of the export file data. 
 Report Title Use to enter a report title up to 28 

characters. 
 Column Separation 

Character 
If you have selected User-defined 
Separators in the Output Format field, you 
can enter a character that you want MPM 
to use to separate columns of data. If you 
have not selected User-defined Separators, 
the character is automatically set by MPM. 
For more information, see topic 17.6  
Creating Export Files. 

 Text Delimiter If you have selected User-defined 
Separators in the Output Format field, you 
can enter a character that you want MPM 
to insert before and after each text field in 
the export file. For more information, see 
topic 17.6  Creating Export Files. 

 Date Format A drop-down list displaying the available 
date formats: YYYYMMDD, 
MM/DD/YY, and DD-MMM-YY. 

 

Unique conditioning options for each export are described later in this chapter. 
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17.6  Creating Export Files 

When exporting data from MPM, you need to specify: 

Output format 
Output delimiters 
Output filename and location 
Format file 

Output Formats 
Export files can be created in several popular formats: 

Excel version 5 or 7 format (.XLS) 
ASCII text with fields separated by commas (.CSV) 
ASCII text with fields separated by tabs (.TXT) 
HTML text for use on a web page (.HTM) 
User-defined Separated Value (*.EXP) 
You can also send the data from an export to the printer or the Report Viewer, where you 
can manipulate, reorganize, or reformat the data. See Chapter 15: Reports for more 
information on how to use the Report Viewer. 

Column Separation Character Delimiter 
The column separation character is inserted between each field in the export file. For 
example, data exported in CSV (Comma Separated Values) format might look like this: 

21-110,102,3,START,0,19980101,N,65,25 

If you choose the CSV format, the column separator is a comma. If you choose HTM, XLS 
or ASCII formats, the column separator is a tab. When using these formats, you cannot 
change the column separator or the text delimiter.  

If you choose the User-defined separators (EXP) format, you can specify the column 
separator character to be used. You can choose any ASCII character to be the column 
separator except space. For example, if you enter * as the separator, the data would look like 
this: 

21-110*102*3*START*0*19980101*N*65*25 
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Text Delimiter 
The text delimiter character is inserted before and after each text field in the export file. For 
example, if you export with the text delimiter set to quotation marks, the record would look 
like this: 

“21-110”,102,3, “START,FINISH”,0,19980101,N,65,25 

The text delimiter is inserted by MPM in case there are delimiting characters used inside the 
text field (such as the comma inside “START,FINISH”). For example, if you enter * as the 
text delimiter (and comma as the column separator), you would see the following: 

*21-110*,102,3,*START,FINISH*,0,19980101,N,65,25 

You can choose most any ASCII character to be the text delimiter except space. You can 
only set the Text Delimiter if you choose the EXP format. 

Output File 
Once you have specified all the required options, enter the file name for the export file being 
created, and if necessary specify the location using the Browse  button. Then run the 
export. If you selected either the output format Printer or Report Viewer, , MPM sends the 
exported data directly to the printer or into the Report Viewer instead of creating an export 
file. In the Viewer, you can reorganize, reformat, analyze, or subtotal the data as desired. 

Format File 
Most of the exports require that you specify or create a format file. A format file is a map of 
the output data. For details, see topic 17.7  Using Format Files. 

Working with .XLS Files 
Exporting data to .XLS files works well, allowing you to edit the files in Excel. However, 
after making edits in Excel, you must save the file in .CSV format if you wish to import the 
data back into MPM. You cannot import a .XLS file directly into MPM. 
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17.7  Using Format Files 

The format file contains the order and selection of the fields you want to export. You must 
enter or specify a format file to use with your export. This is an important step if your export 
data needs to match outside data in a prescribed format. For example, you would use a 
format file if you plan to import the data into an external system or back into MPM. 

Using Standard Format Files 
MPM comes with a set of standard format files that describe the order and fields for the most 
frequently used exports. If you plan to export this data, make changes, and then import that 
data back into MPM, you must use the standard format file for the data. 

Format file names have the extension .FMT. The standard format files are described below: 

 ACTUAL.FMT is used for actuals data 

 BCWP.FMT is used for BCWP data 

 BE-MIL.FMT is used for milestone data being exporting to Deltek 

 ESTIMATE.FMT is used for estimates data 

 MILESTON.FMT is used for milestones data 

 SCHEDULE.FMT is used for schedule data 

 WBS.FMT is used for WBS data 

 WEEKWBS.FMT is used for weekly WBS data 

 WEEKEOC.FMT is used for weekly EOC data 
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Selecting a Format File 
To select a format file: 

1. Click the Format File Name criteria box on the Export Conditioning window. 

The Criteria box will add two buttons, the Browse button and the Field Mapping 
button as shown in Figure A. 

 

Field Mapping 
button 

Browse button 

Figure A. When you click the Format File Name criteria 
box, MPM adds the Browse and Field Mapping buttons. 

2. Click the Field Mapping button. 

 MPM displays the Format File Name dialog box where you can select a format file. 
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17.7  Using Format Files 

17.7.1  Creating Format Files 
To create or modify a format file, click the Field Mapping  button. MPM displays the 
Field Mapping dialog box. See Figure A. 

 
Figure A. Use the Field Mapping dialog box to create custom format 
files. 

The format file is defined by the fields in the right list box labeled Output Fields. When you 
first access this dialog, the format file is empty, waiting for you to tell MPM which fields 
you want to export. The fields shown in the left list box labeled Available Fields are all the 
fields from the data you want to export.  

To add a field to the export, click the desired field and click the  button, or double-
click the field, scrolling the left list box if necessary. MPM moves the field to the right list 
and deletes it from the left. Add additional fields as desired in the order desired. 

To take a field out of the export, click the field in the right box and click . 

To change the order of the fields in the format file, click once on the field in the right list 
and click Move Up or Move Down as many times as desired, until the field is in the desired 
position. 
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Saving the Format File 
If desired, you can save the format file for later or repeated use by clicking the Save button. 
MPM displays the Save Formatting dialog box shown in Figure B. Saving the file is not 
necessary to run the import; it is only necessary if you plan to reuse the format file at a later 
date.  

 
Figure B. Saving the Format File Definition. 

Enter the desired the file name and click Save. You don’t need to add the .FMT extension to 
the name; MPM adds the extension automatically. Then click OK on the Field Mapping 
dialog box.  

The Export Conditioning window now contains the name of the saved format file you 
created. See Figure C. 

MPM fills in the
name of the
Format File

 
Figure C. The newly saved Format File name is filled in the Criteria. 

If you had chose not to save the format file, MPM fills in <Unnamed> as its name. 
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17.8  Batch Export Processing 

Many MPM users perform the same set of exports every month as part of their monthly 
status processing. To set up a batch export process which performs several exports, you 
create a Batch Export file.  

Creating a Batch Export File 
There are two ways to create a Batch Export file:  

On the Menu Manager with the Exports tab selected, double-click the icon for the first 
export to be performed. Inside the Export Conditioning window, click in the left window 
pane and choose Add Export on the Edit menu. MPM displays a list of all available 
exports. Double-click the next export to be added. 
On the Menu Manager with the Exports tab selected, use the Shift and Ctrl keys to select 
more than one type of export. Double-click on the last icon selected. 
Figure A shows a Batch Export file with two exports: Estimates by WBS and Actuals by 
WBS.  

The icons in the left window pane show you the export(s) you have added to this Batch 
Export file. When you click on an icon in the left pane, the right pane shows the export 
conditioning for that export. In Figure 
A, Estimates by WBS is selected and 
the corresponding export conditioning 
fields are displayed. If you clicked the 
Actuals by WBS icon, the Actuals by 
WBS Export Conditioning fields 
would be displayed in the right pane.  

Figure A. Creating a Batch Export File to 
process WBS Descriptive and Schedule Data. 
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Enter the desired export conditions. To accept the selections and run the export, do one of 
the following: 

Click the Run button . 
Choose Run Export on the Tools menu. 
Press Ctrl+R. 
 
To save the Export Conditioning data, do one of the following: 

Click the Save button . 
Choose Save from the File menu. 
Press Ctrl+S. 
MPM prompts for the location and file name to be saved. The default location will be a 
directory called EXPORTS located under the DELTEKMPM directory. Saved exports are 
given the name export.MFE.  Once you have saved an export, MPM adds a Saved Exports 
tab to the Menu Manager, where all saved exports can be accessed later. 

Accessing Saved Conditioning 
When you save your Batch Export file conditioning, MPM adds a tab to the Menu Manager 
next to Exports called Saved Exports the displays an icon for every saved Batch Export file 
you have created. In Figure B below, you can see several saved Batch Exports. To access 
any of the saved Batch Export files, click the appropriate icon. 

  
Figure B. Viewing Batch Export Files 
on the Menu Manager. 
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MPM displays the Export Conditioning window. Change any conditioning as desired, and 
run the export when ready. 

Deleting Batch Exports 
To delete a Batch Export from the Saved Exports tab, do one of the following: 

 Right click on the export then select Delete Item. 

 Select the export then choose Edit|Delete Item. 

 Delete the corresponding .MFE file from the Exports folder in the DELTEKMPM 
directory. 

In Menu Manager, open the View menu and choose Refresh. 

MPM removes the batch export icon from the Saved Exports tab. If the batch export 
is the last icon on the tab, MPM also removes the Saved Exports tab. 
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17.9  Using Formulated Dates 

In all export conditioning options that require a date, you can enter a date formula instead of 
entering an actual date. A date formula is a calculation based on the current date. If you have 
a standard set of exports that are run every month, using this feature will save you time 
because you can reuse the export conditioning without modifying the dates for the current 
period. 

The current accounting period is substituted in any export conditioning criteria when you 
enter =<CURRENT>, based on your system date or the date you enter in Set Current Date on 
the Tools menu. To substitute other dates, modify the date formula by adding or subtracting 
d)ays, w)eeks, p)eriod, or y)ears. 

When filling conditioning options that require a date (for example, 17-JUL-97), you can use 
d)ays or y)ears in your formula. For example, if today is July 17th, 1997: 

 =<CURRENT> + 3y  would be calculated as July 18th, 2000 
 =<CURRENT> + 60d would be calculated as Sept 15th, 1997  

When filling conditioning options that require a period (for example, JUL-97), you can use 
m)onths or p)eriods in your formula. For example, if the current period is JUL-97: 

 =<CURRENT> + 3p would be calculated as OCT-97 
 =<CURRENT> - 2m would be calculated as MAY-97 

Once you enter a formulated date and move to another field on the Export Conditioning 
window, the date is calculated and displayed in brackets based on the current date as shown 
in Figure A.  

Using formulated dates is extremely valuable when you save export conditioning for later 
batch processing, especially when a Batch Export file contains multiple reports. Each time 
you run the same report(s), the dates will be recalculated based on the current date without 
you having to re-enter the new dates.  

Always be sure that the Current Date is set correctly before running the report. The current 
data is taken from the system date or the date you specify using Set Current Date under the 
Tools menu. 



MPM Projects   563 

Entering a Formula for
the Export Timeframe

 
Figure A. Setting the Report From and Through 
Dates using a formulated date based on the 
current period. 
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17.10  Conditioning Options for Specific Exports 

The remaining topics in this chapter describe the conditioning options specific to each type 
of export, and the fields available for each export. The conditioning options common to 
many of the exports are described in two topics presented earlier in this chapter: 

17.4  Global Export Conditioning Options 

17.5  Project Export Conditioning Options 

The exports described on the following pages are: 

17.10.1  Actuals by WBS Exports 

17.10.1  Actuals by WBS Exports 

17.10.3  BCWP Status Exports 

17.10.4  Burden Templates Exports 

17.10.5  Distributed Projects Exports 

17.10.6  EOC Rollups Exports 

17.10.7  EOC Tables Exports 

17.10.8  Estimates by WBS Exports 

17.10.9  Fiscal Calendars Exports 

17.10.10  Holiday Calendars Exports 

17.10.11  Milestones Exports 

17.10.12  Resources & Burdens Exports 

17.10.13  Task Descriptions and Basis of Estimates Exports 

17.10.14  WBS Data Exports 

17.10.15  Weekly Data Exports 
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17.10  Conditioning Options for Specific Exports 

17.10.1  Actuals by WBS Exports 
You use the Actuals by WBS window to export actuals data. Access the Actual by WBS 
Export Conditioning window by selecting Actuals by WBS on the Exports tab. MPM 
displays the Actual by WBS Export Conditioning window shown in Figure A. 

 
Figure A. To export actuals, select Actuals by WBS 
on the Exports tab. 

Conditioning Options 
When exporting actuals, all data conditioning options described in topic 17.4  Global Export 
Conditioning Options are available to condition the data being exported. In addition, you 
can specify the following options: 

Resource Code, Resource Department, XREF-EST, EOC, COC — To select data 
assigned to any of these fields, click in the Criteria box and select from the drop-down list 
containing all possible values.  
Actuals By — You can choose to export actuals by resource, element of cost, or both. 
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Format File Options 
You can use the standard ACTUAL.FMT format file or create a custom file using the fields 
listed below. For information on creating custom format files, see topic 17.7.1  Creating 
Format Files.  

Actuals Fields WBS Fields 

Resource (includes resource and/or 
EOC codes depending on the value 
in the Actuals By field) 

WBS (ID) 
Parent WBS 
Alias 

Baseline Start 
Baseline Complete 
ETC Start 

Resource Department WBS Description ETC Finish 
Overtime Factor Manager Early Start 
XREF-EST Xref-1 Early Finish 
Period Xref-2 Late Start 
Hour/Units (ACWP) Xref-3 Late Finish 
Prime (ACWP) Xref-4 Revision Letter Date 
Overhead (ACWP) Xref-5 Schedule Reference Date 
Burdened (ACWP) Xref-6 Last Statused Date 
General and Administration (ACWP) Xref-7 Total Float 
Total Cost (ACWP) Xref-8 EV Percent Complete 
Cost of Money (ACWP) Xref-9 Recur/NonRecur 
Total Dollars (ACWP) Xref-10 Fee Percent 
Fee (ACWP) Performing Department Fee Limit 
Total Price (ACWP) Responsible Department Earned Value Method 
 Charge Number BCWP Base Unit 
 Element Type CLIN 
  Base WBS 
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17.10  Conditioning Options for Specific Exports 

17.10.2  Audit Trail Exports 
You use the Audit Trail window to export Audit Trail data. Access the Audit Trail Export 
Conditioning window by selecting Audit Trail on the Exports tab. MPM displays the Audit 
Trail Export Conditioning window shown in Figure A. 

 
Figure A. To export audit trail information, select Audit Trail on the Exports tab. 
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Conditioning Options 
When exporting audit trail information, all data conditioning options described in topic 17.5  
Project Export Conditioning Options are available to condition the data being exported. In 
addition, you can specify the following options: 

User, Record Type. 
 
To select data assigned to any of these fields, click in the Criteria box and select from the 
drop-down list containing all possible values.  

Format File Options 
You can use the standard AUDIT.FMT format file or create a custom file using the fields 
listed below. For information on creating custom format files, see topic 17.7.1  Creating 
Format Files.  

Audit Trail Fields  
After At Complete Dollars  
After At Complete Hours  
Before At Complete Dollars  
Before At Complete Hours  
Burden Template  
Complete Date  
Date  
Delta Dollars  
Delta Hours  
Department  
Description  
Dollar Level  
Estimate Type  
Operation  
Overtime  
Rate Table  
Record Type  
Resource  
Start Date  
Time  
User  
WBS  
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17.10  Conditioning Options for Specific Exports 

17.10.3  BCWP Status Exports 
You use the BCWP Status window to export BCWP data. Access the BCWP Status Export 
Conditioning window by selecting BCWP Status on the Exports tab. MPM displays the 
BCWP Status Export Conditioning window shown in Figure A. 

 
Figure A. To export BCWP, select BCWP Status on the Exports tab. 

Conditioning Options 
When exporting BCWP, all data conditioning options described in topic 17.5  Project 
Export Conditioning Options are available to condition the data being exported. In addition, 
you can specify the following options: 

Display Percentages (optional) 
Use this output option to choose whether to export percentages as decimal values (.5050) or 
as a percent (50.50). 
Earned Value Method (optional) 
To select data assigned to a particular EVM, click in the Criteria box and select from the 
drop-down list containing all possible EVMs. 
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Format File Options 
You can use the standard BCWP.FMT format file or create a custom file using the fields 
listed below. For information on creating custom format files, see topic 17.7.1  Creating 
Format Files.  

BCWP Fields  WBS Fields 

Month-Year (in YYYYMM format) WBS (ID)  ETC Start 
Percent Complete Parent WBS  ETC Finish 
Total BCWP Alias Early Start 
 WBS Description Early Finish 
 Manager Late Start 
 Xref-1 Late Finish 
 Xref-2 Revision Letter Date 
 Xref-3 Schedule Reference Date 
 Xref-4 Last Statused Date 
 Xref-5 Total Float 
 Xref-6 EV Percent Complete 
 Xref-7 Recur/NonRecur 
 Xref-8 Fee Percent 
 Xref-9 Fee Limit 
 Xref-10 Earned Value Method 
 Performing Department BCWP Base Unit 
 Responsible Department CLIN 
 Charge Number Base WBS 
 Element Type  
 Baseline Start  
 Baseline Complete  
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17.10  Conditioning Options for Specific Exports 

17.10.4  Burden Templates Exports 
You use the Burden Templates window to export burden templates data. Access the Burden 
Templates Export Conditioning window by selecting Burden Templates on the Exports tab. 
MPM displays the Burden Templates Export Conditioning window shown in Figure A. 

 
Figure A. To export Burden Templates, select Burden Templates on 
the Exports tab. 

Conditioning Options 
When exporting burden templates, all data conditioning options described in topic 17.4  
Global Export Conditioning Options are available to condition the data being exported. In 
addition, you can specify the following options: 

Burden Template ID (optional) 
To select data assigned to a particular Burden Template ID, click in the Criteria box and 
select from the drop-down list containing all possible burden templates. 
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Format File Options 
The fields in Global exports are fixed, and cannot be defined by the user. 
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17.10  Conditioning Options for Specific Exports 

17.10.5  Distributed Projects Exports 
You use the Distributed Projects window to export Distributed Projects data. Access the 
Distributed Projects Export Conditioning window by selecting Distributed Projects on the 
Exports tab. MPM displays the Distributed Projects Export Conditioning window shown in 
Figure A. For information on distributed projects, see Chapter 19: Using Distributed 
Projects. 

 
Figure A. To export Distributed Projects, select Distributed Project on 
the Exports tab. 

Conditioning Options 
When exporting Distributed Projects, the data conditioning options described in topic 17.4  
Global Export Conditioning Options are not available to condition the data being exported. 
You can only specify the following options: 

 Source Project (required) — Use this option to select the Source, or subproject. 
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 Target Project (required) — Use this option to identify the Target, or superproject. 

 Source WBS (optional) — Use this option to identify the WBS data to be exported 
from the Source. 

 Target WBS (required) — Use this option to identify the WBS ID into which the 
data will be imported. 

 Transfer File Name (required) — Enter the name of the file that will contain the 
exported data. All data in the transfer file will constitute one record. The transfer file 
name will be specified during the Distributed Data import process. 

 Export and Import Conversion Codes  — Use these options to specify currency 
conversion codes. Currency conversion codes are specified in Resources and 
Burdens under the Globals tab. For details, see topic 18.2 Consolidating Distributed 
Projects. Please note that the Baseline Rate Table is used for Baseline, ETC and 
Actuals. 

Format File Options 
The fields in Distributed Projects exports are fixed, and cannot be defined by the user. 
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17.10.6  EOC Rollups Exports 
You use the EOC Rollups window to export EOC Rollup data. Access the EOC Rollups 
Export Conditioning window by selecting EOC Rollups on the Exports tab. MPM displays 
the EOC Rollups Export Conditioning window shown in Figure A. 

 
Figure A. To export EOC Rollups, select EOC Rollups 
on the Exports tab. 

Conditioning Options 
When exporting EOC Rollups, all data conditioning options described in topic 17.5  Project 
Export Conditioning Options are available to condition the data being exported. In addition, 
you can specify the following options: 

Elements of Cost to Include 
Use this option to select the elements of cost you want included 
in the export. You can choose from the following:  
L – Labor, M – Material, O – Other Direct Costs, and S -  
Subcontractor 

Display Percentages (optional) 
Use this output option to choose whether to export percentages as decimal values (.5050) or 
as a percent (50.50). 
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Format File Options 
You must create a custom format file using the fields listed below. For information on 
creating custom format files, see topic 17.7.1  Creating Format Files.  
EOC Rollups Fields  WBS Fields 

EOC Code ETC - Standard Hours WBS (ID)  
Month/Year (YYYYMM) ETC - Hours/Units Parent WBS  
BCWS - Standard Hours ETC - Prime Alias 
BCWS - Hours/Units ETC - Overhead WBS Description 
BCWS - Prime ETC - Total Burdened Manager 
BCWS - Overhead ETC - Gen and Admin Xref-1 
BCWS - Total Burdened ETC - Total Cost Xref-2 
BCWS - General and Administration ETC - Cost  of Money Xref-3 
BCWS - Total Cost ETC - Total Dollars Xref-4 
BCWS - Cost  of Money ETC - Fee Xref-5 
BCWS - Total Dollars ETC - Total Price Xref-6 
BCWS - Fee  Xref-7 
BCWS - Total Price  Xref-8 
BCWP - Standard Hours  Xref-9 
BCWP - Hours/Units  Xref-10 
BCWP - Prime  Performing Department 
BCWP - Overhead  Responsible Department 
BCWP - Total Burdened  Charge Number 
BCWP - General and Administration  Element Type 
BCWP - Total Cost  Baseline Start 
BCWP - Cost  of Money  Baseline Complete 
BCWP - Total Dollars  ETC Start 
ACWP - Standard Hours  ETC Finish 
ACWP - Hours/Units  Early Start 
ACWP - Prime  Early Finish 
ACWP - Overhead  Late Start 
ACWP - Total Burdened  Late Finish 
ACWP - General and Administration  Revision Letter Date 
ACWP - Total Cost  Schedule Reference Date 
ACWP - Cost  of Money  Last Statused Date 
ACWP - Total Dollars  Total Float 
ACWP - Fee  EV Percent Complete 
ACWP - Total Price  Recur/NonRecur 
  Fee Percent 
  Fee Limit 
  Earned Value Method 
  BCWP Base Unit 
  CLIN 
  Base WBS 
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17.10.7  EOC Tables Exports 
You use the EOC Tables window to export EOC data. Access the EOC Tables Export 
Conditioning window by selecting EOC Tables on the Exports tab. MPM displays the EOC 
Tables Export Conditioning window shown in Figure A. 

 
Figure A. To export EOC Tables, select EOC Tables on the Exports tab. 
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Conditioning Options 
When exporting EOC Tables, all data conditioning options described in topic 17.4  Global 
Export Conditioning are available to condition the data being exported. In addition, you can 
specify the following options: 

Element of Cost (optional) 
To select data assigned to a particular EOC, click in the Criteria 
box and select from the drop-down list containing all possible 
EOCs. 

Class of Cost (optional) 
To select data assigned to a particular EOC class code, click in 
the Criteria box and select from the drop-down list containing all 
possible EOC class codes. 
 

Format File Options 
The fields in EOC Tables exports are fixed, and cannot be defined by the user. 
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17.10.8  Estimates by WBS Exports 
You use the Estimates by WBS window to export Estimate data. Access the Estimates by 
WBS Export Conditioning window by selecting Estimates by WBS on the Exports tab. 
MPM displays the Estimates by WBS Export Conditioning window shown in Figure A. 

 
Figure A. To export Estimates, select Estimates by WBS on 
the Exports tab. 

Conditioning Options 
When exporting estimates, all data conditioning options described in topic 17.5  Project 
Export Conditioning Options are available to condition the data being exported. In addition, 
you can specify the following options: 

 Resource Code, Resource Department, XREF-EST, EOC, COC (optional) — To 
select estimate data to be exported using any of these fields, click in the Criteria box 
and select from the drop-down list containing all possible values. 

 Data Type (required) — To export baseline estimates, select Baseline in this list 
box.  

 Display Percentages (optional) — Use this output option to choose whether to 
export percentages as decimal values (.5050) or as a percent (50.50). 
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To export ETC estimates, select ETC in this list box. 
 

Format File Options 
You can use the standard ESTIMATES.FMT format file or create a custom file using the 
fields listed below. For information on creating custom format files, see topic 17.7.1  
Creating Format Files.  

Estimates Fields  WBS Fields 

Resource WBS (ID) ETC Start 
Responsible Department Parent WBS  ETC Finish 
XREF-EST  Alias Early Start 
Overtime WBS Description Early Finish 
Rate Table Manager Late Start 
Burden Template Xref-1 Late Finish 
Estimate Start  Xref-2 Revision Letter Date 
Estimate Complete  Xref-3 Schedule Reference Date 
Estimate Type Xref-4 Last Statused Date 
Spread Curve Xref-5 Total Float 
Spread Amount Xref-6 EV Percent Complete 
Efficiency Xref-7 Recur/NonRecur 
Scrap and Rework Xref-8 Fee Percent 
Period Xref-9 Fee Limit 
Standard Hours Xref-10 Earned Value Method 
Hours/Units Performing Department BCWP Base Unit 
EQP (Equiv. Person Hrs.) Responsible Department CLIN 
Prime  Charge Number Base WBS 
Overhead Element Type  
Total Burdened Baseline Start  
Gen and Admin Baseline Complete  
Total Cost   
Cost of Money   
Total Dollars   
Fee   
Total Price   
Estimate Type Value   
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17.10.9  Fiscal Calendars Exports 
You use the Fiscal Calendars window to export fiscal calendars. Access the Fiscal Calendars 
Export Conditioning window by selecting Fiscal Calendars on the Exports tab. MPM displays 
the Fiscal Calendars Export Conditioning window shown in Figure A. 

 
Figure A. To export Fiscal Calendars, select Fiscal Calendars on the 
Exports tab. 

Conditioning Options 
When exporting Fiscal Calendars, all data conditioning options described in topic 17.4  
Global Export Conditioning are available to condition the data being exported.  

Format File Options 
The fields in Fiscal Calendar exports are fixed and cannot be defined by the user. 
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17.10  Conditioning Options for Specific Exports 

17.10.10  Holiday Calendars Exports 
You use the Holiday Calendars window to export holiday calendars. Access the Holiday 
Calendars Export Conditioning window by selecting Holiday Calendars on the Exports tab. 
MPM displays the Holiday Calendars Export Conditioning window shown in Figure A. 

 
Figure A. To export Holiday Calendars, select Holiday Calendars 
on the Exports tab. 

Conditioning Options 
When exporting Holiday Calendars, all data conditioning options described in topic 17.4  
Global Export Conditioning are available to condition the data being exported.  

Format File Options 
The fields in Holiday Calendar exports are fixed, and cannot be defined by the user. 
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17.10.11  Milestones Exports 
You use the Milestones window to export milestones data. Access the Milestones Export 
Conditioning window by selecting Milestones on the Exports tab. MPM displays the 
Milestones Export Conditioning window shown in Figure A. 

 
Figure A. To export Milestones, select Milestones on the Exports tab. 

Conditioning Options 
When exporting milestones, all data conditioning options described in topic 17.5  Project 
Export Conditioning Options are available to condition the data being exported. In addition, 
you can specify the following options: 

Display Percentages (optional) 
Use this output option to choose whether to export percentages as decimal values (.5050) or 
as a percent (50.50). 
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Format File Options 
You can use the standard MILESTON.FMT format file or create a custom file using the 
fields listed below. For information on creating custom format files, see topic 17.7.1  
Creating Format Files.  

Milestone Fields  WBS Fields 

Milestone ID WBS (ID) ETC Start
Milestone Symbol  Parent WBS  ETC Finish
Milestone Description Alias Early Start
Weight WBS Description Early Finish 
Schedule Date Manager Late Start
Forecast Date Xref-1 Late Finish
Complete Y/N Xref-2 Revision Letter Date 
Milestone Weight Percent Complete Xref-3 Schedule Reference Date 
 Xref-4 Last Statused Date 
 Xref-5 Total Float
 Xref-6 EV Percent Complete 
 Xref-7 Recur/NonRecur 
 Xref-8 Fee Percent 
 Xref-9 Fee Limit
 Xref-10 Earned Value Method 
 Performing Department BCWP Base Unit 
 Responsible Department CLIN
 Charge Number Base WBS
 Element Type  
 Baseline Start  
 Baseline Complete  
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17.10.12  Resources & Burdens Exports 
Use the Resource and Burdens export window to export resource and burden rate 
information. To access the Resource and Burdens Export window, select Resources & 
Burdens on the Exports tab in Menu Manager. MPM displays the Resources & Burdens 
Export Conditioning window shown in Figure A. 

 
Figure A. To export Resources & Burdens, select Resources & Burdens on the 
Exports tab. 

Conditioning Options 
When exporting resources and burdens, all data conditioning options described in topic 17.4  
Global Export Conditioning Options are available. In addition, you can specify resource 
options and export options. 

Resource Options 
The Resource Options include: Resource Code, Resource Department, EOC, COC, Rate 
Table (optional). To assign a value to any of these options, click in the Criteria box and 
select from the drop-down list containing all possible values. 
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Export Options 
There are two export options: Include Header and Data Type. You must use these in the 
correct combination to create a valid export file. 

You can assign one of three values to the Data Type option: Descriptive Records Only, Rate 
Records Only, or Both. 

If you choose Descriptive Records Only or Rate Records Only, you can include header data 
if you wish.  
If you choose Both (descriptive and rate records), you must not include header data. If you 
include header data, the rate records will be formatted with an incorrect number of fields, 
and you will not be able to import the file back into MPM. 
The table below summarized the valid export options. 

 Include Header 
Data Type On Off 
Descriptive Records Only   

Rate Records Only   

Both (descriptive and rate records)   

Table A. Valid Date Type and Include Header combinations 

Format File Options 
The fields in Resources and Burdens exports are fixed and cannot be defined by the user. 

 



MPM Projects   587 

17.10  Conditioning Options for Specific Exports 

17.10.13  Task Descriptions and Basis of Estimates 
Exports 

You use the TD/BOE window to export WBS Task Descriptions (TDs) and Basis of 
Estimates (BOEs). Access the TD/BOE Export Conditioning window by selecting TD/BOE 
on the Exports tab. MPM displays the TD/BOE Export Conditioning window shown in 
Figure A. 

 
Figure A. To export Task Descriptions, select TD/BOE on the 
Exports tab. 
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Conditioning Options 
When exporting Task Descriptions, all data conditioning options described in topic 17.4  
Global Export Conditioning are available to condition the data being exported. In addition, 
you can specify the following options: 

Export Type (required) 
To export Task Descriptions, select Task Descriptions in this list box. 
To export Basis of Estimates, select Basis of Estimate in this list box. 
Basis of Estimates By (required if exporting Basis of Estimates) 
To export Resource BOEs, select Resource in this list box. 
To export Summary BOEs, select Summary in this list box. 
To export both types of BOEs, select Both in this list box. 
 

Format File Options 
The fields in Task Descriptions and BOE exports are fixed and cannot be defined by the 
user. 

 



MPM Projects   589 

17.10  Conditioning Options for Specific Exports 

17.10.14  WBS Data Exports 
You use the WBS window to export WBS data. Access the WBS Export Conditioning 
window by selecting WBS on the Exports tab. MPM displays the WBS Export Conditioning 
window shown in Figure A. 

 
Figure A. To export WBS, select WBS on the Exports tab. 

Conditioning Options 
When exporting WBS data, all data conditioning options described in topic 17.5  Project 
Export Conditioning Options are available to condition the data being exported. In addition, 
you can specify the following options: 

Display Percentages (optional) 
Use this output option to choose whether to export percentages as decimal values (.5050) or 
as a percent (50.50). 
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Format File Options 
When creating a format file for exporting WBS data, the following fields are available: 

 WBS Fields 

WBS (ID)  ETC Start 
Parent WBS  ETC Finish 
Alias Early Start 
WBS Description Early Finish 
Manager Late Start 
Xref-1 Late Finish 
Xref-2 Revision Letter Date 
Xref-3 Schedule Reference Date 
Xref-4 Last Statused Date 
Xref-5 Total Float 
Xref-6 EV Percent Complete 
Xref-7 Recur/NonRecur 
Xref-8 Fee Percent 
Xref-9 Fee Limit 
Xref-10 Earned Value Method 
Performing Department BCWP Base Unit 
Responsible Department CLIN 
Charge Number Base WBS 
Element Type WBS Thresholds 
Baseline Start WNSTInt 
Baseline Complete  
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17.10.15 Weekly Data Exports 
You use the Weekly Data window to export weekly data.  Access the Weekly Export 
Conditioning window by selecting Weekly Data on the Exports tab.  MPM displays the 
Weekly Data Export Conditioning Window shown in Figure A. 

 

 

Figure A.  To export weekly data, select Weekly Data on the Exports tab. 

Conditioning Options 
When exporting weekly data, all data conditioning options described in topic 17.5 Project 
Export Conditioning Options are available to condition the data being exported.  In addition, 
you can specify the following options: 
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Export Type (Required) 
Use this option to specify either weekly WBS data or weekly EOC data for export. 
Report From (Week Start) (Required) 
Select the week start for the week you want to export from the list box.  The dates in the list 
box begin with the first week of the three month window. Note that the “=<Current>” 
formula is not supported on weekly reports and exports. 
Report Through (Week End) (Required) 
Select the week end for the week you want to export from the list box.  The dates in the list 
box begin with the end of first week of the three month window. Note that the “=<Current>” 
formula is not supported on weekly reports and exports. 
Elements of Cost to Include (Required if exporting by EOC) 
This option is offered only if you are exporting by EOC and is used to select which EOCs to 
include in the export.   
LRE Option  
Use this option if you want to include the latest revised estimate in the weekly data being 
exported.  You may select either Cum ACWP + ETC or Cum ACWP through Gate Month + 
ETC.  
Gate Month 
The gate month defaults to the current month. 
Display Percentages (Optional) 
Use this output option to choose whether to export percentages as decimal values (.5050) or 
as a percent (50.50). 
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Format File Options 
When exporting weekly data, you can use the standard format files or create a custom format 
file.   

The standard format files, WEEKWBS.FMT and WEEKEOC.FMT, include the following 
fields: 

WEEKWBS.FMT WEEKEOC.FMT 

WBS WBS 
Week End Week End 
BCWS Total Dollars WKLY Element of Cost 
BCWP Total Dollars WKLY BCWS Total Dollars WKLY 
ACWP Total Dollars WKLY BCWP Total Dollars WKLY 
ETC Total Dollars WKLY ACWP Total Dollars WKLY 
 ETC Total Dollars WKLY 

 

You can create a custom file using the fields listed below. You may export up to a maximum 
of 250 fields in one batch. For information about creating custom files, see topic 17.7.1 
Creating Format Files. 

WBS Fields 
Alias Fee Percent WBS Description 
Base WBS Last Statused Date WBS Percent Complete 
Baseline Complete Late Finish XREF-1 
Baseline Start Late Start XREF-2 
BCWP Base Unit Manager XREF-3 
Charge Number Parent WBS XREF-4 
CLIN Performing Dept XREF-5 
Early Finish Recur/NonRecur XREF-6 
Early Start Responsible Dept XREF-7 
Earned Value Method Revision Letter Date XREF-8 
Element Type  Schedule Reference Date XREF-9 
ETC Complete Responsible Dept XREF-10 
ETC Start Total Float  
Fee Limit WBS  
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Weekly Data Fields 
ACWP Cost of Money CUM BAC Cost of Money BCWP Cost of Money CUM 
ACWP Cost of Money MTD BAC EQP BCWP Cost of Money MTD 
ACWP Cost of Money WKLY BAC Fee BCWP Cost of Money WKLY 
ACWP EQP CUM BAC Gen and Admin BCWP EQP CUM 
ACWP EQP MTD BAC Hours/Units BCWP EQP MTD 
ACWP EQP WKLY BAC Overhead BCWP EQP WKLY 
ACWP Fee CUM BAC Prime BCWP Gen and Admin CUM 
ACWP Fee MTD BAC Standard Hours BCWP Gen and Admin MTD 
ACWP Fee WKLY BAC Total Burdened BCWP Gen and Admin WKLY 
ACWP Gen and Admin CUM BAC Total Cost BCWP Hours/Units CUM 
ACWP Gen and Admin MTD BAC Total Dollars BCWP Hours/Units MTD 
ACWP Gen and Admin WKLY BAC Total Price BCWP Hours/Units WKLY 
ACWP Hours/Units CUM  BCWP Overhead CUM 
ACWP Hours/Units MTD  BCWP Overhead MTD 
ACWP Hours/Units WKLY  BCWP Overhead WKLY 
ACWP Overhead CUM  BCWP Prime CUM 
ACWP Overhead MTD  BCWP Prime MTD 
ACWP Overhead WKLY  BCWP Prime WKLY 
ACWP Prime CUM  BCWP Standard Hours CUM 
ACWP Prime MTD  BCWP Standard Hours MTD 
ACWP Prime WKLY   BCWP Standard Hours WKLY 
ACWP Standard Hours CUM  BCWP Total Burdened CUM 
ACWP Standard Hours MTD  BCWP Total Burdened MTD 
ACWP Standard Hours WKLY  BCWP Total Burdened WKLY 
ACWP Total Burdened CUM  BCWP Total Cost CUM 
ACWP Total Burdened MTD  BCWP Total Cost MTD 
ACWP Total Burdened WKLY  BCWP Total Cost WKLY 
ACWP Total Cost CUM  BCWP Total Dollars CUM 
ACWP Total Cost MTD  BCWP Total Dollars MTD 
ACWP Total Cost WKLY  BCWP Total Dollars WKLY 
ACWP Total Dollars CUM  BCWP Total Price CUM 
ACWP Total Dollars MTD  BCWP Total Price MTD 
ACWP Total Dollars WKLY  BCWP Total Price WKLY 
ACWP Total Price CUM   
ACWP Total Price MTD   
ACWP Total Price WKLY   
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Weekly Data Fields, Continued 
BCWS Cost of Money CUM BV (S-A) Cost of Money CUM CPI Cost of Money CUM 
BCWS Cost of Money MTD BV (S-A) Cost of Money MTD CPI Cost of Money MTD 
BCWS Cost of Money WKLY BV (S-A) Cost of Money WKLY CPI Cost of Money WKLY 
BCWS EQP CUM BV (S-A) EQP CUM CPI EQP CUM 
BCWS EQP MTD BV (S-A) EQP MTD CPI EQP MTD 
BCWS EQP WKLY BV (S-A) EQP WKLY CPI EQP WKLY 
BCWS Fee CUM BV (S-A) Fee CUM CPI Gen and Admin CUM 
BCWS Fee MTD BV (S-A) Fee MTD CPI Gen and Admin MTD 
BCWS Fee WKLY BV (S-A) Fee WKLY CPI Gen and Admin WKLY 
BCWS Gen and Admin CUM BV (S-A) Gen and Admin CUM CPI Hours/Units CUM 
BCWS Gen and Admin MTD BV (S-A) Gen and Admin MTD CPI Hours/Units MTD 
BCWS Gen and Admin WKLY BV (S-A) Gen and Admin WKLY CPI Hours/Units WKLY 
BCWS Hours/Units CUM BV (S-A) Hours/Units CUM CPI Overhead CUM 
BCWS Hours/Units MTD BV (S-A) Hours/Units MTD CPI Overhead MTD 
BCWS Hours/Units WKLY BV (S-A) Hours/Units WKLY CPI Overhead WKLY 
BCWS Overhead CUM BV (S-A) Overhead CUM CPI Prime CUM 
BCWS Overhead MTD BV (S-A) Overhead MTD CPI Prime MTD 
BCWS Overhead WKLY BV (S-A) Overhead WKLY CPI Prime WKLY 
BCWS Prime CUM BV (S-A) Prime CUM CPI Standard Hours CUM 
BCWS Prime MTD BV (S-A) Prime MTD CPI Standard Hours MTD 
BCWS Prime WKLY BV (S-A) Prime WKLY CPI Standard Hours WKLY 
BCWS Standard Hours CUM BV (S-A) Standard Hours CUM CPI Total Burdened CUM 
BCWS Standard Hours MTD BV (S-A) Standard Hours MTD CPI Total Burdened MTD 
BCWS Standard Hours WKLY BV (S-A) Standard Hours WKLY CPI Total Burdened WKLY 
BCWS Total Burdened CUM BV (S-A) Total Burdened CUM CPI Total Cost CUM 
BCWS Total Burdened MTD BV (S-A) Total Burdened MTD CPI Total Cost MTD 
BCWS Total Burdened WKLY BV (S-A) Total Burdened WKLY CPI Total Cost WKLY 
BCWS Total Cost CUM BV (S-A) Total Cost CUM CPI Total Dollars CUM 
BCWS Total Cost MTD BV (S-A) Total Cost MTD CPI Total Dollars MTD 
BCWS Total Cost WKLY BV (S-A) Total Cost WKLY CPI Total Dollars WKLY 
BCWS Total Dollars CUM BV (S-A) Total Dollars CUM CPI Total Price CUM 
BCWS Total Dollars MTD BV (S-A) Total Dollars MTD CPI Total Price MTD 
BCWS Total Dollars WKLY BV (S-A) Total Dollars WKLY CPI Total Price WKLY 
BCWS Total Price CUM BV (S-A) Total Price CUM  
BCWS Total Price MTD BV (S-A) Total Price MTD  
BCWS Total Price WKLY BV (S-A) Total Price WKLY  
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Weekly Data Fields, Continued 
CV (P-A) Cost of Money CUM EAC Cost of Money ETC Cost of Money CUM 
CV (P-A) Cost of Money MTD EAC EQP ETC Cost of Money MTD 
CV (P-A) Cost of Money WKLY EAC Fee ETC Cost of Money WKLY 
CV (P-A) EQP CUM EAC Gen and Admin ETC EQP CUM 
CV (P-A) EQP MTD EAC Hours/Units ETC EQP MTD 
CV (P-A) EQP WKLY EAC Overhead ETC EQP WKLY 
CV (P-A) Gen and Admin CUM EAC Prime ETC Fee CUM 
CV (P-A) Gen and Admin MTD EAC Standard Hours ETC Fee MTD 
CV (P-A) Gen and Admin WKLY EAC Total Burdened ETC Fee WKLY 
CV (P-A) Hours/Units CUM EAC Total Cost ETC Gen and Admin CUM 
CV (P-A) Hours/Units MTD EAC Total Dollars ETC Gen and Admin MTD 
CV (P-A) Hours/Units WKLY EAC Total Price ETC Gen and Admin WKLY 
CV (P-A) Overhead CUM  ETC Hours/Units CUM 
CV (P-A) Overhead MTD  ETC Hours/Units MTD 
CV (P-A) Overhead WKLY  ETC Hours/Units WKLY 
CV (P-A) Prime CUM  ETC Overhead CUM 
CV (P-A) Prime MTD  ETC Overhead MTD 
CV (P-A) Prime WKLY  ETC Overhead WKLY 
CV (P-A) Standard Hours CUM  ETC Prime CUM 
CV (P-A) Standard Hours MTD  ETC Prime MTD 
CV (P-A) Standard Hours WKLY  ETC Prime WKLY 
CV (P-A) Total Burdened CUM  ETC Standard Hours CUM 
CV (P-A) Total Burdened MTD  ETC Standard Hours MTD 
CV (P-A) Total Burdened WKLY  ETC Standard Hours WKLY 
CV (P-A) Total Cost CUM  ETC Total Burdened CUM 
CV (P-A) Total Cost MTD  ETC Total Burdened MTD 
CV (P-A) Total Cost WKLY  ETC Total Burdened WKLY 
CV (P-A) Total Dollars CUM  ETC Total Cost CUM 
CV (P-A) Total Dollars MTD  ETC Total Cost MTD 
CV (P-A) Total Dollars WKLY  ETC Total Cost WKLY 
CV (P-A) Total Price CUM  ETC Total Dollars CUM 
CV (P-A) Total Price MTD  ETC Total Dollars MTD 
CV (P-A) Total Price WKLY  ETC Total Dollars WKLY 
  ETC Total Price CUM 
  ETC Total Price MTD 
  ETC Total Price WKLY 
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Weekly Data Fields, Continued 
SPI Cost of Money CUM SV (P-S) Cost of Money CUM TCPI Cost of Money 
SPI Cost of Money MTD SV (P-S) Cost of Money MTD TCPI EQP 
SPI Cost of Money WKLY SV (P-S) Cost of Money WKLY TCPI Fee 
SPI EQP CUM SV (P-S) EQP CUM TCPI Gen and Admin 
SPI EQP MTD SV (P-S) EQP MTD TCPI Hours/Units 
SPI EQP WKLY SV (P-S) EQP WKLY TCPI Overhead 
SPI Gen and Admin CUM SV (P-S) Gen and Admin CUM TCPI Prime 
SPI Gen and Admin MTD SV (P-S) Gen and Admin MTD TCPI Standard Hours 
SPI Gen and Admin WKLY SV (P-S) Gen and Admin WKLY TCPI Total Burdened 
SPI Hours/Units CUM SV (P-S) Hours/Units CUM TCPI Total Cost 
SPI Hours/Units MTD SV (P-S) Hours/Units MTD TCPI Total Dollars 
SPI Hours/Units WKLY SV (P-S) Hours/Units WKLY TCPI Total Price 
SPI Overhead CUM SV (P-S) Overhead CUM  
SPI Overhead MTD SV (P-S) Overhead MTD  
SPI Overhead WKLY SV (P-S) Overhead WKLY VAC (BAC-EAC) Cost of 

Money 
SPI Prime CUM SV (P-S) Prime CUM VAC (BAC-EAC) EQP 
SPI Prime MTD SV (P-S) Prime MTD VAC (BAC-EAC) Fee 
SPI Prime WKLY SV (P-S) Prime WKLY VAC (BAC-EAC) Gen and 

Admin 
SPI Standard Hours CUM SV (P-S) Standard Hours CUM VAC (BAC-EAC) Hours/Units 
SPI Standard Hours MTD SV (P-S) Standard Hours MTD VAC (BAC-EAC) Overhead 
SPI Standard Hours WKLY SV (P-S) Standard Hours WKLY VAC (BAC-EAC) Prime 
SPI Total Burdened CUM SV (P-S) Total Burdened CUM VAC (BAC-EAC) Standard 

Hours 
SPI Total Burdened MTD SV (P-S) Total Burdened MTD VAC (BAC-EAC) Total 

Burdened 
SPI Total Burdened WKLY SV (P-S) Total Burdened WKLY VAC (BAC-EAC) Total Cost 
SPI Total Cost CUM SV (P-S) Total Cost CUM VAC (BAC-EAC) Total 

Dollars 
SPI Total Cost MTD SV (P-S) Total Cost MTD VAC (BAC-EAC) Total Price 
SPI Total Cost WKLY SV (P-S) Total Cost WKLY  
SPI Total Dollars CUM SV (P-S) Total Dollars CUM  
SPI Total Dollars MTD SV (P-S) Total Dollars MTD  
SPI Total Dollars WKLY SV (P-S) Total Dollars WKLY  
SPI Total Price CUM SV (P-S) Total Price CUM  
SPI Total Price MTD SV (P-S) Total Price MTD  
SPI Total Price WKLY SV (P-S) Total Price WKLY  
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18.1 Introduction to the MSP Link 

The MSP Link is a powerful interface between Microsoft Office Project (hereafter 

referred to as MSP) and MPM, Micro-Frame Program Manager.  It provides you 

with an easy to use method for linking MSP data into MPM.  This is an integrated 

applet within MPM's main menu, from the Interface tab.  It allows MPM users to 

easily select the MSP file and begin file generation and validation processing. 

  

In MPM, all planning is done at the WBS ID level.  With MSP, you can plan 

activities, milestones, and resource estimates at a lower level than the WBS ID.  

Through use of the built-in interface you can then easily integrate the MSP detail 

data into the WBS level in MPM.  This interface supports both types of integration:  

one task in MSP mapped to one WBS in MPM and also many tasks in MSP mapped 

to one WBS in MPM. 

  

The MSP Link enables you to transfer data from MSP to MPM in the following 

manner: 

 First, you create your project and plan activities, milestone, and resource 

assignments using MSP in the usual way. 

 When your data is set and ready to transfer to MPM, you set up mapping within 

MPM's MSP Interface for all of the types of information you are planning to 

transfer.  Five interface types are available: 

o WBS Description:  This is used to create WBS elements in MPM, by 

mapping WBS type data from MSP into the WBS Tree in MPM. 

o WBS Schedule:  This interface is used to map dates from MSP tasks to 

MPM WBS tasks.  This interface will also allow you to move resource 

estimates in MPM according to the new dates that are brought over from 

MSP.  (This interface cannot be used with the Estimate interface.) 

o Estimates:  This interface is used to map MSP resource assignments and 

bring them in as WBS level estimates in MPM.  You may choose to use 

resource assignments from any of the plans in MSP (i.e. Work, Baseline, 

Baseline 1, etc.). This interface cannot be used with the WBS Schedule 

interface. 

o BCWP: This interface allows you to map earned value percent complete 

status from MSP tasks to MPM tasks 
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o Milestones:  This interface allows you to create MPM milestones from 

milestones and/or tasks in MSP.  You may also update status and revise 

milestone information using this interface. 

 Once the mapping process has been completed, select Generate and Validate; 

select the MSP file and the applicable data conditioning.  MPM will then 

process the data, generate the import file, and create a validation report. 

 Once you have reviewed the validation report and are happy with the results 

on the report, you select the Import option and the generated file will then be 

transferred into MPM. 

When these steps are completed, the MSP data is completely integrated into an MPM 

project. 

Note: Before running the interface, the projects need to be set up in MPM.  

 

Note: Please see the Installation Guide for the list of supported MS Project 
versions.  
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18.2 Accessing the MSP Link 

The MSP Link can be accessed by selecting the Interfaces tab of the MPM Menu 

Manager, then double-clicking on the MSP Link icon (see Figure A).  

 

Figure A.  Select the MSP Link icon on the Interfaces tab of the MPM 
Menu Manager. 
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18.3 Orientation to the MSP Link 

The MSP Link is used to transfer data from MSP into MPM. A toolbar gives you quick 

access to common tasks. The Interface window displays the information about the MSP 

Link.  

 

Figure A. The MSP Link window. 

MSP Link Window 

The left pane of the window displays the icon(s) for the interface, and the right pane 

displays the conditioning information. The right pane is divided into two columns. The 

Filter column shows the interface condition fields to be specified. The Criteria column 

contains the list boxes, check mark boxes, or text entry boxes in which you enter the 

criteria for the condition. The rows are grouped into categories; category headings are 

shown in gray for reference. 

Previewing and Printing 

You can preview and print the conditioning data using the options on the File menu. 

Print and Preview only show the conditioning which you have entered on the grid. They 

do not display the results of running the interface.  
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Saving the Interface Conditioning 

To save the interface conditioning data, do one of the following: 

 Click the Save button . 

 Choose Save from the File menu, or press Ctrl+S. 

MPM prompts for the location and file name to be saved. See section 18.6 Batch 

Processing for details on using saved conditioning. 
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18.3 Orientations to the MSP Link 

18.3.1 Interface Conditioning Options 

These are all of the available fields displayed in the Interface window. The displayed 

fields change depending on the Type field setting (Generate file and validate, Generate 

file, Import). Category headings are shown in gray for easy reference. Fields which are 

required display <Required> in the cell. These fields must be filled.  

Filter Criteria 

Project Selection 

Project Drop down list of projects 

Interface Process 

Type  Generate file and validate 

 Generate file 

 Import 

MS Project File Name <Required> 

MS Project Task Filter Name 51 character data entry field 

Replace Values  All data 

 Changed data only 

Mapping File Name <Required> 

Generated File Name <Required> 

Output Options 

Output Format  Printer 

 Viewer 

 Comma Separated Values (*.CSV) 

 Excel 95 (*.XLS) 

 Excel 97-2000 (*.XLS) 

 Tab Separated Values (*.TXT) 

 HTML (*.HTM) 

Display errors only 
Check mark option  

File Name Selection 

Output File Name <Required> when Output Format set 

to File Type. 

Append to Existing File 
Check mark option  

WBS Descriptive 
Check mark option  

WBS Schedule 
Check mark option  

Time Now Date <Date> Defaults to current date 

Shift Baseline Resources 
Check mark option  
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Shift ETC Resources 
Check mark option  

Shift Milestones - Schedule 

Dates 
Check mark option  

Shift Milestones - Forecast 

Dates 
Check mark option  

EOC Reprice Conditioning  

 L-LABOR  

 M-MATERIAL 

 O-OTHER DIRECT COSTS 

 Hours 

 EQP 

 Prime Dollars 

 Total Burdened 

 Total Cost 

 Total Dollars 

 Total Price 

 Original Estimate Type 

Time-phased Estimates 
Check mark option  

Estimates to Import  Baseline 

 ETC 

 Baseline and ETC 

Autospread Estimates 
Check mark option  

Estimates to Import  Baseline 

 ETC 

 Baseline and ETC 

BCWP 
Check mark option  

Fiscal Status As Of Date <Date> 

Milestones 
Check mark option  

Identify Milestones by  ID 

 Description 

 Symbol/Description/Schedule Date 

Update BCWP Status 
Check mark option  

Fiscal Status As Of Date <Date> 

Project Selection 

 Project - Displays a drop down list of projects that the user has been granted 

access to. It will not display any projects where the ―suspend user‖ has been 

checked in Project Maintenance. It defaults to the first project in the list if there 

is no previously selected project. 
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Interface Processes 

 Type 

 Generate file and validate: This process first analyzes the data coming from 

MSP to see if it is valid prior to processing. It creates a generated file that 

contains project data to be imported. It also creates a validation report listing all 

warnings and errors based on comparing MPM data to the generated file. See 

section 18.5.1 Generate File and Validate, Generate File for further details. 

 Generate file: This process creates a generated file that contains project data to 

be imported. See section 18.5.1 Generate File and Validate, Generate File for 

further details. 

 Import: This process imports the data from the generated file into MPM and 

generates a processing report listing all warnings and errors. See section 18.5.2 

Import for further details. 

 MS Project File Name - This is a required field when Type field is set to either 

Generate file and validate or Generate file. Click on the Browse button  to 

find the mpp file that you wish to use. This field is not available when Type field 

is set to Import as the interface process uses the generated file. 

 MS Project Task Filter Name - Use this optional field to enter the name of an 

MSP task filter. When a task filter is used, MPM will apply that filter to the MSP 

file prior to the interface process starting. Only that subset of data will be looked 

at and used by the interface process. Valid filters from MSP are those that can be 

found under Project\Filtered For\More Filters with Task selected. This filter list 

is also available in the MSP Organizer under the Filter Tab. This option may 

only be used for task filters. This field is not available when Type field is set to 

Import as the interface process uses the generated file. 

 Replace Values - This field is not available when Type field is set to Import. 

 All data: This selection will update all mapped field data between MSP and 

MPM. 

 Changed data only: This selection will update data in any mapped field that has 

changed between MSP and MPM. With this selection, only the changed data is 

written to the generated file. Any validation will only be run on the changed data 

fields. 
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 Mapping File Name - This is a required field when Type field is set to either 

Generate file and validate or Generate file. Select the Browse button  to 

access a previously saved mapping file. Select the Mappings button  to create 

a new mapping file. See section 18.4 MSP Link Mappings for further information 

on mapping. This field is not available when Type field is set to Import as the 

interface process uses the generated file. 

 Generated File Name - This is a required field. The file type is .gen. It is the 

input file when Type field is set to Import and the output file when Type field is 

set to Generate file and validate or Generate file. Select the Browse button  to 

find and overwrite an existing file, or create a new filename. 

Output Options 

 Output Format - This option is applicable to the validation report when the 

Type field is set to Generate file and validate, and to the processing report when 

the Type field is set to Import. When the drop down arrow is selected, there is 

the option to select a printer, viewer, or a file type. This option is not available 

when the Type field is set to Generate file. 

 Display errors only - This option is only applicable when the Type field is set to 

generate file and validate. When this field is checked, the validation report 

displays only error messages and does not display any warning messages. 

File Name Selection 

 Output File Name - This is a required field when the Output Format is set to 

any other option other than the Viewer or Printer. Select the Browse button  to 

find and overwrite an existing file, or create a new filename. 

 Append to Existing File - This option is enabled when the Output option is set 

to any other option other than Viewer or Printer. This field is only applicable to 

batch processing when it appends the validation reports or the processing reports 

together. See section 18.6 Batch Processing for further details. 
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WBS Descriptive 

Use the WBS Descriptive option to create new WBS elements or update or build onto an 

existing WBS leg by importing new WBS elements. WBS elements created by the interface 

will have Start and Complete dates which default to their parent dates. This interface cannot 

be used to change a parent ID for an existing child. 

If your WBS is currently empty, all of the mapped fields are added to the generated file. If a 

WBS ID already exists in your WBS, all mapped fields except for the parent WBS ID will be 

updated. Any existing fields not included in the import will not be changed.  

Any Fee Limit Amount values imported are assigned to the specific WBS element; however, 

those fields in children of the specified WBS are not modified.   

CLIN, Recurring/Nonrecurring and/or Fee % values imported are assigned to the specific 

WBS element and all of its children. 

WBS Schedule 

These fields are only available if the WBS Schedule row is checked, if the Type field is set 

to Import, and if Estimates is de-selected. The WBS Schedule enables you to: 

 Summarize tasks or activities by assigning them to the same WBS ID. 

 Create a many-to-one relationship between networked activities and a WBS ID. 

When a many-to-one correspondence exists, the WBS Schedule Interface looks at all 

the networked activities. It finds the earliest early and late start and the latest early 

and late finish. 

Use the WBS Schedule option to update Baseline, ETC, Early and Late dates, depending on 

what fields are mapped. 

 Time Now Date - Specifies the point in time where updating dates and shifting 

resources begins. If dates are being updated for WBS elements with no estimates (no 

shift required), only those WBS elements that start after Time Now are updated. If 

dates are being updated for WBS elements with estimates and resources are also 

being shifted, only those estimates that start after Time Now are shifted. If this field 

is left blank, then all dates are updated. 

Note: MPM will not update WBS elements which have already started, or if 
they contain Actuals or BCWP data. 

 Shift Baseline Resources - If a WBS element contains Baseline estimates, click the 

Shift Baseline Resources check mark box to shift baseline resource estimates from 
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their planned start to the new start date. Because the completion of a WBS element is 

determined by the length of its estimates, only the start date will be set equal to the 

imported/early/late start date; the duration of the estimate will be maintained 

 Shift ETC Resources - If a WBS element contains ETC estimates, click the Shift 

ETC Resources check mark box to shift ETC resource estimates from their planned 

start to the new start date. Because the completion of a WBS element is determined 

by the length of its estimates, only the start date will be set equal to the 

imported/early/late start date; the duration of the estimate will be maintained 

 Shift Milestones-Schedule Dates - This option is only available if you selected 

Shift Baseline or ETC Resources. 

o If you select Shift Baseline Resources and Shift Milestones, the milestone 

dates are shifted the same number of days that the baseline has been shifted. 

o If you select Shift ETC Resources and Shift Milestones, the milestone dates 

are shifted the same number of days that the ETC has been shifted. 

o If you select both Shift Baseline and ETC Resources and Shift Milestones, 

the milestone dates are shifted the same number of days that the baseline has 

been shifted. 

 Shift Milestones-Forecast Dates - This option is only available if you selected Shift 

Baseline or ETC Resources. 

o If you select Shift Baseline Resources and Shift Milestones, the milestone 

dates are shifted the same number of days that the baseline has been shifted. 

o If you select Shift ETC Resources and Shift Milestones, the milestone dates 

are shifted the same number of days that the ETC has been shifted. 

o If you select both Shift Baseline and ETC Resources and Shift Milestones, 

the milestone dates are shifted the same number of days that the baseline has 

been shifted. 

 EOC Reprice Conditioning - This option is only available if you selected Shift 

Baseline or ETC Resources. If you elect to shift resources, MPM must reprice after it 

shifts the estimates. All EOC‘s stored in the EOC table are displayed. For each EOC, 

one of the following values must be maintained for repricing: Hours, EQP, Prime 

Dollars, Total Burdened, Total Cost, Total Dollars, Total Price and Original 

Estimate Type. The value that you enter for each EOC is held constant by MPM.  
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Estimates 

These options can only be selected if WBS Schedule is de-selected. This interface allows 

you to import monthly and/or autospread estimate values into MPM. This interface allows 

you to: 

 Summarize all tasks where the WBS ID, Resource Code, Resource Department and 

Overtime fields are the same to one estimate. 

 Do resource loading in MSP and establish estimates in MPM. 

 Enter a total estimate value per task in MSP and have MPM spread the value for you 

over a specified start and finish date. 

 Estimate Summarization — If WBS ID, Resource Name, Resource Department and 

Overtime are the same then we add resource assignments together . If any one of 

these four fields are unique then it is a treated as a new estimate. 

A task in MSP needs to have a Resource assigned to it in order for it to be added to 
the generated import file. 

 Time-phased Estimates - this option is used when you have a resource loaded 

schedule and have made resource assignments on your MSP tasks.  It allows you to 

duplicate the time-phasing of your resource spreads from MSP schedule to MPM. 

o The MSP Link process will pull the resource assignment detailed data (from the 

.mpp file), accumulate it into the right fiscal bucket (according to the calendar in 

MPM), and generate the import file. 

o If this option is selected then the WBS Schedule option will be disabled. 

o Replace Values is always complete. (updates and adds only). 

 Autospread Estimates - this option is used when you have scheduled tasks that have 

a lump sum value and resource assigned to them.  The lump sum can be mapped to 

MPM as the estimate value with a spread curve.  MPM will spread the lump sum 

value according to the task start and complete dates and spread curve that are 

mapped. 

Autospread Estimate Data Summarization 

o If there are several same WBS IDs with the same Resource Code, Resource 

Dept, Overtime field combinations and if the estimate type is all one type, then 

the lump sum value is added. 
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o If summarization has different estimate types, then no records will be produced.  

It will be reported on the validation report. 

o If summarization has different spread curves then the spread curve identified on 

the first existence is used. 

o If summarization has different dates, then the earliest start date and the latest 

completion date from the set of tasks become the estimate start and complete. 

o If the autospread value is at the task level then there can only be one resource.  If 

there is more than one resource, then everything is put onto the first resource.  

This is then noted in the Validation Report. 

BCWP 

This interface allows you to export BCWP (earned value percentage complete) from MSP 

tasks into MPM. 

 Fiscal Status As Of Date - This row is not available when Type field is set to 

Import. Enter the date for the fiscal month for which BCWP is to be statused. 

We suggest that you do not mix Work with Material budgets for the purpose of this 
calculation, i.e.: the tasks are either all Work or all Material but not a mixture of both. 

MSP Link BCWP Summarization 

Summarize all tasks where the WBS ID is the same and the EV% Complete Task Flag exists.  

 The Cumulative Percent Complete will be calculated based on the mapped Task 

BAC of all summarized tasks. If WBS Schedule or Estimates is imported with 

BCWP, then %Complete cannot be calculated because BAC may have changed.  

 The Cumulative BCWP Amount will be the total from all summarized tasks. 

Milestones 

Use the Milestones option to import new milestones for a WBS element or update existing 

milestones. The Milestones fields are only available if the Milestones row is checked. These 

fields allow you to: 

 Set up networked activities and determine which completion points are milestones 

when establishing the project baseline. 

 Establish a direct correlation between scheduled events and milestones. 

 Interface milestones to the WBS ID in MPM. 
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 Status activities in MSP to determine milestone progress in MPM. 

 Interface completed MSP milestones as milestone status in MPM. 

 

Note:  

 We can only auto-weight Milestones if the budget exists at the same level as the 

‗Milestone‘ tasks. 

 If Milestone Weight is mapped to a task work field, then the BCWP Base Unit 

should be set to Hours for labor tasks and Prime for non-labor tasks in order for the 

weight to be calculated. 

 If mapping Milestone weights to a user-defined field, we suggest entering Hours for 

labor tasks and Prime for non-labor tasks in order for the milestone to be weighted 

correctly. 

The Milestones option uses the Task Identifier (Milestone Flag) Field to find all tasks that 

are identified as milestones. Earned value methods can be established in MPM on a WBS ID 

prior to importing tasks identified as milestones in MSP. If you are importing WBS 

Descriptive with Milestones, you can establish the EVM in the WBS in MSP by mapping 

EVM in the WBS Descriptive Import. 

 Identify Milestones by -. This option determines the method for matching the 

milestones in the interface generated file (or with MSP if the process type is 

Generate.) with the milestones in your MPM project. Matching during Generate is 

done when checking if the data has been changed. There are three methods to choose 

from: 

 ID: This method matches milestones by their Milestone ID. The first milestone 

encountered in the project with the same ID as the ID in MSP is updated to the 

generated file for import. If that exact Milestone ID is not found, the data is added as 

a new milestone. If the interface generated file includes a WBS ID with a Milestone 

ID that exists on another WBS, the milestone is added to the WBS ID specified in 

the interface generated file and removed from the WBS ID where it previously 

existed. When using this option for matching, the Milestone ID field is a required 

field in the interface generated file.  
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 Description: This method matches milestones by their WBS ID and Milestone 

Description. The first milestone encountered within the WBS ID specified with the 

same description as one found in MSP is updated to the generated file for import. If 

that exact description is not found, the data is added as a new milestone. If the 

Milestone ID is blank or contains a duplicate of an existing Milestone ID, MPM 

generates a new unique ID for the milestone contained in the interface generated file. 

Milestone Description must be mapped if this is selected. 

 Symbol/Description/Schedule Date: This method matches milestones by their 

WBS ID, Symbol, Milestone Description and Schedule Date. The first milestone 

encountered within the given WBS with the same symbol, description and schedule 

date is added to the interface generated file for import. If that exact combination of 

symbol, description and schedule date is not found, the data will be added as a new 

milestone. If the Milestone ID is blank or contains a duplicate of an existing 

Milestone ID, MPM generates a new unique ID for the milestone contained in the 

interface generated file. Milestone Symbol, Description and Scheduled Date must be 

mapped if this is selected. 

 Update BCWP Status –  To update BCWP status (recalculate percent complete) 

place a check mark in the Update BCWP Status field. MPM will re-evaluate the 

status of all the milestones on the WBS element and calculate a new cumulative 

percent complete to be stored in the designated fiscal As Of Date field for the WBS. 

Statused milestones are put into the Milestone Status section of the generated file 

and future milestones are put into the Milestones section. If the Update BCWP 

Status field is not checked, the new milestone status will be imported but BCWP will 

not reflect the new status. These milestones are put into the Milestones section of the 

generated file. 

 Fiscal Status As Of Date -  If you elected to update BCWP status, enter the date for 

the fiscal month for which BCWP is to be statused. If you elected not to update 

BCWP status, this field is ignored. 
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18.4  MSP Link Mappings 

The mapping process is used to designate which MSP fields are assigned to each of the 

MPM fields displayed in the MSP Link Mappings dialog box. 

When the interface pulls data from MSP into MPM, all data in the MSP field is 

transferred to the assigned MPM field. 

For example, if you need to pull in scheduled dates, you might map (assign) MSP‘s WBS 

field to the MPM WBS ID field. When you use the interface, all data residing in MSP‘s 

WBS field for the tasks you specify would appear in MPM‘s WBS ID field. 

The mapping definitions that you create can be saved to be used as default mappings for 

future imports as well as for generating files and validation. 

The MSP Link Mappings dialog box is accessed from the Mapping File Name line of the 

Interface window. You can create a new mappings definition or open a previously saved 

mappings definition. 
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18.4  MSP Link Mappings 

18.4.1 Creating a New Mappings Definition 

To create a new Mappings definition: 

1. From the Interface window, select the Mappings  button. 

The MSP Link Mappings dialog opens (See Figure A). 

 

Figure A. Select the Mappings button to open the MSP Link Mappings dialog. 

Mappings 
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2. Map the Available MPM fields to the Available MSP fields. See section 18.4.4 

Mappings Field Descriptions for further field description details.  

3. Select Save to save the mappings configuration. 

The Save Mappings Definition dialog opens (See Figure B). 

 

Figure B. Save your Mappings configuration. 

4. Navigate to the correct folder and type in a file name. You don‘t need to add the  

.FMT extension to the name; MPM adds the extension automatically. 

5. Click Save. 

The file saves and you return to the Interface screen. The Mapping File Name 

field changes from <Required> to the name of the file that you have just saved. 
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18.4  MSP Link Mappings 

18.4.2 Opening a Saved Mappings Definition 

To open a previously saved mappings definition: 

1. From the Interface window, select the Browse button . 

The Mapping File Name dialog opens (See Figure A). 

 

Figure A. Select the Browse button to open a saved Mappings file. 

2. Navigate to the correct folder and select the saved .FMP mappings file.  

3. Click Open to open the saved file. 

The mapping fields populate with the saved definition information and the 

Mapping File Name field changes from <Required> to the name of the file that 

you have just opened. 

Browse 
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18.4  MSP Link Mappings 

18.4.3 Editing a Saved Mappings Definition 

To edit a previously saved mappings definition: 

1. Follow the steps in section 18.4.2 Opening a Saved Mappings Definition to 

open a previously saved mappings file. 

2. Select the Mappings button  to open the MSP Link Mappings dialog (See 

Figure A). 

The MSP Link Mappings window opens populated with the saved mappings file 

data.  

 

Figure A. The MSP Link Mappings window. 

3. Edit fields as needed. 

4. Save the file in one of the following ways: 
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 Select OK to overwrite the existing file. The data is saved and you are returned to the 

Interface Window. 

 Select Save to open the Save Mappings Definition dialog. You can then navigate to 

the correct folder and save under a new file name, or overwrite the existing file. 
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18.4  MSP Link Mappings 

18.4.4 Mappings Field Descriptions 

The MSP Link Mappings dialog contains a grid with two columns: 

 Available MPM Fields - This column consists of all mappable MPM fields. The 

rows in this column are read only. 

 Available MSP Fields – The rows in this column consist of drop down pick lists. 

Each pick list contains the fields that can be mapped to the corresponding MPM 

field. 

The WBS ID field defaults to <Required> and is a required field in every mapping file. 

All other fields that are required for the import are prefixed with a ―*.‖ 

Besides WBS ID, all other field mappings are only required for the imports that will be 

selected. 

Field Level Summary 

The following grid is a field level summary of the available MSP field levels for each 

Available MPM field (Task, Resource or Assignment). Required fields are marked with 

an *. 

Available MPM Fields Field Level 

WBS Selection 

*WBS ID Task  

WBS Descriptive 

WBS Description Task 

Alias Task 

User-defined XREF1 Task 

User-defined XREF2 Task 

User-defined XREF3 Task 

User-defined XREF4 Task 

User-defined XREF5 Task 

User-defined XREF6 Task 

User-defined XREF7 Task 

User-defined XREF8 Task 

User-defined XREF9 Task 

User-defined XREF10 Task 

Manager Task 

Charge Number Task 

Performing Department Task 

Responsible Department Task 

Element Type Task 

Earned Value Method Task 
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CLIN Task 

Recurring or non-recurring Task 

Fee % Task 

Fee Limit Amount Task 

BCWP Base Unit Task 

*Parent WBS ID Task 

Base WBS Task 

WBS Schedule 

Baseline Start Task 

Baseline Complete Task 

ETC Start Task 

ETC Complete Task 

Early Start Task 

Early Finish Task 

Late Start Task 

Late Finish Task 

Estimates 

*Resource Code Task 

Resource 

Assignment 

Resource Department Task 

Resource 

Assignment 

XREF-EST Task 

Resource 

Assignment 

Overtime Factor Resource 

Assignment 

Rate Table Task 

Resource 

Assignment 

Burden Template Task 

Resource 

Assignment 

Estimate Identifier  Task 

Time-phased Estimates 

Time-phased Labor Assignment 

Time-phased Material Assignment 
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Autospread Estimates 

Autospread Labor Task 

Assignment 

Autospread Material Task 

Assignment 

Spread Curve  Task 

Resource 

Estimate Type  Task 

Resource 

*Estimate Start Task 

*Estimate Complete Task 

BCWP 

*EV %Complete Task Flag Task 

Task BAC Task 

Cumulative Percent Complete Task 

Cumulative BCWP Amount Task 

Milestones 

Milestone Flag Task 

Milestone ID Task 

Milestone Symbol Task 

Milestone Description Task 

Milestone Weight Task 

Scheduled Date Task 

Forecast Date Task 

Milestone Complete Flag Task 

Percent Complete Task 
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Detailed Field Level Descriptions 

The grid below provides a detailed list of all available MPM Fields, the MSP Field Level 

(Task, Resource, or Assignment) and the Available MSP Fields for each MPM field. 

 Available MPM Fields Field Level Available MSP Fields 

WBS Selection 

 *WBS ID Task  ID, Name, Number1 – Number20, 

Text1 – Text30, Unique ID, WBS 

WBS Descriptive 

 WBS Description Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 Alias Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF1 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF2 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF3 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF4 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF5 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF6 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF7 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 
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WBS Descriptive (continued) 

 User-defined XREF8 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF9 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 User-defined XREF10 Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 – 

Text30, Unique ID, WBS 

 Manager Task Contact, Name, Notes, Number1 – 

Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Summary, Text1 

– Text30 

 Charge Number Task ID, Name, Notes, Number1 – 

Number20, Summary, Text1 – 

Text30, Unique ID, WBS 

 Performing Department Task Contact, ID, Name, Notes, Number1 

– Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 – Text30 

 Responsible Department Task Contact, ID, Name, Notes, Number1 

– Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 – Text30 
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WBS Descriptive (continued) 

 Element Type Task Name, Notes, Text1 – Text30 

 Earned Value Method 

Use the following codes: 

1: 0/100 

2: 25/75 

3: 40/60 

4: 50/50 

5: % Complete 

6: LOE 

7: Earned Standards 

8: Milestone Weights 

9: BCWP 

A: Apportioned 

P: Milestone Weights with 

% Complete 

K: Key Event 

Task Name, Notes, Text1 – Text30 

 CLIN Task ID, Notes, Number1 – Number20, 

Text1 – Text30 

 Recurring or non-recurring 

 If mapped to any Text or 

Notes field, and if that 

field is populated (with 

any value), then it will be 

imported as a recurring 

field. 

 If mapped to any Text or 

Notes field and the field 

is not populated (i.e., it is 

left blank), it will be 

imported as a non-

recurring field. 

Task EffortDriven, Estimated, Flag1 – 

Flag20, Marked, Notes, Recurring, 

Rollup, Text1 – Text30 

 Fee % Task Notes, Number1 – Number20, Text1 

– Text30 

 Fee Limit Amount Task Cost, Cost1 – Cost10, Notes, 

Number1 – Number20, Text1 – 

Text30 
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WBS Descriptive (continued) 

 BCWP Base Unit 

Use the following codes: 

H: Hours/Units 

P: Prime 

B: Total Burdened 

C: Total Cost 

D: Total Dollars 

Task Notes, Text1 - Text30 

 *Parent WBS ID 

(enter * if top level) 

Task Text1 - Text30 

 Base WBS; used if EVM is 

apportioned 

Task ID, Name, Notes, Number1 - 

Number20, Text1 - Text30, 

UniqueID, WBS 

WBS Schedule 

 Baseline Start Task ActualStart, BaselineStart, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Created, Date1 - 

Date10, EarlyStart, LateStart, 

PreleveledStart, Resume, Start, Start1 

- Startt10 

 Baseline Complete Task ActualFinish, BaselineFinish, 

Baseline1Finish - Baseline10Finish, 

ConstraintDate, Date1 - Date10, 

Deadline, EarlyFinish, Finish, 

Finish1 - Finish10, LateFinish, 

PreleveledFinish, Stop 

 ETC Start Task ActualStart, BaselineStart, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Created, Date1 - 

Date10, EarlyStart, LateStart, 

PreleveledStart, Resume, Start, Start1 

- Start10 

 ETC Complete Task ActualFinish, BaselineFinish, 

Baseline1Finish - Baseline10Finish, 

ConstraintDate, Date1 - Date10, 

Deadline, EarlyFinish, Finish, 

Finish1 - Finish10, LateFinish, 

PreleveledFinish, Stop 
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WBS Schedule (continued) 

 Early Start Task ActualStart, BaselineStart, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Created, Date1 - 

Date10, EarlyStart, LateStart, 

PreleveledStart, Resume, Start, Start1 

- Start10 

 Early Finish Task ActualFinish, BaselineFinish, 

Baseline1Finish - Baseline10Finish, 

ConstraintDate, Date1 - Date10, 

Deadline, EarlyFinish, Finish, 

Finish1 - Finish10, LateFinish, 

PreleveledFinish, Stop 

 Late Start Task ActualStart, BaselineStart, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Created, Date1 - 

Date10, EarlyStart, LateStart, 

PreleveledStart, Resume, Start, Start1 

- Start10 

 Late Finish Task ActualFinish, BaselineFinish, 

Baseline1Finish - Baseline10Finish, 

ConstraintDate, Date1 - Date10, 

Deadline, EarlyFinish, Finish, 

Finish1 - Finish10, LateFinish, 

PreleveledFinish, Stop 

Estimates 

 *Resource Code Task ID, Name, Notes, Number1 - 

Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 - Text30 

 Resource Group, ID, Initials, Notes, Number1 - 

Number20, Text1 - Text30 

 Assignment Notes, Number1 - Number20, Text1 - 

Text30 

 Resource Department Task ID, Name, Notes, Number1 - 

Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 - Text30 
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Estimates (Continued) 

  Resource Code, Group, ID, Initials, Notes, 

Number1 - Number20, Text1 - 

Text30 

  Assignment Notes, Number1 - Number20, Text1 - 

Text30 

 XREF-EST Task ID, Name, Notes, Number1 – 

Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 – Text30 

 Resource Group, Initials, Notes, Number1 - 

Number20, OvertimeRate, Text1 - 

Text30, Type 

 Assignment Notes, Number1 - Number20, Text1 - 

Text30 

 Overtime Factor Resource Group, Initials, Notes, Number1 - 

Number20, OvertimeRate, Text1 - 

Text30, Type 

  Assignment Notes, Number1 - Number20, Text1 - 

Text30 

 Rate Table Task ID, Name, Notes, Number1 - 

Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 - Text30 

  Resource Group, ID 

Initials, Notes, Number1 - 

Number20, Text1 - Text30 

  Assignment Notes, Number1 - Number20, Text1 - 

Text30 

 Burden Template Task ID, Name, Notes, Number1 - 

Number20, ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 - Text30 

  Resource Group, ID, Initials, Notes, Number1 - 

Number20, Text1 - Text30 

  Assignment Notes, Number1 - Number20, Text1 - 

Text30 

 Estimate Identifier 

 Note: Required when 

using both time-phased 

and autospread. 

Task Contact, ID, Name, Notes, Number1 

– Number20, Priority, Text1 - 

Text30, WBS 
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Time-phased Estimates 

 Time-phased Labor Assignment BaselineWork, Baseline1Work - 

Baseline10Work, Work 

 Time-phased Material Assignment BaselineCost, BaselineWork, 

Baseline1Cost – Baseline10Cost, 

Baseline1Work - Baseline10Work, 

Cost, Work 

Autospread Estimates 

 Autospread Labor Task 

 

ActualCost,  ActualOvertimeCost, 

ActualOvertimeWork, 

ActualWork, ACWP, 

AssignmentUnits, BaselineCost, 

BaselineWork, Baseline1Cost - 

Baseline10Cost, Baseline1Work - 

Baseline10Work 

BCWP, BCWS, Cost, Cost1 - 

Cost10, CostRateTable, EAC, 

FixedCost, FixedCostAccrual, 

Number1 - Number20, 

OvertimeCost, OvertimeWork, 

RegularWork, RemainingCost, 

RemainingDuration, 

RemainingOvertimeCost, 

RemainingOvertimeWork, 

RemainingWork, Text1 - Text30, 

Work,  

  Assignment ActualCost, ActualOvertimeCost, 

ActualOvertimeWork, 

ActualWork, ACWP, 

BaselineCost, BaselineWork, 

Baseline1Cost - Baseline10Cost, 

Baseline1Work - Baseline10Work 

BCWP, BCWS, Cost, Cost1 - 

Cost10, CostRateTable, 

FixedMaterialAssignment, 

Number1 - Number20, 

OvertimeCost, OvertimeWork, 

RegularWork, RemainingCost, 

RemainingOvertimeCost, 

RemainingOvertimeWork, 

RemainingWork, Text1 - Text30, 

Units, Work,  
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Autospread Estimates Continued 

 Autospread Material Task 

 

ActualCost, ActualOvertimeCost, 

ActualOvertimeWork, 

ActualWork, ACWP, 

AssignmentUnits, BaselineCost, 

BaselineWork, Baseline1Cost - 

Baseline10Cost, Baseline1Work - 

Baseline10Work 

BCWP, BCWS, Cost, Cost1 - 

Cost10, CostRateTable, EAC, 

FixedCost, FixedCostAccrual, 

Number1 - Number20, 

OvertimeCost, OvertimeWork, 

RegularWork, RemainingCost, 

RemainingDuration, 

RemainingOvertimeCost, 

RemainingOvertimeWork, 

RemainingWork, Text1 - Text30, 

Work  

  Assignment ActualCost, ActualOvertimeCost, 

ActualOvertimeWork, 

ActualWork, ACWP, 

BaselineCost, BaselineWork, 

Baseline1Cost - Baseline10Cost, 

Baseline1Work - Baseline10Work 

BCWP, BCWS, Cost, Cost1 - 

Cost10, CostRateTable, 

FixedMaterialAssignment, 

Number1 - Number20, 

OvertimeCost, OvertimeWork, 

RegularWork, RemainingCost, 

RemainingOvertimeCost, 

RemainingOvertimeWork, 

RemainingWork, Text1 - Text30, 

Units, Work  
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Autospread Estimates Continued 

 Spread Curve 

 Note: If no mapping default 

to linear. If mapped field is 

blank default to 1. 

 The numeric value for each 

type of spread curve is: 

o Linear  1 

o Bell Curve  2 

o Front Load #1 3 

o Front Load #2 4 

o Back Load #1 5 

o Back Load #2 6 

o Double Peak 7 

o Early Peak  8 

o Late Peak  9 

o Trapezoid  10 

Task ID, Name, Notes, Number1 - 

Number20, , ResourceGroup, 

ResourceInitials, ResourceNames, 

ResourcePhonetics, Text1 - Text30, 

Unique ID, WBS 

  Resource Cost, Cost1 - Cost10, Group, ID, 

Initials, Notes, Number1 - 

Number20, Text1 - Text30 

  Assignment Cost, Cost1 - Cost10, Notes, 

Number1 - Number20, Text1 - 

Text30 

 Estimate Type 

Note: If blank then we will use 

today‘s defaults labor is B 

(hours) and material is C 

(prime). 

Task Text1 - Text30  

  Resource Text1 - Text30 

 *Estimate Start Task ActualStart, BaselineStart, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Created, Date1 - 

Date10, EarlyStart, LateStart, 

PreleveledStart, Resume, Start, 

Start1 - Start10 
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Autospread Estimates Continued 

 *Estimate Complete Task ActualFinish, BaselineFinish, 

Baseline1Finish -Baseline10Finish, 

ConstraintDate, Date1 - Date10, 

Deadline, EarlyFinish, Finish, 

Finish1 - Finish10, LateFinish, 

PreleveledFinish, Stop 

BCWP 

 *EV %Complete Task Flag 

Note:  

 If this field is blank in MSP, 

it will be ignored and will 

not be added to the 

generated file.  

 If mapped to a Flag field, 

then No is ignored and Yes 

is used.  

 If mapped to a numeric 

field, then value <>0 is 

used.  

 If mapped to a Text field, 

and any value is in the text 

field, then it is used. 

 If flagged, then MPM looks 

at the task for BCWP 

information. 

Task Flag1 - Flag20, Marked, Milestone, 

Name, Notes, Number1 - Number20, 

Text1 - Text30, UniqueID, WBS 

 Task BAC 

Note:  

 This is a required field if 

Cum Percent Complete is 

mapped only if you have 

multiple tasks for the same 

WBS ID. 

 We recommend that this 

field is mapped to the same 

field used for Estimates 

Time-phased Resource 

Plan. 

Task BaselineWork, Baseline1Work - 

Baseline10Work, Work 
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BCWP 

 Cumulative Percent Complete 

Note: Cum Percent Complete 

and/or BCWP Amount must be 

mapped if importing BCWP. 

Task BCWP, Number1 - Number20, 

PercentComplete, 

PercentWorkComplete, 

PhysicalPercentComplete, Text1 - 

Text30 

 Cumulative BCWP 

Note: Cum Percent Complete 

and/or BCWP Amount must be 

mapped if importing Milestone 

Flag. 

Task BCWP, Cost, Cost1 - Cost10, 

Number1 - Number20, Text1 - 

Text30 

Milestones 

 Milestone Flag 

Note:  

 If this field is blank in 

MSP, it will be ignored 

and will not be added to 

the generated file.  

 If mapped to a Flag field, 

then No is ignored and 

Yes is used.  

 If mapped to a numeric 

field, then value <>0 is a 

milestone.  

 If mapped to a Text field, 

and any value is in the 

text field, then it is used. 

 We recommend that this 

field is mapped to the 

same field used for 

Milestone ID. 

 If flagged, then MPM 

looks at the task for 

Milestone information. 

Task Flag1 - Flag20, ID, Marked, 

Milestone, Name, Notes, Number1 - 

Number20, Text1 - Text30, 

UniqueID, WBS 
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Milestones (continued) 

 Milestone ID 

Note: This is a required field if 

identifying milestones by ID. 

Task ID, Name, Notes, Number1 - 

Number20, Text1 - Text30, Unique 

ID 

 Milestone Symbol 

Note: This is a required field if 

identifying milestones by 

Symbol/Description/Scheduled 

Date. 

Task Name, Notes, Number1 – Number20, 

Text1 - Text30 

 Milestone Description 

Note: This is a required field if 

identifying milestones by 

Symbol/Description/Scheduled 

Date OR Description. 

Task EarnedValueMethod, ID, Name, 

Notes, Number1 - Number20, 

ParentTask, Priority, Summary, 

Text1 - Text30, UniqueID, WBS 

 Milestone Weight 

Note:  

 If the Milestone Weight 

field is mapped to a task 

work field, then the weight 

will be calculated based on 

the work values. 

 For import, only hours or 

cost can be used to weight 

milestones. Both cannot be 

imported at the same time. 

 If Milestone Weight is 

mapped to a task work 

field, then the BCWP Base 

Unit should be set to Hours 

for labor tasks and Prime 

for non-labor tasks in order 

for the weight to be 

calculated. 

 If mapping Milestone 

weights to a user-defined 

field, we suggest entering 

Hours for labor tasks and 

Prime for non-labor tasks 

in order for the milestone 

to be weighted correctly 

Task BaselineWork, Baseline1Work - 

Baseline10Work, Cost, Cost1 - 

Cost10, Number1 - Number20, 

Priority, Text1 - Text30, Work 
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Milestones (continued) 

 Scheduled Date 

Note: This is a required field if 

identifying milestones by 

Symbol/Description/Scheduled 

Date. 

Task ActualFinish, ActualStart, 

BaselineFinish, BaselineStart, 

Baseline1Finish - Baseline10Finish, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Date1 - Date10, 

EarlyFinish, EarlyStart, Finish, 

LateFinish, LateStart, Start 

 Forecast Date Task ActualFinish, ActualStart, 

BaselineFinish, BaselineStart, 

Baseline1Finish - Baseline10Finish, 

Baseline1Start - Baseline10Start, 

ConstraintDate, Date1 - Date10, 

EarlyFinish, EarlyStart, Finish, 

LateFinish, LateStart, Start 

 Milestone Complete Flag 

 If mapped, and any value is 

in the Text field, then 

Milestone is imported as 

complete. 

Task Flag1 - Flag20, Marked, Text1 - 

Text30 

 Percent Complete Task BCWP, Number1 - Number20, 

PercentComplete, 

PercentWorkComplete, 

PhysicalPercentComplete, Text1 - 

Text30 

* Required Field 
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18.5  The MSP Link Processes 

There are three types of interface processes: 

 Generate file and validate - This process creates a generated file based on the 

selected import data and analyses the data coming from MSP to see if it is valid. 

A Validation Report is generated, listing any errors and warnings.  

 Generate file - This process creates a generated file based on the selected import 

data without performing any validation on the data that would come in if you 

were to perform an import. 

 Import - This process imports the data into MPM from the generated file and 

creates a Processing Report listing any warnings and errors. 

 

Figure A. Three types of interface processes 
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18.5  The MSP Link Processes 

18.5.1 Generate File and Validate, Generate File 

The only difference between the Generate file and validate and the Generate file 

processes is that the Generate file and validate option validates the incoming data. 

 

Figure A. Select the Type option 

Notes 

 You will need Microsoft Office Project installed on your machine in order to run a 

Generate file and validate or Generate file process. 

 The .mpp must be saved before running the interface, or changes will be lost. 

 Regardless of why you are running generate/validate (i.e. WBS Descriptive, WBS 

Schedule Estimates, BCWP, Milestones), if records/rows in MSP are hidden, those 

hidden records will not be processed.  They must be unhidden and saved prior to 

running generate/validate. 
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 If both autospread and time-phased will be used within one .mpp file, then the 

estimate identifier field must be mapped at task level because having both time-

phased and autospread within one task is not supported. 

 If MSP is open when the process starts, you will see some of the processing in MSP 

(for example, cells being highlighted) during the process. Once the process is 

complete, the interface closes MSP. 

 MSP Link does not support embedded or linked projects. These must be brought in 

separately.  

MSP 2000 Note 

If you are using MSP Link with MSP 2000 and your .mpp contains a macro, the interface 

process is halted and an MSP dialog is displayed asking the user whether to enable or 

disable the macro. You may select either the Enable or Disable button and the process 

will continue. 

To prevent this dialog from being displayed, complete the following steps: 

1. Go to Tools | Macro | Security to display the Security dialog. 

2. Select the Security Level tab. 

3. Select one of the following: 

 High — so no unsigned macros are allowed to run. 

 Low — so that all macros are allowed. 

4. Click OK to save changes and close the Security dialog box. 

Procedure 

You will need Microsoft Project installed on your machine in order to run a 
Generate file and validate or Generate file process.  

1. From the Menu Manager window, select the Interfaces tab and click on the 

MSP Link icon (See Figure A). 

2. Select a project from the drop-down list. 

3. Under Interface Process, select either Generate file and validate, or Generate 

file from the Type drop-down list as shown in Figure A. 
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4. Fill in all other necessary fields. See 18.3.1. Interface Conditioning Options 

for field descriptions. 

5. Under the Interface Process section, click on the Mapping File Name 

Criteria field. 

a. Select the Mappings  button to create a new mappings file (See 

section 18.4.1. Creating a New Mappings Definition for further 

details), or 

b. Select the Browse button  to open an existing mappings file (See 

section 18.4.2. Opening a Saved Mappings Definition and section 

18.4.3 Editing a Saved Mappings Definition for further details). 

6. Once all the conditioning options and mappings fields are completed, click 

on the running man , or select Tools/Run Interface to start the process.  

The .mpp must be saved before running the interface, or changes will be 
lost. 
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Initial Information Check 

An initial information check is performed. If any of these checks are found to be invalid, 

the error messages are displayed in the viewer for the Generate file process, or in the 

Output Format that is indicated in the conditioning options for the Generate file and 

validate or Import processes. The process is then discontinued. 

 Generate file and validate, Generate file processes: 

o Is Microsoft Project (MSP) installed on the computer? 

o Is the MSP Task Filter Name valid? 

o Is at least one import selected? 

o Is the MSP file valid?  

o Is the mappings file valid? 

o Does the mappings file contain mappings for all of the selected import 

types? 

o Does the mappings file contain mappings for all required fields? 

o Is BCWP selected to be imported? If so, then the mappings file should have 

either Cumulative Percent Complete or Cumulative BCWP Amount mapped 

o Is Cumulative Percent Complete mapped and do you have multiple tasks for 

the same WBS ID? If so, then Task BAC must also be mapped. 

o Is Milestones selected? 

 Is Identify Milestones By set to ID? If so, there needs to be a mapping 

for Milestones ID. 

 Is Identify Milestones By set to Description? If so, there needs to be a 

mapping for Milestones Description. 

 Is Identify Milestones By set to Symbol/Description/Schedule Date? If 

so, there needs to be a mapping for Milestones 

Symbol/Description/Schedule Date. 

o Is Time-phased Estimates or Autospread Estimates selected? 

 Is either time-phased labor or time-phased material mapped? One or the 

other has to be mapped. 

 Is either autospread labor or autospread material mapped? One or the 

other has to be mapped. 
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The initial information check is now complete and the Generate File process continues: 

 The MSP Filter is applied to the data (if applicable). 

 The data is processed according to the mapped fields‘ criteria. If a mapped field is 

invalid, an error message is written to the Validation Report. 

 The Interface checks to see if tasks need to be summarized to a WBS element. 

Tasks are summarized if their unique identifier is the same. For example, in WBS 

Schedule, tasks with the same WBS ID will be summarized by taking the earliest 

Start date and latest End date of all tasks. 

 Generate File and Validate only - The data coming in from MSP is validated and 

any errors and inconsistencies are written to the Validation Report. 

o If Generate File was selected, no data validation occurs. 

 The Replace Values conditioning option is checked to see if all data or only 

changed data should be imported: 

o If Replace Values is set to All data, all MPM mapped field data is replaced by 

the imported MSP data.   

o If Replace Values is set to Changed data only, only mapped field data that has 

changed between MSP and MPM, when compared against MPM, will be 

written to the generated file and imported into MPM. 

 A generated file (.gen) is created and saved to the location specified in the 

Generated File Name line of the MSP Link. 

 A Validation Report is created and can be viewed in the format selected in the 

Output Format conditioning option. 
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18.5  The MSP Link Processes 

18.5.2 Import 

The Import process imports the data from the generated file into MPM. 

Note: You do not need Microsoft Office Project installed on your machine in 
order to run an Import process.  

Procedure 

1. From the Menu Manager window, select the Interfaces tab and click on the 

MSP Link icon (See Figure A). 

2. Select a project from the drop-down list. 

3. Under Interface Process, select the Import option from the Type drop-down list 

as shown in Figure A. 

 

Figure A. Select the Import option 

4. Fill in all other necessary fields. See 18.3.1. Interface Conditioning Options for 

further details. 
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5. Click on the running man  or select Tools/Run Interface to start the Import 

process. 

6. The interface performs an initial import information check: 

 Import process: 

o Is at least one import selected? 

o Is the generated file a valid file? 

o Is the project file name in the generated file the same as the project 

name in the interface criteria? 

o Does data exist in the generated file for all selected imports? 

The data from the generated file is imported into MPM and a Processing Report is 

created and can be viewed in the format selected in the Output Format conditioning 

option. 
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18.6  Batch Processing 

Many MPM users perform the same set of interfaces every month as part of their 

monthly status processing. To set up a batch session which performs several processes, 

you will need to create several interfaces.  

Setting up a Batch Interface 

1. Using your mouse, click anywhere in the left pane of the Interface window to 

make that area active. 

2. Select Edit\Add Interface, or right mouse click in the left pane and select Add 

Interface (See Figure A.). 

 

Figure A. Select Edit|Add Interface 

3.  The Add Interface dialog displays (See Figure B.) 

Left pane  
of Interface 
window 
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Figure B. Select MSP Link 

4. Select MSP Link and click on OK. 

A new MSP Link Interface is added to the left pane of the Interface window. 

5. Select conditioning and mapping options for this new Interface. 

6. Repeat steps 1 through 4 to add additional interfaces. 

7. Click on the running man  or select Tools/Run Interface to start the Batch 

process. 

The MSP Link begins with the first interface listed. If any invalid criteria are found 

during the Initial Information check (see section 18.5.1. Generate File and Validate, 

Generate File for further information), the error messages are displayed in the Output 

Format that is indicated in the conditioning options, and the entire batch process is 

discontinued.  

If errors are found during the data validation process, the errors will be written to the 

validation report and the process will continue. 

The Batch processing will always run through the entire list of Interfaces, starting with 

the top interface. 
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18.6  Batch Processing 

18.6.1  Saving an MSP Link Interface 

To save a new interface: 

1. After setting up a new batch interface, select File\Save to save your new 

interface. 

2. A Save Conditioning File dialog displays (See Figure C). 

MPM prompts for the location and file name to be saved. The default location 

is a directory called INTERFACES located under the DELTEKMPM directory. 

Saved interfaces are given the name interface.MFN.  

Once you have saved an interface in the INTERFACES folder, MPM adds a 

Saved Interfaces tab to the Menu Manager (see Figure D), where all saved 

interfaces can be accessed later. 

 

Figure C. Saving an Interface 

3. Click the Save button to save your new interface. 

4. In order to see your saved interface on the Saved Interfaces tab, click F5 

(Refresh) or close and reopen MPM.  

Note: You will not be able to see your new interface on the Saved Interfaces tab 

if it has been saved to any folder other than the INTERFACES folder. 
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Figure D. Saved Interfaces Tab 
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18.6  Batch Processing 

18.6.2  Editing an MSP Link Interface 

To edit criteria in an interface: 

1. Click on the MSP link that you want to edit. 

2. Edit the criteria and mapping data as needed. 

3. Select File\Save (Ctrl + S) to save the new settings. 
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18.6  Batch Processing 

18.6.3  Deleting an MSP Link Interface 

To delete an interface from the left pane of the Interface Window: 

1. Click on the MSP link that you want to delete. 

2. Select Edit|Delete Interface, press your Delete key, or right mouse click and 

select Delete Interface (See Figure E). 

 

Figure E. Right Mouse Click to Delete Interface 
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19.1 Introduction to Distributed Projects 

Distributed Projects is a special feature of MPM which links several projects together. 
You can distribute portions of large programs to subprojects, which you can then status 
individually and later merge together into the parent superproject. See Figure A. 

 
Figure A. The Super Project’s WBS Tree Showing the Subproject 

Using Distributed Projects allows you to consolidate multiple independent projects into a 
corporate hierarchy, which can be of significant benefit in a large environment. You can 
also use Distributed Projects to automatically compute international currency conversions 
during the data consolidation process. 

Create your superproject and subprojects as two separate projects. To link projects 
together, edit the WBS Tree in the superproject. In the lowest level WBS element, enter 
the word DISTRIBUTED (always in upper case) in the Xref-1 field. It does not matter 
what numbering sequence you use in either project. Any alphanumeric numbering 
sequence in the subproject is supported. They are linked by the Xref-1 field. 

In Figure A, WBS ID 2.1.2.1 would be in Project X-20 and would have DISTRIBUTED 
in its Xref-1 field. 

Once a WBS element is marked as DISTRIBUTED, no lower level WBS 
elements may be added below it. Also, MPM will not accept resource estimates 
for DISTRIBUTED WBS elements. 
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Importing and Exporting Distributed Project Data 
To roll up the data from the subprojects into the superproject, you must have complete 
access granted to all projects affected. Follow these steps: 

1. Export Distributed Data from the first subproject. See Chapter 17: Exporting 
Data for complete details. 

2. Repeat Step 1 for all additional subprojects. 

3. Run the Analyze Distributed Import File Report on the new export file. This 
report analyzes the data before importing it to the superproject. See topic 19.4  
Recommended Distributed Projects Reports for details. 

4. Import Distributed Data. See Chapter 16: Importing Data for complete details.  

When you enter the name of the Distributed Project transfer file, MPM displays an 
additional button  which allows you to check the information in the transfer file. 

 
MPM displays a dialog box with the following information: Source Project, Source WBS, 
Target Project, Target WBS, Export Conversion Code, and Import Conversion Code. 

Batch Processing of Distributed Projects 
These imports and exports may be saved and rerun on a periodic basis. See Chapter 16: 
Importing Data and Chapter 17: Exporting Data for details on batch imports and exports. 

Rollup Processing of Distributed Data 
The superproject receives the rolled up data at the EOC level. Imported data from the 
subproject resides only in the super project’s rollup records, not in the detail records, and 
contains summarized data only.  Therefore, reports generated from the detail records 
(Resource Detail, Manpower Detail, etc.) will not include the detail data from the 
subprojects. Reports generated from rollup records (summary reports such as recaps, 
government reports, etc.) will contain subproject data. Distributed elements may not be 
replanned. In addition, the Utilities ignore distributed elements. 

Only summarized project data is consolidated.  That includes BCWS, BCWP, ACWP and 
ETC data by element of cost (labor, material, etc.), milestones and time analysis dates 
including early start/complete, late start/complete and scheduled start/complete. 
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19.2  Consolidating Distributed Projects 

Building a Transfer File 
To build a transfer file containing distributed data for export into another project: 

1. On the Menu Manager with the Export tab selected, choose the Export 
Distributed Project icon. MPM displays the Export Distributed Project 
Conditioning window. 

2. In the Source Project field, select the name of the subproject to be exported. 
3. In the Target Project field, select the name of the superproject to be imported into. 

The Target project name will be validated when you run the import. 
4. To export only one WBS leg, enter the WBS ID in the Source WBS field. 
5. Enter the WBS ID into which data will be imported in the Target WBS field. The 

WBS ID is checked later to ensure that the consolidation happens within the 
correct WBS element. The target WBS must be the lowest WBS element in the 
target leg and must have the word DISTRIBUTED entered in the Xref-1 Field.  

6. Enter the name and location of the export file to be created in the Export File field. 
7. If desired, specify any Conversion Codes (see below). 

8. Click the Run button  or choose Run Export on the Tools menu 
The transfer file may contain summarized EOC data for an entire subproject or just one 
leg of a WBS. The Distributed Project transfer file is a proprietary format and cannot be 
created using a text editor. For complete details, see Chapter 17: Exporting Data. 

Currency Conversion Codes 
To apply time-phased factors when importing or exporting international currency, use 
these optional fields. You can set up export and import conversion rates for as many 
different international currencies as needed.   

You must establish the export/import conversion codes in the Resources and Burdens in 
your Global file prior to building your transfer file. Data is entered in the same manner 
and with the same constraints as other resource codes. See Chapter 5: Defining 
Resources and Burdens in the Globals manual for details. For example, if $100 = 200 
deutsche marks (DM), the export conversion rate would be 2.00 and the import 
conversion rate would be .50. Please note that the Baseline Rate Table is used for 
Baseline, ETC and Actuals. 
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Setting Up Export Conversion Codes 
1. From the Menu Manager, click the Globals tab and select Resources and 

Burdens. 

2. Enter data in the following fields in the Resources and Burdens window: 

 Resource Code:  DOL2DM  
 Description:  DOLLARS TO MARKS 
 Rate:  2.00 

3. Repeat the rate for the duration of your calendar or contract.  You may use the 
automatic rate escalation feature just as with any other resource rate. 

4. Save this data as part of your Resources and Burdens. 

5. Enter DOL2DM in the Export Conversion Code field whenever you want to 
convert dollars to DMs using this conversion rate. 

Setting Up Import Conversion Codes 
1. From the Menu Manager, click the Globals tab and select Resources and 

Burdens. 

2. Enter data in the following fields in the Resources and Burdens window: 

 Resource Code:  DM2DOL   
 Description:  MARKS TO DOLLARS 
 Rate:  .50 

3. Repeat the rate for the duration of your calendar or contract.  You may use the 
automatic rate escalation feature just as with any other resource rate. 

4. Save this data in the Resources window. 

5. Enter DM2DOL in the Import Conversion Code field whenever you want to 
convert DMs to dollars using this conversion rate. 
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19.3  Running the Analyze Distributed Import File 
Report 

The Analyze Distributed Import File report is an analysis report of your Distributed 
Import file, which you generate in the Distributed Project Export window (see Chapter 
17: Exports for details). You use the Analyze Distributed Import File report to check the 
export file of your subproject you create, before you run the import to your superproject. 
This analysis report will detect any potential problems with the data. 

Conditioning Window 
Access the Analyze Distributed Import File Conditioning Window by selecting Analyze 
Distributed Import File on the Reports tab. MPM displays the Analyze Distributed Import 
File Report Conditioning Window shown in Figure A. 

 
Figure A. Selecting the Analyze Distributed Import File Report. 

The Analyze Distributed Import File Report has output options for sending the results of 
the analysis to different destinations. 

Required Entries 
To generate this report, you must identify the name of the Import File to be analyzed 
(Transfer File Name).  
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Optional Entries 
You can output the results of the analysis directly to the Printer, send it to the Report 
Viewer (see Chapter 15: Reports for instructions on using the Report Viewer), or save it 
in several formats (comma- or tab-delimited TEXT, Excel format .XLS, or HTML format 
.HTM). If you choose to save it in one of the file formats, specify the file name and 
location to be created in the Output File option. 

Running the Analysis 

To start the analysis processing and reporting, click the Run button  or choose Run 
Report on the Tools menu 

Validation Processing 
MPM analyzes your Import File for any problems. The Target Project is compared to the 
data in the Import File, and MPM attempts to link the Distributed WBS elements.  

When you exported your Distributed Project to create the Import File, the Source Project 
and Target Project you identified in the Export Conditioning window are stored in the 
Import File. You do not need to identify the Source or Target when running the Analysis 
report or the Import Distributed Project, because MPM knows which projects to use. 

It does not matter what project you are currently editing when importing 
Distributed Project data. The Target Project identified when exporting is always 
used. 
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19.4  Recommended Distributed Projects Reports 

There are several standard MPM reports which you can use to check your Distributed 
Project data and see its coordination with other data. 

 Analyze Distributed Import File Report 
Shows the distributed data in the transfer file, and analyzes the content. We 
recommend you run this report before running the import, to verify your data. See 
below for details. 

 WBS Indented Report 
Shows the WBS in outline (indented) format. Use conditioning to show particular 
WBS leg(s) which include DISTRIBUTED elements.  

 WBS Hierarchy 
Shows the WBS in tabular format. Use conditioning to show particular WBS 
leg(s) which include DISTRIBUTED elements.  
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19.5  Distributed Project Conversion Utility 
(DPCU) 

Introduction 
Distributed Project Conversion Utility (DPCU) provides the capability for Prime 
Contractors to apply their internal burdens to a “Subcontractor’s” data or another 
“Division’s” data created in MPM via the Distributed Project function. 

The DPCU combines and converts Element of Cost (EOC) data residing in Distributed 
Project transfer files (.xfr) into resource detail data. This allows the Prime Contractor to 
import the data, which in turn allows the Prime Contractor to utilize their Resource 
Library for the purpose of burdening the imported data. 

Note: Microsoft Office access is required to run DPCU. 

Conversion Process 
BCWS, ETC and ACWP 
The data within the Transfer Files (.xfr) is first summarized at the Total Price level 
(through Fee) and then converted to Total Prime (unburdened) dollars in the files created 
for importing. This will ensure burden costs (Overhead, G&A, Cost of Money and Fee) 
within the Transfer Files (.xfr) will not be co-mingled with those of the Prime 
Contractor’s. The Prime Dollars then become the pricing base for the application of the 
Prime Contractor’s burdens during importing. 

For the converted BCWS and ETC data, the Prime Contractor will be required to import 
monthly estimate data. 

For the converted ACWP data, the Prime Contractor will be required to import Actuals  -  
using the Auto Burdening import option. 

BCWP 
For BCWP, the process for converting data works somewhat different. Within MPM, Fee 
is not calculated for BCWP. Therefore, DPCU must compute Fee for the BCWP data 
within the Transfer File (.xfr) in order to arrive at the Total Price level. This is done to be 
consistent with the BCWS, ETC and ACWP data types. The formula DPCU uses to 
compute Total Price BCWP is as follows: 

{[Total Dollars BCWP/Total Dollars BAC] x Fee BAC} + Total Dollars BCWP 
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This calculation ensures that the amount of Fee “earned” is based on the percent complete 
of the Source WBS Leg (or Project Level) that is being “Distributed”. The computed 
values are then used for the basis of import. However, the BCWP import file does not 
categorize values in terms of “Prime” vs. “Total Dollars” vs. “Total Price” etc… 
Therefore, it is incumbent upon the Prime Contractor to assign a BCWP Base Unit of 
“Prime Dollars” for the WBS that is to be receiving the converted Distributed data. After 
the BCWP values are imported, the Prime Contractor’s burdening structure is used to 
burden the BCWP Prime Dollars up through Total Dollars. 

DPCU Guidelines 
Project Setup Guidelines 
Prior to importing, the following guidelines must be implemented in the Project (s) and 
WBS (s) receiving the data for the following data types: 

BCWP 
1. You must assign Earned Value Method #9 (BCWP Entry) for all WBS (s) 

receiving the BCWP data. The BCWP import file will include cumulative 
monthly values and will be imported as BCWP amounts. 

2. You must select Prime Dollars as the BCWP base. This and assigning Earned 
Value Methods are done within the Integrated Planning Screen  -  Milestones tab. 

3. You must Calculate BCWP after the import. This is done within the Project 
Maintenance screen. 

ACWP 
1. You must assign a Rate Table ID to be used for the burdening of Actuals. 

Remember that the Actuals import file is for Auto Burdening, meaning that it 
does not include any of the following values: Overhead, G&A, Cost of Money or 
Fee. The rate table must first be created in the Resource Library of the Global 
File ID that is being used by the Project receiving the data. After creation, 
identify the Rate Table ID within the Project Maintenance screen. 

2. The WBS element must have a value (any value) in the charge number field in 
order for MPM to allow Actuals to be accepted for the WBS. You enter this 
value (any value) within the Work Breakdown Structure screen. 

BCWS/ETC/ACWP 
1. You must identify the Resource Code ID that is to be used for the converted 

Distributed Project data. Enter that code in one of the twelve following fields 
from within the Work Breakdown Structure screen: Alias, Manager, Xref-1-10. 
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The Resource Code ID may not exceed 10 alpha-numeric characters, or have any 
embedded blanks. 

2. The Resource Code ID identified in number 1 above, must exist in the Resource 
Library of the Global File ID being used by the Project receiving the imported 
data. 

3. Do NOT enter the word DISTRIBUTED under the Xref-1 field, which is 
normally required only when processing standard (unconverted) Distributed 
Project transfer files. If this identifier is mistakenly entered, the imported data 
will be rejected during the import process. 

Data Comparison 
If you wish to compare the data residing in the converted transfer files with the data 
currently residing in the WBS Element, it is recommended that you import the file into a 
copy of the Project. Not only is this recommended as a standard back-up procedure for 
preserving your current contract position, it allows you to run the Project Comparison 
reports from within MPM. These reports compare the data of two like Projects side by 
side and display the variances between them. This would allow you to analyze the 
“before” and “after” positions before actually updating the master Project. 

Database Performance 
DPCU uses a Microsoft Access database to store the retrieved data from the Transfer 
Files (.xfr) for further data manipulation and calculations. 

Performance may be improved by routinely compacting the database. Refer to the 
following Microsoft Knowledgebase article for further information: 

http://support.microsoft.com/kb/288631 

Opening DPCU 
To open DPCU from the Menu Manager: 

1. Select the Utilities tab. 

2. Choose the Distributed Project Conversion Utility icon. 

 

 

 

 

http://support.microsoft.com/kb/288631
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The Main Menu (below) appears. See below for detailed explanations of the Main Menu 
Options. 

 
Main Menu Options 
XFR File Path: 

Using the Drive drop down list and the Directory drop down list, identify the Drive and 
Subdirectory that contains the Transfer Files (.XFR). 

Note: It is recommended that the Transfer Files to be converted be placed in a dedicated 
directory. Otherwise, all Transfer Files (.XFR) residing in the directory selected will be 
converted. 

XFR File Count: 

This indicates the number of Transfer Files that DPCU found in the Drive/Directory 
selected. 
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Include in Conversion: 
Click inside the box and place a check for the data you wish to be extracted from the 
Transfer Files (.XFR) and converted into data import files. 

Lookup Resource Using: 
DPCU must use a Resource Code for the import file(s) it will create (except for BCWP). 
You instruct DPCU where to find that Resource Code by indicating the appropriate field. 
The five fields from which to choose are all located in the Work Breakdown Structure 
screen within MPM. Only the Target WBS(s) that will be receiving the data need to have 
the Resource Code identified. 

Note: Be sure that the Resource Code value entered in the selected field does not exceed 
10 characters in length and that the value entered is a valid Resource Code in the 
Targeted Project’s Resource Library. 

Process Status 
After selecting the Main Menu Options and clicking the OK button, DPCU displays a 
Process Status window similar to below. Details of this Status window can be found 
below. 

The status window indicates the Status of the conversion process for each Transfer File. 
Once completed, the following files will be created in the same directory as your Transfer 
Files. 

• Target Project Name.S (import file for the BCWS data) 

• Target Project Name.E (import file for the ETC data) 

• Target Project Name.A (import file for the Actuals data) 

• Target Project Name.P (import file for the BCWP data) 

For example, when the “Subcontractor” or other “Division” creates the Transfer Files, 
they must identify a Target Project name (for example, the Prime Contractor’s Project). 
Assume the project name is DIST (as shown in the status above). When the Prime 
Contractor initiates the DPCU, and selects all four data categories to be converted, the 
following files would be created: 

• DIST.S  

• DIST.E 

• DIST.A 

• DIST.E 
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When multiple Transfer Files exist for the same project, DPCU will convert and combine 
all like data types into the same import file, such that the Prime Contractor will never 
have to import more than four files into one project. An example of this would be if the 
Prime Contractor had multiple Subcontractors on the same contract, each required to 
create and submit a Distributed Project Transfer file(s) to the Prime Contractor. Rather 
than converting and creating a separate BCWS Import file for each Transfer File, DPCU 
simply appends the converted BCWS data records into the same “filename.S”. 

Note: Make sure the “Target WBS(s)” exist in the Target Project or you will the import 
file will fail during the import process. 

DPCU Log File 
DPCU does four different validations during the conversion process. They are: 

• Does the Target Project exist? 

• Does the Target WBS exist? 

• Does the Target WBS have a Resource identified in the WBS Lookup field 
indicated? 

• Does the Target WBS have a value in the Charge Number field? 

At the end of the conversion process, a log file will be generated. If any of the above 
validations are not met, then the log file will indicate which validations were not met and 
for which XFR file.  

The log file can be viewed two different ways: 

1. If there were validations not met during the conversion process, DPCU will indicate 
so when the conversion process is complete. 

2 The other way to view the log file is from the Utilities Tool Bar. Under Utilities, 
select “View Log File.” 
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Importing Converted Data 
You can select to import the converted files using the Standard single file import (for 
BCWS, ETC, Actuals and BCWP) or you can create a Batch Import that will import all 
files that exist in the Batch Import job. For details on how to create a Batch Import, see 
Chapter 16, Importing Data.  

The Estimate Import type should be used for the BCWS and ETC monthly data import. 
(projectname.S and projectname.E). 

• Make sure the Target Project’s calendar has the full time span of the data being 
imported 

• Import BCWS before importing BCWP 

 

The Actuals Import type should be used for the Actuals data import (projectname.A). 

• Make sure the “Target WBS(s)” have a value in the Charge Number field in the 
Work Breakdown Structure. 

• Remember to select the option “Autoburden” on Row 10 of the Actual Import 
Conditioning screen. 

The BCWP Import type should be used for the BCWP data import (projectname.P).  

• Make sure the “Target WBS(s)” have the Earned Value Method “BCWP Entry” 
assigned. 

• Import BCWS before importing BCWP. 

• Remember to Calculate BCWP after the import is complete. This is done in the 
Project Maintenance screen. 
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Appendix A: Glossary 

Actual Cost of Work 
Performed (ACWP) 

An applied hour and/or dollar amount as procedurally 
defined by a contractor’s management system and used for 
performance measurement. In MPM these can be 
manually input, or imported from external accounting 
systems. (See Actuals/Actual Cost.) 
 

Actuals/Actual Cost A cost incurred or booked as defined by Generally 
Accepted Accounting Principals (GAAP) and further 
defined as a cash or accrual method in audited/unaudited 
financial statements and government disclosure statement. 
For labor, hour and dollar amounts, usually equals labor 
ACWP; for other elements of cost (particularly material), 
there may be a timing difference between actual costs and 
ACWP. Actuals do not include unallowable cost in 
government contracting. (see Actual Cost of Work 
Performed). 
 

ACWP See Actual Cost of Work Performed. 
 

Algorithm A set of logical steps for solving a problem or 
accomplishing some end result. 
 

Alphanumeric Consisting of letters and/or numbers. 
 

Apportioned Effort Effort that by itself is not readily divisible into short span 
work packages, but which is related in direct proportion to 
some other measured effort. 
 

At Complete Variance The difference between the Budget at Completion (BAC) 
and Estimate at Complete (EAC). This represents a 
forecast of budget overrun or underrun. 
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Baseline/Baseline 
Estimate 

The estimate or budget of time, resources, hours and 
dollars required to complete a task or group of tasks. 
 

Batch A compilation of multiple processes performed all at once; 
for example, Batch Reports, Batch Imports, and Batch 
Exports. 
 

BCWP See Budgeted Cost of Work Performed. 
 

BCWS See Budgeted Cost of Work Scheduled. 
 

BI (Business 
Intelligence) Tool 

A type of application software designed to report, analyze 
and present data. The tools generally read data that have 
been previously stored, often, though not necessarily, in a 
data warehouse or data mart. 

Budgeted Cost of Work 
Performed (BCWP) 

The hours, as applicable, and dollar amounts which have 
been budgeted, for completed work packages and/or 
completed portions of work packages. 
 

Budgeted Cost of Work 
Scheduled (BCWS) 

The hours and/or dollar amounts which have been 
budgeted for all work necessary to complete a project. 
 

Burden Indirect costs (such as overhead and general & 
administrative expense) which are allocated to a project’s 
base amounts. Each direct (or prime) cost category (labor, 
materials, etc.) is allocated its burden (or proportionate 
share) of the indirect costs. 
 

Burdened Dollars Prime (or direct) dollar amount plus overhead dollar 
amount. 
 

Charge Number An in-house accounting system identifier used to record 
actual costs. In performance measurement systems, one or 
more charge numbers are assigned to the control account 
and/or work package. MPM allows only one Charge 
Number per WBS element. 
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Child/Children A WBS element belonging to or subsidiary to another 
WBS element which is at a higher level in the WBS 
hierarchy. 

Class of Cost A class of cost (COC) is a subcategory of an element of 
cost (EOC). You can have up to 13 COCs for each EOC. 

CLIN See Contract Line Item Number. 
 

COC See Class of Cost 
COM See Cost of Money. 

 
Conditioning Screen A screen displayed on your monitor where you define 

various categories of data to appear on reports or exports 
and/or make selections from options listed on the screen. 
 

Contract Line Item 
Number (CLIN) 

The number used to identify a specific contract 
deliverable. 
 

Conventions The manner in which concepts are described in the MPM 
documentation. 

Control Account A management control point at which budgets, earned 
value, estimates and actual costs are accumulated and 
computed for variance analysis. The Control Account is a 
natural control point for cost/schedule planning and 
control since it represents the work assigned to one 
responsible organization on one Contract Work 
Breakdown Structure element.  
 

Cost of Money (COM) The cost of investing capital in equipment and facilities 
which are necessary to perform a given contract.  
Depending upon contract terms, COM can been treated as 
1) non-fee bearing cost; 2) not as a cost; or 3) part of fee. 
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Cost of Performance 
Index (CPI) 

The ratio of work accomplished (BCWP) to the actual cost 
of work performed (ACWP) expressed by the formula: 

   (Monthly/Cumulative) BCWP 
   (Monthly/Cumulative) ACWP 
MPM uses only cumulative values for CPI calculations. 
 

Cost Performance 
Report (CPR) 

A report which shows the cost and schedule performance 
status of a contract; periodic submittal required under 
DoDI 5000.2 (Encl. 2), usually monthly. 
 

Cost/Schedule Control 
Systems Criteria 
(C/SCSC) 

DoD established characteristics that a contractor’s internal 
management system must possess to insure effective 
planning and control of contract work and costs. The 
government instruction is DoDI 7000.2 
 

Cost/Variance The difference between BCWP and ACWP. 
 

CPI See Cost Performance Index. 
 

CPR See Cost Performance Report. 
 

C/SCSC See Cost/Schedule Control Systems Criteria. 
 

C/SSR See Cost/Schedule Status Report. 
 

CSV Column Separated Value 
 

Cursor The marker on the monitor screen indicating where the 
next character input will appear. 
 

Default The setting or value for various functions or fields which 
MPM will use unless you change it. 
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Dimension A data element that categorizes each item in a data set into 

overlapping regions. It provides a means to “slice and 
dice” data in a data warehouse. Dimensions also provide 
structured labeling information to otherwise unordered 
numeric means. The primary function of dimensions is 
threefold: to provide filtering, grouping and labeling. 

Direct Costs The prime cost of labor or materials which is directly 
related to a specific WBS element and is chargeable 
directly to the contract. 
 

Discrete Milestone A milestone having a definite, scheduled time and budget 
for occurrence signaling an event. 
 

Distributed Project A portion of a project distributed outside the host 
processing unit for maintenance and control. 
 

Dollars:  
 Prime Direct cost of each resource or amount chargeable for 

each resource. 
 Overhead Overhead amount allocated to the prime (base/direct) 

hours/dollars. 
 Total Burdened Prime + Overhead 
 Total Cost Prime + Overhead + G&A 
 Total Dollars Prime + Overhead + G&A + COM 
 Total Price Total Dollars + Fee 

 
DW (Data Warehouse) A central repository for project and global data from any 

and all corporate locations. The consolidated data can be 
used for analysis and reporting. 

EAC See Estimate at Completion. 
 

Earned Value The value of work completed to date; also known as 
BCWP. The total budget for completed work packages 
plus a pro rata share of the budget for work packages only 
partially completed. 
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Earned Value Method 
(EVM) 

A quantitative method used to calculate BCWP; MPM 
provides many methods of calculating earned value which 
are defined in the MPM Projects manual. 
 

Element/WBS Element A discrete portion of a Work Breakdown Structure 
(WBS); an identifiable product, set of data, or service. In 
MPM all tasks from the contract level to the lowest finite 
level require a WBS identifier. 
 

Element of Cost Definitions vary dependent upon the accounting structure 
but normally include categories of labor, material, other 
direct costs, and subcontractor. 
 

Element Type The WBS identifier element type. 
   C: Control Account 
   W: Work Package 
   P: Planning Package 
   O: Other 
 

Equivalent Person  
Month 

One person working normal hours/days exclusive of 
holidays, normally expressed in hours per month. In MPM 
it is defined by the resource work calendar or fiscal 
calendar hours per month. 
 

Estimate at Completion 
(EAC) 

The actual cost of all incurred cost to date plus the 
anticipated cost of remaining work. Also known the Latest 
Revised Estimate (LRE). 
 

Estimate to Complete 
(ETC) 

The total estimated cost of all remaining work necessary 
to complete the total project. 
 

Estimate the WBS The process of estimating resources requirements for a 
specific WBS ID. 
 

ETC See Estimate to Complete. 
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EVM See Earned Value Method. 
 

Export Any data originating within MPM that is transferred to an 
outside system. 
 

Fiscal Month/Year A period of time or calendar unit used for accounting 
purposes which may or may not coincide with the 
standard Gregorian calendar. 
 

Float The number of calendar units between the early start and 
late start of an activity. 
 

Functional Organization An organization or group of organizations with a common 
operational orientation (for example, Design, Engineering, 
Quality Assurance). 
 

G&A See General & Administrative. 
 

Gantt Chart A scheduling tool showing the time span of each activity 
or WBS as a horizontal line, the ends of which correspond 
to the start and finish of the activity or WBS as indicated 
by a date line on the chart. (Also known as a bar chart.) 
 

General & 
Administrative 

Expenses incurred in the management and administration 
of a company and allocated in whole or part to a contact. 
 

Hour A labor unit of time. 
 

IEAC See Independent Estimate at Complete. 
 

Import Any data brought into MPM from a source outside MPM. 
 

Independent Estimate at 
Complete (IEAC) 

The formula used in MPM for IEAC is BAC/CPI.  This 
EAC formula assumes the project will continue to perform 
at the same efficiency rate through the completion of the 
contract. 
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Indirect Cost Burden (usually overhead and G&A) allocated to an 
accounting base and charged to contract effort. 
 

Input Anything you communicate to your computer by any 
method (i.e., typed from the keyboard, copied from 
another drive or retrieved from a floppy diskette). 
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Input Screen A screen displayed on your monitor into which you type 

raw data. 
 

Inventory 
Account/Charge 
Numbers 

An accounting record (normally a charge number) used to 
hold or suspend actual costs until applied (or input) to the 
performance measurement system as ACWP. See 
Actuals/Actual Costs. 
 

Label A word, phrase or other text that identifies a particular 
field of a report or chart. 
 

Latest Revised Estimate 
(LRE) 

The actual cost of all incurred cost to date plus the 
anticipated cost of remaining work.  Also known as 
Estimate-At-Complete (EAC). 
 

Level of Effort (LOE) Effort of a general supportive nature. It is activity which 
cannot be associated with a measured task or milestone 
and is controllable by time-phased budgets established for 
that purpose. For LOE activity, BCWP = BCWS. 
 

LOE See Level of Effort. 
 

LRE See Latest Revised Estimate. 
 

Management Reserve An amount of the total allocated budget withheld for 
management control purposes rather than designated for 
the accomplishment of a specific task or set of tasks. It is 
not a part of the Performance Measure Baseline, but is 
included in the total Contract Budget Base. Management 
cannot be a negative value. 
 

Man Hour A labor unit of time. 
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Material 
Burden/Material 
Overhead 

Material indirect costs allocated to a material base. 

Measure Data that can be examined or analyzed, such as sales or 
cost data. You can select and display the data in a 
measure. Measures can be stored as variables or relations, 
or measures can be calculated by means of formulas. 
These are derived from the records in the fact table and 
therefore consist of numeric facts. 

Menu The screen display of options available for your selection. 
 

Milestone A discrete point or event for measurement/assessment of 
work package accomplished. (Also called an interim 
milestone.) 
 

Milestone Weight A numerical factor assigned to a milestone for a portion of 
a task to express its relative budget value to the total 
budget value for the task. 
 

MPM DW (Data 
Warehouse) 

A central repository for project and global data from any 
and all corporate locations. The consolidated data can be 
used for analysis and reporting. 

Nonrecurring Cost Expenditures against specific tasks that would not occur 
on a repetitive basis in any given program. Examples are 
such items as preliminary design effort, qualification 
testing, initial tooling and planning, etc. 
 

OBS See Organization Breakdown Structure. 
 

ODC See Other Direct Costs. 
 

OLTP On-Line Transaction Processing is a class of program that 
facilitates and manages transaction-oriented applications. 

Organization 
Breakdown Structure 
(OBS) 

A hierarchical structure depicting an organization and 
used as a framework for assigning and managing work 
responsibilities. Can also be used to summarize data by 
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department, responsible person, functional categories, 
natural work groups, matrix organization, project 
organizations, etc. 
 

Original Duration The length of time a particular activity will require to 
complete, from start to finish; usually expressed in work 
days. 
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Other Direct Costs 
(ODC) 

A group of certain accounting elements which can be 
isolated to specific tasks, other than labor and material. 
 

Overhead Indirect costs which, because they are incurred for 
common or joint objectives, are not readily subject to 
treatment as direct costs. Indirect costs are planned and 
applied as a rate against a direct cost base. 
 

Overhead Dollars Overhead amount allocated to the prime (base/direct) 
hours/dollars. 
 

PAR See Problem Analysis Report. 
 

Parent A higher level WBS element owning other elements as 
subsidiaries at a lower level in the WBS hierarchical tree 
structure. 
 

Performing 
Organization 

(See Responsible Organization for comparison). The OBS 
departments which expend resources to accomplish a 
WBS task, usually work package elements. 
 

Planning Package A logical aggregation of far term work within a control 
account that can be identified and budgeted but is not yet 
defined into work packages. Planning packages are 
identified during the initial baseline planning to establish 
the time phasing of the major activities within a control 
account and the quantity of the resources required for their 
performance. Planning Packages are planned into work 
packages consistent with the rolling wave concept prior to 
the performance of the work. 
 

Price Variance Difference between the earned price of a purchase item 
and its actual cost.  Price variance is derived by 
subtracting (earned quantity X actual cost) from (earned 
quantity X planned cost). 
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Prime Dollars The dollar amount chargeable for the resource itself before 

adding overhead and G&A; that is, direct cost. 
 

Problem Analysis Report 
(PAR) 

A report used for analyzing cost or schedule variances to 
determine cause, effect and action necessary for 
correction; usually generated by the responsible manager. 
 

Purchased Parts Parts or small sub-assemblies purchased from an outside 
source, usually outside of the prime contractor’s 
manufacturing capability. 
 

Real Time A term used to indicate computer methodology wherein 
data is updated and summarized at the time of input as 
opposed to methods where data is input and then at some 
later time is processed and updated. 
 

Recurring Costs Expenses for specific tasks that occur repeatedly during 
the life of the project. 
 

Replanning A change in the original plan for accomplishing 
authorized contractual requirements. 
 

Reprice The process of recalculating estimated (or budget) based 
upon different resource rates and/or overhead/G&A rates 
and/or COM rates in the Resources and Burdens windows.
 

Request for Proposal 
(RFP) 

A document requesting a bid for a specified body of work; 
it also outlines the fee arrangement, the scope of the work, 
time for performance and reporting requirements. 
 

Resource The most elemental level of a bidding or costing category 
used to establish the requirements for a task. 
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Responsible 
Organization 

(See Performing Organization for comparison) A defined 
department/unit within an organization structure (OBS) 
which is assigned responsibility for accomplishing 
specific tasks and to which one or more control accounts 
are assigned. 
 

RFP See Request for Proposal. 
 

Schedule Variance The difference between BCWP and BCWS (BCWP – 
BCWS). 
 

Schedule of 
Performance Index (SPI) 

The ratio of work accomplished (BCWP) to the actual cost 
of work scheduled (BCWS) expressed by the formula: 

 (Monthly/Cumulative) BCWP 
 (Monthly/Cumulative) BCWS 
MPM uses only cumulative values for SPI calculations. 
 

Scrap & Rework Factor The allowance for material and labor deficiencies not 
meeting product specification. 
 

SOW See Statement of Work. 
 

Spread Curve Numeric distribution pattern used in an automatic spread 
of a resource. 
 

Standard Hour Industrial Engineering Standard Hour; a quantitative 
measurement of work content. 
 

Statement of Work 
(SOW) 

A document which outlines the work required to complete 
a given project; prepared by the customer. 
 

Time Now The calendar date conditioned by the user; used on many 
time-oriented graphic reports. 
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To Complete 
Performance Index 
(TCPI) 

The projected value to be earned for every measurable  
unit to be expended in the future. 
TCPI  =  BAC – Cum BCWP 
   BAC – Cum ACWP 
 

Total Cost Dollars Prime dollar amount plus overhead dollar amount plus 
G&A dollar amount. 
 

Total Dollars Prime dollars plus overhead amounts plus G&A plus cost 
of money. 
 

Undistributed Budget That portion of the contract budget not yet assigned to a 
specific WBS element. 
 

Unit of Measure A single quantity regarded as a whole and adopted as a 
standard of measurement; may be hours, dollars, months, 
etc. 
 

VAC See Variance at Completion. 
 

Value The quantity or percentage contributed by a single unit of 
measure to the whole. 
 

Variance Deviation from as established amount. 
 

Variance at Completion The formula used in MPM for VAC is BAC - LRE. 
 

Weight/Milestone 
Weight 

A numerical factor assigned to a particular milestone or 
portion of a task to express its relative amount to the 
whole task. 
 

WBS See Work Breakdown Structure. 
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WBS Element A portion of a work breakdown structure; it may be an 

identifiable product, a set of data, or a service. 
 

What If Analysis The process of analyzing possible alternative plans in 
terms of budget, manpower and resource amounts required 
for the completion of a project. 
 

Work Breakdown 
Structure 

A hierarchical tree, usually product oriented, that 
organizes, defines and graphically displays the hardware, 
software, services and other work tasks necessary to 
complete a project. 
 

Work Package (WP) A detailed task representing a unit of work at the levels 
where the work will be performed, having scheduled start 
and completion dates and a budget. 
 

XREF Optional fields provided as additional identifiers that can 
be used for reporting, exporting, or onscreen filtering.  
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Appendix B: Error Messages 
Many of the MPM error messages are self-explanatory. However, there are other 
messages that we felt could use additional explanation. Those messages are included in 
this appendix.  

 The messages are listed alphabetically.  

 The messages are displayed in bold type, followed by their explanations. 

 Variables that appear in the messages are displayed in italics. 

A Global File ID already exists for this path. 
There are six global files for each Global File ID.  The names of these six files remain the 
same regardless of the fact that you assign them a Global File ID.  For this reason, each 
global file ID must exist in a unique directory. Enter a unique path and this error message 
will no longer appear. 

A user cannot be assigned rights to more than 100 WBS Legs. xxx WBS 
Legs have been selected for this user. 
This restriction applies when you select specific WBS legs (elements) for a user. The 
restriction does not apply if you assign the user access to an entire project. If you need to 
assign specific WBS legs, you may be able to assign a parent rather than its individual 
children, decreasing the number of WBSs assigned. 

Access to the system is restricted because there are more users in the 
system than the number specified in the license. Please contact your 
system administrator. 
When the License Type is Named User and a non-SYSADMIN user logs in, the number 
of users logged onto the system is now higher than the number of users specified in the 
license. 
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Access to the system is restricted to non-SYSADMIN users because there 
are more users in the system than the number specified in the license. 
Please delete excess users. 
When the License Type is Named User and a SYSADMIN user logs in, the number of 
users logged into the system is now higher than the number of users specified in the 
license. 

All references to the User ID(s) in all projects will be deleted. Are you sure 
you want to delete the selected User(s)? 
Users can be referenced in the Suspended By field in Project Maintenance. If you delete a 
user, his name will be removed from this field. 

An EOC cannot have more than 13 COCs. 
An Element of Cost (EOC) cannot have more than 13 Classes of Cost. This is a limit 
imposed by MPM. There is no workaround. 

Another user has changed one or more Log(s) in the selection.  The 
modification(s) from the other user will now be displayed. 
Another user is editing the same data in the same window and has saved his changes. 
Your changes will be lost and the other user’s changes will be displayed instead. You can 
re-enter your edits and save them. This will overwrite the other user’s changes. However, 
you should determine who the other user is before doing any more editing. 

Another user has changed one or more Resource(s)/Burden(s) in the 
selection.  The modification(s) from the other user will now be displayed. 
Another user is editing the same data in the same window and has saved his changes. 
Your changes will be lost and the other user’s changes will be displayed instead. You can 
re-enter your edits and save them. This will overwrite the other user’s changes. However, 
you should determine who the other user is before doing any more editing. 

Another user has changed this xxxx. The modification from the other user 
will now be displayed.  
Another user is editing the same data in the same window and has saved his changes. 
Your changes will be lost and the other user’s changes will be displayed instead. You can 
re-enter your edits and save them. This will overwrite the other user’s changes. However, 
you should determine who the other user is before doing any more editing. 
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Another user has created an identical actual. The actual from the other user 
will now be displayed. 
Another user is editing the same data in the same window and has saved his changes. 
Your changes will be lost and the other user’s changes will be displayed instead. You can 
re-enter your edits and save them. This will overwrite the other user’s changes. However, 
you should determine who the other user is before doing any more editing. 

Another user has created an identical CLIN. The CLIN from the other user 
will now be displayed. 
Another user is editing the same data in the same window and has saved his changes. 
Your changes will be lost and the other user’s changes will be displayed instead. You can 
re-enter your edits and save them. This will overwrite the other user’s changes. However, 
you should determine who the other user is before doing any more editing. 

Another user has created this xxxx. 
Another user is working in the same window and has used the same name you are trying 
to enter. Use a different name for the object. 

Another user has deleted one or more Log(s) in the selection.  The Log(s) 
will now be removed. 
Another user has deleted the same data in the same window and has saved his changes. 
Your changes will be lost and the record will be removed from your grid. You can add 
the record back in again if you wish. However, you should contact the other user before 
doing any more editing. 

Another user has deleted one or more Resource(s)/Burden(s) in the 
selection.  The Resource(s)/Burden(s) will now be removed. 
Another user has deleted the same data in the same window and has saved his changes. 
Your changes will be lost and the record will be removed from your grid. You can add 
the record back in again if you wish. However, you should contact the other user before 
doing any more editing. 

Another user has deleted this xxxx. This xxxx will now be removed.  
Another user has deleted the same data in the same window and has saved his changes. 
Your changes will be lost and the record will be removed from your grid. You can add 
the record back in again if you wish. However, you should contact the other user before 
doing any more editing. 
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Another user has deleted this User. This User and any associated 
Project(s) will now be removed. 
Another user has deleted the user. Your changes will be lost and the record will be 
removed from your grid. You can add the user back in again if you wish. However, you 
should contact the other user before doing any more editing. 

Another user has deleted this User’s access to this Project. This Project 
will now be removed. 
Another user has deleted a project listed under the user. Your changes will be lost and the 
project will be removed from your grid. You can add the project back in again if you 
wish. However, you should contact the other user before doing any more editing. 

Another user has deleted this WBS element. This WBS element and any 
actuals belonging to it will now be removed. 
Another user has deleted the WBS. Your changes will be lost and the WBS will be 
removed from your grid. You can add the WBS and actuals back in again if you wish. 
However, you should contact the other user before doing any more editing. 

Any WBSs or estimates using the department(s) should be updated. Are 
you sure you want to delete the selected department(s) and children? 
A department is assigned to a WBS as a performing or responsible department. If you 
delete a department, you should go into the WBS window and assign a new department 
to the elements using the old department. 

Apportioned ETC estimate (WBS, resource code, resource department, overtime) 
already exists under base estimate (WBS, resource code, resource department, 
overtime).  Do you want to move it to a new base estimate (WBS, resource code, 
resource department, overtime)? 
If you choose Yes, MPM updates the ETC apportioned link and the apportioned estimate 
based on the new base. If you choose No, MPM does not create or modify any ETC 
apportioned estimate. 

Burden Code xxx already exists for this Burden Template. 
You have typed in a burden code that already exists for the burden template. Instead of 
typing in an entry, try selecting a burden code from the drop-down list box in the Burden 
Code field. 
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Cannot move or delete the DEFAULT Global Set. 
The Default global set ships with MPM and cannot be moved or deleted.  

CLIN xxx already exists. 
You have typed in a CLIN that already exists for the WBS. Instead of typing in an entry, 
try selecting a CLIN from the drop-down list box in the CLIN field. 

COC xxx already exists. 
You have typed in a COC that already exists for the EOC. Instead of typing in an entry, 
try selecting a COC from the drop-down list box in the COC field. 

Current and Rename To cannot be the same for all three values. 
At least one of the fields (Resource Code, Resource Department, or Overtime) in the 
Rename group box must be different from the matching fields in the Current group box. 

Current Resource Code, Resource Department, and Overtime cannot be 
conditioned to “ALL” at the same time. 
One of the above must be set to something other than “ALL” in order to clear this error. 

Curve ID xxx already exists. 
You have typed in a curve ID that already exists. Instead of typing in an entry, try 
selecting an ID from the drop-down list box in the field. 

Data on the clipboard is not the same size and shape as the selected area. 
When you cut and paste more than one cell in a grid, you can select the entire destination 
area, or only the cell in the upper left corner of the destination area. If you select the 
entire destination area, the source and destination areas must match exactly in height and 
width. 

Data records from the following files cannot be recovered: filename, 
filename. Files may have to be recovered from backup. 
MPM could not recover the files listed in this message. You will need to recover the files 
using the latest backup. Be sure to have your System Administrator run Recover on the 
recovered copy of your backup to ensure that the problem does not exist in the backup. 
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Database is Busy! 
File: drive:\directory\filename 
Another user is performing an action that accesses the database. Try the operation again 
in a few minutes. Note the numeric value that follows this error message for further 
troubleshooting. 

Database is Busy! 
File: drive:\directory\projectnameT.HED 
Another user is performing an action that accesses the database. Try the operation again 
in a few minutes. Note the numeric value that follows this error message for further 
troubleshooting. 

DD-MMM-YY is not within calendar range of DD-MMM-YY through DD-
MMM-YY. 
The date you have entered falls outside the fiscal calendar established for the project. To 
check the fiscal calendar dates, select Calendars from the Globals tab in the MPM Menu 
Manager. 

Department xxxx not found. 
You have typed in a parent department that does not exist. Instead of typing in an entry, 
try selecting a parent department from the drop-down list box in the Parent field. 

Department(s) beginning with xx not found. 
You used a wild card (*) in the Department field, and no departments were found that 
begin with the characters you entered before the wild card. Enter different characters or 
select a department from the drop-down list box in the Department field.  

Do you also want to change the children’s Burden Template IDs which 
match the parent’s original Burden Template ID? 
If one or more of the children of the parent have the same burden template, you can 
change the parent’s and children’s burden templates at this same time by choosing Yes. 

<ERROR!!!>.  A report will be created showing the error(s).  Do you want to 
continue adjusting other estimates. 
This message is displayed when MPM encounters an error in the data used in the 
adjustment. You can stop the processing, check the report, attempt to correct the error, 
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then rerun the adjustment. Or you can continue with the processing. If you are adjusting 
by WBS ID, you can rerun the adjustment from the point where the error occurred. 

<ERROR!!!>.  A report will be created showing the error(s).  Do you want to 
continue repricing other estimates. 
This message is displayed when MPM encounters an error in the data used in the reprice. 
You can stop the processing, check the report, attempt to correct the error, then rerun the 
repricing. Or you can continue with the processing. If you are repricing by WBS ID, you 
can rerun the repricing from the point where the error occurred. 

Error: 30 - Not a Btrieve File 
File: drive:\directory\filename 
The file format is one that Btrieve does not recognize, or a data or program file may be 
corrupted. 

<ERROR!!!>. You must correct the error and restart the date shift process.  
Check to see if a date has been shifted outside the calendar range. 

<ERROR!!!>. You must correct the error and restart the rename process. 
Check the syntax for the renaming, or check to see if the character limit has been 
exceeded. 

Estimate (WBS, resource code, resource department and overtime) already exists. 
You have typed in an estimate that already exists. Instead of typing in an entry, try 
selecting an entry from the drop-down list box in the field. 

ETC estimate (WBS, resource code, resource department and overtime) already 
exists. 
You have typed in an estimate that already exists. Instead of typing in an entry, try 
selecting an entry from the drop-down list box in the field. 

Global ID is not valid. 
You have typed in a global ID that does not exist. Instead of typing in an entry, try 
selecting an entry from the drop-down list box in the field. 



694   Appendix B: Error Messages 

Global ID xxxx already exists. 
You have typed in a global ID that already exists. Try a different name. 

Insufficient disk space at drive:\directory 
Space Required:   xx,xxx 
Space Available:    x,xxx 
The path you have specified does not contain enough disk space. Select a different path 
or increase the disk space. 

MMM-YY is not within calendar range of MMM-YY through MMM-YY. 
The date you have entered falls outside the fiscal calendar established for the project. To 
check the fiscal calendar dates, select Calendars from the Globals tab in the MPM Menu 
Manager. 

MPM cannot have more than 300 users. 
You are limited to defining up to 300 users. If you need to have more than 300 users, 
contact your Deltek representative about purchasing an additional copy of MPM. If you 
use a named user license key when installing MPM, and your users.dat file contains more 
users than your named user license allows, an error message displays when starting 
MPM. The sysadmin will need to delete extra users from the user list. 

No filtering has been applied to the Resources view.  Download of data may 
take a few minutes.  Do you wish to continue? 
If you are working with a large project, you should consider entering values for one or 
more of the Resource Filtering fields. This will limit the data you view to what you need 
to work with and speed up the download  

Non-numeric characters have been entered, therefore, OT will not be 
calculated.  This message will not be displayed again in this session. 
When you enter non-numeric characters in this field, MPM assumes you are using the 
field as a way to distinguish between different estimates. For information on using the 
Overtime field to indicate different estimates, see topic 7.3.2  Using the Overtime Field in 
the MPM Projects manual. 
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One or more of the selected estimates exist in ETC as apportioned 
estimates and cannot be deleted. 
You cannot delete apportioned estimates. Apportioned estimates are indicated by a 
percent sign (%) in front of the resource code for the estimate. 

One or more user/project record(s) in the selection is used as either a WBS 
or Functional Security Equivalence and could not be deleted. 
WBS and Functional Equivalent Users are generic user entries that are assigned a set of 
access privileges. The Equivalent Users are then assigned to other users, giving those 
users the same access privileges as the Equivalent Users. Before you can delete an 
Equivalent User, you must delete all references to the user. For information on 
Equivalent Users, see Restricting Access Using Equivalent Users. 

Please alert your System Administrator to contact Deltek support within the 
next xx days for a software extension. 
The license agreement on your software is about to expire. If the license expires, you will 
no longer be able to log in to MPM. Contact MPM Customer support for an extension. 

Project projectname has been suspended by username on DD-MMM-YY. 
Project projectname has been suspended by username on DD-MMM-YY 
HH:MM. 
A System Administrator or Project Administrator has turned off access to the project. 
This is usually done when maintenance is being performed on the project. Check with the 
individual named in the message to see when the project will be available. 

Resource Code x, Resource Department x and O/T x not found. 
You have typed an entry in one or more of the fields that is not in the database. Instead of 
typing in an entry, try selecting an entry from the drop-down list box in these fields. 

<Required> fields still exist which must be entered before record can be 
saved. 
In each window, there are one or more fields that you must complete before you can save 
the entry. The text <Required> is displayed in these fields. If the required field is not 
currently visible in the window, scroll the window horizontally. 
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Root directory files are not supported. 
You cannot store global ID files in a root directory (for example, C:\ ). Enter a path that 
includes at least one directory. For example: C:\PROJECTS. 

Save ETC as well as Baseline? 
MPM displays this message when you have selected the Prompt for ETC Save option in 
the Integrated Planning window. If you choose Yes, MPM makes an identical entry in the 
ETC view and links the two values. For information on setting this option, see topic 7.3.1  
Saving Estimates in the MPM Projects manual. 

The key you entered does not fit the lock. 
The key you entered is not registered. Contact Deltek MPM Support to check on the 
correct key. 

The maximum number of users are already logged into WinMPM. 
Wait a few minutes and try again. If the problem persists, contact your System 
Administrator. 

The Rate Table you are about to delete may be in use by one or more 
projects. You may access Project Maintenance for a complete list of 
projects which are using the xxxxxxxx global set.  Are you sure you want to 
delete this Rate Table? 
Rate tables are assigned to resources and burdens. They are part of a global set. If you 
delete a rate table, you should assign a new rate table to each resource and burden that 
used the deleted table. 

The Resource(s)/Burden(s) you are about to delete may be in use by one or 
more projects.  You may access Project Maintenance for a complete list of 
projects which are using the xxxxxxxx global set.  Are you sure you want to 
delete selected Resource(s)/Burden(s)? 
After you delete the selected Resource(s)/Burden(s), you can reprice the project for the 
WBS IDs affected to see the impact. 

The User List file (MPMUSERS.DAT) could not be found in drive:\directory 
The MPMUSERS.DAT file stores the user ID and password for each user. Have your 
System Administrator check to see if the file has accidentally been moved or corrupted. If 
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the file has been corrupted, the System Administrator will need to restore the file from 
backup.  

The xxxxxxxx global files are already open.  OK to reload data? 
If you choose Yes, then all data is refreshed and the cell focus is returned to Column 1 
Row 1 of the grid. You will lose any unsaved changes. 

If you choose No, the data is left alone and the focus is returned to where it was when 
you selected File|Open. 

The xxxxxxxx project is already open.  OK to reload data? 
If you choose Yes, then all data is refreshed and the cell focus is returned to Column 1 
Row 1 of the grid. You will lose any unsaved changes. 

If you choose No, the data is left alone and the focus is returned to where it was when 
you selected File|Open. 

The xxxxxxxx global files are already open. OK to reload data? 
If you choose Yes, then all data is refreshed and the cell focus is returned to Column 1 
Row 1 of the grid. You will lose any unsaved changes. 

If you choose No, the data is left alone and the focus is returned to where it was when 
you selected File|Open. 

The xxxxxxxx global files could not be found in drive:\directory\subdirectory 
This message is displayed when MPM cannot find one or more of the six global files 
(RATE.LIB, TEMPLATE.LIB, EOCCODES.LIB, RESOURCE.LIB, 
CALENDAR.HOL, or CALENDAR.FSC) in the specified location. Check the path. If 
the path is correct, the files may have been accidentally deleted. Check with your System 
Administrator about getting the files restored from the most recent backup. 

The xxxxxxxx Project WBS file could not be found in 
drive:\directory\subdirectory.  Press OK and select the directory containing this 
file. 
MPM expects to find the file in the same directory as the MPM executable file. Check 
with your System Administrator or Project Administrator for the location of the file. 
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The calendar for global set xxxxxxxx does not exist. Would you like to copy 
the calendar from another global set? 
This message is displayed when the CALENDAR.FSC file does not exist, or contains no 
records. If you choose Yes, MPM brings up the Copy Calendar dialog box where you can 
select a calendar from another Global set. If you choose No, MPM creates the 
CALENDAR.FSC and CALENDAR.HOL files and brings up the Setup dialog. 

The CLIN(s) will be removed from any WBSs using it. Are you sure you 
want to delete the selected CLIN(s)? 
CLIN(s) can be assigned to WBS elements in the Work Breakdown Structure window. If 
you delete a CLIN, the CLIN will be removed from the WBS elements. This will impact 
CLIN reports. You should assign new CLIN(s) to the WBS elements. 

The COC(s) you are about to delete may be in use by one or more 
resources. You may access Resources & Burdens to edit the resource(s) 
using the COC(s).  Are you sure you want to delete the COC(s)? 
After deleting the COC(s), go to the Resources tab in the Resources & Burdens window 
and assign new COC(s) to the resources. 

The EOC(s) you are about to delete may be in use by one or more 
resources or projects. Are you sure you want to delete the selected 
EOC(s)? 
After deleting the EOC(s), go to the Resources tab in the Resources & Burdens window 
and assign new EOC(s) to the resources. 

The number of allowable users has been exceeded and access shall be 
restricted. Please delete excess users. Your license allows <Number of 
users specified in the license> users. 
This message displays when the License Type is Named User and the Security window is 
closed while the total number of users exceeds the User Limit specified by the license. 

The number of allowable users has been exceeded. Your license allows 
<Number of users specified in the license> users. 
When the License Type is Named User and another user is added, the number of users 
exceeds the User Limit specified in the license. 
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The OBS for project projectname does not exist. Would you like to copy the 
OBS from another project? 
This message is displayed when an OBS does not exist for a project, or only the top level 
record exists. To build a new OBS, choose No. If you want to base the new OBS on an 
existing OBS, choose Yes. 

The operation cannot be completed because the Global Set is currently in 
use.  
One or more of the global files associated with the global set is being edited. The files 
are: CALENDAR.FSC, CALENDAR.HOL, EOCCODES.LIB, RATE.LIB, 
RESOURCE.LIB, TEMPLATE.LIB. Wait a few minutes and try the operation again. 

The operation cannot be completed because the Global Set is in use by one 
or more Project(s). 
Before you can perform the operation, you will have to assign a different global ID to the 
project(s) using the Project Maintenance window. 

The operation cannot be performed because there are users currently 
accessing Project projectname.  
Wait a few minutes and try the operation again. If the problem persists, contact your 
System Administrator for assistance. To find out who is accessing the project, check the 
MPMLOG. 

The Template(s) you are about to delete may be in use by one or more 
resources, OBS departments, or projects. Are you sure you want to delete 
the selected Template(s)? 
Deleting the burden templates will impact the calculated values. You should check all 
resources, OBS departments, and projects to see where the template is used and assign a 
different template. 

There are Global Files existing in this directory. Do you want to overwrite 
them? 
Check the path you entered. If the path is correct, and you want to overwrite the existing 
global files in the directory, choose Yes. To cancel the operation , choose No. 
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There are no projects to which you have been granted access. 
Check with the project or System Administrator. They can assign projects to you. 

There is insufficient disk space to recover these files: 
File     Size 
drive:\directory\filename x,xxx 
drive:\directory\filename x,xxx 
drive:\directory\filename x,xxx 
 
Space Required:  xx,xxx 
Space Available:    x,xxx 
 
Check with your System Administrator about increasing the available disk space. 

This actual (Resource Code, Resource Department and OT) already exists 
for this WBS element. 
You have typed an entry in the field that already exists. Type in a different entry. 

This actual has been changed by another user. The modification from the 
other user will now be displayed. 
Another user has edited the actual you are editing. Your changes will be lost and the 
actual created by the other user will be displayed on your grid. You can change the actual 
again if you wish. However, you should contact the other user before doing any more 
editing. 

This CLIN has been changed by another user. The modification from the 
other user will now be displayed. 
Another user has edited the CLIN you are editing. Your changes will be lost and the 
CLIN created by the other user will be displayed on your grid. You can change the CLIN 
again if you wish. However, you should contact the other user before doing any more 
editing. 

This estimate already exists in ETC as an apportioned estimate and cannot 
be overwritten. 
To change an apportioned estimate, you must change the base estimate from which it is 
calculated. To accept the estimate in the Baseline view, choose OK. 



MPM Projects   701 

This User is currently identified as a Feature or WBS Security Equivalence 
for another User ID.  
A user ID that is referenced as a Feature Equivalence cannot be assigned an authorization 
level other than User. 

This User is currently logged in from another machine.  
This error message displays when the License Type is Named User and a user that logs in 
to the system is already logged in from another machine. 

User ID or Password not valid. 
Ask your System Administrator to check your user ID and password. If necessary, the 
System Administrator can reset your password to “PASSWORD.” 

WBS must have a charge number in order to enter actuals. 
To assign a charge number to a WBS element, go the WBS window. 

Would you like to copy the Global Set from another Global ID? 
No global files exist at the path you specified. If you would like to base the new global 
set on existing files, choose Yes. If you want to build the files from scratch, choose No. 

x is not a valid Critical Float Threshold value. 
You have typed in a value that is not valid. Try selecting a value from the drop down list 
box. This will ensure a valid entry. 

x is not a valid Cost Element. 
You have typed in a value that is not valid. Try selecting a value from the drop down list 
box. This will ensure a valid entry. 

drive:\directory\filename does not exist. 
The path and file you have specified does not exist. If available, use the Browse function 
in the dialog box to locate the file. 

username is already logged into the system.  Do you wish to continue? 
If you continue, the user will be logged out and then back into the system. 
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You can only apply Fee or COM to Total Cost. 
Only Fee and Cost of Money (COM) can be applied to Total Cost. If the burden code is 
Fee or COM, you must select Total Cost in the Apply To column. 

You cannot apply Overhead to Total Burdened. 
If the burden code is Overhead, you cannot select Total Burdened in the Apply To 
column. 

You do not have access to this WBS Leg. 
– or -- 
You do not have access to WBS leg xxx. 
Check with your project or System Administrator about getting access to the WBS leg. 

You must first create a fiscal calendar. 
You have attempted to perform an action that requires a fiscal calendar. A fiscal calendar 
identifies the start of each accounting month. Check with your Project Administrator. To 
create a fiscal calendar, select the Calendar icon from the Globals window. 
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Appendix C: Summary of System Specifications 
The table below summarizes the system specifications. For additional information, check 
Appendix D: File Formats, or call Deltek MPM Support. 

Function Limitations 
All imports Cannot import data after year 2050 
Security 300 users 
Fiscal calendar 50 years; fiscal month cannot be less than two weeks nor more than 

eight weeks in length 
Holiday calendar 300 holidays 
Element of Cost 13 EOCs; 13 Classes of Cost per EOC 
Burden templates Limited by disk space available. Each template can have up to 10 

burden codes. 
Burden rates Unlimited 
WBS tree Unlimited 
Task description One per WBS ID. 100 lines of text per task description. 
OBS 498 children per department. 
Estimates 10 years. 100 per WBS ID, 72 months duration per estimate. 

Baseline + ETC cannot exceed 144 months. 
Spread curves 1,000 spread curves (10 default, 990 user-defined). 
Resource Basis of 
Estimate 

One per estimate. 100 lines of text per Resource BOE. 

Summary Basis of 
Estimate 

100 lines of text per Summary BOE. 

Plan milestones 99 Milestone IDs per WBS element. 
Program log 9,999 log entries 
Responsibility 
Assignment Report 

Will report a maximum of 500 OBS elements. 
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Function Limitations 
C/SSR & CPR 
Format 1 

Maximum of 250 elements at Level 2 and 250 elements of depth in 
WBS. 

CPR Format 2 Will report a maximum of 500 OBS elements. 
Project Comparison 
Report 

Maximum of 300 WBS children 

All reports Report Timeframe Max: 10 years in Month mode, 30 years in 
Quarter mode, 99 years in Year mode. 

1861 report 1,000 total Resources/Departments that use burden templates. 
DD1921 Maximum 50 elements at Level 2. 

 



MPM Projects   705 

Appendix D: MPM File Formats 
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D.1  Introduction to File Formats 

Your MPM software includes a mechanism that allows its licensed software users direct 

read access to proprietary data files.  This Read Access feature is designed to provide you 

with an easy method for extracting data from the MPM database without using a third 

party report writer. 

The MPM file formats are to be used for read-only access. You are urged not to attempt 

write access.  Writing directly to the MPM proprietary files is strictly forbidden and will 

constitute a violation of your Software License Agreement and Maintenance Agreement. 

The MPM file formats may change from time to time.  Although it is not anticipated that 

file formats will change with every release, Deltek reserves the right to do so.  Therefore, 

any programs you choose to develop that access these file formats may need to be 

modified when Deltek releases a new version of the MPM software. 

Data Storage Formats 

Data is stored in MPM system files in the following formats: 

Character Stored in ASCII characters (string). 

Integer Stored as two-byte binary numbers ranging from-32768 to 32767. 

Long Stored as four-byte binary numbers ranging from -2,147,483,648 

to 2,147,483,647. 

Single Stored as four-byte IEEE (Institute of Electrical and Electronic 

Engineers) format floating point numbers; accurate to seven 

digits. 

Double Stored as eight-byte IEEE format floating point numbers; 

accurate to 15 digits. 

System Use Data in fields designated System Use on the following tables 

could be any of the above.  These fields are used internally by the 

MPM system. 

In order to work with the MPM file formats, you must have a prerequisite knowledge of 

database access methodology. Deltek Customer Support does not provide instruction in 

this regard.   

To access MPM data files, you must have an SQL tool or report writer capable of 

accessing Btrieve files. 
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If you are a programmer and would like to write applications and/or reports, you must 

have the following: 

 A Btrieve programmer's manual and software. (Contact your software vendor or 

Novell Inc. for purchase information.) 

 A compiler (Basic, C, Pascal, Cobol, etc.) 
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D.2  Global File Formats 

Accessing Resource and Burden Rates: 

In MPM all resource rates and burden rates are stored in the RATE.LIB file.  This file 

contains all rate tables, resource rates and burden rates for a specific Global File ID. 

For example, assume you need to print a report that shows rates for Resource Code 

ENGR from Rate Table 001 from January 1991 through December 1992.  To do this, you 

must complete the following steps: 

1. Open the RATE.LIB File. 

2. Build the RATE record key: 

 Segment 1 = Resource Code  (ENGR) 

 Segment 2 = Rate Table ID  (001) 

 Segment 3 = Fiscal Year  (1991) 

3. Perform a GET GREATER THAN OR EQUAL operation on the RATE.LIB File 

using Key 0. 

4. DO UNTIL Resource Code <> ENGR or Rate Table ID <> 001 or Fiscal Year > 

1992. 

 For Month = 1 to 12: 

If Fiscal Year plus Month > December 1992 THEN exit 

[Print rate of month 

Perform a GET NEXT operation on the RATE.LIB File] 

5. Close the RATE.LIB File. 
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D.2  Global File Formats 

D.2.1  Element of Cost File Format 

MPM Global File Name:  EOCCODES.LIB 

File Type:  Btrieve 

Record Length:  387 Bytes 

Keys:  1 

Field Type * Length Description 

EOC C 1 Element of cost code 

Description C 20 Element of cost description 

EOC Classes C 3*13 Class of cost codes (1 - 13) 

System Use  6 System use 

EOC Class Descriptions C 20*13 Class of cost descriptions 

(1 - 13) 

System Use  40 System use 

EOC Hours/Units Flag C 1 Hours/units flag (H or U) 

System Use  20 System use 

* C = Character    D = Double    S = Single    I = Integer     L = Long 

Keys 

This file contains one key. This key contains no duplicates. 

 Key 0 = Element of Cost 
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D.2  Global File Formats 

D.2.2  Fiscal Calendar File Format 

MPM Global File Name:  CALENDAR.FSC 

File Type:  Btrieve 

Record Length:  21 Bytes 

Keys:  2 

Field Type * Length Description 

Fiscal Start L 4 Fiscal start date 

(YYYYMMDD) 

Fiscal Label C 5 Fiscal label (MMMYY) 

Fiscal Period L 4 Fiscal period (YYYYMM) 

Equivalent People D 8 Equivalent people 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains two keys. These keys contain no duplicates. 

 Key 0 = Fiscal Start 

 Key 1 = Fiscal Period 
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D.2  Global File Formats 

D.2.3  Global File Format 

MPM Global File Name:  GLOBAL.DAT   

File Type:  Btrieve 

Record Length:  280 Bytes 

Keys:  2 

Field Type * Length Description 

Global ID    C 8 Global ID 

Description  C 20 Description  

Path  C 242 Path where global files attached to this Global ID 

reside 

Release 

Number 

C 2 First character = major release number; second 

character = minor release number 

Week Type C 1 Type of week; used for posting weekly data. Select 

(W)hole Weeks or (P)artial Weeks 

Start Day of 

Week 

C 1 Start day of week; used for posting weekly data 

1 = Monday   4 = Thursday 6 = Saturday 

2 = Tuesday 5 = Friday 7 = Sunday 

3 = Wednesday 

Hours per 

Day 

S 4 Number of hours in a normal workday; used for 

posting weekly data 

System Use  2 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains two keys. These keys contain no duplicates. 

 Key 0: 

Segment 1 = Global ID 

 Key 1: 

Segment 1 = Path  
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D.2  Global File Formats 

D.2.4  Holiday Calendar File Format 

MPM Global File Name:  CALENDAR.HOL 

File Type:  Btrieve 

Record Length:  24 Bytes 

Keys:  1 

Field Type * Length Description 

Holiday 

Date 

L 4 Holiday date (YYYYMMDD) 

Holiday 

Description 

C 20 Holiday description 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one key.  This key contains no duplicates. 

 Key 0  = Holiday Date 
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D.2  Global File Formats 

D.2.5  Rate Library File Format 

MPM Global File Name:  RATE.LIB 

File Type:  Btrieve 

Record Length:  128 Bytes 

Keys:  2 

Field Type * Length Description 

Burden or 

Resource Code 

C 10 Burden code or resource code 

Rate Table ID C 20 Rate table identification 

Fiscal Year I 2 Fiscal year (YYYY) 

Rate D 8*12 Rate for calendar year (months 1 thru 12) 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains two segmented keys. Key 1 contains duplicates. 

 Key 0:  

Segment 1 = Burden/Resource Code 

Segment 2 = Rate Table ID  

Segment 3 = Fiscal Year  

 Key 1: 

Segment 1 = Rate Table ID 



714   Appendix D: MPM File Formats 

D.2  Global File Formats 

D.2.6  Resource Library File Format 

MPM Global File Name:  RESOURCE.LIB 

File Type:  Btrieve 

Record Length:  68 Bytes 

Keys:  1 

Field Type * Length Description 

Code C 10 Burden or resource code 

Type C 1 Resource type: (R)esource 

Burden type: (O)verhead, (G)&A, (C)ost of money, or 

(F)ee 

Description C 20 Resource or burden description 

Template ID C 20 Resource burden template identification; not applicable 

to burden codes 

Resource 

Class 

C 3 Resource class of cost; not applicable to burden codes 

EOC Code C 1 Resource element of cost; not applicable to burden 

codes 

Hours Per 

Day 

C 4 Hours per day; not applicable to burden codes 

Days Per 

Week 

C 1 Days per week; not applicable to burden codes 

System Use  8 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one key.  This key contains no duplicates. 

 Key 0  = Burden/Resource Code 
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D.2  Global File Formats 

D.2.7  Burden Template Library File Format 

MPM Global File Name:  TEMPLATE.LIB 

File Type:  Btrieve 

Record Length:  175 Bytes 

Keys:  1 

Field Type * Length Description 

Burden Template ID C 20 Burden template identification 

Burden Description 1 C 20 Burden template description 1 

Burden Description 2 C 20 Burden template description 2 

System Use  3 System use 

Burden Codes C 10*10 Burden Codes (1 - 10)  

Apply To Codes C 1*10 Apply to codes (1 - 10) 

System Use  2 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one key.  This key contains no duplicates. 

 Key 0  = Burden Template ID 
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D.3  Project File Formats 

Accessing Estimates 

The estimate data structure is made up of three files: the Resource Rollup Header File 

(projectnameU.RRH), the Resource Rollup Detail File (projectnameW.RRD) and the 

Weekly File (projectnameF.WRD). 

The Resource Rollup Header File contains all header information for each estimate or 

summary (i.e., WBS Key, Resource Code, Resource Department, EOC, COC, etc.).  Four 

types of records (as indicated by the (D)etail, (S)ummary, (E)OC, or (W)eekly flag) exist 

in this file: 

 Detail Records:  These records contain data for each WBS estimate by 

Resource Code, Resource Department, XREF-EST and Overtime Factor. 

 Summary Records:  These records contain the rolled up data by Resource 

Code, Resource Department, XREF-EST and Overtime Factor of all estimates in 

the WBS' children, grandchildren etc.  These records are updated only if the 

Summary Rollup Processing Flag is set to On Mode. 

 EOC Records:  These records contain the summary values by EOC of all 

estimates at and below the specified WBS ID.  These records are updated only if 

the EOC Rollup Processing Flag is set to On Mode. 

 Weekly Records: These records contain data by week for each WBS estimate 

by Resource Code, Resource Department and Overtime Factor. 

The Resource Rollup Detail File contains BCWS, ACWP, BCWP and ETC data in yearly 

records.  Using the Link Field in the RRH File, corresponding data can be accessed in the 

RRD file.  

The Weekly File contains BCWS, ACWP, BCWP and ETC data in weekly records. 

Using the Link Field in the RRH File, corresponding data can be accessed in the 

WRD file. 
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D.3  Project File Formats  

D.3.1  Audit Trail Documentation File Format 

MPM Project File Name:  projectnameG.Atx 

File Type:  Btrieve 

Record Length: 784 

Description: This file is used to document the text table that lists the changes done in a 

tabular format.  

Field Type * Length Description 

Audit Trail 

Record Link 
L 4 Link to Audit Trail Record 

Description C 780 User provided Estimate change Description 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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D.3  Project File Formats  

D.3.2  Audit Trail File Format 

MPM Project File Name:  projectnameC.Aud 

File Type:  Btrieve 

Record Length: 232 

Description: This file is used to store the audit log for every estimate change that occurs. 

It tracks the information by WBS, by Resource or by Resource Dept. It also tracks who 

made what changes to which data in the system. 

Field Type * Length Description 

RecNum L 4 Record Number 

User ID C 9 User ID 

Date Modified C 8 Date Modified (  YYMMDD). 

(Value is padded with two blanks at 

the beginning) 

Time Modified C 12 Time Modified  

(HH:MM:SS) 

System Use  1 System Use 

Operation Type I 2 Operation Type – 

0 – Audit Trail On 

1 – Audit Delete         

2 – Integrated Planning Edit 

3 – Integrated Planning Add         

4 – Integrated Planning Delete 

5 – Apportioned Estimate Edit           

6 – Apportioned Estimate Add 

7 – Apportioned Estimate Delete       

8 – Import Estimate 

9 – Import WBS Schedule  

10 – Import Distributed Project 

11 – Reprice              

12 – Estimate Adjust 

13 – Project Date Shift    

14 – Estimate Rename 

15 – Project Replan         

16 – Delete Project Data 

17 – Base Estimate Edit     

18 – Base Estimate Delete 

19 – Audit Trail Off 
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Field Type * Length Description 

Record Type I 2 Record Type –  

0 – Baseline                

1 -  ETC 

99 - Audit 

WBSId C 40 Estimate WBSID 

Resource Code C 10 Estimate Resource Code 

Resource Dept C 10 Estimate Resource Dept 

Overtime C 20 Estimate Overtime 

Start Date C 8 Estimate Start Date (  YYMMDD) 

(Value is padded with two blanks at 

the beginning) 

End Date C 8 Estimate End Date (  YYMMDD) 

(Value is padded with two blanks at 

the beginning) 

Rate Table C 20 Estimate Rate Table 

BurdenTemplate C 20 Estimate Burden Template 

Estimate Type I 2 Estimate Type – 

0 – Std Hours               

1 – Hours 

2 – Units                      

3 – EQP 

4 – Prime                     

5 – Total Burden 

6 – Total Cost               

7 – Total Dollars 

8 – Total Price 

Before At Complete 

Hours 
D 8 Before At Complete Hours 

Before At Complete 

Dollars 
D 8 Before At Complete Dollars 

After At Complete 

Hours 

D 8 After At Complete Hours 

After At Complete 

Dollars 

D 8 After At Complete Dollars 

Delta Hours D 8 Delta Hours (Before – After) 

Delta Dollars D 8 Delta Dollars (Before – After) 
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Field Type * Length Description 

Dollar Type I 2 Dollar Type – 

0 – Prime                     

1 – Total Burden 

2 – Total Cost               

3 – Total Dollars 

4 – Total Price 

System Use  2 System Use 

Audit Description 

Record Link 
L 4 Link to Audit Trail Description 

table 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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D.3  Project File Formats  

D.3.3  Basis of Estimate File Format 

MPM Project File Name:  projectnameE.BOE 

File Type:  Btrieve 

Record Length:  826 Bytes 

Keys:  1 

Field Type * Length Description 

WBS Key L 4 Unique WBS key  

Resource Dept C 10  Resource department 

Resource Code C 10 Resource code 

Overtime Factor C  20 Overtime factor 

BOE Sequence C 2 Basis of estimate record sequence (01-10).  

Record sequence field – for each BOE there is a 

record for every 10 lines of text the record 

sequence field identifies the records 1-10 for each 

BOE. 

BOE Text C 780 Basis of estimate text; this field contains 10 lines 

of 78 characters associated with this BOE. 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = WBS Key 

Segment 2 = Resource Department 

Segment 3 = Resource Code 

Segment 4 = Overtime Factor 

Segment 5 = BOE sequence 
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D.3  Project File Formats  

D.3.4  BCWP File Format  

MPM Project File Name:  projectnameI.BWP 

File Type:  Btrieve 

Record Length:  28 Bytes 

Keys:   1 

Field Type * Length Description 

WBS Key     L 4 WBS element to which the BCWP applies 

Month/Year L 6 BCWP for the month and year (YYYYMM) 

Percent Complete D 8 BCWP percent complete as of the month and year 

specified 

Total BCWP        D 8 Cumulative BCWP dollars as of the month and 

year specified 

System Use  2 System Use 

 * C = Character    D = Double    S = Single    L = Long Integer 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = WBS Key 

Segment 2 = Month/Year 
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D.3  Project File Formats  

D.3.5  CLIN File Format 

MPM Project File Name:  projectnameR.CLN 

File Type:  Btrieve 

Record Length:  255 Bytes 

Keys:  None 

Field Type * Length Description 

System Use  1 System use 

ID C 8 CLIN identification 

Description C 40 CLIN description 

Qty C 8 Quantity to be contracted 

Reference C 5 Reference code 

Element C 6 Element code 

1411 Flag C 1 Include on SF1411 flag 

1921 Flag C 1 Include on DD1921 flag 

System Use  185 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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D.3  Project File Formats  

D.3.6  Distributed Transfer File Format 

MPM Project File Name:  filename.XFR 

File Type:  Random 

Record Length:  1,675 Bytes 

Keys:   

WBS RECORD 

Field Type * Length Description 

Record Type C 1 WBS record type (W) 

Source Project C  20  From project name 

Target Project C  20 To project name 

Source WBS ID C 40 From WBS ID 

Target WBS ID C 40 To WBS ID  

Early Start Date L 4 WBS early start date  (YYYYMMDD) 

Early End Date L 4 WBS early finish date  (YYYYMMDD) 

Sched Start Date L 4 WBS scheduled start date (YYYYMMDD) 

Sched End Date L 4 WBS scheduled finish date  (YYYYMMDD) 

Late Start Date L 4 WBS late start date  (YYYYMMDD) 

Late End Date L 4 WBS late finish date  (YYYYMMDD) 

ETC Start Date L 4 WBS ETC start date (YYYYMMDD) 

ETC End Date L 4 WBS ETC finish date (YYYYMMDD) 

Conversion Factor 

(Export) 

C 10 Export conversion factor (optional) 

Conversion Factor 

(Import) 

C 10 Import conversion factor (optional) 

System Use              1502 System use                          
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MILESTONE RECORD 

Field Type * Length Description 

Record Type C 1 Milestone Record type  (M) 

WBS Key        L  4  WBS unique key  

Milestone ID   C 10 Milestone identifier 

System Use  2 System Use 

Milestone Symbol C 1 Milestone symbol used (1-9, A or B) 

Milestone Description C 40 Milestone description  

Milestone Weight C 8 Milestone weight  

Milestone Schedule Date L 4 Milestone schedule date (YYYYMMDD) 

Milestone Forecast Date L 4 Milestone forecast date (YYYYMMDD) 

Milestone Complete Flag   C 1 Milestone complete flag (Y or N) 

Milestone Percent 

Complete 

C 3 Milestone percent complete (1-100) 

System Use  1556 System use 

 
DISTRIBUTED ROLLUP RECORD 

Field Type * Length Description 

Transfer Type C 1 Distributed transfer type I 

Record Type C 1 Record type: 

  BCW(S)     BCW(P)   

  (A)CWP    (E)TC 

Year I  2 Year for the record 

Detail Subrecords  107*15 See description of detail sub-record below 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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Detail Subrecord 

Field Type * Length Description 

Cost Element C 1 Cost element: 

 (S)td hours      

(G)&A 

 (H)rs/units      

(O)verhead 

 (E)quiv people    

(F)ee 

 (P)rime          

(C)ost of money 

Burden Code C 10 Burden Code 

Monthly Values D 8*12 Monthly values (January through December) 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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D.3  Project File Formats  

D.3.7  Header File Format 

MPM Project File Name:  projectnameT.HED 

File Type:  Btrieve 

Record Length:  84 Bytes 

Keys:  1 

Field Type * Length Description 

Header Key  I 2 Header key value (see table of header key 

values below) 

Header Text  C 80 Header text 

Header Length I 2 Header length 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = Header Key  

KEY 

VALUE 

Type Length Description 

CPR FORMATS 1 & 2: 

100 String 18 Contract Name 

101 String 21 Contractor Name 

102 String 18 Contract Number 

103 String 7 Contract Type 

104 String 18 Program Name 

105 String 1 R&D Prod (R or P) 

106 String 18 Program Number 

107 String 24 Location 

108 String 6 From 

109 String 6 To 
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KEY 

VALUE 

Type Length Description 

110 String 16 Approval Name  

111 String 16 Title 

112 String 6 Date 

113 String 1 G&A Add/Non-Add (A or N) 

114 String 8 Security Class 

115 String 1 Format 1 

116 String 1 Format 2O 

117 String 1 Format 2L 

118 String 8 Quantity 

119 String 4 Target Profit % 

120 String 4 Target Fee 

121 Double  Target Price Override 

122 Double  Estimated Price Override 

123 String 6 Share Ratio 

124 String 8 Contract Ceiling 

125 String 8 Estimate Ceiling 

126 Double  Negotiated Cost 

127 Double  Negotiated Cost Override 

128 String 7 Distributed Filter Flags 

129 Double  Target Profit Amount Override 

130 String 1 MEAC Best Case Option 

131 String 1 MEAC Worst Case Option 

132 String 1 MEAC Most Likely Option 

133 String 5 MEAC Gate Month 

134 String 5 Cum Through Month 

135 String 1 MEAC Option (C/SSR) 

201 Double  Authorized Unpriced 
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KEY 

VALUE 

Type Length Description 

202 Double  Authorized Unpriced Override 

203 Double  Management Reserve  

204 Double  Management Reserve Override 

205 Double  Management Reserve LRE 

206 Double  Management Reserve LRE Override 

207 Double  Monthly COM BCWS 

208 Double  Monthly COM BCWP 

209 Double  Monthly COM ACWP 

210 Double  Cumulative COM BCWS 

211 Double  Cumulative COM BCWP 

212 Double  Cumulative COM ACWP 

213 Double  Undistributed Budget – Format 1 

214 Double  Undistributed Budget Override – Format 1 

215 Double  Undistributed Budget LRE – Format 1 

216 Double  Undistributed Budget LRE Override – Format 1 

217 Double  Undistributed Budget – Format 2 

218 Double  Undistributed Budget Override – Format 2 

219 Double  Undistributed Budget LRE – Format 2 

220 Double  Undistributed Budget LRE Override – Format 2 

221 Double  Original Contract Target 

222 Double  Negotiated Contract Change 

223 Double  Negotiated Contract Change Override 

224 Double  Current Target Cost 

225 Double  Current Target Override 

226 Double  Contract Budget Base 

227 Double  Contract Budget Base Override 

228 Double  Total Allocated Budget 

229 Double  LRE COM At Complete 
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KEY 

VALUE 

Type Length Description 

230 Double  Budget COM At Completion 

231 Double  Contract Baseline Log COM Balance 

240 Double  MEAC Best Case Computed 

241 Double  MEAC Worst Case Computed 

242 Double  MEAC Most Likely Computed 

243 Double  MEAC Best Case Override 

244 Double  MEAC Worst Case Override 

245 Double  MEAC Best Case Override 

246 Double  MEAC Computed (C/SSR) 

247 Double  MEAC Override (C/SSR) 

CPR FORMATS 3 & 4: 

301 Double  Total Allocated Budget Override 

302 String 6 Contract Start Date (YYMMDD) 

303 String 6 Contract Definition Date (YYMMDD) 

304 String 6 Last Item Completion Date (YYMMDD) 

305 String 6 Contract Completion Date (YYMMDD) 

306 String 6 Estimated Completion Date (YYMMDD) 

307 String 5 Monthly Variance Threshold – Percent 

308 String 8 Monthly Variance Threshold – Dollar 

309 String 5 Cumulative Variance Threshold – Percent 

310 String 8 Cumulative Variance Threshold – Dollar 

311 String 5 Estimate At Completion Variance Threshold – Percent 

312 String 8 Estimate At Completion Variance Threshold – Dollar 

313 String 8 Management Reserve Monthly Amount 

314 String 45 Management Reserve Log Line Numbers 

315 String 8 Baseline Change Monthly Amount 

316 String 45 Program Baseline Log Line Numbers 
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KEY 

VALUE 

Type Length Description 

317 String 5 Format ¾ Specific Periods (Y, S, Q or M) 

318 Double  Target Cost 

319 String 1 Network Processor Fixed Turnaround Flag (E or F) 

320 String 6 Network Processor Fixed Turnaround End Date 

(YYMMDD) 

321 String 1 Lag Days Per Week 

CPR FORMAT 3 & NASA: 

401 Double  Previous Month Cumulative BCWS 

402 Double  Previous Month Undistributed Budget 

403 Double  Previous Month At Completion 

404 String 4 Starting Month (YYMM) 

405 Double + 7 BCWS for First Seven Months 

412 String 21 NASA Installation 

413 String 24 Location of Installation 

414 String 18 Latest Amendment Number 

415 Double  NASA Contract Cost 

416 Double  NASA Contract Fee 

417 Double  NASA Fund Limitation 

418 Double  Amounts Billed to NASA 

419 Double  Total Payments Received 

420 String 2 NASA 533-M Report Detail Periods 

501 Double + 30 BCWS Amounts 

601 Double + 30 BCWS Amounts 

COST OF MONEY OVERRIDE: 

701 String 6 Overhead 1 

702 String 8 Overhead 1 COM 

703 String 6 Overhead 2 

704 String 8 Overhead 2 COM 
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KEY 

VALUE 

Type Length Description 

705 String  6 Overhead 3 

706 String  8 Overhead 3 COM 

707 String 6 Overhead 4 

708 String 8 Overhead 4 COM 

709 String 6 Overhead 5 

710 String 8 Overhead 5 COM 

711 String 8 Material COM 

712 String 8 G&A COM 

713 String 8 Total cost COM 

714 String 5 L C COM 

715 String 8 Current Period BCWS Computed 

716 String 8 Current Period BCWP Computed 

717 String 8 Current Period ACWP Computed 

718  String 8 Cumulative BCWS Computed 

719 String 8 Cumulative BCWP Computed 

720 String 8 Cumulative ACWP Computed 

721 String 8 At Complete Budget Computed 

722 String 8 At Complete LRE Computed 

PROJECT INITIATION: 

801 String 40 Company Name 

802 String 40 Program Name 

803 String 20 Proposal Number 

804 String 20 Contract Number 

805 String 20 Internal ID 

806 String 5 Program Type 

807 String 5 Contract Type 

808 String 20 Program Manager 
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KEY 

VALUE 

Type Length Description 

809 String 12 Program Manager’s Telephone Number 

810 String 20 Proposal Manager 

811 String 12 Proposal Manager’s Telephone Number 

812 String 20 Baseline Rate Table ID 

813 String 20 ETC Rate Table ID 

814 String 1 Calendar Type (R, W or E) 

815 String 7 Xref-1 Label 

816 String 7 Xref-2 Label 

817 String 7 Xref-3 Label 

818 String 1 Fee Application (W or R) 

819 String 20 ACWP Rate Table ID 

820 String 1 Burden Template Override 

821 String 1 Rate Table Override 

822 String 7 Xref-4 Label 

823 String 7 Xref-5 Label 

824 String 7 Xref-6 Label 

825 String 7 Xref-7 Label 

826 String 7 Xref-8 Label 

827 String 7 Xref-9 Label 

828 String 7 Xref-10 Label 

3001 String 80 Project Description 

3002 String 80 Project Description 

3003 String 80 Project Description 

3004 String 80 Project Description 

3005 String 80 Project Description 

3006 String  50 Project Description  

SF 1411 HEADER: 

901 String 22 Solicitation/Contract Number 
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KEY 

VALUE 

Type Length Description 

902 String 33 Offeror Address 1 

903 String 33 Offeror Address 2 

904 String 33 Offeror Address 3 

905 String 33 Offeror Address 4 

906 String 25 Offeror Contact 1 

907 String 25 Offeror Contact 2 

908 String 17 Contact Telephone Number 

1001 String 60 Place/Period of Performance 1 

1002 String 60 Place/Period of Performance 2 

1003 String 37 Contract Administrator’s Office 1 

1004 String 37 Contract Administrator’s Office 2 

1005 String 37 Contract Administrator’s Office 3 

1101 String 37 Contract Administrator’s Office 4 

1102 String 37 Audit Office 1 

1103 String 37 Audit Office 2 

1104 String 37 Audit Office 3 

1105 String 37 Audit Office 4 

1106 String 2 Type of Contract Action 

1107 String 20 Contract Action Description 

1108 String 1 Type of Contract 

1109 String 20 Type of Contract Description 

1201 String 11 Proposed Cost 

1202 String 11 Proposed Profit/Fee 

1203 String 11 Proposed Total 

1204 String 1 Use of Government Property (Y or N) 

1205 String 20 Government Property Description 1 

1206 String 20 Government Property Description 2 
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KEY 

VALUE 

Type Length Description 

1207 String 1 Government Financing (Y or N) 

1208 String 1 Type of Government Financing (A, P or G) 

1209 String 1 Any Contracts Awarded (Y or N) 

1210 String 30 Awarded Contract Description 1 

1211 String 30 Awarded Contract Description 2 

1212 String 30 Awarded Contract Description 3 

1213 String 30 Awarded Contract Description 4 

1214 String 1 Proposal/Contract Consistent (Y or N) 

1215 String 30 Proposal/Contract Consistent Description 1 

1301 String 30 Proposal/Contract Consistent Description 2 

1302 String 30 Proposal/Contract Consistent Description 3 

1303 String 30 Proposal/Contract Consistent Description 4 

1304 String 1 Subject to CASB Regulations (Y or N) 

1305 String 1 Submitted a CASB Disclosure Statement (Y or N) 

1306 String 1 Compliance with Standards (Y or N) 

1307 String 1 Consistent with Practices (Y or N) 

1308 String 35 Name and Title 1 

1309 String 35 Name and Title 2 

1310 String 35 Firm Name 1 

1311 String 35 Firm Name 2 

1312 String 6 Date of Submission 

DD1921 AND ROLLUP TOGGLE INFORMATION: 

1401 String 21 Contractor 

1402 String 24 Location 

1403 String 18 Program Name 

1404 Double  Target Profit 

1405 Double  Contract Price 

1406 Double  Contract Ceiling 
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KEY 

VALUE 

Type Length Description 

1407 String 7 Contract Type 

1408 String 16 Contact Name 

1409 String 15 Customer Name 

1410 String 1 Contract/RFP/Program Estimate (C, R or P) 

1411 String 1 R&D/Production Contract (R or P) 

1412 String 1 Multiple Year Contract (Y or N) 

1413 String 1 Prime/Subcontractor (P or S) 

1414 String 6 Fiscal Year Funded 

1415 String 1 EOC Rollup Toggle Switch 

1416 String 10 EOC Rollup Turned Off Date  

1417 String 8 EOC Rollup Turned Off Time  

1418 String 8 EOC Rollup Turned Off User Name 

1419 String 1 Pending Transactions (Y or N) 

1420 String 1 Summary Rollup Toggle Switch 

1421 String 10 Summary Rollup Turned Off Date 

1422 String 8 Summary Rollup Turned Off Time 

1423 String 8 Summary Rollup Turned Off User Name 

DD 1861: 

1601 String 4 S Date 

1602 String 4 F Date 

1603 String 7 Land Percent 

1604 String 7 Building Percent 

1605 String 7 Equipment Percent 

1606 String 7 Treasury Rate 

1607 String 7 RFP/Contract PIIN No 

1701 Double  Adj Sched 

1702 Double  Adj Cost 
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KEY 

VALUE 

Type Length Description 

1703 Double  Tot Sched 

1704 Double  Tot Cost 

1705 Double  At Complete BAC 

1706 Double  At Complete LRE 
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D.3  Project File Formats  

D.3.8  Milestone File Format 

MPM Project File Name:  projectnameA.MIL 

File Type:  Btrieve 

Record Length:  90 Bytes 

Keys:  2 

Field Type * Length Description 

System Use   6 System use  

Milestone ID C 10 Milestone identification 

System Use  2 System Use 

Milestone Symbol C 1 Milestone symbol 

Milestone Description C 40 Milestone description 

Milestone Weight C 8 Milestone weight 

Milestone Schedule Date L 4 Schedule date 

Milestone Forecast Date L 4 Forecast date 

Milestone Complete Flag C 1 Milestone complete flag (Y or N) 

Milestone Weight Pct Compl C 3 Weight percent complete (0-100) 

WBS Key L 4 WBS Key 

System Use   7 System use 

*  C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains two keys.  These keys contain no duplicates. 

 Key 0: 

Segment 1 =  WBS Key 

Segment 2 =  Schedule Date 

 Key 1: 

Segment 1 = Milestone ID 
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D.3  Project File Formats  

D.3.9  Organization Breakdown Structure (OBS) File 
Format 

MPM Project File Name:  projectnameB.OBS 

File Type:  Btrieve 

Record Length:  92 Bytes 

Keys:  3 

Field Type * Length Description 

OBS Department ID C 10 Department identification 

Performing parent C 10 Parent for OBS department identification 

(Performing) 

Responsible parent C 10 Parent for OBS department identification 

(Responsible) 

Department ID desc C 20   Department identification description 

Department Manager C 20 Department manager 

Burden Template ID C 20 Burden template ID for department 

System Use  2 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains three keys.  These keys contain no duplicates. 

 Key 0 = OBS Department ID 

 Key 1: 

Segment 1 = Performing Parent 

Segment 2 = OBS Department ID 

 Key 2: 

Segment 1 = Responsible Parent 

Segment 2 = OBS Department ID 
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D.3  Project File Formats  

D.3.10  Program Log File Format 

MPM Project File Name:  projectnameQ.LOG 

File Type:  Btrieve 

Record Length:  250 Bytes 

Keys: 1 

Field Type * Length Description 

Log Record ID I 2 Log entry number 

Transaction Date C 6 Transaction date (YYMMDD) 

Change Reference C 10 Customer change reference 

Internal Reference C 10 Internal reference 

Negotiated Contract 

Change 

D 8 Negotiated contract change 

Authorized Unpriced 

Amount 

 D  8 Authorized unpriced amount 

G&A D 8 General and administrative amount 

COM D 8 Cost of money amount 

Management Reserve D 8 Management reserve amount 

Prime Dollars D 8 Prime dollars amount 

Undistributed Budget D 8 Undistributed budget amount 

System Use  2 System use 

Total Overhead D 8 Total overhead 

Undistributed budget 

Desc 

C 60 Undistributed budget description 

Mgmt Reserve Budget 

Desc 

C 60 Management reserve budget description 

Total Burden D 8 Total burden amount 

Total Cost D 8 Total cost amount 

Total Dollars D 8 Total dollars amount 

System Use  12 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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Keys 

Each Record Number correlates to a specific Log Entry Number (Log Entry Number = 

Record Number). 

Log Entry Number 1 is Project Totals. 

This file contains one key. This key contains no duplicates. 

 Key 0: 

Segment 1 = Log Entry Number 
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D.3  Project File Formats  

D.3.11  Project File Format 

MPM File Name:  PROJ.DAT 

File Type:  Btrieve 

Record Length:  984 Bytes 

Keys:  5 

This file is used to store both the Project Names and Users attached to each project.  

There are two record types: 

Project Records: These records store the project related data. 

User Records:  These records store the user information related to each project. 

Project Record Type: 

Field Type * Length Description 

User ID C 8 User ID 

Project ID C 20 Project ID 

System Use   16 System Use 

Path C  242 Subdirectory where the project attached to this 

Project ID resides 

System Use  C   118 System Use 

Project Notes C 450 Long description of the project.  Note: Same as the 

Project Description key value in the Header file 

format (.HED file) 

System Use C 82 System Use 

Global ID C 8 Global File ID of the global files used for the project 

Description C 40 Description of the project 

Note:  Same as the Program Name field in the 

Header file format (.HED file) 

 

User Record Type: 

Field Type * Length Description 

User ID C 8 User ID 
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Field Type * Length Description 

Project ID C 20 Project ID 

Date Modified C 8 The date the User ID record was last modified 

(YYYYMMDD) 

Modified By C 8 User ID of the individual who made the last 

modification 

System Use  C 360 System Use  

Project Notes C 450 Long description of the project.  Note: Same as the 

Project Description key value in the Header file 

format (.HED file) 

System Use C 66 System Use 

Functional 

Equivalence 

C 8 Functional Security Equivalence ID 

WBS Security 

Equivalence 

C 8 WBS Security Equivalence 

Global ID  C 8 Global File ID of the global files used for the 

project 

Description C 40 Description of the project 
Note:  Same as the Program Name field in the 

Header file format (.HED file) 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains five keys.  These keys contain no duplicates. 

 Key 0: 

Segment 1 = User ID* 

Segment 2 = Project ID 

 Key 1: 

Segment 1 = Project ID 

Segment 2 = User ID  
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 Key 2: 

Segment 1 = Functional Equivalence  

Segment 2 = Project ID 

 Key 3: 

Segment 1 = WBS Security Equivalence 

Segment 2 = Project ID 

 Key 4: 

Segment 1 = Global ID 

Segment 2 = Project ID 

 

* In order to access a specific project record, you must populate the User ID segment 

with "********" and the Project ID segment with the project name if you are using Key 

0 to access the project record. 
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D.3  Project File Formats  

D.3.12  Resource Rollup (Detail) And File Format 

MPM Project File Name: projectnameW.RRD 

File Type: Btrieve 

Record Length:  1,612 Bytes 

Keys: 1 

Field Type * Length Description 

Header Link L 4 Link to header record in RRH file 

Record Type C 1 Record type: 

  BCW(S)     BCW(P)   

  (A)CWP    (E)TC 

Year I  2 Year for the record 

Detail 

Subrecords 

 107*15 See description of detail subrecord 

below 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0:                   

Segment 1 = Header Link 

Segment 2 = Record Type 

Segment 3 = Year 

Detail Subrecord 

Field Type * Length Description 

Cost Element C 1 Cost element: 

(S)td hours     (G)&A 

(H)rs/units     (O)verhead 

(E)quiv people   (F)ee 

(P)rime         (C)ost of money 

Burden Code C 10 Burden Code 

Monthly Values D 8*12 Monthly values (January through December) 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 
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D.3  Project File Formats  

D.3.13  Resource Rollup Header File Format 

MPM Project File Name:  projectnameU.RRH 

File Type:  Btrieve 

Record Length:  242 Bytes 

Keys:   4 

Field Type * Length Description 

WBS Key L 4 WBS key 

Element of Cost C 1 Element of cost code 

Class of Cost C  3 Class of cost code 

Resource Code C 10 Resource code 

Resource Dept C 10 Resource department (for burdening 

template) 

Overtime Factor C 20 Overtime factor 

Detail/Summary/EOC/ 

Weekly Flag 

C 1 Detail/summary/EOC/Weekly flag (D, 

S, E or W) 

BCWS Start Date L 4 Baseline start date 

BCWS End Date L 4 Baseline end date 

ETC Start Date L 4 ETC start date 

ETC End Date L 4 ETC end date 

BCWS Estimate Type C 1  

ETC Estimate Type C 1  

BCWS Spread Curve C 3  

ETC Spread Curve C 3  

BCWS Spread Curve 

Amount 

D 8  

ETC Spread Curve 

Amount 

D 8  

BCWS Efficiency 

Percent  

I 2  

ETC Efficiency I 2  
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Field Type * Length Description 

Percent 

BCWS Scrap & 

Rework Percent 

I 2  

ETC Scrap & Rework 

Percent 

I 2  

Detail Record Link L 4 Link to detail records  

System Use  1 System use 

BCWS Apport Est 

Flag 

C 1 BCWS apportion estimate flag 

BCWS Apport Est 

Link 

L 4 BCWS apportion estimate link 

BCWS Apport Est Pct D 8 BCWS apportion estimate percent 

BCWS Burd Temp C 20 BCWS burden template 

ETC Apport Est Flag C 1 ETC apportion estimate flag 

ETC App Est Link L 4 ETC apportion estimate link 

ETC App Est Pct D 8 ETC apportion estimate percent 

ETC Burd Temp C 20 ETC burden template 

SrateTbl C 20 BCWS rate table 

ErateTbl C 20 ETC rate table 

System Use C 14 System use 

XREF-EST C 20 XREF Estimate (optional field) 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains four keys.  Key 0 and Key 3 do not contain duplicates. 

 Key 0:  

Segment 1 = WBS Key (Long) 

Segment 2 = Resource Code 

Segment 3 = Resource Department 

Segment 4 = Overtime Factor 

Segment 5 = Detail/Summary/EOC Flag 

Segment 6 = XREF-EST 
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 Key 1: 

Segment 1 = WBS Key (Long) 

Segment 2 = Element of Cost Code 

Segment 3 = Class of Cost Code  

Segment 4 = Resource Code 

 Key 2: 

Segment 1 = Resource Department 

Segment 2 = Element of Cost Code 

Segment 3 = Class of Cost Code  

Segment 4 = Resource Code 

 Key 3:  

Segment 1 = Detail Record Link 
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D.3  Project File Formats  

D.3.14  User WBS Restrictions File Format 

MPM Project File Name:  projectnameN.USR 

File Type:  Btrieve 

Record Length:  48 Bytes 

Keys:  1 

Field Type * Length Description 

User ID C  8 User ID                     

WBS ID C 40 WBS ID                      

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = User ID  

Segment 2 = WBS ID 
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D.3  Project File Formats  

D.3.15  Weekly File Format  

MPM Project File Name:  projectnameF.WRD 

File Type:  Btrieve 

Record Length:  18 Bytes 

Keys:   1 

Field Type * Length Description 

Header Link     L 4 Link to header record in RRH file. 

Record Type C 1 Record Type: BCW(S), BCW(P), (A)CWP, 

(E)TC. 

Date L 4 Week Date (starting date) in YYYYMMDD 

format (for example, 20021231) 

Cost Element C 1 Cost Element: (S)td Hours, (H)ours/Units, (E)quiv 

People, (P)rime, (G)&A, (O)verhead, (F)ee, (C)ost 

of Money. 

Value D 8 Weekly value. 

 * C = Character    D = Double    S = Single    L = Long Integer 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = Header Link 

Segment 2 = Record Type 

Segment 3 = Cost Element 

Segment 4 = Date 
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D.3  Project File Formats  

D.3.16  Work Breakdown Structure (WBS) File Format 

File Name:  projectnameP.WBS 

File Type:  Btrieve 

Record Length:  619 Bytes 

Keys:  4 

Field Type * Length Description 

System Use  1 System use  

ID C 40 WBS identification 

Description C 100 WBS description 

System Use  2 System use 

Xref Field 1 C 20 WBS cross-reference 1 

Xref Field 2 C 20 WBS cross-reference 2 

Xref Field 3 C 20 WBS cross-reference 3 

Xref Field 4 C 20 WBS cross-reference 4 

Xref Field 5 C 20 WBS cross-reference 5 

Xref Field 6 C 20 WBS cross-reference 6 

Xref Field 7 C 20 WBS cross-reference 7 

Xref Field 8 C 20 WBS cross-reference 8 

Xref Field 9 C 20 WBS cross-reference 9 

Xref Field 10 C 20 WBS cross-reference 10 

System Use  4 System use 

Charge Number C 20 Accounting charge 

number 

Earned Value Code C 1 WBS earned value method (1-9, P or K) 

Performing Dept C 10 WBS performing department 

Responsible Dept C 10 WBS responsible department 

Network Flag C 1 Critical path flag for network processor 

* = On critical path 
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Field Type * Length Description 

Alias ID C 20 Alternate WBS alias name 

CLIN C 8 WBS contract line item reference label 

Manager C 20 WBS manager reference field 

System Use  1 System use 

System Use  2 System use 

System Use  2 System use 

WBS Element Type C 1 C = Control account 

W = Work Package 

P = Planning Package 

O = Other Package 

Early Start Date L 4 Early start date  (YYYYMMDD) 

Early Finish Date L 4 Early finish date  (YYYYMMDD) 

Scheduled Start L 4 Scheduled start date  (YYYYMMDD) 

Scheduled End L 4 Scheduled end date  (YYYYMMDD) 

Late Start Date L 4 Late start date (YYYYMMDD) 

Late Finish Date L 4 Late finish date  (YYYYMMDD) 

Last AS OF Date L 4 Last AS OF date (YYYYMMDD)   

System Use  6 System use 

System Use  1 System use 

System Use  2 System use 

System Use  1 System use 

System Use  2 System use 

Tech Pct Complete I 2 Technical percent complete.  Used in NASA 

533-P Report. 

ETC Start Date L 4 Estimate to complete start date 

(YYYYMMDD) 

ETC End Date L 4 Estimate to complete end date 

(YYYYMMDD) 
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Field Type * Length Description 

System Use   8 System use 

Parent ID C 40 WBS parent identification 

Revision Letter Date L 4 Revision letter date (YYYYMMDD) 

Scheduled Ref Date L 4 Scheduled reference date (YYYYMMDD) 

Recurring Flag C 1 Recurring/Non-recurring flag (R or N) 

Fee Percentage S 4 WBS fee percentage 

Fee Limit Amount D 8 WBS fee limit amount 

System Use   1 System use 

System Use   1 System use 

BCWP Flag S 1 BGWP Flag 

System Use   6 System use 

System Use   1 System use 

BCWP Base  C 1 WBS BCWP Base in: 

H = Hours/Units  

P = Prime  

B = Total Burdened  

C = Total Cost  

D = Total Dollars 

WBS Key L 4 WBS unique key 

Parent L 4 Parent's WBS key 

System Use  4 System use 

System Use  4 System use 

Sequence L 4 Value identifying the relationship of a WBS 

to its siblings (i.e., sort order). 

WBS Level I 2 WBS level 

System Use  4 System use 

Apport Base ID L 4 Apportioned base WBS key 

System Use  16 System use 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 



754   Appendix D: MPM File Formats 

Keys 

This file contains four keys.  Only Key 3 may contain duplicates. 

 Key 0:   

Segment 1 = WBS ID 

 Key 1:   

Segment 1 = WBS Key 

 Key 2:   

Segment 1 = Parent 

Segment 2 = Sequence 

 Key 3: 

Segment 1 = CLIN 
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D.3  Project File Formats  

D.3.17  WBS Task Description File Format 

MPM Project File Name:  projectnameD.WTD 

File Type:  Btrieve 

Record Length:  806 Bytes 

Keys:  1 

Field Type * Length Description 

WBS Key L  4 WBS element to which the task description is 

attached  

Sequence C 2 Task description record sequence (01-10).  Record 

sequence field - for each task description there is a 

record for every 10 lines of text the record sequence 

field identifies the records 1-10 for each task 

description.  

System Use  20 System use 

Task Text C 780 This field contains 10 lines of 78 characters of text 

associated with task description 

 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one segmented key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = WBS Key 

Segment 2 = Sequence Field 
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D.3  Project File Formats  

D.3.18  WBS Thresholds File Format 

MPM Project File Name:  projectnameX.WTH 

File Type:  Btrieve 

Record Length:  171 Bytes 

Keys:  1 

Field Type * Length Description 

LinkToWbsTable I 4 Links to the WbsIntKey field in the WBS table. 

This shows the relationship to a node in WBS 

table. 

CPFSVValue D 8 Current Period, Schedule Variance, Favorable 

Value. 

CPFSVPercentage D 12 Current Period, Schedule Variance, Favorable 

Percentage 

CPUFSVValue D 8 Current Period, Schedule Variance, Unfavorable 

Value 

CPUFSVPercentage D 8 Current Period, Schedule Variance, Unfavorable 

Percentage 

CFSVValue D 8 Cumulative, Schedule Variance, Favorable Value 

CFSVPercentage D 8 Cumulative, Schedule Variance, Favorable 

Percentage 

CUFSVValue D 8 Cumulative, Schedule Variance, Unfavorable 

Value 

CUFSVPercentage D 8 Cumulative, Schedule Variance, Unfavorable 

Percentage 

CPFCVValue D 8 Current Period, Cost Variance, Favorable Value 

CPFCVPercentage D 8 Current Period, Cost Variance, Favorable 

Percentage 

CPUFCVValue D 8 Current Period, Cost Variance, Unfavorable 

Value 

CPUFCVPercentage D 8 Current Period, Cost Variance, Unfavorable 

Percentage 

CFCVValue D 8 Cumulative, Cost Variance, Favorable Value 
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Field Type * Length Description 

CFCVPercentage D 8 Cumulative, Cost Variance, Favorable 

Percentage 

CUFCVValue D 8 Cumulative, Cost Variance, Unfavorable Value 

CUFCVPercentage D 8 Cumulative, Cost Variance, Unfavorable 

Percentage 

ACFValue D 8 At Complete, Favorable Value 

ACFPercentage D 8 At Complete, Favorable Percentage 

ACUFValue D 8 At Complete, Unfavorable Value 

ACUFPercentage D 8 At Complete, Unfavorable Percentage 

CLogic S 1 Comparison Logic 

CUnits S 1 Units (Hours or Dollars) 

ThresholdLevel S 1 Flag indicating whether Threshold is set at 

Project Level 

 * C = Character    D = Double    S = Single    I = Integer    L = Long 

Keys 

This file contains one key.  This key contains no duplicates. 

 Key 0: 

Segment 1 = LinkToWbsTable 
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Appendix E: Data Utilities 
Data Dictionary File Utility ................................................................ 762 
Flatten File Utility .............................................................................. 764 
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Data Dictionary File Utility 
If you need to generate data dictionary files from a project, you can use the Data 
Dictionary File utility. You run the utility from the Windows Start menu. The executable 
file is name MPMDDF.EXE. 

The utility generates three data dictionary files: 
 FILE.DDF 
 FIELD.DDF 
 INDEX.DDF 

The utility generates the same three files each time it is run. If you want to create a set of 
files for more than one project, you must move the data dictionary files out of the 
DELTEKMPM folder each time you run the executable.  The DDF files contain 
definitions for the following files: 

Project File File Name 
Audit Trail Documentation projnameG.ATX  

Audit Trail  projnameC.AUD 

Basis of Estimate projnameE.BOE 

BCWP projnameI.BWP 

CLIN projnameR.CLN 

Flattened Resource Detail Monthly projname.RRM 

Flattened Resource Detail Yearly projname.RRY 

Milestones projnameA.MIL. 

OBS projnameB.OBS 

Program Log projnameQ.LOG 

Project Header projnameT.HED 

Resource Rollup Detail projnameW.RRD 

Resource Rollup Header projnameU.RRH 

Task Description projnameD.WTD 

WBS projnameP.WBS 

WBS Restrictions projnameN.USR 

WBS Thresholds projnameX.WTH 

Weekly projnameF.WRD 
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Global Files File Name 
Burden Templates TEMPLATE.LIB 

Element of Cost Coded EOCCODES.LIB 

Fiscal Calendar CALENDAR.FSC 

Holiday Calendar CALENDAR.HOL 

Resource Rates Library RATE.LIB 

Resource Descriptions Library RESOURCE.LIB 

System Files File Name 
Global File IDs GLOBAL.DAT 

Project File Names PROJ.DAT 

 

Procedure 
To run the Data Dictionary File utility: 

1. Run MPMDDF.EXE from the MPM Executable folder. 

2. Click Ok. 

The MPM Data Dictionary File Utility dialog box displays. 
 

 
3. In the Projects column, highlight the project you want to use to create the data 

dictionary files. 

4. The Output Directory defaults to the project file location for the selected project. You 
may optionally choose a different output directory for the .DDF files. 

 



764   Appendix E: Data Utilities 

Flatten File Utility 
When you run this program, it creates a resource rollup project file in the project 
directory. The file is called projname.RRM or projname.RRY depending on whether you 
select the monthly or yearly option. The file is a copy of the .RRD file that is easier to 
read with report writers. The files can be used to create custom reports instead of using 
the .RRD file. 

The .RRM and/or .RRY files will contain the contents of the .RRD file that existed at the 
time the files were created. If changes are made to the project, you should rerun the 
utility. 

Procedure 
To run the utility: 

1. On the Windows task bar click Start and then choose Run. 

2. On the Run dialog, type MPMRRF.EXE in the Open box. 

3. Click OK and the Flatten File Utility dialog is displayed. 
 

 
4. In the Projects column, highlight the project you want to use to create the 

resource rollup project file. 

5. Choose whether you would like to create monthly or yearly data. 

6. The Output Directory defaults to the project file location for the selected project. 
You may optionally choose a different output directory for the file. 
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Resource Rollup Monthly File Format 
File Name: projectname.RRM 

File Type: Btrieve 

Record Length: 28 bytes 

Keys: 1 

Field Type* Length Description 
Header Link Long 4 Link to header record in RRH file 
Value Type Character 1 Value type:  

 BCW(S) 
BCW(P) 
(A)CWP 
(E)TC 

Cost Element Character 1 Cost element: 
(S)td hours 
(H)rs/units 
(E)quiv men 
(P)rime 
(G) & A 
(O)verhead 
(F)ee 
(C)ost of money 

Burden Code Character 10 Burden Code 
Year and 
Month 

Integer 4 Year and month 

Monthly Values Double 8 Monthly values 
 

This file contains one segmented key. This key contains no duplicates. 

 Key 0: 

 Segment 1 = Header Link 
 Segment 2 = Value Type 
 Segment 3 = Cost Element 
 Segment 4 = Burden Code 
 Segment 5 = Year and Month        
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Resource Rollup Yearly File Format 
File Name: projectname.RRY 

File Type: Btrieve 

Record Length: 114 bytes 

Keys: 1 

Field Type* Length Description 
Header Link Long 4 Link to header record in RRH file 
Value Type Character 1 Value type:  

 BCW(S) 
BCW(P) 
(A)CWP 
(E)TC 

Cost Element Character 1 Cost element: 
(S)td hours 
(H)rs/units 
(E)quiv men 
(P)rime 
(G) & A 
(O)verhead 
(F)ee 
(C)ost of money 

Burden Code Character 10 Burden Code 
Year Integer 2 Year  
Monthly Values Double 8*12 Monthly values 

 

This file contains one segmented key. This key contains no duplicates. 

 Key 0: 

 Segment 1 = Header Link 
 Segment 2 = Value Type 
 Segment 3 = Cost Element 
 Segment 4 = Burden Code 
 Segment 5 = Year 
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Index 

% 
% Complete EVM, 226 
% Complete field description, Milestones view, 261 
% Start / %Complete EVM, 226 

. 
.FMT format files used in exporting, 555 
.HED file, icons in Project Maintenance window, 45 
.XLS files, exporting and importing, 554 

2 
2D Line Graph Symbols option, setting in GDD 

window, 401 

A 
Accessing 

Actuals window, 282 
Baseline view in Integrated Planning 

window, 165 
CLIN window, 92 
ETC view in Integrated Planning 

window, 210 
Export Conditioning windows, 544 
Graphic Drill Down window, 378 
Import Conditioning window, 455 
Milestones view in Integrated Planning 

window, 219 
OBS window, 78 
Program Log window, 363 
Project Maintenance window, 42 
Project Replan dialog box, 337 
Report Conditioning windows, 416 
Report Viewer, 434 
utilities, 301 
WBS window, 110 

accessing the MSP Link, 602 
Actual Import Conditioning Window, 658 

Actuals 
comparing to Budget, 281 
creating, 286 
deleting, 293 
duplicate values, how handled when 

imported, 479 
editing, 293 
exporting by WBS, 565, 567 
filtering, 295 
formulas, 280 
import file format, 480 
importing, 286, 478 
importing with Autoburdening, 478 
previewing, 285 
printing, 285 
rebuild option in Rollup Processing, 71 
recommended reports, 297 
repricing, 303 
Rollup Processing, 287 

Actuals Rate Table field description, Project 
Maintenance window, 51 

Actuals window 
accessing, 282 
field descriptions 

EOC Code, 292 
EOC Description, 292 
Overtime, 290 
Resource Code, 290 
Resource Dept, 290 
Resource Description, 290 

orientation, 284 
ACWP data, including in a graph, 398 
Adjusting Baseline and EOC estimates 

procedure, 308 
Adjusting Baseline and ETC estimates, 306 

adjusting by 
percentage, 310 
target value, 311 

entering adjustment units, 310 
special guidelines, 306 

Adjustment units, entering in the Estimates Adjust 
dialog, 310 
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Alias field descripton, WBS window, 127 
Alias option, Project Data options 

Import Conditioning window, 461 
Analyze Transfer File Report, 660 
Append to Existing File (MSP Link), 609 
Apportioned estimates 

characteristics, 181 
creating, 181 
showing in Baseline view, 199 
special guidelines, 181 

Apportioned EVM, 227 
choosing for a milestone, 225 

Area charts, selecting in GDD window, 383 
Area graphs, drilling into, 396 
As of Month, specifying for statusing milestones, 

240 
At Complete bar or line graphs, drilling into, 391 
At Complete stacked area graphs, drilling into, 395 
At Complete stacked bar graphs, drilling into, 393 
Audit Trail, 326 

Deleting Audit Trail Data in Project 
Maintenance, 332 

Setting the Audit Trail Options in 
Project Maintenance, 330 

Setting the Security Audit Trail 
Options, 327 

Autoburdening 
using when importing Actuals, 478 

Autofill 
using to enter milestone information, 

258 
using to enter values in Baseline view, 

177 
Automatic and manual redraw in GDD window, 381 
Autospread 

using to enter values in Baseline view, 
179 

Autoweight function, using to enter milestone 
weights, 236 

B 
Bar charts, selecting in GDD window, 382 
Base WBS field description, Milestones view, 262 
Base WBS ID field descripton, WBS window, 131 
Baseline 

estimates, adjusting, 306 

save options, setting, 171 
Baseline and ETC relationship, 164 
Baseline Complete field description, Milestones 

view, 262 
Baseline dates 

updating when importing WBS 
schedule data, 530 

Baseline Rate Table field description 
Project Maintenance window, 51 

Baseline Start field description, Milestones view, 
262 

Baseline view 
adding resource estimates, 168 
changing periods, 199 
copying/pasting cells, 192 
copying/pasting estimates, 190 
deleting cells, 194 
deleting estimates, 194 
entering values using Autofill, 177 
entering values using Autospread, 179 
field descriptions 

Burden Template, 186 
Complete, 186 
Description, 185 
Estimate Type, 186 
Overtime, 186 
Rate Table, 186 
Resource, 185 
Resource Department, 185 
Start, 186 
WBS ID, 185 

filtering data, 198 
in Integrated Planning window, 

accessing, 165 
orientation, 166 
Overtime field description, 173 
showing Apportioned estimates, 199 
showing Replan estimates, 199 
task descriptions, adding, editing, and 

deleting, 196 
Basis of Estimates (BOE) 

creating, 200 
exporting, 587 
importing, 517 

Batch Export file 
creating, 559 
saving, 560 
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Batch export processing, 559 
using Formulated Dates, 562 

Batch Import file 
creating, 465 
saving, 466 

Batch import processing 
overview, 465 
using Formulated Dates, 467 

Batch Processing 
reports, 446 

batch processing (MSP Link), 647 
BCWP 

import file format, 485 
importing, 483 
status, exporting, 569 

BCWP (MSP Link), 613 
BCWP Base 

field description 
Milestones view, 260 

field descripton 
WBS window, 131 

selecting for a milestone, 229 
BCWP data, including in a graph, 398 
BCWP Entry EVM, 227 
BCWP values, how impacted by budget changes, 

320 
BCWP values, how impacted by budget changes, 

256 
BCWS data, including in a graph, 398 
Before Replan state, restoring data to, 339 
Budget changes, impact on BCWP values, 256 
Burden Codes 

import file format, 503 
importing, 503 

Burden Rates 
import file format, 504 
importing, 504 

Burden Template 
field description 

Baseline view, 186 
OBS window, 85 

Burden Template Override 
field description, 53 
setting, 53 

Burden templates 
exporting, 571 
import file format, 505 

importing, 505 
role in OBS, 77 

Burdened totals for WBS elements and resource 
estimates, 161 

Burdens, exporting, 585 

C 
C/SSR Reports, 425 
Calculating BCWP, 320 

procedure, 325 
special guidelines, 320 

Calculating overtime rates, 173 
Calendar field description, 54 
CBB 

see Program Log, 361 
Cells 

copying/pasting in Baseline view, 192 
copyping and pasting in Milestones 

view, 267 
deleting in Baseline view, 194 
deleting in Milestones view, 271 

Changing 
a milestone weight for work in 

progress, 251 
an element’s Budget at Completion 

(BAC), 254 
an EVM for work in progress, 249 
periods in Baseline view, 199 
project start date, 318 
the BCWP base for work in progress, 

250 
the path for projects, 65 

Changing project start date 
special guidelines, 318 

Charge Number field descripton, WBS window, 126 
Classes of Cost (COC), importing, 502 
CLIN Elements 

deleting, 100 
editing, 100 
linking to WBS, 91 

CLIN field description 
CLIN table, 98 

CLIN field descripton 
WBS window, 128 

CLIN option, Project Data options 
Import Conditioning window, 461 
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CLIN Table, 90 
creating, 96 
field descriptions, 98 
in Government Reporting, 90 
saving, 97 

CLIN window 
accessing, 92 
navigating, 94 
orientation, 94 

Column separator character for exports, 553 
Company Name field description, 58 
Comparing Budget to Actuals, 281 
Complete estimates, importing, 491 
Complete field description 

Milestones view, 261 
Complete field descripton 

Baseline view, 186 
WBS window, 125 

Conditioning reports, 420 
Contract Complete field description, 50 
Contract environment, estimating for, 164 
Contract information, entering, 60 
Contract Line Items (see CLIN), 90 
Contract No. field description, 60 
Contract Proposal Reports, 90, 426 
Contract Start field description, 50 
Contract Type field description, 61 
Control Account element type in WBS, 128 
Copy utility, WBS Legs, 140 
Copying 

WBS legs with the Copy WBS utility, 
140 

Copying and exporting data in GDD window, 403 
Copying and pasting 

cells 
Milestones view, 267 

milestones, 265 
project information, 63 
WBS legs, 136 

Cost of Money override, 432 
CPR Reports, 424 
Creating 

Actuals, 286 
Apportioned estimates, 181 
Basis of Estimates, 200 
Batch export file, procedure, 559 
Batch import file, procedure, 465 

CLIN Table, 96 
ETC, 214 
Export files, 553 
Government Reports, 424 
graphs 

SPA Line Graph, 406 
import files, guidelines, 462 
milestones, 222 
OBS, 82 
projects, 46 
Resource Basis of Estimate, 200 
Summary Basis of Estimate, 202 
WBS, 122 

creating a new mappings definition, 618 
Criteria column, Import Conditioning window, 457 
Cross references, entering, 62 
Cum BCWP field description, Milestones view, 261 
Cum From field in GDD window, 384 
Currency Conversion Codes, 656 

D 
Data 

filtering in Milestones view, 273 
selecting types to include in graphs, 

398 
Data imports 

introduction, 453 
types, 453 

Date formats, import files, 462 
Dates 

formulated, 449 
formulated, using in Batch Export 

processing, 562 
formulated, using in Batch Import 

processing, 467 
valid formats for import files, 462 

Decimal places 
specifying for graphs, 400 

Default settings, returning to in GDD window, 381 
Deleting 

Actuals, 293 
cells in Milestones view, 271 
milestones, 269 
OBS data, 86 
OBS departments, 86 
project data, 66 
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projects, 67 
deleting an MSP Link interface, 652 
Department field descripton, OBS window, 84 
Department option, Project Data options 

Import Conditioning window, 461 
Description field description 

Baseline view, 185 
CLIN table, 98 
Milestones view, 259 
OBS window, 85 
WBS window, 125 

Display Errors Only (MSP Link), 609 
Distributed Project Conversion Utility (DPCU), 661 
Distributed Project function, activating with Xref‐1 

field, 62 
Distributed Projects, 654 

Analyze Transfer File Report, 660 
consolidated data, 655 
Currency Conversion Codes, 656 
data roll up, 655 
exporting, 573 
importing, 487 
international currency conversions, 

654 
Rollup Processing, 655 
Run Import, 656, 659 
sub‐projects, 654 
super‐projects, 654 
transfer file, 656 

DISTRIBUTED WBS Elements. See Distributed 
Projects 

DPCU, 661 
Drilling down in GDD, 376 
Drilling methods 

by EOC, 386 
by Resource, 387 
by WBS, 386 
drilling into 

area graphs, 396 
At Complete bar or line graphs, 391 
At Complete stacked area graphs, 

395 
At Complete stacked bar graphs, 

393 
Single Period stacked area graphs, 

394 

Single Period stacked bar graphs, 
392 

Timephased bar or line graphs, 390 
Timephased stacked area graphs, 

394 
Timephased stacked bar graphs, 

392 
drilling into Single Period bar or line 

graphs, 390 
Drilling up in GDD window, 381 
Duplicate values, how handled when importing 

Actuals, 479 

E 
Early Finish field descripton, WBS window, 131 
Early Start field descripton, WBS window, 131 
Earned Standards EVM, 227 
Earned Value Methods. See EVM 
Editing 

Actuals, 293 
OBS departments, 86 
report data, 438 
WBS elements, 134 

editing a saved mappings definition, 621 
editing an MSP Link interface, 651 
Efficiency field, Baseline view, 187 
Element Code field description, CLIN table, 98 
Element Type field descripton, WBS window, 128 
Element type in WBS 

Control Account, 128 
Planning Package, 128 
Work Package, 128 

Element Type option, Project Data options 
Import Conditioning window, 461 

Elements of Cost 
import file format, 502 

Elements of Cost (EOC) 
importing, 502 

embedded projects (MSP Link), 641 
Entering 

Government Reports data, 428 
milestone weights 

automatically using the Autoweight 
function, 236 

manually, 234 
EOC 
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Code field descripton, Actuals window, 
292 

Description field descripton, Actuals 
window, 292 

drilling down by, 386 
option, setting in Rollup Processing, 70 
rollups,exporting, 575 
tables, exporting, 577 

EOC Reprice Conditioning (MSP Link), 611 
EQP 

calculation, 204 
formulas, 205 

EQPM calculation method 
EQPM option, 55 
Resource Work option, 54 
setting in project maintenance, 54 

Equivalent Persons formula, 205 
Estimate Type field descripton, Baseline view, 186 
Estimates 

copying/pasting in Baseline view, 190 
deleting in Baseline view, 194 
import file format, 496 
importing, 489 
importing, complete, 491 
importing, partial, 492 
rebuild option in Rollup Processing, 71 
repricing when importing WBS 

schedule data, 532 
saving, 171 

Estimates (MSP Link), 612 
Estimates by WBS, exporting, 579 
Estimating 

in a contract environment, 164 
in a proposal environment, 164 

Estimating utilities 
repricing actuals, 281, 294 

ETC 
creating, 214 
data, including in a graph, 398 
estimates, adjusting, 306 
ETC Complete field descripton, WBS 

window, 131 
ETC Rate Table field description, 

Project Maintenance window, 51 
ETC Start field descripton, WBS 

window, 131 
relationship to Baseline, 164 

updating when importing WBS 
schedule data, 530 

view 
in Integrated Planning window, 

accessing, 210 
orientation, 212 

EVM 
Apportioned EVM, choosing for a 

milestone, 225 
choosing for milestones, 224 

EVM descriptions 
% Complete, 226 
% Start / %Complete, 226 
Apportioned, 227 
BCWP Entry, 227 
Earned Standards, 227 
Key Event, 228 
Level of Effort (LOE), 226 
Milestone Weights, 227 
Milestone Weights with % Complete, 

228 
No EVM Required, 226 

EVM field description 
Milestones view, 259 

EVM field descripton 
WBS window, 131 

Expanding/collapsing 
WBS legs, 148 

Export Conditioning windows 
accessing, 544 
orientation, 546 

Export Distributed Data. See Exports, Distributed 
Projects 

Export files 
creating, 553 
formats, 553 

Export processing, batch, 559 
Exporting 

Actuals by WBS, 565, 567 
Basis of Estimates (BOE), 587 
BCWP Status, 569 
Burden Templates, 571 
Burdens, 585 
Distributed projects, 573 
EOC rollups, 575 
EOC tables, 577 
Estimates by WBS, 579 
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Fiscal calendars, 581 
Holiday calendars, 582 
Milestones, 583 
Resources, 585 
Task descriptions, 587 
WBS data, 589 
weekly data, 591 

Exports 
.XLS files, 554 
column separator character, 553 
Distributed Project, 656 
format files, 555 
text delimiter character, 554 
types, 542 

F 
Fee % field descripton, WBS window, 129 
Fee Calculation field description, 56 
Fee calculation method 

Resource option, 57 
selecting, 56 
WBS option, 56 

Fee Limit field descripton, WBS window, 129 
Field descriptions 

Actuals window 
EOC Code, 292 
EOC Description, 292 
Overtime, 290 
Resource Code, 290 
Resource Dept, 290 
Resource Description, 290 

Baseline view 
Burden Template, 186 
Complete, 186 
Description, 185 
Efficiency, 187 
Estimate Type, 186 
Overtime, 186 
Rate Table, 186 
Resource, 185 
Resource Department, 185 
Scrap and Rework, 187 
Start, 186 
WBS ID, 185 

CLIN Table, 98 
Description, 98 

Element Code, 98 
Include on DD 1921, 99 
Include on SF 1411, 99 
Quantity, 98 
Reference Code, 98 

Milestones view 
% Complete, 261 
Base WBS, 262 
Baseline Complete, 262 
Baseline Start, 262 
BCWP Base, 260 
Complete, 261 
Cum BCWP, 261 
Description, 259 
EVM, 259 
Forecast Date, 260 
Last Statused Date, 262 
Level, 259 
Milestone ID, 259 
Schedule Date, 260 
Symbol, 260 
WBS ID, 259 
Weight, 260 

OBS window 
Burden Template, 85 
Department, 84 
Description, 85 
Level, 84 
Manager, 85 
Parent Dept, 84 

Program Log window, 369 
Project Maintenance window 

Actuals Rate Table, 51 
Baseline Rate Table, 51 
Burden Template Override, 53 
Calendar, 54 
Company Name, 58 
Contract Complete, 50 
Contract No., 60 
Contract Start, 50 
Contract Type, 61 
ETC Rate Table, 51 
Fee Calculation, 56 
Global ID, 51 
Internal ID, 60 
Path, 50 
Program Manager, 58 
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Program Manager Phone Number, 
58 

Program name, 49 
Program Type, 61 
Project ID, 49 
Proposal Manager, 59 
Proposal Manager Phone Number, 

59 
Proposal No., 60 
Rate Table Override, 53 
Xref Fields, 62 

WBS window 
Alias, 127 
Base WBS ID, 131 
BCWP Base, 131 
Charge Number, 126 
CLIN, 128 
Complete, 125 
Description, 125 
Early Finish, 131 
Early Start, 131 
Element Type, 128 
ETC Complete, 131 
ETC Start, 131 
EVM, 131 
Fee %, 129 
Fee Limit, 129 
Float, 131 
Last Statused Date, 131 
Late Finish, 131 
Late Start, 131 
Level, 124 
Manager, 126 
Parent, 125 
Perf Dept, 126 
Resp Dept, 126 
Revised Letter Date, 130 
Schedule Reference Date, 130 
Start, 125 
Threshold, 127 
WBS % Complete, 131 
WBS ID, 125 
XREF Fields, 127 

field descriptions (mappings), 623 
File Name Selection (MSP Link), 609 
Fill Down, WBS window, 134 
Filter column, Import Conditioning window, 457 

Filtering 
Actuals, 295 
data in Baseline view, 198 
data, Milestones view, 273 
WBS legs, 148 

Fiscal calendar 
exporting, 581 
import file format, 500 

Fiscal Status As Of Date (MSP Link), 616 
Float field descripton, WBS window, 131 
Forecast Date 

field description for Milestones view, 
260 

revising for milestones, 242 
Format files for exports, 555 
Formats for export files, 553 
Formatting report data, 440 
Formulas 

Actuals, 280 
Equivalent Persons, 205 
Hours, 205 
Person Months, 205 
Standard Hours, 205 

Formulated dates 
using in Batch Export processing, 562 
using in Batch Import processing, 467 

Formulated Dates 
using in reports, 449 

G 
Gate Month field in GDD window, 384 
Generate File and Validate process, 640 
Generate File Name (MSP Link), 609 
Generate File process, 640 
Global ID field description 

Project Maintenance window, 51 
Global ID option, Global Data options 

Import Conditioning window, 460 
Globals, importing, 499 
Government Reports 

CLIN Table, 90 
Cost of Money override, 432 
creating, 424 
data,entering, 428 
Program Log, 361 

Graph periods, changing in GDD window, 385 
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Graph type, selecting in GDD window, 382 
Graphic Draw option, setting in GDD window, 401 
Graphic Drill Down 

drilling down, how to, 376 
window, accessing, 378 

Graphic Drill Down window 
adding third dimension, 382 
automatic and manual redraw, 381 
changing graph periods, 385 
conditioning Timeframe, 384 
copying and exporting data, 403 
drilling up, how to, 381 
options 

2D Line Graph Symbols, 401 
Graphic Draw, 401 
Legends and Labels, 401 

orientation, 380 
previewing, 402 
printing, 402 
returning to default settings, 381 
selecting 

bar charts, 382 
data types to include, 398 
graph type, 382 
line charts, 382 

selecting area charts, 383 
showing variance, 398 
specifying the number of decimal 

places, 400 
specifying the units of data, 381 
view data as table, 383 

Graphic Previewing 
GDD window, 402 

Graphic Printing 
GDD window, 402 

Graphs 
SPA Line Graph, 406 

H 
Headers and thresholds, entering from Project 

Maintenance, 41 
Headers in Government Reports data, 428 
Holiday calendars 

exporting, 582 
import file format, 501 
importing, 501 

Hours formula, 205 

I 
Identify Milestones by (MSP Link), 615 
If No Baseline option, replanning, 345 
Impact of budget changes on BCWP values, 320 
Import Conditioning window 

accessing, 455 
Criteria column, 457 
Filter column, 457 
Global Data options, 460 
orientation, 457 
previewing, 458 
printing, 458 
Processing report, 459 
project data options, 460 

Import data conditioning 
Global Data options 

Global ID, 460 
Report Timeframe Information, 460 

Project Data options 
Alias, 461 
CLIN, 461 
Department, 461 
Element Type, 461 
OBS, 461 
Project Selection, 460 
Recurring/Non‐recurring, 461 
Report Timeframe Information, 460 
WBS Leg, 461 
WBS Level, 461 
WBS Manager, 461 
XREF, 461 

Import file formats 
Actuals, 480 
BCWP, 485 
Burden Code, 503 
Burden Rate, 504 
Burden Template, 505 
Elements of Cost, 502 
Estimates, 496 
Fiscal Calendar, 500 
Holiday calendar, 501 
Milestones, 513 
Resource BOE, 521 
Resource Code, 507 
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Resource Rate, 508 
Summary BOE, 523 
Task Description, 519 
WBS Descriptive, 527 
WBS Schedule, 533 

Import files 
creating, 462 

Import process, 645 
Import processing, batch, 465 
Importing 

Actuals, 286, 478 
duplicate values, how handled, 479 

Basis of Estimates (BOE), 517 
BCWP, 483 
Burden Codes, 503 
Burden Rates, 504 
Burden templates, 505 
Classes of Cost (COC), 502 
Distributed Projects, 487 
Elements of Cost (EOC), 502 
Estimates, 489 
Globals, 499 
Holiday calendars, 501 
Milestones, 509 
OBS, 515 
Resource Codes, 507 
Resource Rates, 508 
Task Descriptions, 517 
WBS Descriptive Data, 525 
WBS Schedule Data, 529 

Imports 
.XLS files, 554 
Actual Import Conditioning Window, 

658 
Run Import, 419 
Save Conditioning, 419 
Set Current Date, 419 

Include on DD 1921 field description, CLIN table, 99 
Include on SF 1411 field description, CLIN table, 99 
Indicating different estimates using the Overtime 

field, 174 
Inserting a milestone for a WBS element, 230 
Integrated Planning window 

Rollup totals, 160 
Totals, 160 

interface 
deleting (MSP Link), 652 

editing (MSP Link), 651 
saving (MSP Link), 649 

interface conditioning options, 606 
interface process types (MSP Link), 608 
Internal ID field description, 60 
International currency conversions in distributed 

projects, 654 
Introduction 

Program Log, 360 
Reports, 414 

Introduction to the MSP Link, 600 

K 
Key Event EVM, 228 

L 
Last Statused Date field description 

Milestones view, 262 
Last Statused Date field descripton 

WBS window, 131 
Late Finish field descripton, WBS window, 131 
Late Start field descripton, WBS window, 131 
Legends and Labels options, setting in GDD 

window, 401 
Level field description 

Milestones view, 259 
Level field descripton 

OBS window, 84 
WBS window, 124 

Level of Effort (LOE) EVM, 226 
Line charts, selecting in GDD window, 382 
linked projects (MSP Link), 641 
Linking WBS to the OBS, 106 
LRE (Last Revised Estimate) data, including in a 

graph, 398 

M 
Maintaining 

Program Logs, 371 
Manager field descripton 

OBS window, 85 
WBS window, 126 

Manually entering milestone weights, 234 
Mapping File Name (MSP Link), 609 
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Mappings 
creating a new mappings definition, 

618 
editing a saved mappings definition, 

621 
field descriptions, 623 
opening a saved mappings definition, 

620 
Mappings (MSP Link), 617 
Milestone ID field description, Milestones view, 

259 
Milestone weights 

applying to a fraction of a month, 236 
applying to a whole month, 237 
entering automatically, 236 
entering manually, 234 
entering, introduction, 232 

Milestone Weights EVM, 227 
Milestone Weights with % Complete EVM, 228 
Milestones 

choosing an Apportioned EVM, 225 
choosing an EVM, 224 
copying and pasting, 265 
creating, 222 
deleting, 269 
entering information using Autofill, 

258 
entering weights for, 232 
exporting, 583 
import file format, 513 
importing, 509 
inserting for a WBS element, 230 
previewing, 275 
printing, 275 
recommended reports, 277, 297 
shifting when importing WBS schedule 

data, 531 
statusing, 238 

for work in progress, 248 
revising the Forecast Date, 242 
specifying the As of Month, 240 
when % Complete EVM is specified, 

245 
when %Start / % Complete EVM is 

specified, 245 
when a milestone is 100% 

complete, 243 

when Apportioned EVM is specified, 
247 

when BCWP Entry EVM is specified, 
246 

when Earned Standards EVM is 
specified, 245 

when Key Event EVM is specified, 
247 

when Level of Effort EVM is 
specified, 245 

when Milestone Weights EVM is 
specified, 246 

when Milestone Weights with % 
Complete EVM is specified, 246 

when no EVM is specified, 244 
statusing for work in progress 

changing a milestone weight, 251 
changing an element’s Budget at 

Completion (BAC), 254 
changing an EVM, 249 
changing the BCWP base, 250 
modifying an element’s prior status, 

252 
Milestones (MSP Link), 613 
Milestones view 

accessing in the Integrated Planning 
window, 219 

copying and pasting cells, 267 
field descriptions 

% Complete, 261 
Base WBS, 262 
Baseline Complete, 262 
Baseline Start, 262 
BCWP Base, 260 
Complete, 261 
Cum BCWP, 261 
Description, 259 
EVM, 259 
Forecast Date, 260 
Last Statused Date, 262 
Level, 259 
Milestone ID, 259 
Schedule Date, 260 
Symbol, 260 
WBS ID, 259 
Weight, 260 

filtering data, 273 
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orientation, 220 
Timephased BCWS window, 221 

Modifying an element’s prior status for work in 
progress, 252 

Move utility, WBS Legs, 142 
Moving WBS legs, 142 
MS Project File Name (MSP Link), 608 
MS Project Task Filter Name (MSP Link), 608 
MSP Link 

accessing, 602 
batch processing, 647 
BCWP, 613 
creating a new mappings definition, 

618 
deleting an MSP Link interface, 652 
editing a saved mappings definition, 

621 
editing an MSP Link interface, 651 
embedded projects, 641 
Estimates, 612 
field descriptions 

Append to Existing File, 609 
Display Errors Only, 609 
EOC Reprice Conditioning, 611 
Fiscal Status As Of Date, 616 
Generate File Name, 609 
Identify Milestones by, 615 
Mapping File Name, 609 
MS Project File Name, 608 
MS Project Task Filter Name, 608 
Output File Name, 609 
Output Format, 609 
Replace Values, 608 
Shift Baseline Resources, 610 
Shift ETC Resources, 611 
Shift Milestones Forecast Dates, 

611 
Shift Milestones Schedule Dates, 

611 
Time Now Date, 610 
Update BCWP Status, 616 

File Name Selection, 609 
Generate File and Validate process, 

640 
Generate File process, 640 
Import process, 645 
interface conditioning options, 606 

Interface Processes, 608 
interface, deleting, 652 
interface, editing, 651 
interface, saving, 649 
introduction, 600 
linked projects, 641 
Mappings, 617 
mappings field descriptions, 623 
Milestones, 613 
opening a saved mappings definition, 

620 
orientation to, 604 
Output Options, 609 
previewing and printing, 604 
processes, 639 
project field, 607 
saving an MSP Link interface, 649 
saving the interface conditioning, 605 
setting up a batch interface, 647 
WBS Descriptive, 610 
WBS Schedule, 610 
window, 604 

MSP Link Mappings, 617 
MSP Link Processes, 639 

N 
NASA Reports, 425 
Navigating 

OBS window, 81 
Project Maintenance window, 45 
WBS window, 114 

No EVM Required EVM, 226 

O 
OBS 

creating, 82 
data, deleting, 86 
departments 

deleting, 86 
editing, 86 

importing, 515 
saving, 83 
trees 

performing organization, 76 
responsible organization, 76 
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types, 76 
OBS option, Project Data options 

Import Conditioning window, 461 
OBS window 

accessing, 78 
field descriptions 

Burden Template, 85 
Department, 84 
Description, 85 
Level, 84 
Manager, 85 
Parent Dept, 84 

navigating, 81 
orientation, 80 

opening a saved mappings definition, 620 
Organizational Breakdown Structure. See OBS 
Orientation 

Actuals window, 284 
Baseline view, 166 
CLIN window, 94 
ETC view, 212 
Export Conditioning windows, 546 
Graphic Drill Down window, 380 
Import Conditioning window, 457 
Milestones view, 220 
OBS window, 80 
Program Log window, 365 
Project Maintenance window, 45 
Report Conditioning windows, 418 
Report Viewer, 436 
WBS window, 112 

Orientation to the MSP Link, 604 
Output File Name (MSP Link), 609 
Output Format (MSP Link), 609 
Output Options (MSP Link), 609 
Overtime field 

description 
Actuals window, 290 
Baseline view, 186 

how used in Baseline view, 173 
using to indicate different estimates, 

174 
Overtime field descripton, Actuals window, 290 
Overtime rates, calculating, 173 

P 
Parent Dept field descripton, OBS window, 84 
Parent field descripton, WBS window, 125 
Partial estimates, importing, 492 
Path field description, 50 
Path, changing for a project, 65 
Perf Dept field descripton, WBS window, 126 
Performing OBS tree, linking to a WBS, 107 
Person Months formula, 205 
Planning Package element type in WBS, 128 
Posting Weekly Data, 322 
Preview 

Report conditioning data, 419 
Previewing 

Actuals, 285 
Import Conditioning window, 458 
milestones, 275 

previewing and printing (MSP Link), 604 
Printing 

Actuals, 285 
Import Conditioning window, 458 
milestones, 275 

process 
batch processing, 647 
Generate File, 640 
Generate File and Validate, 640 
Import, 645 

processes (MSP Link), 639 
Processing report, Import Conditioning window, 

459 
Program Log 

Contract Budget Base, 361 
Government Reporting, 361 
introduction, 360 
maintaining, 371 
Total Allocated Budget, 361 

Program Log window 
accessing, 363 
creating logs, 367 
field descriptions, 369 
navigating, 365 
orientation, 365 

Program Manager field description, 58 
Program Manager Phone Number field description, 

58 
Program Name field description, 49 
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Program Type field description, 61 
project (MSP Link), 607 
Project data 

deleting, 66 
deleting selected categories, 68 
recovering, 73 

Project ID field description, 49 
Project Maintenance 

Deleting Audit Trail Data, 332 
Setting the Audit Trail Options, 330 

Project Maintenance window 
accessing, 42 
copying and pasting information, 63 
field descriptions 

Actuals Rate Table, 51 
Baseline Rate Table, 51 
Burden Template Override, 53 
Calendar, 54 
Company Name, 58 
Contract Complete, 50 
Contract No., 60 
Contract Start, 50 
Contract Type, 61 
ETC Rate Table, 51 
Fee Calculation, 56 
Global ID, 51 
Internal ID, 60 
Path, 50 
Program Manager, 58 
Program Manager Phone Number, 

58 
Program Name, 49 
Program Type, 61 
Project ID, 49 
Proposal Manager, 59 
Proposal Manager Phone Number, 

59 
Proposal No., 60 
Rate Table Override, 53 
Xref Fields, 62 

icons displayed before row numbers, 
45 

navigating, 45 
orientation, 45 

Project Replan, accessing, 337 
Project Selection option, Project Data options 

Import Conditioning window, 460 

Projects 
changing the path, 65 
creating, 46 
deleting, 67 
suspending access to, 72 

Prompt for ETC save option, 171 
Proposal environment, estimating for, 164 
Proposal Manager field description, 59 
Proposal Manager Phone Number field description, 

59 
Proposal No. field description, 60 

Q 
Quantity field description, CLIN table, 98 

R 
Rate Table field descripton, Baseline view, 186 
Rate Tables 

assigning to a project, 52 
Override field description, 53 
Override setting, 53 

Rebuild options, setting in Rollup Processing, 71 
Recommended reports 

Actuals, 297 
Milestones, 277, 297 

Recovering project data, 73 
Recurring/Non‐recurring option, Project Data 

options 
Import Conditioning window, 461 

Redrawing in GDD window, manual and automatic, 
381 

Reference Code field description, CLIN table, 98 
Rename utility, WBS Legs, 144 
Renaming 

resource codes and departments, 312 
impact on Summary BOE, 316 
procedure, 314 
special guidelines, 312 

WBS legs, 144 
Replace Values (MSP Link), 608 
Replacement characters, specifying in WBS Leg 

utilities, 138 
Replan estimates, showing in Baseline view, 199 
Replanning 

general procedure, 342 
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how it affects other MPM functions, 
340 

introduction, 336 
options 

Set Baseline = Actuals, 347 
Set Baseline = Earned Value, 353 
Set Baseline and Earned Value = 

Actuals, 351 
Set Earned Value = Actuals, 349 
Set Estimate to Complete = 

Baseline, 355 
restoring data to its Before Replan 

state, 339 
selecting a WBS leg, 356 
selecting an option, 344 
WBS requirements, 338 

Report Conditioning 
previewing data, 419 

Report Conditioning windows 
orientation, 418 

Report Conditioning windows 
accessing, 416 

Report data 
editing, 438 
formatting, 440 

Report Timeframe Information option 
Global Data options 

Import Conditioning window, 460 
Project Data options 

Import Conditioning window, 460 
Report Viewer 

accessing, 434 
orientation, 436 
output, 444 
sheets, 442 

Reports 
Analyze Transfer File Report, 660 
batch processing, 446 
conditioning, 420 
introduction, 414 
outputting, 422 
running, 419 
Set Current Date, 449 
viewing and editing, 434 

Repricing 
actuals, 281, 294 
Actuals, 303 

estimates, 302 
procedure, 304 
special guidelines, 303 
when importing WBS schedule data, 

532 
Resource 

drilling down by, 387 
Resource Basis of Estimate 

creating, 200 
import file format, 521 

Resource Code field descripton, Actuals window, 
290 

Resource Codes 
import file format, 507 
importing, 507 

Resource Department field descripton 
Baseline view, 185 

Resource Deptartment field descripton 
Actuals window, 290 

Resource Description field descripton, Actuals 
window, 290 

Resource estimates 
adding to a Baseline view, 168 
burdened totals for, displaying, 161 

Resource field descripton, Baseline view, 185 
Resource option, Fee Calculation method, 57 
Resource Rates 

import file format, 508 
importing, 508 

Resource Work option for EQPM hours, selecting, 
54 

Resources, exporting, 585 
Resp Dept field descripton, WBS window, 126 
Responsibility Assignment Matrix, definition, 106 
Responsible OBS tree, linking to a WBS, 106 
Restoring data to its Before Replan state, 339 
Revised Letter Date field descripton, WBS window, 

130 
Revising Forecast Date for milestones, 242 
Rollup Processing 

Actuals, 287 
Distributed Data, 655 
EOC and Summary options, 70 
Rebuild options, 71 

Rollup totals in the Integrated Planning window, 
160 

Rpt Month field in GDD window, 384 
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Run Import. See Imports 
Distributed Projects, 656, 659 

S 
Save Baseline and ETC option, 171 
Save Baseline only option, 171 
Saving 

Batch Export file, 560 
Batch Import file, 466 
estimates, 171 
Import Conditions, 419 

saving an MSP Link interface, 649 
saving the interface conditioning (MSP Link), 605 
Schedule Date field description, Milestones view, 

260 
Schedule Reference Date field descripton, WBS 

window, 130 
Scrap and Rework field, Baseline view, 187 
Security 

Setting the Security Audit Trail 
Options, 327 

Selecting 
BCWP base for a milestone, 229 
Fee Calculation method, 56 
WBS legs, 149 

Set Baseline = Actuals option, replanning, 347 
Set Baseline = Earned Value option, replanning, 353 
Set Baseline and Earned Value = Actuals option, 

replanning, 351 
Set Current Date. See Imports 

reports, 449 
Set Earned Value = Actuals option, replanning, 349 
Set Estimate to Complete = Baseline, replanning, 

355 
Setting 

Baseline save options, 171 
Burden Template Override, 53 
Rate Table Override, 53 

setting up a batch interface (MSP Link), 647 
Shift Baseline Resources (MSP Link), 610 
Shift ETC Resources (MSP Link), 611 
Shift Milestones Forecast Dates (MSP Link), 611 
Shift Milestones Schedule Dates (MSP Link), 611 
Shifting Milestones when importing WBS schedule 

data, 531 
Single Period bar or line graphs, drilling into, 390 

Single Period stacked area graphs, drilling into, 394 
Single Period stacked bar graphs, drilling into, 392 
Sort utility, WBS Legs, 146 
Sorting 

elements 
Milestones window, 274 

WBS legs, 146 
SOW, including in the CLIN/SOW/WBS Baseline 

report, 62 
SPA Line Graph, creating, 406 
Special guidelines 

adjusting Baseline and ETC estimates, 
306 

Apportioned estimates, 181 
calculating BCWP, 320 
changing project start date, 318 
renaming resource codes and 

departments, 312 
Specifying the units of data in Graphic Drill Down 

window, 381 
Spread Curve ID’s, 634 
Standard Hours formula, 205 
Start field description 

Baseline view, 186 
WBS window, 125 

Statusing milestones, 238 
for work in progress, 248 

changing a milestone weight, 251 
changing an element’s Budget at 

Completion (BAC), 254 
changing an EVM, 249 
changing the BCWP base, 250 
modifying an element’s prior status, 

252 
revising the Forecast Date, 242 
specifying the As of Month, 240 
when % Complete EVM is specified, 

245 
when %Start / % Complete EVM is 

specified, 245 
when a milestone is 100% complete, 

243 
when Apportioned EVM is specified, 

247 
when BCWP Entry EVM is specified, 

246 
when Earned EVM is specified, 245 
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when Key Event EVM is specified, 247 
when Level of Effort EVM is specified, 

245 
when Milestone Weights EVM is 

specified, 246 
when Milestone Weights with % 

Complete EVM is specified, 246 
when no EVM is specified, 244 

Structuring the WBS, 108 
sub‐projects. See Distributed Projects 
Summary Basis of Estimate (BOE) 

creating, 202 
how impacted when rename resource 

codes and departments, 316 
import file format, 523 

Summary option, setting in Rollup Processing, 70 
super‐projects. See Distributed Projects 
Suspending access to a project, 72 
Symbol field description, Milestones view, 260 
Symbol/Description/Schedule Date, 616 

T 
TAB 

see Program Log, 361 
Table, viewing data in GDD window, 383 
Task description 

adding, editing, and deleting in 
Baseline view, 196 

entering for WBS element, 132 
exporting, 587 
import file format, 519 
importing, 517 

Test delimiter character for exports, 554 
Third dimension, selecting in GDD window, 382 
Threshold field descripton, WBS window, 127 
thresholds, 116 
Time Now Date (MSP Link), 610 
Time Now Date, specifying when importing WBS 

Schedule Data, 529 
Timeframe, conditioning in GDD window, 384 
Timephased 

bar or line graphs, drilling into, 390 
stacked area graphs, drilling into, 394 
stacked bar graphs, drilling into, 392 
Timephased BCWS window, in 

Milestones view, 221 

Totals in the Integrated Planning window, 160 
Transferring data 

Distributed Projects, 656 

U 
Update BCWP Status (MSP Link), 616 
Updating 

Baseline dates when importing WBS 
schedule data, 530 

ETC when importing WBS schedule 
data, 530 

Utilities 
accessing, 301 
adjusting Baseline and ETC estimates, 

306 
calculating BCWP, 320 
changing project start date, 318 
introduction, 300 
posting weekly data, 322 
renaming resource codes and 

departments, 312 
repricing estimates, 302 

V 
Valid date formats, import files, 462 
Values, entering in Baseline view using 

Autofill, 177 
Autospread, 179 

Variance, showing in a graph, 398 

W 
WBS 

creating, 122 
data, exporting, 589 
Descriptive Data 

import file format, 527 
importing, 525 

drilling down by, 386 
editing WBS elements, 134 
requirements for replanning, 338 
structuring, 108 

WBS % Complete field descripton, WBS window, 
131 

WBS Descriptive (MSP Link), 610 
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WBS elements 
burdened totals for, displaying, 161 
editing, 134 

WBS ID field description 
Milestones view, 259 

WBS ID field descripton 
Baseline view, 185 
WBS window, 125 

WBS Leg option, Project Data options 
Import Conditioning window, 461 

WBS Leg utilities 
Copy utility, 140 
log and report, 139 
Move utility, 142 
overview, 138 
Rename utility, 144 
Sort utility, 146 
specifying replacement characters, 

138 
WBS leg, selecting for a replan, 356 
WBS legs 

copying and pasting, 136 
deleting in WBS window, 135 
downloading into WBS window, 123 
filtering, 148 
selecting and deselecting, 149 

WBS legs, expanding and collapsing, 148 
WBS Level option, Project Data options 

Import Conditioning window, 461 
WBS option, Fee Calculation method, 56 
WBS Schedule (MSP Link), 610 
WBS Schedule data 

import file format, 533 
importing, 529 

WBS Sheet, 112 
WBS thresholds, 116 
WBS window 

accessing, 110 
copying/pasting cell data, 134 
deleting WBS legs, 135 
downloading WBS legs into, 123 
field descriptions 

Alias, 127 
Base WBS ID, 131 
BCWP Base, 131 
Charge Number, 126 
CLIN, 128 

Complete, 125 
Description, 125 
Early Finish, 131 
Early Start, 131 
Element Type, 128 
ETC Complete, 131 
ETC Start, 131 
EVM, 131 
Fee %, 129 
Fee Limit, 129 
Float, 131 
Last Statused Date, 131 
Late Finish, 131 
Late Start, 131 
Level, 124 
Manager, 126 
Parent, 125 
Perf Dept, 126 
Resp Dept, 126 
Revised Letter Date, 130 
Schedule Reference Date, 130 
Start, 125 
Threshold, 127 
WBS % Complete, 131 
WBS ID, 125 
XREF Fields, 127 

Fill Down, 134 
navigating, 114 
orientation, 112 
thresholds, 116 

Weekly data 
data exports, 591 
posting weekly data, 322 

Weight field description, Milestones view, 260 
When a milestone is 100% complete, statusing, 243 
Work Breakdown Structure. See WBS 

WBS Sheet, 112 
Work in progress 

changing a milestone weight, 251 
changing an element’s Budget at 

Completion (BAC), 254 
changing an EVM, 249 
changing the BCWP base, 250 
modifying an element’s prior status, 

252 
Work Package element type in WBS, 128 
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X 
Xref field descriptions, Project Maintenance 

window, 62 

XREF Fields field descripton, WBS window, 127 
XREF option, Project Data options 

Import Conditioning window, 461 
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